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Preface

About this Manual
This manual combines primer, reference guide, and theory into one document. New
users are advised to read the Getting Started section, which acts as a primer to the sys-
tem. Detailed information on windows and parameter settings are described. Advanced
users may also look at some of the Appendices.

Appendix A describes attributes and filters, what they do, and what parameters can be
set. Appendix B describes the Command Driver plug- in. Appendix C describes
examples of SEG-Y loading problems and proposes solutions for the most often
encountered problems. Appendix D describes how to use OpendTect on Wacom Digit-
izing Tablets. Appendix E describes how to do Synthetic Data Generation in OpendTect.

This document was written using Madcap Flare. Two versions are published: an html
manual for online use and a pdf version for printing. The html manual comes with the
OpendTect software when it is downloaded from the Download Center. Both the html
and pdf manual can be separately downloaded from the OpendTect website:
http://www.opendtect.org/index.php/support.html

While every precaution has been taken in the preparation of this manual, it is possible
that last minute changes to the user interface are not reflected in the manual, or are not
described accurately. Please help us improve future editions by reporting any errors,
inaccuracies, bugs, misleading or confusing statements you encounter.

Please note that apart from this user manual, there is also an Application manager
manual. These can be found in the doc/SysAdm/base directory or the software install-
ation directory. Commercial plugins are not described in this manual but in separate
Help files.

Release Notes
This is the user documentation for release OpendTect v.5.0 - an open source post-pro-
cessing, and seismic interpretation system launched by dGB.

OpendTect is an open source software system that is released via the internet. Users
can download the software from the OpendTect website.

http://www.opendtect.org/index.php/support.html
http://www.dgbes.com/
http://www.opendtect.org/
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OpendTect system is a complete seismic interpretation system that can compete with
any commercial system available on the market to date.

OpendTect V5.0 is released under a triple licensing strategy:

1) under the GNU GPL license.
2) under a Commercial license.
3) under an Academic license.

Under the GNU / GPL license OpendTect is completely free-of-charge, including for com-
mercial use.

The Commercial license enables the user to extend the system with (closed source) com-
mercial plugins that can either be purchased or leased.

Under the Academic license agreement universities can get free licenses for OpendTect
and commercial plugins for R&D and educational purposes.

OpendTect is currently supported on the following platforms:

l Linux 32/64bit
l Windows 7, 8, 10 (32/64bit)
l Mac OS X 10.6 - Mac OS X 10.10

About OpendTect
OpendTect is a seismic post-processing and interpretation system, as well as an R&D
platform, for developing innovative seismic interpretation tools.

The system is released under a triple licensing strategy:

l under the GNU GPL license.
l under a Commercial license.
l under an Academic license.

For more information go to dGB's OpendTect download center.

This manual describes the functionality in the OpendTect system. Manuals for com-
mercial plugins have their own help files.
The manual may contain figures with dGB plugins like HorizonCube, SteeringCube,
Neural Networks etc ... However, these commercial plugins are described individually in
different sections in the dGB-plugin documentation.

http://www.gnu.org/licenses/gpl.html
http://dgbes.com/images/PDF/Proforma_OpendTect_commercial_V1-4.website.pdf
http://dgbes.com/images/PDF/Proforma_OpendTect_academic_v2f.pdf
http://www.gnu.org/licenses/gpl.html
http://dgbes.com/images/PDF/Proforma_OpendTect_commercial_V1-4.website.pdf
http://dgbes.com/images/PDF/Proforma_OpendTect_academic_v2f.pdf
http://www.opendtect.org/index.php/download.html
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OpendTect system features:

l Visualization and analysis of 2D and 3D seismic data in a single survey.
l Sophisticated 2D and 3D horizon tracking including auto-tracking, plane-by-plane,
line and manual tracking.

l On-the-fly calculation and visualization of various attributes and filters.
l Multi-platform distributed computing
l Plug-in architecture.

Other features in OpendTect:

OpendTect is built with MSVC 2005 starting from version 4.0, allowing for better integ-
ration with the third party libraries and stability on Windows Operating Systems. New fea-
tures have now been made available, previously unavailable for versions built with
Cygwin. OpendTect is available for both 32 bit and 64 bit Systems for Windows.

Installation and directory structure: The installation and directory structure are entirely dif-
ferent from the previous releases. Unlike the previous versions, OpendTect is a com-
plete Windows application and does not require any Unix shell scripts for its operation.
The console window is no longer necessary for OpendTect on Windows. OpendTect
can automatically find its current installation folder and load the data, plugins and icons
from respective folders. Use of DTECT_WINAPPL environment variable no longer
needed.

Progress Windows: The launching of batch programs and view progress windows is
now implemented in similar manners to that of Linux, which means the application has
almost the same features on both Unix and Windows (Previously, Cygwin Installation
could not launch view progress window ).

User Messages: User messages have been standardized, containing relevant text on
the buttons rather than only yes/no options.

Implementation of a new Axis Drawer: An axis drawer has been implemented with better
looking arrows and annotations. The new Axes will not interfere with the other 3D
objects in the scene. It is now possible to take the snapshot of the scene along with
axes, allowing the user to understand the orientation of the survey in the snapshot
image.

Implementation of Top Bottom Image: Users can add rectangular Images on top or bot-
tom of the survey box with transparency. This feature is useful if users want to add any



- 15 -

reference map of the survey so that they can understand the geographical position and
corresponding seismic profile in a better way.

View Orientation: A View North, and View North-Z options are available to the Graphical
Tools toolbar along with View Inline and View Crossline buttons.

Wacom digitizing tablets

OpendTect is the first seismic interpretation system to support Wacom digitizing tablets.
Workflows for horizon tracking, fault interpretation, drawing of polygons & bodies etc...
have been adapted to benefit from the superior hand-eye co-ordination offered by the
pen device.

For a video demo, click here

https://www.youtube.com/watch?v=fWsEsGe-268
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Copyright
The information contained in this manual and the accompanying software programs are
copyrighted and all rights reserved by dGB Beheer BV, hereinafter dGB. dGB reserves
the right to make periodic modifications to this product without obligation to notify any per-
son or entity of such revision. Copying, duplicating, selling, or otherwise distributing any
part of this product without any prior consent of an authorized representative of dGB is
prohibited.

OpendTect license holders are permitted to print and copy this manual for internal use.

Acknowledgements
The OpendTect system is developed around concepts and ideas originating from a long-
term collaboration between dGB and Statoil. Most of the system was and is developed
through sponsored projects. We are indebted to all past, present and future sponsors. To
name a few:
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Getting Started

System Overview
OpendTect contains several commercial and non-commercial plugins that have their
own menus/icons/toolbars.

Commercial plugin tools appear on the main window if the licenses are available.

The main user interface is shown below. The interface is comprised of main menu bar,
several toolbars (OpendTect, Graphical, Tracking, Color Table etc), a tree scene control,
and a 3D scene. Within the user interface, a scene contains the displayed data and data
is loaded as an element of the tree. The important toolbox is an attribute set window,
which is used to define seismic attributes as an attribute set. Such set can then be used
to display attributes on-the-fly, or to create an attribute output. The attribute set can also
be combined to generate a Meta-attribute. Meta-attributes can be predicted by using
Neural Networks, mathematical manipulations and/or logical operations. ChimneyCube,
SaltCube, FaultCube are our Patent Meta-attributes.

OpendTect main user interface including commercial plugins:

Just some of the functions for which OpendTect can be used:
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l To perform seismic data interpretation.
l To create advanced single-attribute cubes.
l To filter the seismic data.
l To track and filter horizons
l To combine attribute and filter responses by maths and logic (IF..THEN..ELSE,
..AND.., ..OR.. etc.)

l As a platform to develop new applications or plug-ins.

Projects in OpendTect are associated with a seismic survey, which must be defined at
the start (File - Survey). The survey specifications define the geographical boundaries of
the study area and the relationship between inline/cross-line and X/Y co-ordinate sys-
tem. Seismic data is loaded from external sources (e.g. SEGY) into OpendTect's CBVS
(Common Binary Volume Storage) format.

An important thing to remember is that OpendTect works with an active attribute set (You
can auto-load an attribute-set which will be active the next time you open the survey. Do
the following: open an attribute set window, then select File > Autoload Attribute set).
Only attributes in the current active set can be used to make displays. You must select
an existing attribute set or create a new one before you can apply attributes. If you wish
to test a different attribute or, in case you simply wish to change the parameters of an
attribute, you can do so by modifying the current attribute set.

Interactive testing of attributes is a key benefit of OpendTect. Attributes and input data
can be visualized in multiple graphic windows ("Scenes") using multiple plane viewers
(inline, crossline, randomline, Z-slice). Each scene has its own graphic tree that controls
the elements that can be switched on/off. The plane viewer dimensions can be re-sized
to reduce calculation times. The attribute specification window supports a direct applic-
ation mode for fast testing of attribute parameters. Press the "Swift" icon to apply the cur-
rent attribute to the currently selected active element. Up to eight different attributes can
be displayed in one element (inline, crossline, 2D line, Z-slice, randomline).

Multi-Threaded Programming
A thread of execution is the smallest unit of processing that can be scheduled by an oper-
ating system. It generally results from a fork of a computer program into two or more con-
currently running tasks. The implementation of threads and processes differs from one
operating system to another, but in most cases, a thread is contained inside a process.

Multithreading allows multiple threads to exist within the context of a single or multiple
process. These threads share the process' resources (such as memory) but are able to
execute independently.
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OpendTect uses the power of multithreading to run different applications in data loading,
visualization, processing etc ..

Multithreaded: Not multi-threaded:
BG Steering* Constant Steering
Central Steering Convolve (Wavelet option)
Convolve (all except Wavelet option) DeltaResample
Curvature Energy (Gradient option)
Dip Angle Event Steering
Velocity Fan Filter (=DipFilter) FaultDip
Energy (all except Gradient option) FingerPrint
Event GapDecon
FreqFilter* HorizonCube Curvature
Frequency* HorizonCube Dip
Full Steering HorizonCube Spacing
HorizonCube Data Horizon
HorizonCube Density Match Delta
HorizonCube Layer Maths (recursive expression)
Hilbert Perpendicular Dip Extractor
Instantaneous** SampleValue

Local Fluid Contact Finder Scaling (scaling type AGC and stats
type = detrend)

Maths (except when expression is recursive) Shift
Polar Dip
Position
PreStack
Reference
Scaling (all except scaling type AGC and stats
type = detrend)
Semblance
Similarity
Spectral Decomposition*
SpectrogramDip (create SteeringCube, FFT
steering)
Texture
Tutorial
Volume Statistics
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*multi-threading implemented in March 2014
**multi-threading improved in March 2014

Toolbars
Please refer to the relevant sections below for details:

OpendTect Toolbar
The OpendTect toolbar contains icons to launch OpendTect specific modules:

starts the Survey definition module

starts the Attribute module 3D

starts the Attribute module 2D

starts the 3D output module

starts the 2D output module

starts the Volume builder

starts Attribute vs. Well crossplot

starts the Attribute vs. Attribute crossplot

leads you to the RockPhysics library

starts the XField Plugin*
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starts the PDF 3D Plugin*

starts the Fluid Contact Finder (CCB) Plugin*

starts the Generic Mapping Tools Plugin

starts the HorizonCube Plugin*

starts the Madagascar link

starts the 3D Neural Network Plugin*

starts the 2D Neural Network Plugin*

starts the SynthRock Plugin*

starts the Well Correlation Panel Plugin*

* These are commercial plugins, that are available under license. See:
http://opendtect.org/index.php/support/licenses

Manage Toolbar
The Manage Toolbar allows fast access to the various data management windows via
the following icons:

http://opendtect.org/index.php/support/licenses
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Opens the Seismics Manager (options for 3D, 3D Prestack, 2D
and 2D Prestack)

Opens the Horizons Manager (options for 3D and 2D)

Opens the Faults & FaultStickSets Manager

Opens the Well Manager

Opens the Pickset Manager

Opens the Bodies Manager

Opens the Wavelet Manager

Opens the Stratigraphy Manager

Opens the HorizonCube Manager* (options for 3D and 2D)

* HorizonCube is a commercial plugin, available under license. For more details, see:
http://opendtect.org/index.php/products/commercial-products/horizoncube

Graphics Toolbar
The graphics toolbar contains icons to manipulate the scenes (graphics window) using
the icons listed below:

http://opendtect.org/index.php/products/commercial-products/horizoncube


- 24 -

When this icon is visible, you are in interact mode
on. Click on the element that you wish to move or edit.
If the element is an inline, crossline or Z-slice, a frame
with handles (green squares) appears around the
clicked element. The handles are used to re-size the
frame. Clicking and dragging inside the element is the
way to move the entire element in the in-plane dir-
ection. Tip: For accurate positioning of a data element,
use the Position option from the right-hand mouse but-
ton pop-up menu in the tree.

When this icon is visible, you are in view mode. In
this mode, you can rotate the view and zoom in and
out. Tip: in order to evaluate data values, zoom in and
switch to interact mode by clicking on the appropriate
icon. Move the cursor over the zoomed-in data and
watch the returned position (inline, crossline and
X,Y,T plus value) in the status line at the bottom of the
main window.

Resets the view to the position that was saved
when you pressed the "save home position" icon, one
below.

Saves the current view as the home position that
can be recalled with the previous icon

Allows to reset the view such that all data are vis-
ible.

Toggles the view between orthographic & per-
spective view.

Use this icon to set the scene orientation to a par-
ticular 'standard' direction. Options include 'View
Inline', 'View Crossline', 'View Z', 'View North' and
'View North Z'

Will open the directional lightening dialog box
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The display rotation axis is used to show/hide the
N-E-Z (North-East-Z) orientation arrows. This button
can only be activated in View mode, but the arrows
remain active in both view mode and interact mode.

Toggles the colorbar on and off.

Opens the snapshot window, so that the user can
grab pictures of the scene, window, and/or the
desktop.

Sets the selection to polygon or rectangular
modes and allows the user to select an area (or ele-
ments within an area, i.e faults sticks..)

For removal/deletion of selected elements.

Displays selected element only. When more than
one element is displayed in the tree, one can quickly
view a single element and toggle between elements
by clicking the different elements in the tree.

Tool to measure distances by drawing a polygon
on an inline/crossline or on a Z-slice. The tool returns
horizontal distance (meters), vertical distance (ms in
time survey or meter/feet in depth survey) and the
inline or crossline distance respectively. The distance
is computed by using input constant velocity.
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Take Snapshots

It is possible to take different kinds of snapshots in OpendTect. Three options are avail-
able: Scene,Window, and Desktop.

The Scene option allows the user to grab the displayed (selected) scene within
OpendTect.The OSG (OpenSceneGraph) 3D library is used, allowing the output picture
to have a better resolution than the screen resolution. Every element displayed in the
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scene will be in the output picture, including the annotations (color bar, orientation etc) if
displayed. Any overlapping windows will be neglected.

You can change the image properties e.g. height, width, resolution etc. If you save the
settings, they will appear by default in all sessions next time you grab new snapshots.
The 'Screen ' parameters corresponds to the parameters of the picture as displayed on
your screen.

TheWindow option grabs the whole window, including the sidebars. It can be either the
main window or any 2D viewer opened when the snapshot button was pressed.

The Desktop option is similar and will snap the entire user desktop. Both options use the
Qt library for grabbing the picture. As a result the output is limited to the actual screen res-
olution, and overlapping windows will appear on the snapshot.
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Directional Lighting

The directional lighting feature is used to illuminate the objects (displayed data) at a spe-
cific inclination (or dip angle) and azimuth. The feature controls the main headlight i.e.
the intensity of the camera light and the intensity of the directional light. The dialog is
launched by clicking the icon shown above.
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Directional light Dialog

The directional light dialog updates the scene instantly to reflect the changes made to
the properties. If the OK button is clicked, the changes are retained, whereas, the Cancel
button rules out all changes.

Apply light to: The directional lighting is independent for each scene, i.e the selected
scene will be illuminated. However, selecting the option All in the drop down list will illu-
minate all scenes that are currently open.

Azimuth: This slider is used to set the azimuth (in degrees) value of the directional light.
It can be any value from 0 to 360 degrees.

Dip: This slider is used to set the dip value (in degrees) of the directional light. The dir-
ectional dip is limited from 0 to 90 degrees.
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Intensity: Sets the percentage of the intensity of the additional directional light. 0% cor-
responds to total darkness while 100% corresponds to full intensity.

Show polar diagram: The azimuth and dip can be visualized using this diagram. This
diagram can be used in combination with the sliders of the main dialog in order to pos-
ition the directional light around the scene.

Polar diagram dialog

This is a dialog that displays the polar diagram for setting the azimuth and the dip values
of the additional directional light. The location of the pointer (the red dot) determines the
properties of the directional light. The pointer can be moved around by using the mouse
within the polar diagram. The azimuth value can be read off the circumference of the out-
ermost circle while the dip value is given by the location of the pointer along the radius of
the circle.

Camera light intensity: Use this slider to change the percentage of intensity of the cam-
era light or the head light. 0% corresponds to total darkness while 100% corresponds to
full intensity.

Similar to the directional light dialog, the changes made to the azimuth and

dip are instantly reflected in the selected scene(s).



- 31 -

Tracking Toolbar
This toolbar will remain hidden until you choose to track a new surface. Eg:

Once visible, the tracking toolbar will remain in position, just below the scene. Inactive
icons are visible, but greyed-out.

The Tracking toolbar contains icons to control tracking of surfaces:

Opens Tracking Settings

Activates seed pick mode

Starts horizon tracking from seeds

Removes all previously auto-tracked horizons, after which they are re-
tracked from seeds only (within the tracking box).

This icon toggles the tracking cube on/off. Only data within this volume is
stored in memory. When the tracking cube is on, it can be re-sized using the
green anchors.

This icon displays the QC plane in the direction of the inline. The user

can also QC the tracking on a crossline or timeslice

The tracked horizon will be displayed at current section only

The tracking plane can be moved N positions back /
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forward i.e. towards a lower/higher inline, crossline or time (depth) number. N
is the specified step size (in this case, 1).

Polygon selection tool

Remove / delete the selected elements (within the selection area).

Undo /redo

Save

Slice Position Tool

The slice position toolbar is used to move the 3D slices (inline, crossline or timeslice)
according to the user-defined steps. The slice position and number of steps are manu-
ally entered in the fields. The forward and backward arrows of this toolbar are used to
move the selected slice in increasing or decreasing directions. The workflow is very
simple. Add an inline in a scene. By default, a blank attribute (inline, crossline or
timeslice) is added in the middle of the survey box. Right click on the attribute and add
display the seismic data. Select the inline in the tree. Note that the toolbar items will be
updated and the arrows will be activated. Update the inline position and the steps in the
toolbar. Use the arrows to move the inline position according to the given steps.

While moving the planes, the progress bar appears by default every time

when a user moves the plane to display the data. This can be avoided by

changing the Personal Settings. Additionally, if the computer memory is suf-

ficient, the seismic volume can be preloaded for displaying it quickly. Use Pre-

load settings to keep a seismic volume in the memory.

Keyboard shortcuts can be used to ease the sliding: Utilities > Settings > Key-

board shortcuts. The step used will be the one specified in the slice position

tool.
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Mouse Controls - Scenes and Graphical Interaction
The workspace contains one or more graphics windows. There are two basic manip-
ulation modes: view mode and interact mode. The latter has two sub-modes: moving and

picking. One can toggle between the view and interact mode with the Esc key or
by directly clicking on the icon.

In view mode (active when the "hand" icon is displayed), the cursor is displayed with

two circular arrows ( ). In this mode, each scene can be rotated and zoomed inde-
pendently using mouse button operations. Left-click and drag is for rotating the image.
Simultaneous left+middle button click and drag is for moving the camera closer or further
away. Shifting the image is done by middle mouse button click and drag movements.

In interact mode (active when the "arrow" icon is displayed), the cursor is an arrow. In
interact mode, you can move the elements in 3D space (move mode) or you can pick
example position to train neural networks (pick mode).

In pick mode, the current pickset is highlighted in the tree and the status bar displays a
message; for example: "Nr of picks: 25". A new position is added to the current pickset
by clicking with the left-hand mouse button. The status bar message is updated: "Nr of
picks: 26". Picks from the current pickset can be removed by holding the Ctrl-key (the
Apple key on MacOS) and pressing the left-hand mouse button.

Move mode is used to move elements to other positions in the data cube (ie: to move/re-
position an inline, crossline, Z-slice or volume). An element is selected by clicking with
the left mouse button in the tree, or on the element in the graphics window (only if you
are not in pick mode). Arrows and a frame with handles appear around the active ele-
ment. Moving the element to another parallel plane is done by left-clicking and dragging
on one of the arrows. The new position is also indicated in the status bar at the bottom of
the OpendTect main window. The element can be re-sized by left-click and drag on one
of the green handles. Left-click and drag inside the element moves the element in the in-
plane direction. Data will be loaded into the new position after left-clicking outside the
element frame. To reset to the initial position, right-click and chose reset manipulation.
Left-click outside the element validates the move.

Direct accurate positioning of data elements is possible using the Position option from
the pop-up menu in the tree. In interact mode, as well as move the cursor position (inline,
crossline, Z-slice), the data value at the cursor position are returned. These are dis-
played in a status line at the bottom of the OpendTect main window. Scenes can be
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rotated and zoomed in and out simultaneously using the wheel controls and the zoom
slide-bar in the OpendTect main window. These controls operate irrespective of the view
mode (view, interact, pick).

With Mouse

View Mode Interact Mode
Move Mode Pick Mode

left-
click +
drag

rotate

left-click activate
element

left-
click

pick
position

left click outside active element, or left
click in empty space of tree

de-activ-
ate ele-
ment

CTRL-
left
click

delete
pick

middle-
click shift left click+drag arrow

move
element
to par-
allel
plane

left-
and
middle-
click +
drag

move camera
closer/away left click+drag inside active element

move
element
in-plane
direction

left-
click +
drag +
quick
release

spin left click+drag handles resize

move cursor

return
position
and
value

move
cursor

return
position
and
value

Using Touchpad

View Mode

Hold down left-click and move Rotate
Hold down Ctrl+left-click and move Pan
Hold down Ctrl+shift+left-click and
move Zoom
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De-activate elements is also possible by clicking (left-hand) in an empty

space of the tree.

The Apple key usually has the same function as the CTRL key on a PC.

However, it is recommended to use a three-button mouse. All manipulations

mentioned in this table (and elsewhere in the documentation) are also pos-

sible with a single button apple mouse, in combination with SHIFT and/or the

Apple key and/or the CTRL key, but it is easier to work with a three-button

mouse.

Color Tables
A colortable is a predefined group of color settings that can readily be applied to any
attribute. This group includes items such as the primary colorbar, undefined color set-
tings, color segmentation, and opacity. Changes made to the colortable are applied uni-
versally to any item that uses that colorbar.

A colorbar is the specific colortable for a particular element's (line/horizon) attribute that
is displayed in a scene. Updating the colorbar can update the selected element's attrib-
ute. The image below is an example colorbar:

The colorbar is composed of four elements: the color display itself, the minimum and the
maximum value of the variation for the colortable (as it is defined for the currently selec-
ted item), and a set of colortables.

This drop down list of predefined colortables appears when the user clicks on the name
of the colortable being used in the colorbar (ex: Channels). If no item is selected in the
tree, the colorbar will not show any value/range although it can be manipulated. The
colortable is manipulated by right-clicking on the colorbar.

The pop-up sub-menu contains several manipulation functionality. These are described
in the following:
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Flip causes the scale to be flipped. (The color assigned to the high value, now becomes
the color assigned to the low value, etc.)

Ranges/Clipping allows the user to change the range of the color scale, or clip a certain
percent of the scale. Please be aware that because of display time consuming, only
2000 random sampling points are by default used to clip data. The clip values thus
change from one data set to another.(An alternate method for clipping is described in the
Inline, Crossline & Z-slice sub-chapter).

Set as default sets the current color settings as the default color scheme for all elements
in the tree.

Manage is used to modify the current colortable and to create new colortables with the
current one as a starting point. Colortables are modified by adding, removing, changing
colors, varying opacity, and defining the colorbar to be gradational or segmentized. The
effect of the changes on your displayed element can be seen directly. Colortables can
be removed from the list by pressing the Remove button. (OpendTect Default colortables
can not be removed). Moreover, the user can import user-defined colortables by pressing
the Import button.

Colortable Manager window
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The Colortable Manager window opens when the user selects the Manage option
described above.

A marker is the color you see in the colorbar. The black lines, in the white field above the
colorbar, are the marker boundaries. The marker boundaries are where the settings for
the markers are defined. Right-clicking on a marker boundary shows the following
options: Remove color, Change color, and Edit Markers.

Remove color deletes the marker boundary from the colortable.

Import colortable file: The colortables can also be imported by pressing the From other
user... button. The default colortables are stored in a file (ColoTabs) that is located in the
OpendTect installation directory (/root/opendtect-4.6/data/). Moreover, the colortables
saved by a user are stored in a file (settings_coltabs.user) that is located in the user
home directory ($HOME/.od/), here user is the OpendTect username. These files can be
modified or imported by using import color table window (see below).



- 38 -

Marker color brings up a standard color definition window, where this defined color can
be changed.

Edit Markers opens the Manage Marker window that displays all markers: marker ID,
position, and current color. The marker's position, in relation to low and high values, can
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be specified by number. The standard color definition window can be opened from here
too, by double-clicking the marker color.

Opacity: A thin red line, capped on each end by small red nodes, is visible at the bottom
of the histogram located in the top panel. By moving these nodes, or adding additional
nodes, the user can vary the opacity of the colors below. One can add opacity nodes by
double-clicking in this area. These opacity nodes can be dragged up or down to
increase or decrease, respectively, the transparency of the color directly below it in the
colorbar. A hatched area (visible in the color toolbar in the main window of OpendTect)
indicates the part of the color bar that will display with some level of transparency. The
darker the color of the hatch marks, the higher the level of transparency.

Transparency performance depends on the graphics card. When displaying

two elements in exactly the same position, transparency may not work as you

expect. It may help to set transparency values to the maximum to get the sort

of display you desire. In addition, it may help to change the transparency of

the element as a whole by right-clicking the element in the tree, and selecting

Properties.

In the background of the opacity panel, a histogram is shown in light grey. This his-
togram shows the distribution of attribute values in the selected element. This helps you
to tune the colorbar to the value range you may want to highlight. To alter the histogram
see Show Histogram in the Inline, Crossline & Zslice sub-chapter.

Segmentation allows the user to segment the colorbar into a user-defined discrete num-
ber of colors. This can be done in a Fixed or Variable manner. Fixed allows the user to
define the number of segments they would like to have, but does not allow the marker
boundaries to be moved. Variable allows the user to both define the number of seg-
ments, and move the marker boundaries to suit specific needs. Fixed is good for pur-
poses such as velocity and contour lines, while Variable is good for use with waveform
segmentation.

Undefined color specifies the color that will be used to display undefined values in the
data.

General Selection Window
The general selection window is used for various purposes:
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l Selection of an attribute set (2D/3D Attributeset > Open attribute set...)
l Restoring/Saving a session. (Survey > Session > Save/Restore...)

The window contains following standard buttons:

renames the object.

toggles the object to Read only. Use this option to protect any object from
overwriting.

removes the object.

sets the object as default.

When the user clicks Survey > Session, there are three options: Save.., Restore.. and
Auto.., which enables the user to select a session which will restore, by default, each
time the user opens OpendTect.
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2D Viewer
The 2D Viewer is used for examining the seismic data of an inline, crossline, or a 2D
lines in a 2D-screen. To open the main 2D viewer, display an attribute on e.g an inline.
Right-click on that attribute, display in a 2D viewer as .. Wiggles or Variable Density
(VD).
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The 2D Viewer shows several options:

Enables the user to select a zone of interest and to zoom in on this region: In this
mode the mouse wheel will zoom in and out, and the left click will drag the data on the
sides. The view is refreshed only once the left click button is released.

This option can be used to zoom in a specific area within the viewer.

This creates seeds on the 2D viewer, this is especially possible when tracking a hori-
zon. To track an horizon on 2D viewer, make sure that the picking mode is active in both
the main scene and the 2D viewer.

Zooms in when clicking

Zooms out when clicking

Flip the 2D-section

enables the user to grab pictures

Set display parameters

2D-Viewer's Help

Manage the polygon selection

Remove the selected data within the polygon

Clicking this icon will start the HorizonCube slider
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When clicking the right mouse-button on the 2D Viewer, and clicking Properties, the Spe-
cify Display Properties Window appears in which the display parameters can be set for
both theWiggle Variable area and the Variable Density.
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2D Viewer Wiggles Display Properties; 2D Viewer Variable Density (VD) Display Prop-
erties; 2D Viewer Annotation Settings

Please note that under the 'Annotation' tab, the user may choose between different dis-
tance values to be displayed on the Axis-distances:
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l Trace number*: This will display the traces number on the X axis
l Reference position*: This displays the SP (shot points) number that is available in
the shot point header field of the original SEG-Y

l X-Coordinate: This shows the X coordinate in the axis
l Y-Coordinate: This displays the Y coordinate in the axis
* for 2D only

Pre-Stack 2D Viewer
In this window one or several pre-stack dataset can be viewed simultaneously. In this
viewer you can:

l Display gathers from one datastore at different locations.
l Display gathers from different datastores side by side.
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l Use the two modes above in combination.
l Display mute definitions that were either imported or computed before starting the
viewer.

l Apply a pre-processing on the gathers: AGC, application of the mute functions
(stored or computed on the fly), ...

l Display an angle gather by providing the corresponding velocity model using a
stored cube.

Gathers position selection
You can set the gathers to be displayed from this window. The top part is used to set a
grid of regular positions from provided ranges. Keep in mind that you can get another 2D
pre-stack viewer if you wish to have data from several inlines. From this regular grid, you
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set the position where gathers should be displayed. You can also manually change a
crossline number. Press Apply to reload the view.

Selection of several datasets

Multiple gathers can also be added together in the 2D panels by pressing this icon.
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Display of angle gathers
In this window you can set the parameters for creating the angle gather that corresponds
to the prestack datastore. For each sample of the input seismic prestack gather, the incid-
ence angle in degrees will be computed and color-coded with the rainbow colorbar. The
seismic data will then switch automatically to wiggle display.

Example of pre-stack gathers (wiggle) with a mute functions, and the corresponding
angle gather on the background:
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How To

QuickStart a Project
OpendTect is a seismic attribute processing, visualization and interpretation sys-
tem.

The primary input is:
A 3D seismic data volume or 2D seismic data set (most commonly as SEG-Y files)

The primary outputs are:
l A 3D volume/2D data sets, such as a filtered cube/data sets or any other type of
cube/data set produced by the system. Seismic data are exported via SEG-Y.

l Interpretations horizon/faults.

OpendTect Projects are associated with a seismic survey. The first time OpendTect
is started, the user must define a new survey and import seismic data. At subsequent
start-ups, OpendTect will start-up in the survey that was active when the program was
closed. The user may select another, previously defined survey using Survey >
Select/Setup and browsing to its location using Set data root.

Define a new survey. Select the Select/Setup option under the Survey menu or click on

the survey setup icon . In the Survey Setup and Selection window, now press the

Create New Survey icon . The Create New Survey window appears, giving you sev-
eral options on how to setup your new survey:
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Choosing to Enter by hand brings you to the Edit Survey Parameters window where you
can specify the name of the new survey. The ranges and the relationship between
inline/crossline and X/Y coordinates can either be set manually, copied from another sur-
vey in the same data root, or obtained by scanning a segy file. After scanning, you can
still adjust all parameters.

Optionally, a data access module can be purchased at dGB that gives access to Seis-
works/OpenWorks (Landmark) or GeoFrame (GeoQuest IESX). The core of this module
is developed by UK-based software providers ARK CLS. The license gives you access
to the data store of your choice. It currently supports I/O of survey parameter, seismic
data, horizons, and well data.

1. Import seismic data. Select Import-SEGY via Survey > Import > Seismics
> SEG-Yand specify the input parameters. In case you do not know the para-
meters, use the Examine utility to dump the EBCIDIC header, the binary
header and the first 100 traces header. From these it should be possible to
determine the few input parameters needed by the program. The internal
OpendTect format is 8,16 or 32-bit depending on whether the input Cube was
8, 16 or 32 bit.

2. Generating seismic attributes. Now, you are almost ready to go! You
have created a survey, which contains at least one seismic volume. To do

http://dgbes.com/index.php/products/commercial-products/workstation-access
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some real work, you must also create one or more attributes in the attribute
engine that reveal relevant, useful seismic information. Several default attrib-
ute sets are available to get you started quickly. Open the attribute engine

Analysis>Attributes (or press the icon) and press the button to open
a default attribute set. You are asked to select the input data to complete the
attribute definitions. Press "OK" to save the attribute set, this will bring you
back to the main window.

3. Display your data or attributes. Now you are ready to display any of the
defined attributes, anywhere in the volume. Display in the scene, for
example, an inline element by right-clicking on Inline in the tree and pressing
Add. The empty element is by default in the middle of the cube. You can
move it in the scene using the arrows. Once the element has been added to
the scene, right-click on the element in the scene and Add > Attribute... select
in the data selection window that automatically pops up the data you wish to
view on this element. You can either select from a stored volume or you
select one of the defined attributes. If you choose an attribute, then this attrib-
ute will be calculated on-the-fly at all sample positions of the displayed ele-
ment.

The time taken to display an attribute on-the-fly can be significantly longer

than the time taken to display a stored volume. That is why it is recommended

to store your attribute(s) as stored volume or stored surface data. (See Create

Seismic Output - 3D, Create Seismic Output - 2D and Create Horizon Output)

You can also find tutorial videos on the OpendTect's website, which will guide in steps
to start a new project.

OpendTect Survey
The OpendTect Surveys are organized under Survey selection window which is used to
change, create, edit or remove the survey(s). It is launched from Survey > Select/Setup

or select survey icon .

The Survey selection window is divided into four panels with some key buttons. The left
panel shows the already existing surveys in the present root directory. The root (location)

directory of OpendTect survey can be changed by pressing the Set Data Root... icon

http://opendtect.org/index.php/support
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. The right panel shows the map view of selected/loaded survey. It is helpful to QC the
survey orientation (true north display).

The information panel gives the basic survey information (in-line, cross-line, Z-
ranges, bin-size and 2/3D...etc)

The bottom notes panel is the place to put important notes about the project (Type of
Project, Client Company, Contact Person etc ...).

For more further information about this window, please go to Survey selection window.
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Setup 2D & 3D Survey

To setup a new Survey (2D/3D) press New button in the survey selection window.
The Create New Survey window will pop up (see below) which will lead you through the
setup process.

The survey setup defines the survey box. The key parameters are the survey type and its
respective coordinates. These can be entered either manually, by scanning a SEG-Y
file, or copied from another OpendTect survey if one already exists in the data root folder.
Optionally, in case you have workstation access, you can get them from GeoFrame as
well. Or if the OpendTect survey already exists, copy the coordinates by pointing the
other survey.

For full details of this setup process, please refer to New Survey Window (and sub-
sequent entries).

In OpendTect, everything is tied to a 3D (X,Y,Z) with inline/crossline coordin-

ate system. This is regardless of whether you have 3D data at all. Thus, for a

survey which contains only 2D lines, a 'fake' 3D survey box of inline/crossline
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system is needed. If you want to use both 3D and 2D data, set up the survey

according to the 3D cube.

Survey Name and Type

The top most panel of the survey setup window defines two important things along with
its disk location. The Survey directory name is entered in the first field. A directory with
this name would be created in the root where you will save the OpendTect survey. The
field for Full Survey name is filled with proper name of the survey that will be seen later
on in the OpendTect survey selection window. Any name can be given to the survey and
its directory but we advise you to gives similar names. The name can be edited later. In
third field select the location on disk where you want to save this survey.

The most important thing is the Survey type which can be Only 3D, Both 2D and 3D or
Only 2D. The type is set accordingly:

l Only 3D is used when the survey contains only 3D cube(s).
l Both 2D and 3D is set when survey contains both 3D cube(s) and 2D line(s).
l Only 2D is set when survey contains only 2D line(s). Remember: A fake
inline/crossline system is defined to setup such a survey regardless of the fact that
the 3D cube is not actually present.

Survey Ranges

In the second panel of survey setup window the fields for Inline, Crossline and Z-ranges
are filled with following possible ways:

l Filling the ranges by scanning a SEG-Y file: Set the Survey ranges in Scan
SEG-Y File(s). The SEG-Y import window will pop up. In this window, select the
input file/volume and press OK to start scanning the input file. After the scan is com-
pleted, the survey ranges will be filled automatically.

l Entering Manually: If you already know the extents of survey ranges (Inline/Cross-
line/Z-range), just fill the maximum and minimum ranges and corresponding steps.

l For 2D only: Set the Survey ranges into Set for 2D only and press GO... The win-
dow will pop up (as shown below) in which the average trace distance (which
determines the grid spacing of the 3D horizons) and the ranges for XY-coordinates
are entered; Fill the approximate values and press OK afterward. These para-
meters are the survey characteristics used to define the survey box. In the survey
ranges the fake ranges for inline, crossline are automatically set. Then fill in the Z
range (no precision needed; 2D lines can stick out of the display box in all
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directions). The limit of the survey box will not affect the loading of 2D lines. The
lines outside the survey area would be loaded normally. And that should be it.
Press OK and select the new survey.

l Get from GeoFrame: This option is used if you have workstation access to get the
survey ranges from a GeoFrame project.

l Copy from other Survey: Additionally, if the survey already exists, you can copy
the ranges from that OpendTect survey.
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Coordinate Settings

The relationship between inline/crossline and X/Y is setup generally by using this panel.
The coordinates are automatically setup after scanning the SEG-Y file. You will only fill
them if you are inserting survey ranges manually. Nevertheless, the three point (easy)
method is not accurate because of rounding off errors which may not be 100% accurate.
Both methods have been described here.

l In Easy mode, the coordinates are transformed by using three known points.
Under Coordinate settings panel of Survey setup window, fill the inline and cross-
line and corresponding known XY-transformation as shown in figure of previous
section.

l In Advanced mode, the XY coordinates are calculated by using an equation
shown below. The inputs required from user are origin (X,Y) and inline/crossline
intervals along X/Y directions respectively. By checking the Overrule easy settings,
the current easy settings would be overwritten.

The basic idea behind this has been elaborated in following figure:
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** The required inputs include origin X,Y pair, inline and crossline interval in both X & Y
directions.

If the provided coordinates are in feet, the Coordinates are in feet check box

must be checked. If the survey is a time survey and the Z-range units are set

to milli-seconds (ms), you might want to display the depth in feet in the

scene/annotations. For the later purpose the check box Display depths in feet

should be checked.

Data Loading
The data loading is briefly addressed in two sections. The first section will guide in load-
ing the 2D/3D SEG-Y data, while the second will guide in loading well data.

Load Seismic (2D & 3D)

The loading of SEG-Y data is done via Import sub menu under survey main menu (Sur-
vey > Import > Seismic > SEG-Y..)
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To start loading of 3D SEG-Y Volume, follow the steps:

1. Go to Survey >Import > Seismic >SEG-Y... In SEG-Y Tool window choose File
type: 3D Volume to import the SEG-Y data.

2. In the Input SEG-Y field, select and locate the input SEG-Y file.
3. Set check to the Multiple files to import more SEG-Y files. Write the number of files

in the first text field and number of steps (e.g. Vol-1, Vol-2, Vol-3, ... Vol-n). Where
'n' is number.

4. Select the input file type: 2D/3D-Pre or Poststack data.
5. Select the number of traces that will be examined to display the trace header

information.
6. Optionally, if you want to overrule the number of samples, set check to this field

and fill the correct number of samples.
7. Select an appropriate SEG-Y file format.
8. If the bytes in a header have to be swapped, it can be set here.
9. Press OK to proceed further
10. The SEG-Y Scan and SEG-Y Examiner window will launch in next step. Fill the

appropriate byte locations in the SEG-Y scan window. Write the output cube name
and press OK to start loading the SEG-Y file.

Load Well Data

In OpendTect, the well data has been organized into four sub-categories: Well tracks,
Logs, TD Models and Markers. Each category is either loaded via Survey > Import menu
or via the Well manager. In this section, we will cover how to load/setup a complete well
in OpendTect.

Load Well track and Time to depth Model (via Import): To load a well track, go to the
main menu bar and select Survey > Import > Well > Ascii > Track. The Import Well Track
window will be launched. In the Well Track file field select the input well track file. The
Well track file should contain three main columns i.e. X, Y, TVDSS (True Vertical Depth
Sub Surface) and optional MD (Measure Depth) column. The file header can be defined
in this window. Click the Examine button to view the input file before loading, and to
determine the header type. See Import - Well section to learn how to set the file headers
(fixed size/variable). The format definition is used to specify the columns (XYZ) definition
and unit system of the input ASCII file. Optionally, a vertical well can also be defined if
the file doesn't exist. This is done by setting uncheck toWell Track File field. In this case,
specify the XY coordinates and depth range (default meters).

In the depth to time model field, locate and select the appropriate time-depth file. Specify
the file header and format definitions. If the time-depth model/checkshot does not exist,
set uncheck to this fill to set a constant velocity model to load the well. Later on the time-
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depth model/checkshot can be imported via the Well Manager. Additionally, specify
whether the file is a checkshot data or not. The additional information (Well ID, Operator,
State, Country) can be included in the well track by selecting the Advanced/Optional but-
ton.

Name the Output well and press Go, to complete the loading of well track. It will return a
message, "Well track imported successfully". Press Ok to close information window.
Press Dismiss to exit.

Note: The surface coordinates and elevation above surface are defined from

the well track file. In normal cases, these definitions will be in the first line of

the well track file. If the well track file starts below the datum (KB, Kelly Bush-

ing), you will need to manually adjust these parameters in the well track file

before importing it as a well track. Elevation above the surface is normally con-

sidered positive if the reference datum is above sea level. Conversely, if the

elevation reference is below sea level, you can define the negative values in

the elevation as those above the surface elevation reference.

Load Logs & Markers (via Well manager): Launch the Well manager . Here you
will find the loaded well track(s) from the previous step in the left panel.

To import Logs, select the recently loaded well and press the Import button. In pop-up
window, select the input LAS log file, and then examine the file. The remainder of the
window will be automatically filled in from input file. Importantly, if you only want to load
certain logs, highlight only the wanted logs. (By default all available logs will auto-
matically be highlighted.) Press Ok. The logs will be loaded and will appear in the right
panel.

To import Markers, select the recently loaded well and press the Markers button. In pop-
up window, select the Read file button and follow the same steps as before when load-
ing Ascii files. Alternately, instead of reading a file, you can manually type in the depth,
name and assign marker colors.

Updating well tracks, checkshot data, and depth to time models can also be done in this
Well file management window.
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Display Loaded Data
To display the loaded Seismic data, use a mouse click on inline/crossline in the tree and
select the Add sub menu from the pop-up tree. A seismic line will be displayed in the
middle of a survey that will contain a blank attribute. Right click on the attribute to select
and display the loaded data. In a similar way, a 2D seismic line can also be loaded from
the 2D Seismic element.

In order to load a horizon, click on the Horizon element in the tree to select the inter-
preted/imported horizons from a list. Select Add option from the pop-up menu tree. In the
pop-up window, select one or more horizons to be displayed in the scene. The horizon
with its Z-values will be displayed in the scene. You can edit/select the desired color-
spectrum (Color Tables ). And, just as for inline/crossline/z-slice, you can also add a
defined attribute from the active attribute set that will be calculated on the fly along this
horizon.

To display the loaded Wells in the scene, click on the tree element 'Well ' and click
'Add'...Select the desired Wells. The Wells would be displayed in the scene. To manip-
ulate a Well and set its properties, right click on the Well name in the tree. The pop-up
list will show the options available. From here you can edit Well track, Show/Hide Mark-
ers/Logs, change the properties, select logs, etc.

Troubleshooting:

l Often, users do not find a good trace number in the SEG-Y headers. Without that,
weird things can happen. Use the Examine button in the SEG-Y setup dialog to fig-
ure out what header value may be usable as trace number. Or better: find the num-
ber that you recognize the data by.

l If X and Y in the SEG-Y file are not correct, the data may be a long way outside the
Survey box. Then, nothing may be there after loading a line, or even the entire Sur-
vey box disappears.

l If you have trouble with your graphics card, the lines may remain white after load-
ing the Seismic data. But if your mouse goes over the line, you can see Coordin-
ates, trace numbers and amplitudes. Then try to:

l install the latest driver
l make sure you have a good card (hopefully NVIDIA-based)
l disable OpenGL shading in Utilities >Settings >Look and feel... Visualization
tab...

If this does not help, please check through the Appendix-C (SEG-Y Check list)
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Interpret Horizons

3D Horizons

Horizons can be tracked in various modes:

l Autotracked
l Tracked on lines (in the 3D scene or 2D viewer)
l Manually picked on lines (in the 3D scene or 2D viewer)

Basic Workflow:

1. Add an inline/crossline and display the seismic data you want to use for the inter-
pretation

2. Right-click on Horizon in the tree and select Track New ....
3. Define mode and tracker settings.
4. Pick seeds, Autotrack (or interpret the horizon on lines).
5. QC and Edit the horizon.

These steps are explained more fully below:

1. Define mode and tracker settings
Right-click "Horizon" in the tree and select New ....This will launch a tracking setup
which contains several tabs:

l Mode:
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Choose the tracking mode:

l Tracking in volume is used to auto-track a horizon inside a user defined
tracking area (3D (sub)volume). The tracker area can be moved and
adjusted inside the survey box. This mode is preferred for most horizon
tracking.

l Line tracking is used to track a horizon on a line (inline or crossline).
This mode gives the interpreter more control and is the one mainly
used when creating the initial horizon grid. In between the seeds the
horizon is tracked along the line. The result is a grid that needs to be
filled, either by autotracking or interpolation.

l Line manual mode will manually pick a horizon (interpolated line)
between two seeds on lines. This workflow differs from the line tracking
as in this case seeds are linked by a straight line: there is no automated
tracking. This mode is used in difficult areas, for example to cross
faults, push through noise zones or interpret unconformities.

l Event:
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Volume tracking and line tracking are automated tracking workflows. Thus the user
needs to define several tracking criteria:

l Input data: The input data is automatically selected as being any seis-
mic attribute active in the tree. This can be the original seismic volume,
or a filtered seismic volume (preferred) or any other attribute. The hori-
zon is linked to this input seismic. you can change the input seismic at
any time: it won't change your saved interpretation. It can be useful if for
example you receive an improve seismic and you want to re-track in
volume your horizon according to this new seismic.

l Event type: Specify the event type you want to track. The tracker can
track negative reflectors (Min), positive reflectors (Max), a Z-type zero-
crossing (0+-), or a S-type zero-crossing (0-+). If the tracking does not
seem to work, check that the event type corresponds to the event you
actually interpreted the seed(s).

l Search Window: Search window: Automated tracking is based on amp-
litude: the he tracker searches for the chosen event type based on amp-
litude in a time window relative to the last tracked sample (see drawing
A, below).

l Threshold type:
l Cut-off amplitude: Here, an absolute amplitude is used as the
stopping criteria for the tracker. When the tracker encounters a
value below this threshold value it stops tracking. (For a max-
event the tracker stops if the value is below this threshold value,
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and for a min-event when it is above this threshold value). Tip:
point your mouse at the event and the amplitude value is dis-
played at the bottom of your screen.

l Relative difference: The tracker will compare the amplitude of the
last tracked point to the amplitude of the point that is candidate for
tracking. If the difference exceeds the chosen percentage, the
tracker stops tracking.

l Steps...: Step-wise tracking results in a better tracked horizons. Good
parts of the horizon are tracked first, followed by the more difficult areas.
The tracker will first track those part of the horizon that have a low dif-
ference to the seeds or parts that have a high amplitude. In subsequent
steps the tracker settings become less strict. Therefore, the horizon will
be of better quality and needs less editing.

The user can define the subsequent percentage values (incremental:
eg 1,2,5,10,20) , or subsequent amplitude values (decremental e.g.
2500,2000,1500,1000,500)

If tracking fails..: If the tracker can not find a neighbouring point
(that complies with the specified relative difference or cut-off amp-
litude) it can either stop tracking or extrapolate the horizon. (Tip:
When the tracker stops tracking before you want it to, adjust the
Threshold value and/or Similarity threshold before choosing the
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extrapolate option.)

l Similarity:

Similarity is a kind of cross-correlation. A part of a trace (trace segment) around the last
tracked point is compared to all the trace segments on the neighboring traces around the
points that lie within the Search window (See figure below). The distance between the
points is typically 1 ms. The number of comparisons is thus controlled by the search win-
dow, while the compare window controls the length of the trace segments. The measure
of Similarity between the trace segments lies between 0 and 1. The tracker will choose
the point that has the highest similarity drawing C , below). When the point with the
highest similarity has a value below the defined threshold the tracker stops tracking.
Tracking with "Similarity" is optional. It is more accurate, but increases the computation
time.
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l Properties:

This tab is used to adjust the display properties of the horizon.

l Dip Steering:



- 69 -

The dipsteering cube can be now added as constraint for horizon interpretation. This will
improve the horizon tracking especially in the areas of dipping reflectors. Dip steering
gives structural information.

For loading a color blended horizon in a scene, please take a look at dGB's How to...-
manuals

2. Tracking
After adjusting the parameters in the tracker setup (which can remain open during track-
ing), start picking seeds on a displayed inline/crossline. The corresponding tracking con-
trols are described in the tracking toolbar section.

Tracking in volume:

Pick one or more seeds and display the tracking area . Resize the tracking area by
dragging the green anchors on the edges of the cube, but do not exceed your computer's
memory size or the size of your graphics card memory. If you run out of computer
memory, OpendTect will crash.

http://dgbes.com/index.php/support/tutorials/how-to-manuals
http://dgbes.com/index.php/support/tutorials/how-to-manuals
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Seeds picked and tracking area resized

Now, click the auto-track icon . After the input data is loaded inside the tracking area
the horizon is tracked

Auto-track the horizon within the tracking area

After tracking a part of the 3D-horizon, move the tracking cube to next place (click the top
of the tracking cube and drag). A small part of the horizon should be inside the new pos-
ition of the tracking area.
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Move the tracking cube to next location

When the Cube is at its desired position, click again.
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Next location is auto-tracked

Optionally, you can chose to track from the seeds only (only the seeds are taken into
account for the tracking).

Line tracking and line manual:
Interpreting on lines creates a grid, which allows for greater user control. Line tracking
and manual interpretation can be done directly in the 3D scene and optionally in the 2D
viewer for better accuracy. To launch a 2D viewer, the tree is used. Right click on the
seismic data (at an inline/crossline) in the tree... and select Display > 2D Viewer - VD .
Select the track/edit mode button and pick seeds, then move the line and repeat the pro-
cess.
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Edit 3D Horizons
When a horizon (or a part of horizon) is tracked, the quality can be assessed by using

the QC tool . The horizon is displayed at section as a line on inline and/or crossline
elements and on the QC plane. Drag the QC plane over the tracked horizon to QC the
tracking. SHIFT-click on the tracker plane to QC in another direction or select another ori-
entation in the tracker toolbar. If the horizon needs editing, there are several options:
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l Polygonal / Rectangular tool. Remove a part of a horizon with either a polygon
or a rectangle and re-track it. First select the polygon / rectangular selection tool of
the tracker toolbar and select an area to delete. Remove the part of the horizon

selected in the tree inside the polygon by clicking the icon . Please note that
your polygon is not self intersecting, otherwise the remove icon will not work.

To fill the hole again:

l Autotrack will track the hole from the edges

l Pick a seed on the QC-plain and track from seeds only
l Interpolate

When QC-ing horizons, it may be necessary to manually correct auto-tracker

errors over a limited region. This can be done by switching to 'Line Manual '

mode and placing two control points as boundaries to the area you wish to

edit/re-draw. These control points can be set down using Ctrl+Shft+left-
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mouse-button . Changes made to the horizon are then limited to the area

between these points.

1. Whilst QC-ing in 'Display--> Only at sections', locate a section that requires editing:

2. Switch to 'Line Manual' mode and use Ctrl+Shft+left-mouse-button to insert two control
points, one either side of the to-be-edited section:

3. Holding the left mouse button down, draw the new line where needed inside the two
control points:
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4. On releasing the left mouse button, the old horizon is replaced with your edited ver-
sion:

Tools:
There are several tools available to manipulate a horizon: 'Filter', 'Gridding', 'Shift', 'Snap-
ping' and 'Store Z as attribute'
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Once you are satisfied with the results, do not forget to save your horizon

using .

2D Horizons
For a 2D horizon tracking, the workflow is slightly different. The tracking wizard is similar
to the 3D tracking wizard shown in the previous section. To start tracking a 2D horizon,
click on 2D Horizon element of the tree and select New option from the sub-menu. This
will launch the tracking Setup window. The tracking setup contains the tabs similar to
that of a 3D horizon. See description of the tracking setup in the chapter: Interpret 3D
horizon.

First, define the tracking mode. Go to the Event tab to define the tracking parameters
(time gate, event, thresholds etc). In this tab, the data on which to track the horizon must
be selected.
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The same horizon can be picked across several 2D lines, providing the hori-

zon is interpreted on lines showing the same 'Input data' (see Event tab)

After defining the event parameters, pick a seed on a displayed 2D line in a scene. If the
corresponding settings for event are not appropriate, edit and change the parameters
(e.g. time gate and threshold type) and press Retrack icon in the tracking toolbar. This
will re-track the same horizon with new settings. After adjusting the appropriate settings
for the horizon, the tracking parameter window can be closed by pressing Dismiss but-
ton. When closing this window, the tracking settings are saved.

In order to change the settings (for tracking), the tracking parameter window

can be launched later on by right clicking on a horizon (in the tree) selecting

Tracking > Change setup (click on the tracking setup icon ). Also at the

bottom of the window, the tracking toolbar appears. This is routinely used to

update the modes and for switching between seeds (TAB-key).

For seed picking the options are:

* left mouse-click on plane = pick seed & local track
+ Ctrl-Shift = drop seed
* left mouse-click on seed = local retrack
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+ Ctrl = remove seed & local retrack
+ Shift = remove seed & local erase
+ Ctrl-Shift = undrop seed

After finishing the horizon tracking on one 2D line, start tracking on next 2D line. The hori-
zon can be displayed only at corresponding lines by right clicking on the horizon name
in the tree, and selecting "Display only at sections". There are also several others
options in the pop-up tree.

Always save the horizon routinely.

Interpret Faults
Click on the element Fault in the tree scene and select Add to select a fault or New to
map a new one.

New will insert a new fault {New Fault x} with a blank attribute. Insert the inline/crossline
in the scene where you want to interpret the faults. Highlight the newly inserted fault in
the tree and start interpreting a fault by clicking on inline/crossline. In OpendTect, the
fault model is arranged in an ordered sequence of faultsticks that are picked on vertical
planes (inlines/crosslines) and horizontal planes (Z slices). Thus faults originally picked
on inline/crossline cannot be picked on a Z-slice. When you are done, right-click on the
fault and select Save. Write an appropriate name of the fault and leave the Replace in
tree checked. Press OK. This will save and update the name of the interpreted fault. To
continue fault picking on a next inline/crossline or Z-slice, a user can take benefit of the
scrolling options available for inline/crossline/Z-slices.
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To remove a node, press Ctrl and click on the node to delete. To move the node pos-
ition, use mouse to select and drag the seed. After editing/interpreting, please do not for-
get to save the faults.

Fault tree pop-up menu items:

l Add Attributes: The fault attribute in OpendTect works similar as other attributes.
The selected attribute would be displayed on fault plane. It can be the original seis-
mic, calculated attributes, or others. Up to eight (8) attributes can be inserted for
one fault. In the tree, right click on the fault attribute and select the corresponding
attribute from the list.

l Show histogram: The histogram of the faults attribute can be displayed using this
option. For example, this allows the user to clip the range of a displayed attribute.

l Properties: The option allows to change the general display properties for faults,
i.e. color, reflectivity, and transparency.

l Use single color: Use this option to display a fault plane in single color.
l Display: Three display modes for faults are categorized in the tree. To display only
the fault planes in full, select the Fault planes option. The Fault sticks option will
display the fault sticks in full. To display the faults only on the displayed inter-
secting inline/crossline, chose At sections only.

l Save: This option will save the newly inserted/edited fault.
l Save as: To save the fault with a new name.
l Lock: It will lock the current fault. The fault cannot then be edited.
l Remove: This will only remove the loaded fault from the tree. Remember, it will not
delete the fault from the project. To delete the fault, launch the Fault Management

Window by pressing in the manage toolbar.

The figure below is an example section with interpreted faults. The displayed attribute
along faults is the original seismic. Notice that how the events would have been char-
acterized along the fault plane. You can edit and adjust the fault planes by using the yel-
low nodes, CTRL/SHIFT keys and mouse click as described earlier.
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The fault interpretation has only been developed for 3D surveys. For 2D, only

fault stick sets are interpreted.
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OpendTect Trees and Elements
Each scene has a corresponding detachable tree to control the elements to be dis-
played. A tree consists of several elements of different type, which are described in
detail below. Tree elements containing elements one level down can be expanded by
clicking on the markers (+ or -) left of each main element. The order in which items
appear in the tree can be changed by selecting the item that you want to move, then
press and hold shift, and press the arrow up or down keys on your keyboard.

The tree is a utility window that can be moved outside of the main OpendTect window.
To do so, first click once on the small squares at the top-right corner of the tree scene,
then drag by clicking (left-click) on its title bar to place it anywhere.

Some operating system hide utility windows when the main win-

dow is inactive.

A common issue with certain Linux distributions is this: decoupling the tree
causes tree to disappear when using, for example, the attribute engine or
when the progress bar is showing. To resolve this, please do the following:

1. Go to the KDE Start button
2. Applications
3. Configure desktop
4. Under 'Workspace Appearance and Behavior' click on 'Win-

dow Behavior'. You should see this window:



- 83 -

5. Make sure the option 'Hide utility windows for inactive
applications' is not checked.

6. Click on Apply button.

Scene
In OpendTect, a Scene is a main working window associated with a tree. In the scene, it
is possible to work in three separate domains i.e. Time- domain , Depth- domain ,
Flattened and Wheeler-domain. A time/depth-domain scene can be inserted via Scenes
menu. Each scene has its own tree elements so that the elements and scene settings
can be modified accordingly.

The scene Properties can be changed by right-clicking on a scene name in the Tree
e.g. Scene 1 > Properties. This will pop up the following window:



- 84 -

In this window, the following options can be set for the specific scene:

l Survey box: If checked, a 3D survey box will be shown in this specific scene.
l Annotation text: If checked, the survey box annotations (inline, crossline, TWT) will
be displayed in the scene.

l Annotation scale: If checked, the numeric values of inlines, crosslines and Z-val-
ues will be displayed.

l Background Color: The user can specify his/her own background color for par-
ticular scene. By default it is black.

l Mouse Marker Size: This option is used to increase the Mouse Marker (a marker
pointing mouse location on multiwindows) size on various windows in multiscene
view.

l Mouse Marker Color: The color of Mouse Marker can be changed from here. The
default color is white.

l Annotation color: The color of Annotation can be changed from here. The default
color is white.

l Line/Surface separation: The user can change the setting between Line and Sur-
face separation as shown below
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The Top/Bottom image...

This option allows to display images at the top and base of the survey area, with or
without transparency. The picture will be stretched to fit into the TopLeft and BottomRight
corners of the survey (in a north view). The proposed coordinates are the survey ranges.

This feature is specially useful to add any reference map of the survey to understand the
geographical position and corresponding seismic profile in a better way.
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You can use the Google export tool to convert the survey boundaries to lat-

itude and longitudes. They can be then imported into a mapping program (like

Google Earth) in order to take the appropriate screenshot.

The Scene Color Bar Settings can be used to set the position and size of the colorbar
in the scene:

The Export scene option is only made for the debugging purposes. The export option
dumps the scene information into a .osg file (OpenSceneGraph), which can be sent to
OpendTect and used for bug analysis.
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Inline, Crossline & Z-Slice

Inline, Crossline and Z-slice elements can be added into the tree by clicking on the ele-
ment name and selecting Add/Add default data/Add color blended from the pop-up
menu. The Add option will insert an inline/crossline/Z-slice with a blank line in the
middle of the survey (ready for an attribute or stored cube to be loaded). If a well has
been loaded in the project and is within the survey box, it is possible to Add at Well loc-
ation an inline or crossline. The inline/crossline loaded will be according to the surface
coordinates that can be found in the well manager information summary section. Once
added, a selection window will pop up to select the attribute to display: Stored volume,
Attribute from the active attribute set,... If cancel is clicked, the attribute line will stay
blank in the scene and the tree entry will read <right click>.
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Pre-stack stored cubes will appear in the list surrounded by curly brackets {}. They can
be displayed on the slices of the 3D scene as common offset volumes, in a similar way
to the components of multi-components volumes. The prefix "O=" is then presented with
the offset value in XY units (meter or feet). Attributes may be computed on common offset
volumes like for components or multi-component volumes.

Any desired cube can be selected from the list. The selected cube will be added as an
attribute for the displayed inlinecrossline/Z-slice number. The added attribute can also
be replaced at any time by right-clicking on it (see the figure below).

The check-boxes are used to show/hide the corresponding sub-element of

inline/crossline/Z-slice.

After an attribute is displayed in the scene, it can be manipulated further by right-clicking
over it (see figure below). The explanation for this list is described at the end of this sec-
tion.

Pop-up List Menus
Each individual element (Inline/Crossline/Z-slice) has a similar pop-up list menu (see
below). There are two different ways to open this list. Either display it from the Tree (as
shown below) or display it in the scene. In the latter case, place the mouse over the
inline/crossline/Z-slice and right-click to launch the tree. This menu list has several func-
tions that are described in following text.
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Add:

l Attribute: Add an additional blank attribute for the corresponding
inline/crossline/Z-slice number. The attribute data (stored cubes or the
attribute definition) can be displayed by right-clicking on it and selecting
the desired attribute. Up to eight different attributes can be displayed
within one element (inline, crossline, Z-slice).

l Volume Processing attribute: This option will add the volume pro-
cessing attribute.

l HorizonCube Display: This will display the HorizonCube. It requires the
HorizonCube plugin.

l Systems Tracts Display: This adds system tracts interpretation. It
requires the SSIS plugin.

Display:
l Histograms: The histograms of all added attributes of an element can
be displayed using the right-click option of the parent element (inline
number, surface name...). It is a useful tool to clip the ranges of an attrib-
ute by using vertical green lines in the histogram: The vertical green
lines show the current amplitude range and can be moved left or right
using the left mouse-click. The display is updated when the mouse
click is released. This is performed independently for each attribute.
Please note that this will toggle off the automatic clipping.
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A multi-histogram display for an inline containing two attributes
(DSMF Seismic and Energy).

The green lines do not appear on histograms dis-

played fro single attributes.

l Positions: Change an inline/crossline/Z-slice number. This option is
used to manipulate (sub-select a range of traces/time) a line or to
quickly scroll through the data for visualization.
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(L to R) Manipulate or scroll the inline; Manual Scroll and Auto
Scroll

By pressing the Scroll button, elements are moved either manu-
ally (select Control Manual ), or automatically (select Control
Auto). Scroll in the inline/crossline direction by specifying a fixed
Scroll step. In the manual mode, the line/Z-slice is stepped to the
new position after each subsequent click on the Advance button.
In the automatic mode, the line/Z-slice is updated in a movie-style
with a fixed time interval (in seconds) - Time between updates .
The auto-scrolling can be paused by pressing the Pause button.
To resume the auto-scrolling again press Go button.

Gridlines: Enables displaying grid lines on the particular element.
A new menu appears where the grid line spacing, style, color and
width can be set.
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Resolution: Edit the graphical resolution of the element. The
Default does not involve any rescaling before the data is sent to
the graphic card. The options Moderate and High do some pre-
interpolation before the data is sent to the graphic card and gen-
erally results in a cleaner picture. If the memory of your graphic
card does not allow high resolution, the element becomes black.

If Shading is on, the resolution option is not available

anymore(except for the horizon element).

Properties: Access display parameters; Transparency, Ambi-
ence/diffuse relflection, texture and mouse movement (scroll and
pan settings).
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Duplicate: Add a new duplicate/copy of a selected element in the tree.

Reset Manipulation: Reset changes made in the position of the line/Z-slice.
Restore the original configuration.

Display PS Gather: Pop-up a pre-stack viewer perpendicular to the inline or
crossline.

Note: It is also possible to display the offset of each CDP gather
similarly to any post-stack data. The pre-stack data is available in
the list of stored cubes and is marked with quotes { }, at the end of
the list.

Correlate with wells: This will correlate the line with 2D well

Lock: Lock the selected object. Prevents accidental removing, moving or dis-
playing data on the object. After clicking Unlock, all editing is again enabled.

Remove: This removes the element from the OpendTect tree and the graph-
ics area.

The options available for attribute pop-up menu list are briefly described here:

Select Attribute:When selected, data can be displayed from stored cubes or
an attribute from the current attribute set (if available). To display an attribute,
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select or create an attribute set first.

Save Colour Settings: Save color settings for a specific stored volume and
make them available for future use.

Move:Move the attribute up, down, to top of the list, or to bottom of the list.

Display:

l Show Histogram: Display data statistics (selected attribute) of the
defined volume as a histogram in a pop up window.

l Show Amplitude Spectrum: Amplitude vs frequency plot will be shown
in pop up window. Moving the mouse over the spectrum displays the
Values.
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l Show F-K Spectrum: A two-dimensional Fourier transform over time
and space where F is the frequency (Fourier transform over time) and K
refers to wave-number (Fourier transform over space).
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Pressing Ctrl+P in either the Histogram, Amplitude- or F-K Spec-
trum windows pops up a settings window where you may define
parameters for a snapshot:
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l Change transparency: Change the transparency of the attribute item to
view one or more overlaying attributes simultaneously.

l 2D Viewer - VD / Wiggles: Display an attribute in the 2D viewer as
"Wiggle" or "VD" (Variable Density). For more details, please refer to:
2D viewer

Remove: Removes the attribute item from the tree.

Volume
A volume can be added by clicking on Volume element in the tree and selecting Add
option. A small volume box with blank attribute is added to the scene. An attribute in the
newly inserted volume can be displayed by right clicking on the volume and selecting
the Select Attribute option. This works similar to inline/crossline/Zslice.

You can display either the stored volumes or calculate the attribute within the

sub-volume.

For faster response times, pre-load the data you wish to visualize using this

tree element.
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The pop-up menu for the Volume element resembles that described in the previous sec-
tion for inline/crossline/Z-slice:

l Select Attribute: Select/change the data in a volume.

l Display:

l Properties: Change display parameters such as transparency and ambiance
reflectivity: 
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l Add isosurface: Compute arbitrary iso value surfaces and convert them into
bodies.

If the option Add > Iso surface is selected, the following window
pops up with choice of modes:
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The window displays the histogram of the data collected within the loaded volume (left),
or from seeds only that are stored in a pickset (right). "Update" will update the display in
the 3D scene (requires some computation time) while leaving the window open. OK will
accept the currently selected (or updated) value and dismiss the selection window.

Right-click to display the iso surface menu and convert the iso surface into a stored body
that in turn can be retrieved:

l Amplitude Spectrum: Pop-up amplitude vs frequency plot.
l Histogram: Display data statistics (selected attribute) of defined volume
as histogram in pop up window.

l Position: Change the inl/xline/Z position within the survey boundaries.

l Duplicate: Create a duplicate/copy of the sub-volume.
l Reset Manipulation: Reset the changes made in the position of the sub-volume.
This option is only available if the user has made any changes.

l Save color settings: Save the color settings.
l Lock: "Lock" option with lock the selected object, this will prevent accidental
removing, moving or displaying of data on the object. After clicking "unlock" editing
is enabled again.

l Remove: This will removes the element from the display.

In Interact mode, (see Mouse Controls ) the cursor will return the position

(inline, cross-line and X,Y,Z) and the data value at that position in the hori-

zontal status bar of the OpendTect window.

Random Line
If you click on the Random line in the tree, four options will be available: Add Empty, Add
Stored, Add Color blended and New.
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Add Empty: Right-click on Random line and select 'Empty'. The new line will be added
as a sub-element of the random line. By default, this is the centre inline of the cube. To
create the new arbitrary direction of random line, the user can modify nodes by editing or
inserting nodes:

With multiple nodes, the random line can also consist of multiple flat sections. The sec-
tions of one single random line may intersect one another. In interact mode, the little
plane of a node can be used to drag the node laterally, and the vertical tube can be used
to shift the edge of the random line vertically. Nodes can be added from the pop menu by
right clicking on the random line in the Interact mode.

Add Stored: Select from a list of (previously stored) random lines to display it in the
scene.
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Add Color blended: A color blended Random Line may be added. This may be either a
color blended version of a previously-stored random line, or an 'Empty' color blended ran-
dom line:

RGB(A*) color-blended attribute display is used to create a normalized color-blended dis-
play that often show features with greater clarity and enhances a detail map view.
Though traditionally, it is used to blend the iso-frequency responses (Spectral Decom-
position), RGB(A) can also be used to blend three or four different attributes that define a
comparable spectrum. For instance, spectral decomposition outputs the amplitude at dis-
crete frequencies. So, it renders the same output (unit=amplitude). Depending upon a
geological condition or the objective, FFT short window or CWT (continuous wavelet
transform) can be chosen.

* Once you have your inputs selected for the appropriate color attributes, it is also pos-
sible to add a fourth attribute (the 'A' or 'Alpha channel') to highlight structural features
such as faults/fractures (ie: add a similarity attribute).

New: There are several ways to create a new random line:
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l Interactive:When creating a random line from interactive mode, a horizon or Z slice
must be loaded in the scene first, a random line can then be created by picking
nodes on the displayed horizon/Z-slice.

l Along Contours: Create random lines between specified contour ranges. Note that
a interpreted horizon grid will be required to provide the contours.

l From Existing:Generate random line(s) from existing random line(s). There is an
option available to generate random line at some distance away from existing ran-
dom geometry and store it in new random line geometry.

l From Polygon: Create random line from a saved polygon.
l From Table: Create random line from table. The input will be X/Y coordinates,
Inline/Crossline and Z ranges.

l Create FromWells: Connect several wells by a random line. The line follows the
deviated well paths (optional). By right clicking on the random line tree, and select-
ing Create from wells, a dialogue box appears with a list of wells that can be selec-
ted in order to set up the random line path.

Use in HorizonCube creation, when it is created in a 2D line-sec-

tion that follows the well paths.

When right-clicking on the newly created random line, the following options are
available in a pop-up menu:



- 105 -

l Add:
l Add attribute:When selected, choose to display data from stored cubes, from
an attribute from the current attribute set or from an output node of the current
neural network. To display an attribute or neural network, select or create an
attribute set or neural network first.

l Add Volume processing attribute: Display volume created from the volume
builder

l Add HorizonCube display: Display the stored HorizonCube
l Add System tracts display: This option will add systems tract interpretation.

l Display:

l Histogram: Displays multiple histograms for the randomline. If there are
more than one attributes displayed, it will show the histograms of each
in a pop-up view.

l Resolution: Choose the resolution between standard/higher/highest
l Position: It is used to manipulate the nodes / position of a random line.
To read more, please go to the Manual mode sub-section of this
chapter.

l Insert node: Insert a new node before the selected node.
l Properties: This option refers to display parameters such as Ambient
reflectivity, Diffuse reflectivity, Transparency.

l Duplicate: Duplicate the line as an empty element in the tree. This option displays
different attributes on the duplicated line whilst keeping the original data.

l Reset Manipulation: This will reset any change in the position of the random line
(or its nodes) that you have applied and it will set line to its original position. This
option is only available if changes have been made to the position of the element.
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l Create 2D Grid: The random lines (with two nodes only) can be used to create a
2D grid with a fixed grid spacing. When selected, the Create 2D Grid window is
launched (see below). Here, specify the input 3D seismic volume and the output
data set name. The output grid is generated according to the dip (parallel) and
strike (perpendicular) direction of the selected random line. The prefix labels are
used as prefixes to the output line names, stored to the specified new data set
name. The grid spacing is the constant spacing between the two lines. At the bot-
tom, the total number of parallel and perpendicular lines will be updated according
to the grid spacing. By pressing OK, a batch process will start to generate the 2D
grid. When the batch program is finished, the data can be displayed in the scene
(see 2D Seismic section for details).

l Save As: Save the random line as a new name or overwrite the existing.
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l Save As 2D: Creates a 2D line from a Random line. Right-click on the random line
in the tree and select Save As 2D. A window will pop up, as shown below. Select
the Input cube, the output line and the line name. The first trace nr number of line is
also necessary.

The survey type should be 2D as well if you want to view the 2D line created

from a random line.

l Correlate with wells: This option is used to correlate a random line with wells.
Well - seismic correlation is normally done in the Well Correlation Plugin (WCP),
which requires a commercial license.

l Lock: Locks the selected object. This will prevent accidental removing, moving or
displaying data on the object. After clicking lock again, editing is again enabled.

l Export to Google KLM: Export selected random line to a Google KML file. Specify
the KML file parameters in the pop-up dialog.
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Annotate the start and end of the random line with a user defined

line annotation in the output file settings.

l Remove: Remove the random line from the tree and the scene. Do ensure to first
'Save' (any changes to) the random line before removing it.

The options available for attribute pop-up menu list are briefly described here:

l Select Attribute:When selected, data can be displayed from stored cubes or an
attribute from the current attribute set (if available). To display an attribute, select or
create an attribute set first.

l Save Colour Settings: Save color settings for a specific stored volume and make
them available for later use.

l Move:Move the attribute up, down, to top of the list, or to bottom of the list.
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l Display: There are several display settings / features that are briefly explained
below:

l Show Histogram: Display data statistics (selected attribute) of the randomline
as a histogram in a pop up window.

l Show Amplitude Spectrum: Amplitude vs frequency plot will be shown in pop
up window.

l Change transparency: Change the transparency of the attribute item to view
one or more overlaying attributes simultaneously.

l 2D Viewer - VD / Wiggles: Display the selected attribute in the 2D viewer as
"Wiggle" or "VD" (Variable Density). For more details, please refer to: 2D
viewer

l Remove: Removes the attribute item from the tree.

Manual Mode (Empty)
Manual Mode. In manual mode, the random line will first be displayed in the 3D scene.
Nodes may be added and their position changed interactively, in a second step. This
starting random line will have two nodes, one at each end of the central inline. More
nodes can also be inserted in the right click menu of the random line in the tree (see fig-
ure below). Please note that the same menu is available with the right-click on the ran-
dom line in the scene.

Adding/inserting new nodes between the existing nodes.

The node on the left-hand side of the newly created random line is designated node 0,
and the one in the right hand side node 1. It is possible to insert a node before node 0,
before node 1, and after node 1. The node will be created half-way between the two
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surrounding nodes. In order to move a node to a desired position, click on the random
line to make the nodes visible/editable. In the interact mode, click at the node plane (hori-
zontal/vertical) to move the node location. A purple surface appears around the node
and the node can be moved in any direction inside the survey area.

The node can be moved in two directions (horizontal and vertical). The node's ori-
entation can be changed by placing the mouse pointer over the node and pressing the
Ctrl key.

Editing or modifying the position of the nodes is also possible through clicking the option
Edit nodes.... The following windows will pop-up and the nodes are editable. Modifying
or inserting new nodes is also enabled. In this table, each node is defined by its
inline/cross-line or X/Y position. The nodes can also be removed by right clicking over
the desired cell and selecting the 'remove node' option. Similarly, for the pop-up menu,
more nodes can be inserted before/after the selected cell (node).
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Create from Existing
This option allows the user to generate random line offset from an existing random line.
There is an option available to generate a random line at some distance away from exist-
ing random geometry and store it in new random line geometry.

Create Random line from existing line geometry in left/right or both directions. The dir-
ection is defined by the path described by the nodes, in the order seen in the table.

The first generation parameter is the input random line, which has to be chosen between
the already existing random lines. Then, define the distance from input in meters and the
direction in which the node will be added. There are three directions: left, right, and both.
The final step is to name the output random line.

Click on the Display Random line on creation box to immediately visualize the random
line.

Create Along Contour
Random lines can be create along the contour geometry. For this, an interpreted horizon
grid will be required. The horizon grid is use to generate the random lines at a selected
index contours range. All contour values that are present within the given Z-range, are
used to construct the random lines. When the process is completed, you can edit the ran-
dom lines also. This functionality is important to see the seismic section along the con-
tours (e.g. AVO responses, DHIs or hydrocarbon contacts).
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First, specify the input horizon, and optionally select if it is within a polygon. Then define
the contour Z range and the step. Then the Random line Z range, there is an option to
chose whether the random line Z range will be made relative to the horizon or not. Last
step is to give a name to the newly created Random Line Set. If you want to display the
random line on creation, check the box Display Random Line on creation.

The option Display Random Line on creation can be selected and the new random line
will be displayed after clicking OK.

The following picture shows an example of result for a random line created along con-
tour, it is composed of a set of random lines that satisfy the contour z range and therefore
is composed of more than one element.



- 113 -

An example random line generated along a fixed contour line.

Create from Polygons
This option allows the user to create random line definition from already created poly-
gon. In the parameters, select the existing polygon and sub-select the Z-range for the ran-
dom line, which will be generated. Write an output name for this random line and
optionally, set check to display random line on creation so that after creation it will be dis-
played in the scene/tree. Press OK to proceed.
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An example random- line generated along the white colored polygon. The polygon
approximates the closure of a gas anomaly.

Create From Wells
A random line can be created in such a way that it follows wells path. By right-clicking on
Random line in the tree, and selecting Generate > From Wells ..., a dialog box appears
with a list of wells that can be selected in order to set up the random line path.

Use the arrows to add and/or remove wells. Use the second set of arrows to setup a well
sequence. Specify whether you want to use only the well top position or not. When you
use all well points, you can specify the order by clicking the Change Order arrows.

The Extend outward allows the extension of the random lines in both sides away from
wells.

Press the preview button to see a top view of the random line that will be created. If the
preview does not show exactly the desired random line, then change the parameters
(the wells involved or the order in which they are listed). You can save the newly created
random line by specifying the name in Output Random line(s) field. If you want to display
the random line on creation, check the box Display Random Line on creation.



- 116 -

The following picture is an example of random line created from wells.
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In this picture, a random line goes through four wells following a random path between
these wells (which are used as constraints).

Create From Table
This is launched from: Random line > right click > New > From Table
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This allows the user to create a random line from table. The input here are whether X/Y
coordinates or Inlines/Crosslines and Z range
.
The random line resulting from this table is shown below
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Interactive Mode
This option is launched via right-clicking on Random line > New > Interactive...

This allows the user to create random line from interactive mode. A horizon or Z slice is
first loaded in the scene, then a random line can be created by picking nodes.

A window pops up asking the user to create a randomline from Polyline.
The user can now pick nodes on Z -slices or Horizons, as shown below:
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After clicking OK, a random line is created:

An attribute can then be displayed:
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2D Seismic
The user can either add 2D seismic lines, create a 2D Grid form 3D data, create new
lines from 3D data or generate 3D cube from 2D data set:

Right click on 2D and select Add to add one or more 2D lines:
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Before pressing 'Ok ', choose how you would like the lines to appear in the scene from
the three options shown below:

Display projection lines only: shows only the position of the 2D line(s) at
the top of the survey:
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Load default data: loads the line(s) into the scene, fully displaying them with
the data selected as default in the 'Manage 2D Seismics' window:
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Select Attribute: loads the projection lines into the scene and brings up the
'Select Dataset' window to choose what to display:
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l Create 2D Grid from 3D... This option can be used to create a 2D grid with a fixed
grid spacing. When selected, the Create 2D Grid window is launched. Here, spe-
cify the input 3D seismic volume and the output data set name. The output grid is
generated according to the dip (parallel) and strike (perpendicular) direction of the
selected volume. For more detail, click here

l Extract from 3D... Extract 3D data onto selected 2D lines. Input data is required in
the form of a stored 3D volume. One or more 2D lines can be selected for the 3D
data to be extracted onto. (Note: If just one line is selected, you may also sub-
select a trace range.) The output data set requires naming:
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Once several lines displaying data are loaded, right-clicking on '2D Line' in the tree
gives the following pop-out menu. In addition to the options explained above, selections
can be made for all displayed lines:

l Add attribute Select an (additional) attribute to be added to the lines. (See above
for details.)

l Replace attribute Select an attribute from those displayed on the line(s). Once
selected, this will launch the 'Select Dataset' window and a replacement can be
chosen.

l Display attribute Choose which of the available attributes to display.
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l Remove attribute Remove one of the loaded attributes (Only available if lines dis-
play more than one attribute)

l Display Attribute Checks on the selected attributes to display them on the lines
showing in the scene

l Hide attribute Checks off the selected attributes to stop them displaying on the
lines showing in the scene

l Edit Color Settings Select an attribute and set the color bar and ranges:

l Display all/Hide All Display or hide the line names, 2D planes and line geometry
(projection lines).

l Show/Hide all items: Shows or hides all lines in the scene and checks/unchecks
the line names in the tree

l Remove all items: Removes all lines from the scene and the tree

Right-clicking on an individual line in the tree gives the following options:
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l Add Add either an attribute or a Volume processing attribute
l Display Allows the following:

l Histogram: The histograms of all added attributes of an element can
be displayed using the right-click option of the parent element (inline
number, surface name...). It is a useful tool to clip the ranges of an attrib-
ute by using vertical green lines in the histogram: The vertical green
lines show the current amplitude range and can be moved left or right
using the left mouse-click and drag. The display is updated when the
mouse click is released. This is performed independently for each attrib-
ute. Please note that this will toggle off the automatic clipping.

l Properties: Use this option to set the Material, Texture and Line Style
properties:
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Material: Set the base color for the projection line (2D geometry)
and set the reflectivity and transparency properties for the dis-
played attribute.

Texture: Set the texture type.
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Line Style: Set line thickness.

l Resolution: Set the resolution of the displayed data.

l Show linename/2D plane/line geometry: Toggle on or off each of the
2D line components per line.

l Position: Set the number of traces and Z-range of the displayed line:

l Duplicate: Duplicates the 2D line as displayed in the scene, including its dis-
played attributes. Can be a useful option to compare colorbar settings, or be used
to 'extend' the eight-per-line attribute limit by replacing existing attributes with oth-
ers on the duplicate.

Pickset & Polygon
A Pickset is a point data that can be used in OpendTect for several purposes, as simple
point, vector quantizer, as polygons, etc. The Pickset pop-up menu has four options as
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shown below:

Add Pickset, Add Polygon will load existing picksets/polygons while New Pickset, New
Polygon will create new ones.

Add Pickset... Load a previously created and saved pickset.

Add Polygon... Load a previously created and saved polygon.

New Pickset: A pickset can be filled using the following three options :

Manual & Empty Picksets
An empty pickset is added so that the locations (of object) are picked manually. The
empty picksets are generally used for supervised neural network training (see the dGB
plugins help documentation). An empty pickset is defined by right-clicking on the Pickset
element and selecting New > Empty from the pop-up sub-menu. In the Pickset Creation
window, write an appropriate name and press OK to insert an empty pickset in the tree.
For instance, lets define an object by using manual picks that are representative of salt.
Display the corresponding data (line/slice/horizon) in the scene. To start picking, please
make it active by clicking on it (If active, it will be highlighted). Within the scene, start
clicking on the displayed data (line/horizon). Each click will add a pick. If the pick is
wrong, it can be removed by using Ctrl key and left mouse-button click.
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Pickset creation window plus example of picks from the manual creation option. These
picks will be used in Neural Network training.

Generate Random Picks (3D)
Random picks are very important especially for prediction purposes or object detection.
These are defined specifically for unsupervised neural network training (see dGB Plugin
documentation for more details, specifically: Unsupervised waveform segmentation
(UVQ)). The window is launched from the tree element Pickset/Polygon > (right click) >
New Pickset > Generate 3D.... The following window pops up.
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Random (3D) pickset creation window

In this window write an appropriate name for the picks and select a distinct color. The
generate location by contains several options: Range, Polygon, Table, Surface. It gen-
erates random picks within a selected range of inlines/crosslines/time, polygon, table, at
a surface, or between two surfaces. Select and fill rest fields that are according to the
selection in the generate locations by... option.

Optionally, a rejection filter can also be applied by selecting Remove locations. It passes
each random position according to a selected filter (random, polygon, subsample, table,
surface). It is useful to avoid random picks in unwanted regions e.g. by providing a poly-
gon.

Provide the maximum number of locations to be inserted in the bottom text field. Fill an
appropriate random number. Press OK to insert random picks.

Generate Random Picks (2D)
Random picks for the 2D data can also be used for the same purposes as that for ran-
dom picks for 3D (read previous section). The pickset creation window for 2D random
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Pickset/Polygon > (right click) > New Pickset> Generate 2D... sub menu. It will launch
the following pickset creation window.

Random (2D) pickset creation window

In this window fill/select the fields for name, a color, the number of (random) picks to be
generated, on a specific data set (or line(s) in a data set), geometry and Z-range. It may
be noted that the specified random picks are generated according to the given geometry.
The geometry is defined by a Z- range/ horizon (s). It depends upon the pur-
pose/objective. For instance, if the objective is to detect facies by using random vectors
(picks) on a surface, then horizon geometry shall be provided. Similarly, random picks
can also be defined between two horizons on the selected lines.

Polygon
The new Polygon can be created by doing the following: Pickset/Polygon > right-click >
New Polygon...
The window pops up as shown below:
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Choose a name and color for the new polygon. An empty polygon folder is created and
the user needs to pick a polygon on the chosen horizon or Z-slice.

Making polygons. Polygon picksets are activated by clicking on the element in the tree.
The active polygon pickset is shown in reverse video and pick mode is automatically
enabled. Left clicks in the graphics window will result in adding picks to the active poly-
gon. The picks will be connected by a line. The last pick of the polygon can be removed
from the active polygon with Ctrl-left clicks (use the Apple key on MacOS).

In the following picture we can see two examples of polygon picksets, closed polygon
(deltaic facies belt), and non closed polygon (fault pickset).
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Pop-Up Menus
Pickset/Polygon Element Pop-up Menu

This is the menu that pops-up when a user right-clicks on the main Pickset/Polygon ele-
ment when at least one pickset/polygon is already loaded. It contains the following menu
items.

l Load Pickset... Display stored pickset(s).

l Load Polygon... Display stored polygon(s).

l New Pickset Adds a new pickset

l New Polygon Adds a new polygon

l Save changes. The pickset/polygon changes can be saved and reloaded at any
time during the building process.

l Display only at sections. Display picks on the displayed elements in the graphics
area only. This mode enables picking in a new location without being distracted by
previously picked points throughout the survey volume.

l Show all picks. (Re)display all picks.

l Merge Sets.When at least one pickset is opened in the tree, it is possible to
merge picksets by right-clicking "pickset". A window pops up and the sets can be
selected. A name for the output set should be defined. Picksets can also be
merged from the Pickset Manager.

l Show all items. Show the picksets from the tree-scene.

l Hide all items. Hide the picksets from the tree-scene.
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l Remove all items. Remove the picksets from the tree-scene.

Pickset Sub-elements Pop-up Menu
If more than one pickset is loaded, the following options will be available in the tree:

l Calculate Volume

In OpendTect, an estimated volume can be computed from a polygon to a
given surface.
The velocity default is set to 3000 m/s. Negative thicknesses can either be
discarded or taken into account.
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l Close polygon. During, and at the end of a picking session, picksets should be
stored.

l Properties: In this window the Type, Size and Color of the pick markers on the
graphics area can be set. The type Arrow is also automatically used when the pick
is given directional information in the Set directions option under the pickset pop-
up menu.

l Display only at sections: Shows picks on the displayed elements in the graphics
area only. This mode allows to pick new locations without being distracted by pre-
viously picked points throughout the survey volume.

l Convert to body: Convert the polygon into a body.

l Set direction: Display direction, guided by the SteeringCube/attribute. This helps
to understand the geological dips and fluid flow. It is assigned by setting a direction
to each pick based on dip and azimuth information (attributes). In the pop-up win-
dow (see below), specify either a SteeringCube or two attributes providing the
polar dip and azimuth in degrees. A velocity of 2000 m/s will be used in time sur-
vey to convert the dip from degrees to µs/m if the dip angle data is read from a
stored cube instead of the dip angle attribute. Do not forget after setting the dir-
ections to save you pickset and change the display type to "Arrow".
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An example of setting direction (black arrows) to a pickset.
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SteeringCube direction and Attributes input

l Save/Save As: Either overwrite the stored input by using option Save or store as
new pickset by using Save As option.

l Create Body: This option is available only for a polygon. It is used to create a
body using the polygon as a constraining area. It requires a top and bottom horizon
between which the body would be created. This feature is only enabled if SSIS plu-
gin is loaded (or licensed). For details, please go to the Manual SSIS chapter of
the plugin documentation.

l Lock / Unlock: Lock the selected object. Prevents accidental removing, moving or
displaying data on the object. Clicking "Unlock" enables editing again.

l Remove: Remove pickset from tree.

Note: removing any unsaved pickset will result in complete loss of

data.

l Export to Google KML: Export selected polygon to a Google KML file. When
selected, the following export window is launched. Fill in the output KML para-
meters and write/select the output file location. Press the 'Ok' button to export the
polygon in the selected location. The feature will prompt an additional conversion
dialog if the conversion settings for the survey are not defined. For further inform-
ation, please refer to the Survey Selection section.

Export the polygon to a KML file
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Horizon

An existing horizon can be displayed in the scene by selecting Add option from the pop-
up menu (see above). It will launch a horizon selector window from which multiple hori-
zons can be selected. See also Add color blended .

Once at least one horizon is displayed, there is an addition to the pop-out

menu, Display All , which contains several options: only at sections, in full or

both at sections and in full. Only at sections results in a horizon display (as a

line) on the inline/crossline/timeslice. Full displays the complete horizon in

3D space.

Track new sub menu is used to start a new horizon interpretation.

The popup menu from a displayed horizon has several options, which are covered in the
following sections:
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Add Attribute
This allows choosing the data to display on the horizon from stored cubes, a calculated
attribute from the current attribute set, or horizon data that were included with the horizon
already. For Horizon data a dialog will popup where you can select multiple data files.
After loading you can browse through the data by pressing the 'Page Up' and 'Page
Down' buttons on your keyboard.

For PgUP & PgDn to work, the mouse pointer must be in the scene.

Once a horizon is added (with its Z-values displayed in the scene), it is possible to also
right-click on 'Z-values' in the tree to give you other options:
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Furthermore, once a horizon has an attribute displayed, it is also possible to 'Save as
Horizon Data'... and will be visible in the 'Manage 3D Horizons' window:

Color-Blended Display

ð becomesð

The load color blended sub-menu displays an RGBA (red-green-blue and alpha) blen-
ded horizon(s) in the scene. This is used to blend multi-attributes with similar spectral
outputs. This is an interactive tool especially to color blend the iso-frequency grids (or
attributes).

Color blended display:
RGBA* blending attribute display is used to create a normalized color-blended display
that often show features with greater clarity and enhances a detail map view. Tra-
ditionally, it is used to blend the iso-frequency responses (Spectral Decomposition), but
a user can blend three/four different attributes that define a spectrum that is comparable.
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For instance, spectral decomposition outputs the amplitude at discrete frequencies. So, it
renders the same output (unit=amplitude). Depending upon a geological condition or the
objective, FFT short window or CWT (continuous wavelet transform) can be chosen.
Results are best displayed on time/horizon slices, volume.

A color blended map view (image on right) of the spectral decomposition (red-10hz,
green-20Hz, blue-40hz). Compare the results with the coherency map (image on left).
Note that the yellowish colored fault bounder region is thicker as compared to the sur-
rounding regions. The faults throw (red- color) are also clearly observable. Semb-
lance/similarity together with color blended spectral images can reveal better geological
information.

Tools
Several processing algorithms may be applied to horizon and will be described here:
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Adding picks to existing horizons by interpolation (grid)
Filtering interpretations
Snapping an existing interpretation to a given amplitude event.
Storing the Reference Z as an attribute

The recommended workflow order after horizon tracking is:
1. Snap the interpretation to a given event (min/max/zero crossing).
2. Grid the snapped grid since snapping can generate holes.
3. Filter the output grid.

Grid

This utility is used to grid/interpolate a horizon having gaps/holes or to filter (aver-
age/median) a horizon grid. There are several gridding algorithms supported in
OpendTect.
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Gridding Parameters:

l Geometry: There are different types of geometries that are used to do inter-
polation. The Full survey is used to interpolate (in-/out-wards) the Horizon-Z values
within the entire survey box. The Bounding Box defines the rectangle fitting the
horizon geometry, which is generally smaller than the survey box. The Convex hull
type of area fitting also restricts the gridding geometry within the horizon bound-
aries. To grid the gaps or holes in a horizons, the Only holes type of gridding geo-
metry is used.

l Inl/Crl step: The default steps correspond to the sampling rate of the input horizon.
The step can be decreased up to the survey sampling rate to get a higher res-
olution horizon.

l Algorithm(s): Inverse distance algorithm uses an inverse distance method of inter-
polation. Inverse distance requires the search radius with optional parameters
(step-size and number of steps). The step size of '1' means that one bin would be



- 147 -

used in all directions to interpolate the horizon Z-values. Whereas the number of
steps define the number of concentric circles for inverse distance computation. For
these steps, the grid computation can be set to the corner points for the defined
radius or not (default option).

l Inverse distance algorithm uses an inverse distance method of inter-
polation. Inverse distance requires the search radius with optional para-
meters (step-size and number of steps). The step size of '1' means that
one bin would be used in all directions to interpolate the horizon Z-val-
ues. Whereas the number of steps define the number of concentric
circles for inverse distance computation. For these steps, the grid com-
putation can be set to the corner points for the defined radius or not
(default option).

l Triangulation is a fast gridding algorithm, which uses triangulation
method of interpolation. The interpolation can also be defined by provid-
ing an optional maximum distance (radius) by setting interpolate option
checked.

l Extension uses a simple linear interpolation algorithm to extend the
horizon Z-values outward using the number of steps (bins), which need
to be defined in the following parameter field (Number of steps).

l Continuous Curvature (GMT) is a continuous curvature algorithm of
interpolation, which is a part of the GMT Plugin of OpendTect. Please
check the GMT website for further details. This algorithm only requires
the tension parameter (ranges from 0-1), which controls the smoothing.
The tension 0 gives minimum curvature type of surface interpolation,
while the tension of 1 gives a harmonic surface.

l Nearest Neighbour (GMT) is also another interpolation algorithm com-
ing from the GMT Plugin of OpendTect. This algorithm requires the

http://www.soest.hawaii.edu/gmt/
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search radius to be defined. It is mostly useful for a regularly spaced
grid data. Please check the GMT website for further details.

Filter

The "filter" utility enables filtering of the horizon using either median or average filter.
The inline and crossline step- out should be defined. The larger the step- out, the
smoother the result of the filter.

Snap-To Event

In case the horizon is not correctly snapped to a seismic event, this option can be used.
The user should define the input data, the event type (peak or trough, zero-crossing etc.),
the search gate relative to the original horizon, and whether the snapped horizon should
be saved as new or overwrite the original horizon.

http://www.soest.hawaii.edu/gmt/
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Variogram

For any horizon data displayed on a horizon, a horizontal variogram can be computed:

The variogram describes the spatial continuity, here in the horizontal direction but it can
also be computed vertically from the crossplot tool. It is commonly represented as a
graph that shows the variance in measure with distance between all pairs of sampled loc-
ations. Modeling of relationship among sample locations to indicate the variability of the
measure with distance of separation is called Semivariogram or Variogram modeling.
Variograms are important when doing inversion as it allows to predict a value at a loc-
ation where it has not been measured.
To compute the variogram, parameters need to be provided: the maximum range (max-
imum distance allowed between the pairs for the analysis), the step and the minimum
pairs per log distance:
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Once the variogram has been created, the analysis consists in finding the model that
best fits the measured data in changing the variogram type and changing the sill and
range:
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Display Contours
Add Contour Display: This option displays the contour on the horizon. That the contour
step (interval) is automatically calculated but can be edited at any time. The input for the
contour display can be either a reference Z or any surface attribute like Similarity,
Energy, Dip etc ...
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The contours properties can be manipulated by right-clicking on the Contour attribute in
the horizon element.
A user can adjust contour range/index, color and line thickness.

The images below show a horizon with both reference Z and Similarity contours, respect-
ively:
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Calculate Isopach
Calculate isopach: This option will compute the time or depth difference between two
horizons. The computed grid will be displayed as a new layer on this horizon and may
be stored as a surface data. The output will always be in seconds, meters, or feet.
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Flattening
Write Flattened Cube: It creates the flattened seismic at specified time value of horizon.
The output is stored as a new flattened cube. The user can choose the benefit of this
option by flattening the cube at the horizon.

Create flattened scene: This option enables the user to create a second scene in which
the data is displayed relative to the flattened horizon. This can be a very useful tool in
specific situations. By flattening a horizon, the user gets an idea of the approximate sec-
tion at the time of the deposition of this horizon. The tectonic history can be derived from
the difference between the original section and the "restored" section. Another advant-
age of flattening the horizon is that it becomes easier to evaluate the depositional envir-
onments.
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Unflattening the cube: Should you need to unflatten the cube then please refer to the
following: Delta Resample Attribute

Tracking
The Tracking pop-up menu is used to enable horizon tracking for the selected horizon.
To enable horizon tracking for a horizon, a user may select Start Tracking option, which
will pop-up the Tracking Setup dialog and will also activate the tracking toolbar. After
this, the user may start horizon tracking for the selected horizon. Please read How to ...
Interpret Horizons for further details.

Shift
Shift: The scrollbar allows the user to scroll the 3D horizon vertically. The shift range
allows the user to define the upper and lower boundaries of the scrollbar range. The step
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size defines the distance between each possible horizon position. (e.g. A range of -100
to +100 with a step of 10 allows for the user to scroll through 20 possible horizon pos-
itions, centered about the original position.) Different attributes can be calculated for the
horizon in this user defined shift range. The user can then use the scrollbar to move up
and down and view the attribute as it would appear on that horizon at the various shift
positions. This shifted horizon can be saved as surface data to be viewed later.

Calculate Volume
Calculate volume: It is used to calculate the volume between the two horizons. The
volume is calculated within an existing polygon. Select the polygon and press Estimate
Volume button to calculate the volume within the polygon. To read more about this,
please go to the chapter Pickset: Pop-up Menus



- 157 -

Other Options
Properties: The Material window allows changing of the graphical settings like trans-
parency, line style, and thickness.

Resolution: The resolution of a horizon can be changed for performance reasons.
When using a low-end graphics card, performance during rotating and moving the scene
may suffer. By showing the horizons in a lower resolution, scrolling and rotating
becomes smoother. By default, the resolution is set to Automatic . This setting uses
higher resolution in areas where a horizon has a complicated shape, and low resolution
in relatively flat areas. Also, when rotating, the resolution will be set to low in order to
enhance responsiveness of the rotation action. When released again, the resolution is
set higher again. Attributes displayed will always have full color resolution, only the
shape of the horizon surface is affected by this setting.

Horizon default resolution and colortable settings can now be defined under

the 'Horizons' tab via Utilities--> Settings--> Look and Feel....

Quick UVQ: This option is related the Neural Network plugin license, if it is available. It
is used to create a quick unsupervised facies map. For further information please refer to
the plugin documentation.
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Use single color: When this option is selected, the horizon is displayed in a single
color, which can be chosen from a standard color selection window.

Display: The horizon can be displayed on the sections (inline/cross-
line/2Dline/timeslice) as a line, as a 3D surface or both.

Tracking: Horizons can be edited and tracked through the survey. The various tracking
options are described in here.

Save: The save option gets highlighted when changes are made to the surface geo-
metry. Save saves the new geometry of the horizon. If a horizon consists of patches, you
can save a sub-selection of these patches.

Save as: Save a sub-area or the complete horizon using an other name.

Position: It is used to re-position (selected inline/crossline range) the displayed horizon.
In the position dialog, set the ranges of the inline or crossline to sub-select the horizon
display.
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Lock: This will lock the selected object. It prevents accidental removing, moving, or dis-
playing data on the object. After clicking unlock, all manipulations are possible again.

Remove: This option removes the horizon from the tree and the graphics area.

Store Z as Attribute
This option gives the possibility to store 'Z' values as a Horizon data for an horizon. Sub-
sequently, this newly created attribute can be used to change 'Z' values of another hori-
zon by means of Set Z values.

The name of the new 'Z' attribute and in which units it will be saved need to be specified.

Set Z Values
A 'Z' value surface attribute (see Store Z as attribute) can be used to shift a horizon or
completely change its 'Z' positions using the Set Z values option.
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Specifying values as Relative (deltas) will shift the horizon; infact the software adds the
attributes 'Z' values to the 'Z' values of horizon to achieve this shift. Absolute is used
while completely changing the 'Z' values of the horizon to the 'Z' values of the surface
attribute. Specification of units of 'Z' values (i.e. in 'milliseconds' or 'seconds') is also
required.

2D Horizon

Add... an existing 2D horizon into the scene.

Track new... Allows a new 2D horizon to be created.

Create from 3D... Generate 2D horizons from existing 3D horizons by right-clicking on
2D Horizon in the tree and selecting Create from 3D. A window pops up where you can
designate the 3D horizon, the 2D data set and 2D line(s) where you want to create the
new 2D horizon. This function allows for the 2D horizon to be created on one line, or on
as many lines as a data set contains, all at once.
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Once you have selected a 2D horizon, two other options become available:

The selected horizon(s) will be displayed in the scene. To start a new 2D horizon inter-
pretation, read the chapter How to interpret Horizons.
The displayed 2D horizon pop-up menu contains the following items:

These options are described in the following sub-sections.
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Display

Properties: Change the display settings for a horizon (color, reflectivity, line style).

Only at sections: Display the tracking horizon at section. This is especially usefull for
QC purposes to check if the tracked horizon lies on the expected reflector. Can be
toggled back to In full

Tracking

A 2D horizon displayed in the Scene can be re-interpreted by enabling the tracking
option. Once it is enabled, it will launch the Tracking Setup window to start 2D horizon
interpretation on 2D lines. It will also enable the tracking toolbar. Furthermore, the seed
properties (e.g. color/size) can also be changed using this option.
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Tools

Snapping: This option allows for the selected 2D horizon to be 'snapped' to the nearest
event defined in the Event option (see below).
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Horizon before snapping(red), after snapping (green)

Interpolate: This is a 2D gridding option for horizon interpolation by filling the
gaps/holes in interpretation. If this option is selected for a horizon, it will pop-up the fol-
lowing Horizon Gridding dialog box.

Keep holes larger than: By checking this box, the gridding interpolation
area can be defined i.e. by defining a threshold e.g. 2500m. By setting this
value, the gridding is restricted and gaps/holes up to a radius of 2500 meters
will be filled.

Algorithm: Interpolation algorithms for 2D horizon(s). Currently, OpendTect
supports linear and polynomial types of interpolation.
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Output horizon:Overwrite or create a new horizon from the selected horizon
.

Workflows

Derive 3D horizon: Create a 3D-horizon from a 2D horizon. As soon as a 2D horizon is
tracked, a 3D horizon can be derived by right-clicking the 2D horizon in the tree and
choose Derive 3D horizon. A window pops up in which you can select the algorithm
(inverse distance interpolation or triangulation), shown in images below. The results can
be displayed immediately by selecting the Display after generation option.

Create Flattened Scene: The 2D line(s) can also be flattened using this option. Once
clicked, it will create a new flattened scene based on the selected 2D Horizon. (see also:
Flattened Horizon Scenes)

Fault

The fault option enables interpretation of either a new fault or loading an existing one.

Add: Adds selected faults into the tree and displays them in the scene:
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New: Adds an empty fault in the scene (New fault 1) that needs to be named and saved
once the interpretation is completed.

Display all: If more than one faults have already been displayed or added in the tree,
this option will be available. It is used to display all faults in full, only at sections, or at
horizons, or both. It is also used to toggle On/Off the fault plane, sticks and both displays.

Show all items: It is used to check all items, which means that all items would be dis-
played in the scene.

Hide all items: It is used to hide all (check out) the displayed faults.

Remove all items: To remove all faults that are added in the tree, this option is used.

An example of a picked fault line on a seismic section:

Once a fault has been added, right-clicking will pop-out the following menus :
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Add:

Attribute: Add a new attribute for fault element. Right click and
choose 'Select attribute' to select the desired seismic volume. The
attribute will be displayed along fault planes. The example line
with interpreted faults in a 3D volume has been shown below.
Note that the faults have seismic data displayed as an attribute
along their planes.
Volume Processing Attribute: It is used to add a special sub
layer to the fault that belongs to volume processing attribute. To
read more about this, please go to the Volume Builder Setup
chapter.

Display:

Histograms: It shows multiple histograms of the displayed data
along the selected fault plane.
Only at sections: It is a toggle that is used to display a fault plane
on a section as a stick.
Only at horizons: To display a fault plane on a horizon as a fault
trace, this option could be toggled On/Off.
Fault planes: If a fault has been displayed either on a section or
a horizon, it can be back into a 3D fault plane. This option toggles
On a fault plane display.
Fault sticks: To see the fault sticks only in 3D, this option should
be toggled on.
Use single color: It sets a single color to a fault plane display.
Any displayed attribute along the fault plane will become hidden
an only the fault color would be displayed.
Properties: Set the Type, Size, and Color of the pick markers on
the graphics area.
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Save: It saves the selected fault.

Save As: To save the selected fault with a new name, this option is used.

Lock: Lock the selected object. Prevents accidental removing, moving, or dis-
playing data on object. After clicking on Lock again (i.e unlocking), editing is
enabled.

Remove: It removes the selected fault from the scene.

The sub-menus for the displayed attributes are explained below:

Select Attribute: It is used to select and display various types of data(see
below).

Stored Cubes: Any stored volume could be displayed along the
fault plane in 3D.
Attributes: Any attribute defined in the Attribute set window could
be displayed. This requires a pre-defined attribute set in the Attrib-
ute set window. It will be inactive if no attribute is defined in that
window.
SteeringCubes: If a SteeringCube has already been pre-pro-
cessed it can be selected and displayed along the fault plane.

Save Color Settings: The active color table could be stored permanently or
updated for the displayed stored attribute. For instance, if you do not like the
color bar for a particular seismic data (say PSTM) that is Red-white-blue
(color table) and you want to change it into Magic, you could set it here. It will
save the colour settings for this specific stored volume (PSTM).

Move: To change the display level of an attribute, it can either be moved up /
down or placed to top / bottom.
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Display: To make a fault semi- transparent, the transparency is used. One
can also visualize the histogram of the attribute.

Remove: It remove the selected attribute from the tree.

For Fault interpretation, please see the interpret faults chapter

FaultStickSet
A FaultStickSet is a set of sticks for faults interpretation. Sticks are segments that are cre-
ated by connecting two or more nodes.
The FaultStickSet tree item allows the user to create a new FaultStickSet or to load an
existing one.

The new FaultStickSet is inserted by selecting the New option in the tree. The blank
fault New sticks 1 will be inserted as sub-element of FaultStickSet.
The user can then interpret the fault sticks on inline/crossline/Zslice and/or on 2D lines
as well.

In order to create and edit a faultstickset, check first that the faultstisckset is active in the
tree, then do the following:
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1. Click along the fault to create your first fault stick for one specific section .
2. The second fault stick in the same section is created by shift + leftclick for the first

pick then just leftclick for the next faultpick(s)
3. To remove a fault stick node, Ctrl+leftclick on the already picked nodes.
4. Once you are done with one section, move to another inline/crossline/timeslice/ or

2D line to create new fault sticks. A simple click will start the fault stick creation.
5. If you want to edit one stick while being busy with another, just click on one of it

nodes to make it active. While editing, you can click and drag a node to another
position.

After interpreting the FaultStickSet, use the option Save to save your set with an appro-
priate name.

An example of a picked FaultStickSet with nodes, the active stick is the second from
right (the node connecting line is thicker)

FaultStickSet to Fault
In OpendTect, newly interpreted faultsticksets (or a selection) can be transformed into
3D faults and vice versa, from 3D faults the user can output faultsticks.
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The conversion between faults and faultsticks is done in a special toolbar as shown
below:

In the toolbar, they are two modes: The Edit mode and the Selection mode:

Edit Mode: In this mode, nodes are yellow, the user can add nodes (click),
remove nodes (Ctrl+click). Nodes can be dragged from one location to
another. New sticks are created by Shift+click for the first node then just click
for other sticks.
When using Space+click, this will duplicate the node(s) and new sticks can
be added to the user-defined direction.
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Nodes are yellow in Edit Mode

Selection mode: When this mode is active, Faults/Faultsticks are selected,
copied (or moved) to new or already existed faults/sticks group. The outputs
are: New group, merge to existing one, replace (overwrite) the already exis-
ted group.
Creating new group of faults/sticks in series will automatically rename group
by adding a suffix to the first new group name provided by the user. If the
name is e.g Fault-Area then automatically generated names will be like,
Fault-Area_1, Fault-Area_2, Fault-Area_3 etc ....

In Selection Mode, Nodes are green (selected) and pink (unselected)

When converting faultsticks into faults, please keep in mind that

OpendTect doesn't support the files that contain (1) Crossing fault

sticks, (2) Fault sticks interpreted on vertical (e.g. inline) as well as

horizontal (e.g. Z slice) planes. If the input file contains such type
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of stick sorting, you might encounter problem in OpendTect to get

a regular fault plane.

Clicking the icon allows you to set the transfer (or conversion) settings
which will be applied after the copy or move is put into action:

Body

Bodies are displayed and created from this tree item. Using the option "New polygon
body" the bodies can be drawn by picking on vertical and horizontal slices. The body
will always be the convex envelope around the picked locations.

It is also possible to create bodies from:

l An isovalue surface (implicit representation): The body is extracted from a volume
based on the amplitude distribution.

l A polygon projected between two horizons.
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Bodies may be used for display but also the creation of volumes using the volume
builder: The inner and/or outer parts of the body are filled with constant value(s).

Stored bodies may be displayed in the scene by using Add...

Well
Clicking the well-element in the pops up a menu with 3 options: Add, Tie Well to Seismic
and New WellTrack

Basic Well Pop-up Menus

Add:Wells are added and displayed in the scene using Add option.
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Tie Well to Seismic: Access the seismic to well tie module. Generally, three
parameters are needed for a successful well-seismic tie: sonic/velocity log,
density log and a reference wavelet. The wavelet can be either imported or
extracted in OpendTect. Logs can also be created in the Well Manager.

New Well Track: Create new well tracks interactively in the 3D scene. After
selecting this option the system will prompt for a well track name. After spe-
cifying the well track name, display an element (inline/crossline/2D line) in
the scene. Drawing the well track on the selected element is enabled. After
drawing the well track, right click on the well track name and select the Save
option. Note that drawing a new well track works similarly to editing a exist-
ing well track. Well track-nodes can be picked on the active elements dis-
played in the scene. Also note that a display with a Z-scale (View - Z-scale)
other than 1 distorts the appearance of distance in the 3D view.
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After loading new wells, items are added to the right-click menu as follows:

Well popup menu (multiple) and menu for individual wells.

Multiple Well Options
These options are available only when more than one well is loaded in the tree, and can
be accessed by right-clicking Well in the tree. The new options available when multiple
wells are loaded. Items described in the previous sections above will not be described
again here.

Create Attribute Log: creates selected seismic data as a log for multi-wells.
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Constant Log Size: keeps a well log display width relative to a scene zoom
ratio i.e. a log display width increases with the zoom in and vice versa.
However, this option can be toggled off by clicking on the sub menu item
(Basic Well Pop-up Menus). In the later case, a log display width is adjusted
opposite to the zoom i.e. if a scene is zoomed in, a log display width is
reduced relative to the scene zoomed in ratio and vice versa.

Show all: allows the user to toggle on all well names (top),well names (bot-
tom), markers, marker names, and logs.

Hide all: allows the user to toggle off all well names (top),well names (bot-
tom), markers, marker names, and logs.

Show all items: allows the user to toggle on all wells currently loaded and
visible in the tree.

Hide all items: allows the user to toggle off all wells currently loaded and vis-
ible in the tree.

Remove all items: allows the user to remove all wells currently loaded and
visible in the tree. This only removes the wells from the scene, it does not
delete them from the disk.

Individual Well Options
Once a well has been loaded into the scene and is visible in the tree, right-clicking an
individual well pops-up a window with the following options:
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Create attribute log: allows to create a new log by calculating an attribute
along the well track. A new window pops up where the attribute, log name,
and the depth range should be provided. The Depth range is defined as start
depth, stop depth, and sample distance.

Create log cube: enables to create a volume of a selected log. The log is
duplicated on a user-defined number of traces around the well location. More
than one log can be selected at once and one volume for each log will be
generated. This allows easier comparison between well logs and seismic
data.

Properties: sets various display settings of a well track, the logs, and the
markers. The properties can be set for each well and can also be updated for
all wells displayed in a scene. The later can be done using the button Apply
to all wells available in the Well Display Properties window.
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Log display, Markers display and Track display properties

Well Log Properties: In a scene, the log are displayed using the
Left Log and Right Log tabs. The logs are displayed on the left
and/or on the right of a well track according to a current view. The
log properties include the log selection, log range, fill color and
the the thickness of the log line. None refers to no log selec-
tion/display. If the logs are already imported, the Select log should
contain the name of the logs in the drop down list. The data
ranges and the color ranges are updated automatically from the
selected log. However, both fields are editable. Two types of log
displays styles are supported. For a standard log trace display
style Well log radio button is selected. For a wiggle display, the
Seismic radio box is selected. The well logs can be filled with any
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selected color table . The color ranges can also be manually
set/clipped. However, the seismic style contains different settings.
The synthetic seismic traces can be displayed by toggling the
Seismic radio box ON. The seismic traces can be repeated by
specifying the repetition numbers in the spin box adjacent to the
Repeat text. The Overlap field refers to the overlap percentage of
the repeated traces. Optionally, dual logs spectra can be dis-
played together on the same side by displaying one log as a trace
and filling the color with another log (Fill with Log).

Well Track Properties: The track properties are modified in this
tab. The track line thickness is changed by scrolling the Line
Thickness spin box. The well track/name color is updated by
pressing the colored button. The well name can be displayed
above and below the track. The name size can also be increased
or decreased. It may be noted that the name size is adjusted rel-
ative to the 3D zoom.

Well Marker Properties: Well marker properties tab include the
settings for marker's name size, color, shape (3D), etc. The
marker size is adjusted using the spin box (up/down). The limits
for the size are set from 1 to 100. The color of all markers of a well
track can be changed in to a one unique color. This is supported
by the 'use single color' option. If the same color is to be assigned
to all available well markers, set check to this field and select the
color. Additionally, three different 3D shapes are supported (Cylin-
der, Sphere, Square). The cylindrical shape is added for ortho-
graphic camera displays, which is better for the visualization
purposes. The height of a cylinder is supported.

Edit Welltrack: Allows you to add or delete nodes to the well track. Deleting
nodes is done by holding CTRL and clicking a node. Adding nodes is done
by making "node picks" on any of the active elements on your screen.
Remember that the Z-scale caused a vertical stretch, distorting the appear-
ance of real distance in the 3D view.

2D Log viewer: This property allows you to display a well log in a 2D scene.
The display in log viewer is driven by the 3D scene. To interactively display
different logs, go to the well properties and make the desired changes.
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Save: Stores a new well or saves the changes that were made to an existing
one. Provide a name for a new well, and if a depth to time model is available,
select the file. The file should have the same format as when importing a well-
track. Optionally, you can examine the file using the corresponding button.
Specify if the model uses TVDSS or MS, also the measurement units.

Lock / Unlock: Locks the selected object. This prevents accidental remov-
ing, moving, or displaying data on the object. After clicking unlock all manip-
ulations are possible again.

Remove: Removes the well from the tree (not from disc).

Pre-Stack Events

This tree item allows you to display picked or imported pre-stack events in the 3D scene.
Note that this tree item is only display when there are pre-stack events in the current pro-
ject. Otherwise it is hidden.

There are five display modes:

l None: nothing is displayed.
l Zero offset: A pick shows the location of each pre-stack events, and the Z value of
the zero offset.

l Sticks from sections: Picks show not only the location but also the moveout
curve described by the picked events.

l Zero offset on sections: Same as zero offset, but only the events that exists on
displayed inlines/crosslines will be shown.

l Sticks to gathers: Same of sticks from sections, but only the events that exists on
displayed 3D pre-stack planes will be shown.

The displayed picks are always linked with a thin line. Regardless of the display mode
the picks are colour-coded with respect to the following color settings:
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l Single: Default mode, one single color for all picks of the pre-stack events.
l Quality: The color of the picks is related to its quality. This attribute is either impor-
ted with the pre-stack event or set when picked in the Velocity Model Building plu-
gin.

l Velocity: The color of the picks is related to the corresponding interval velocity.
Note that for this to work the input pre-stack datastore and corresponding migration
velocity must be specified in the velocity model building plugin.

l Velocity fit: The color of the picks is related to the deviation between the picked
event and velocity of the best fitting normal/residual moveout curve. Note that for
this to work the input pre-stack datastore and corresponding migration velocity
must be specified in the velocity model building plugin.

The color of the picks, except in single mode, should be adjusted using the colorbar like
with any attribute by ajusting the colorbar and amplitude ranges.

Pre-Stack 3D Viewer
Prestack gather selection from the tree

Pre-stack (PS) gathers can be displayed in the 3D scene, perpendicular to an inline or
crossline. Post stack data must first be displayed on an inline/crossline. The post-stack
data does not need to be linked to the pre-stack data. Once the line is loaded, go to inter-
act mode (graphical toolbar, second icon from the left), right-click in the scene your inline
and use the option Display PS gather. The menu will list any pre-stack data available
(loaded) in the survey. Please note that multiple PS gathers can be displayed on the
same inline, and moving the inline to another position will keep the position of the PS
gather and update its content.
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Right-click menu of a vertical slice tree item when pre-stack datasets are available.

Post-stack data on an inline (left) with a prestack gather displayed perpendicular to it.

Positioning the prestack gather
When a pre-stack data is displayed in a scene, the pre-stack positioning window also
pop-ups (look at the corners of the screen). By using this window, the pre-stack data can
be scrolled interactively. The crossline value locates the currently-displayed prestack
panel. That can be scrolled at given steps (increment). You can use either the arrows or
the mouse wheel over the inline/crossline value.
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Right-click options for a prestack dataset

Right-click menu on the pre-stack gather display to open it in the prestack 2D viewer.

Properties:
There are several display properties available that are described below. Please note
that the gathers are first displayed without any processing. This can be set together with
other properties in the PS gather display properties:

Shape: The shape tab will set the size of the gather with respect to other 3D
elements and its relative position
Appearance: Color bar, amplitude ranges and grid lines can be set in this
tab.
Scaling: This tab is used to scale (clip) the amplitude range of the displayed
data.
Preprocessing: Pre-processing may be applied to enhance the display. The
available algorithms are presented in the prestack processing chapter.
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Resolution: Interpolates the data to get a better display (consumes more memory).

View in 2D panel: Transfer this dataset to view it in the prestack 2D viewer.

Amplitude spectrum: Display the average frequency spectrum of the trace of that
gather, for the displayed Z range.

Annotations
With this option, you can draw arrows, load images, and write text on the display window
by right clicking in one of the items in this tree.

Arrow: You can add new arrow groups, change the properties, lock-unlock, and remove
them by right clicking on this element.

Once you have added a new arrow group, named it and saved it, you can now click in
the scene to add arrows (CTRL+left-click to remove an arrow). The arrow properties can
then be changed by right-clicking on the newly inserted arrow group and selecting the
properties from the fold-out menu. In the arrow properties, arrow type (top, bottom or both
heads), color, width and size are adjusted.

Arrow style properties

Image:Once you have added a new image group, you can click in the scene to add an
image (CTRL+left-click to remove an image). It is then possible to store, resize, change
image, lock-unlock, and remove it by right clicking on the relevant image group in the
tree.
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Add a new annotation group and changing the position of the annotation

Text contains two pop-up menus:

l Add Text Group: Adds a blank text group
l Load: It is used to load the stored annotation group(s).

The text group pop-up menu can be launched by right clicking on the text group name.

l Size: Resize the text group. It may be noted that it will resize the all inserted text
sub-elements according to the new size.

l Save/Save as: Saves the text group in to an existing name/new name.
l Change Text: it is used to replace/change the text of the selected annotation. It
may be noted that in the tree pop-up menu it si inactive. A user can only change
the text of a selected annotation. It is done by right-clicking over the annotation in a
working scene.

l Background Color:Modifies the background color of the annotation.
l Lock: If lock is selected, it will prevent further modification of the group.
l Remove: It removes the group from the tree/scene.

Scale Bar: Use this option to add a scale bar to an inline, crossline or Z-slice. Once
added and saved, right-clicking on this element will also give you the option to change
the properties.
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For Inlines and Crosslines, this includes the Horizontal or Vertical direction options

For Z-slices, this includes the X or Y direction option
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Survey

Select & Setup Survey
The Survey module is used to select, create, modify, delete or copy surveys. A survey
defines the geographical boundaries of an OpendTect project and relevant positioning
information such as the relationship between inline/crossline and X/Y co-ordinate sys-
tems. Each survey (project) stores its data in a separate directory that needs to be spe-
cified along with the survey reference name. Moreover, the survey rotation angle is
displayed; this angle shows the deviation from geographic North.

Survey Selection Window
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Select an existing survey from the list of surveys on the left or create a new one with

New ... (see below). The boundaries of the survey are depicted in the field to the

right and detailed in the information field . The Notes field is a free-format text
field to store relevant survey notes.

When you install OpendTect, selected an OpendTect data
directory where all your surveys are stored:
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Any folder can be turned into an OpendTect folder, the only change being the
addition of a parameter file (.omf).
Only surveys stored in the selected OpendTect folder are displayed and can
be accessed. Later you can open another OpendTect folder clicking on Sur-
vey Data root. The current data root is always displayed on the top of the win-
dow.

Use for creating new surveys

Use for editing survey box ranges or update coordinate information (see
Edit Survey Window)

Copy whole surveys from your data root to a designated location.

Allows you to compress/pack your entire survey into a zip file. This is
highly recommended when transferring your survey from a computer to
another computer, especially if they do not use the same platform. All data
from this survey will be contained in the zip file, with the exception of the
SEG-Y and/or CBVS files that were used 'in-place' from another location (ie:
those SEG-Y or CBVS files that were used but not actually put inside the sur-
vey folder)
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Unpacks a previously packed survey (see above) into your Data root
folder. Most zip files could potentially be unpacked, but we support only the
unpacking of survey packed using the OpendTect packing tool. If you wish to
share your survey with the community, visit our Open Seismic Repository.

Takes the user to the Open Seismic Repository (OSR) page on the
OpendTect website (https://opendtect.org/osr/). Here, one can find inform-
ation on how to share surveys with the wider community.

In the position conversion window there are two modes available for
coordinate conversion: Manual / File. In Manual mode, specify a inline/cross-
line pair, or a X/Y pair, and press the corresponding arrow key to obtain the
position in the other domain. In File mode, browse the input file and create a
new output file. By specifying the corresponding type conversion (XY to IC or
IC to XY) and pressing the GO button, the desired conversion is written to the
output file. There is no specific file type necessary for this input - even files
without extension may be used. Simply Select them and, if desired, Examine,
too.

http://opendtect.org/index.php/share-seismic-data/osr.html
https://opendtect.org/osr/
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is used to export the selected survey boundary in a *.kml file, which is
accessible via Google Earth. The dialog box contains the editable fields for
the survey box. The area of the survey box is filled with the selected color.
The width is the horizontal thickness of the survey outline. The border height
is the altitude of the line with respect to the ground. The Output file field is an
output location of the *.kml file. On 'Ok' the file (*.kml) is written at the spe-
cified path, which can be opened directly in Google Earth.
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Before exporting the *.kml file, specify the correspondence between X-Y

coordinates and latitude/longitude at any location in the surveybox :

After pressing Ok provide an output filename.
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New Survey Window
To launch the survey setup window select New in survey selection window. The fol-
lowing window will appear on your screen:

Survey name: In the text area specify the OpendTect survey name.

Data to use: Toggle on the data type(s) to be included in the survey (2D only, 3D only or
both 2D and 3D)

Note: Select only 3D, if the survey contains only 3D type data set. Select
both 2D and 3D, if the survey contains both 2D and 3D type data set. If the
survey contains only 2D type data set, select only 2D. Selection type here
affects the tree structure and what functions are available to you in the sur-
vey.

Initial setup: Determines how you set up the survey ranges and coordinates:

Scan SEG-Y file(s): takes you to the SEG-Y tool to scan the file(s) for survey
setup.
Get from Petrel: allows you to copy the survey ranges/coordinates from
another software. (Available only with the Petrel Connector plugin.)

http://www.arkcls.com/software/opendtect-connector


- 199 -

Set for 2D only: takes you to the following window where you can enter the
working area values:

Copy from other survey: allows you to copy the survey setup from another
survey on your drive/network.
Manual selection: enter the values manually (see Edit Survey Window)

Domain: Can be in time or depth (for depth, define here the unit):
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Edit Survey Window
To launch the survey setup window select Edit in the survey selection window. The fol-
lowing window will appear on your screen:
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All fields must be completed.

Survey name: In the text area specify the OpendTect survey name.

Location on disk: Specify a directory on disk where the OpendTect survey would be
stored. The directory would be turned in to the OpendTect survey location.

Survey type: For the survey type, there are three options:
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Select only 3D, if the survey contains only 3D data. Select both 2D and 3D, if

the survey contains both 2D and 3D data. If the survey contains only 2D type

data set, select only 2D. Selection type here affects the tree structure and

what functions are available to you in the survey.

Ranges/Coordinate settings are described in the following sections.

Survey Ranges

The survey ranges are the inline, crossline and Z-range values. The ranges define a 3D
survey area for 3D seismic surveys and 2D grid area for 2D seismic surveys. These
fields can be filled manually, by scanning a SEG-Y file (2D/3D), using set for 2D only
option in Ranges/coordinate settings, or by copying the ranges from another survey. If
the Workstation Access plugin is available, one will see the Get from GeoFrame or Get
from Seisworks option in the drop-down menu.

The set for 2D only option is especially used to create a 2D seismic survey. Set the aver-
age trace distance and the x and y coordinate ranges, and these will automatically be
translated into suitable survey settings.

Click on the Scan SEG-Y file(s) button to select a SEG-Y file. In the new window, you set
the SEG-Y settings, see also SEG-Y scan section. Pressing OK will start scanning the
file(s). After scanning, you'll get a file report containing sampling info, data statistics, and
the survey setup. The Survey ranges and Coordinate settings will be filled in auto-
matically.

The Z range is specified in milliseconds, meter, or feet. The steps are incremental Z-
steps of the survey i.e. the seismic sampling rate.
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Coordinate Ranges

The relationship between inline/crossline and X/Y can be specified in two ways. The
easy way is to specify three points, two of which must be on the same inline. Due to
rounding off errors, this method may not be 100% accurate.

In the Advanced option, the exact transformation from one co-ordinate system to an other
can be specified. The Apply button can be used to verify results graphically and to check
the co-ordinate transformation formula.

Read more about Coordinate Settings in Setup 2D/3D Survey and following.

Session
The OpendTect session is generally used to save and to retrieve the specific settings of
a scene. This helps to resume work from previous settings. The session will save all set-
tings of the displayed elements, and can be restored at any later time. When clicking the
Survey option in the tool bar and then click Session, three options appear. It is possible
to save the session or restore a previously saved session. When clicking Auto, the ses-
sion will restore itself automatically the next time you start OpendTect.
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When a session is saved, the system stores all element positions and relevant inform-
ation to recreate the images. The content of the elements is not saved but is re-created
when the session is restored.

The auto-load window (left) and the 'Select' option (right)

The user can enable or disable the auto- load session option. It is also possible to
choose if one of the save sessions will be used in this session. Finally the user has the
choice on whether or not to load the selected session now.

A similar function exists to auto-load one of the attribute sets.
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As mentioned earlier that the contents of the elements are not saved but are

recreated. It is a common practice of the OpendTect user(s) to save and

restore a session. The mistake a user(s) can normally make is to save a ses-

sion with the contents of an element(s) (e.g. attributes) that takes a long time

to compute. In this way, when such session is restored, it will take a way too

long time to restore, because the session can only store the settings (or rel-

evant information) but not the on-the-fly attributes. Thus, it re-calculates the

contents. This can be avoided by creating the attribute outputs of such attrib-

utes. If an attribute already reside in a disk (a session is saved), the session

will be restored very quickly. Similarly, the same thing can happen in a ses-

sion that contains contents of surface data (the attributes calculated along hori-

zon). The attributes applied along a horizon can be saved as a surface data. It

is recommended, to save the surface data before saving a session.

Import
The Import menu is used to import seismic data, horizons, faults, well data, picksets,
wavelets, mute/velocity functions etc... Seismic data can be imported as SEG-Y file,
Workstation (SeisWorks, GeoFrame- IESX), or from dGB's CBVS (Common Binary
Volume Storage) formatted files. The SeisWorks and GeoFrame options are only avail-
able if a user have a workstation license*. Whilst OpendTect can handle data volumes
with irregular boundaries and gaps, strong irregularity (e.g. frequent non-constant steps
between inlines and/or crosslines) throughout the volume may cause problems.

The default location for input data is the survey root directory, with the exception of cbvs
volumes where the DTECT_DATA root location is the default folder.
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Import Attributes

Clicking on ASCII, above, opens the simple 'Import Attribute Set' window, allowing a
user to import OpendTect attribute sets form any other (network) location. The file may
be renamed on import in the 'Output Attribute Set' field.
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The imported attribute set can then be opened from the normal location within the Attrib-
ute Set window.

Import Color Table
Colortables can either be imported from 'Other user' or from 'File'. Default colortables are
stored in a file (ColoTabs) that is located in the OpendTect installation directory
(/root/OpendTect/5.0.0/data/). The colortables saved by a user are stored in a file (set-
tings_coltabs.user) that is located in the user home directory ($HOME/.od/), here user is
the OpendTect username. These files can be modified or imported by using import color
table window (see below).

Import color table from other user
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Import color table from file

Import Cross-Plot Data
Select the input Ascii file. You may display the input file by pressing the Examine button.
The input file should be column sorted with one point per record (line).

The main work is to specify the presence of a file header and the file format definition.
The header, if present, can be of fixed length (number of lines), or delimited on its last
line by a keyword.
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Predefined and saved file formats are available by pressing the icon. Otherwise the
format must be manually specified. The Define button gives access to the format defin-
ition window.

You must specify in the format definition window the column numbers for the position, in
terms of an X-Y-Z or an inline-crossline-Z. The Z units can be seconds, milliseconds or
microseconds (meters of feet in depth surveys). All other columns with be treated as amp-
litude data referenced with respect to the given position. The first row may contain either
the first vector with its position and the corresponding amplitudes ("Data"), or the name
of the attributes in each column ("Column names"). Reading may be stopped at a spe-
cific line by providing the adequate keyword.

It is recommended to save the format definition for a later use and QC, by clicking on the

icon . In pop-up window, write the name of the format and store it. The format can be



- 210 -

stored at different levels (All surveys, Current survey, Current OpendTect user level)
depending on the usage. Press OK when done.

Import Faults
3D Faults (planes) can be imported in OpendTect via Survey -> Import -> Faults, from
Ascii files or from GeoFrame Workstation (plugin).

Faults are non-editable objects that may be used as display element in the 3D scene,
displayed in full or a section. Attributes can also be applied along faults. If you are look-
ing for an editable object that can be converted at a later stage into a fault plane, please
load your data as fault stick sets.

Import Fault Ascii 3D

Select the input Ascii file. You may display the input file by pressing the Examine button.
The input file should be column sorted with one point per record (line).
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The main work is to specify the type of data, the presence of a file header, and the file
format definition.

The sticks composing the planes can be either gathered automatically, either from
picked slices (inlines or crosslines), and/or based on their slope. The sorting can be
done based on the geometry of the fault sticks, on an index written in the input file, or in
the order found in the file. The header, if present, can be of fixed length (number of lines),
or delimited on its last line by a keyword.

Note: that OpendTect does not support crossing fault sticks (a fault plane can-

not cross itself). If faults were picked on inlines, crosslines and horizontal

slices, only the largest subset of the three will be used to import the faults.

Predefined and saved formats are available by pressing the icon. Otherwise the
format must be manually specified. The Define button gives access to the format defin-
ition window.
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You must specify in the format definition the column numbers for the position; in terms of
an X-Y pair, pick column, and optionally stick index (0 = no stick index). The Z units can
be seconds, milliseconds or microseconds. Reading may be stopped at a specific line
by providing the adequate keyword.

It is recommended to save the format definition for a later use and QC, by clicking on the

icon . In pop-up window, write the name of the format and store it. The format can be
stored at different levels (All surveys, Current survey, Current OpendTect user level)
depending on the usage. Press OK after having provided the name of the fault to be
imported.
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Import FaultStickSets
Fault stick sets are the editable version of the fault planes. Fault stick sets are fully edit-
able objects either for faults interpretation , or later as fault input to correct for the fault
throw. They can be imported in OpendTect via Survey > Import > FaultStickSets, from
Ascii files of from GeoFrame Workstation (plugin).

Import FaultStickSets Ascii 3D

Select the input ASCII file. You can display the input file by pressing the Examine button.
The input file should be column sorted with one point per record (line).

The important point is to specify the presence of a file header and the file format defin-
ition. The header, if present, can be of fixed length (number of lines), or delimited on its
last line by a keyword.
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Predefined and saved formats are available by pressing the icon. Otherwise the
format must be manually specified. The Define button gives access to the format defin-
ition window.

You must specify in the format definition the column numbers for the position, in terms of
an X/Y pair, pick column, and optionally stick index (0 = no stick index). The Z units can
be seconds, milliseconds or microseconds. Reading may be stopped at a specific line
by providing the adequate keyword.

It is recommended to save the format definition for a later use and QC, by clicking on the

icon . In pop-up window, write the name of the format and store it. The format can be
stored at different levels (All surveys, Current survey, Current OpendTect user level)
depending on the usage. Press OK after having provided the name of the name of the
faultstickset to be imported.
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Import FaultStickSets Ascii 2D

Select the input Ascii file. You may display the input file by pressing the Examine button.
The input file should be column sorted with one point per record (line).

The main work is to specify the presence of a file header, and the file format definition.
The header, if present, can be of fixed length (number of lines), or delimited on its last
line by a keyword.
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Predefined and saved formats are available by pressing the icon. Otherwise the
format must be manually specified. The Define button gives access to the format defin-
ition window.

You must specify in the format definition the column numbers for the position, in terms of
an X-Y pair, pick column, and optionally stick index (0 = no stick index). The Z units can
be seconds, milliseconds or microseconds. The name of the 2D line(s) must also be
provided. Reading may be stopped at a specific line by providing the adequate keyword.

It is recommended to save the format definition for a later use and QC, by clicking on the

icon . In pop-up window, write the name of the format and store it. The format can be
stored at different levels (All surveys, Current survey, Current OpendTect user level)
depending on the usage. Press OK after having provided the name of the faultstickset to
be imported.
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Import Horizons
Horizons interpreted on 3D and 2D seismic data and (attribute) grids can be imported in
a OpendTect survey via Survey > Import > Horizons. The grids are called "Surface data"
in Opendtect and are attached to 3D horizons. Horizon import supports the following:



- 218 -

The standard input data is Ascii files. Three options are available (explained in the fol-
lowing subsections):

l Geometry 3D: Import horizons interpreted on a 3D grid (e.g. XYZ)
l Attributes 3D: Import an attribute grid as a surface data, for a given 3D horizon.
l Geometry 2D: Import horizons interpreted along 2D lines.
l Bulk 3D: Import multiple 3D horizons from a single file

Import Horizon from Geoframe/Petrel: Horizons can also be imported into OpendTect
from Geoframe 2D/3D (Survey > Import > Horizon > GeoFrame > 2D or 3D). The fol-
lowing dialog will pop up. Select the GeoFrame project and the survey name that con-
tains the horizon to be imported.

Geometry 3D

Select the input ASCII file. You may display the input file by pressing the Examine but-
ton. Available grids (attributes) present in the input file may also be imported sim-
ultaneously. The input file should be column sorted with one point per record (line).
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The main work is to specify the presence of a file header and the file format definition.
The header, if present, can be of fixed length (number of lines), or delimited on its last
line by a keyword.
Predefined and saved file formats are available by pressing the icon. Otherwise the
format must be manually specified. The Define button gives access to the format defin-
ition window.
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You must specify in the format definition window the column numbers for the position, in
terms of an X-Y pair or an inline-crossline pair, and the pick column. Picks that should
not be read must all have the same numerical value, which is to be filled in as the
"Undefined value". The Z units can be seconds, milliseconds or microseconds. Option-
ally, if attributes were added in the Import Horizon window, additional columns with
given attribute(s) name(s) will also appear in this format definition window. Reading may
be stopped at a specific line by providing the adequate keyword.

It is recommended to save the format definition for a later use and QC, by clicking on the

icon . In pop-up window, write the name of the format and store it. The format can be
stored at different levels (All surveys, Current survey, Current OpendTect user level)
depending on the usage. Press Ok when done.
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It is highly recommended to scan the input file after providing its format, and prior to the
actual import. The scanned information will pop-up and error(s) or warning(s) may sug-
gest a change of the format definition.

The area sub-selection can be used in two ways:
- Reduce the amount of data to be loaded: By reducing the inline/crossline ranges
- Specify a new grid size if a coarse input grid should be gridded during import: By
decreasing the inline/crosslines steps to the survey steps (minimum).

The option Fill undefined parts will be toggle on if gaps were found during scan. A tri-
angulation to the convex hull with an interpolation where the maximum size is the input
grid step (in XY units, thus meters or feet), and Keep holes larger than toggled off, should
be the optimal settings in most cases.

Tied to level is additional option specifically designed to tie horizons to well

markers, for correlation purposes. In order to define the stratigraphic inform-

ation of the survey, please read about Manage Stratigraphy.

Attributes 3D

This window is used to import grids from ascii files and attached them to Existing 3D hori-
zons. Select the input Ascii file. You may display the input file by pressing the Examine
button. The input file should be column sorted with one point per record (line).
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Grid names must first be provided in front of Select Attribute(s) to import. This can be
done by pressing Add new right of it, and providing each time a new grid name. This will
populate the list of importable grids. Only the highlighted grids will be imported, which is
why each new grid is highlighted after providing its name.

Next, the presence of a file header must be specified and the file format definition must
be provided. The header, if present, can be of fixed length (number of lines), or delimited
on its last line by a keyword.

Predefined and saved file formats are available by pressing the icon. Otherwise the
format must be manually specified. The Define button gives access to the format defin-
ition window.
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You must specify in the format definition window the column numbers for the position, in
terms of an X-Y pair or an inline-crossline pair, and the grid(s) column(s). Grid values
that should not be read must all have the same numerical value, which is to be filled in
as the Undefined value. Reading may be stopped at a specific line by providing the
adequate keyword.

It is recommended to save the format definition for a later use and QC, by clicking on the

icon . In pop-up window, write the name of the format and store it. The format can be
stored at different levels (All surveys, Current survey, Current OpendTect user level)
depending on the usage. Please note that the full grid names will be saved as provided
in the format definition. Press OK when done.

It is highly recommended to scan the input file after providing its format, and prior to the
actual import. The scanned information will pop-up and error(s) or warning(s) may sug-
gest a change of the format definition. The area subselection is essentially present to
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optionally reduce the amount of data to be imported, by reducing the inline/crossline
range(s).

Finally an horizon must be provided, to attach the grid(s) to it. Grids will be accessible
only after having loaded this horizon in the tree. Press Go to launch the import.

Geometry 2D

This window is used to import 2D interpretations form ascii files. Select the input ascii
file. You may display the input file by pressing the Examine button. The input file should
be column sorted with one point per record (line).

Several 2D horizons can be imported at once. Their name should be provided in front of
Select Horizons to import. This can be done by pressing Add new right of it, and provid-
ing each time a new horizon name. This will populate the list of importable horizons.
Only the highlighted horizons will be imported, which is why each new horizon is high-
lighted after providing its name. Ctrl-left click may be used to highlight or deselect an hori-
zon.
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Next, the presence of a file header must be specified and the file format definition must
be provided. The header, if present, can be of fixed length (number of lines), or delimited
on its last line by a keyword.

Predefined and saved file formats are available by pressing the icon. Otherwise the
format must be manually specified. The Define button gives access to the format defin-
ition window.

You must specify in the format definition window the line name, column numbers for the
position, in terms of an X-Y pair or a unique trace number, and the horizon(s) column(s).
Horizon Z values that should not be read must all have the same numerical value, which
is to be filled in as the Undefined value. Reading may be stopped at a specific line by
providing the adequate keyword.

It is recommended to save the format definition for a later use and QC, by clicking the

icon . In pop-up window, write the name of the format and store it. The format can be
stored at different levels (All surveys, Current survey, Current OpendTect user level)
depending on the usage. Press OK when done.
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It is highly recommended to scan the input file after providing its format, and prior to the
actual import. The scanned information will pop-up and error(s) or warning(s) may sug-
gest a change of the format definition. Press Go to launch the import.

Bulk 3D

The bulk import tool allows for the import of multiple 3D horizons from one single file.
The data is matched by name. This has the following implications:

The horizon name must appear on each line of the input file. The horizon name should
not contain spaces, otherwise the matching with a given column number will not work as
expected.

Apart from being a multiple horizon import tool, it behaves following the rules of the
standard horizon import.
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This option is not yet available for 2D horizons.

Import Mute Functions
Mute definitions can be used for pre-processing pre-stack seismic data.

Mute definitions can be imported in OpendTect using Ascii files. The import window is
launched from the OpendTect main menu (Survey > Import > Mute definitions > Ascii).
Select the input Ascii file. You can display the input file by pressing the Examine button.
The input file should be column sorted with one point per record (line).
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The main work is to specify the presence of a file header and the file format definition.
The header, if present, can be of fixed length (number of lines), or delimited on its last
line by a keyword. The mute definition can be either variable throughout the survey, in
which case a position must be provided in the input file for all data points, or fixed. In this
latter case, toggle File contains position to No and provide any location for the mute
definition.

Predefined and saved file formats are available by pressing the icon. Otherwise the
format must be manually specified. The Define button gives access to the format defin-
ition window.
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You must specify in the format definition window the column numbers for the position, in
terms of an X-Y pair or an inline-crossline pair, and the pick column, in terms of an Off-
set-Z value pair. Picks that should not be read must all have the same numerical value,
which is to be filled in as the "Undefined value". The Z units can be seconds, mil-
liseconds or microseconds (meters of feet in depth surveys). Reading may be stopped at
a specific line by providing the adequate keyword.

It is recommended to save the format definition for a later use and QC, by clicking on the

icon . In pop-up window, write the name of the format and store it. The format can be
stored at different levels (All surveys, Current survey, Current OpendTect user level)
depending on the usage. Press OK when done.

Import PickSets & Polygons
Point/vector data can be loaded in OpendTect from Survey -> Import -> PickSet/Polygon.
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Select the input Ascii file. You can display the input file by pressing the Examine button.
The input file should be column sorted with one position per record (line).
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The main work is to specify the presence of a file header and the file format definition.
The header, if present, can be of fixed length (number of lines), or delimited on its last
line by a keyword.
Predefined and saved file formats are available by pressing the icon. Otherwise the
format must be manually specified. The Define button gives access to the format defin-
ition window.

You must specify in the format definition window the column numbers for the position, in
terms of an X/Y pair or an inline-crossline pair, and the pick column. Picks that should
not be read must all have the same numerical value, which is to be filled in as the
"Undefined value". The Z units can be seconds, milliseconds or microseconds. Reading
may be stopped at a specific line by providing the adequate keyword.

It is recommended to save the format definition for a later use and QC, by clicking on the

icon . In pop-up window, write the name of the format and store it. The format can be
stored at different levels (All surveys, Current survey, Current OpendTect user level)
depending on the usage.
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The option Import as polygon will flag this specific datatype to the loaded data. It also
adds as constraint during loading that the points are ordered in the expected way. The
import tool will not apply any sorting.
Press OK when done.

Import Probability Density Functions
Probability density functions can be imported in order to run Bayesian classifications.
The manage tool can later be used to edit the PDF before running the Bayesian clas-
sification.
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RokDoc formatted data is required for importing PDF in OpendTect. After having selec-
ted the input file, the two contained variables will be shown in the import window,
together with their amplitude ranges and bin size.

The variable names and parameters may be modified before pressing the Go button that

will launch the import. The icon to the right can be used to quickly extend both vari-
able ranges by one bin size outwards.
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Import Seismics
Volumes and 2D Lines can be imported in the Survey menu from files in different modes:

SEG-Y: By converting a SEG-Y file to an OpendTect file.
SEG-Y scanned: By referencing (linking) a SEG-Y file to the survey without creating a
new file.
Simple file: From a regular ascii or binary file, with or without header.
CBVS: By copying or linking an existing OpendTect (CBVS) volume.
Petrel: Import seismic data from other software (depending on system setup)
GPR-DZT: Import the files made by GSSI Ground Penetrating Radar (GPR) systems in
the 'DZT' format.

SEG-Y

SEG-Y is the standard way to share volumes/lines of data. In OpendTect the files are
loaded with a rigorous respect to the SEG standards using a loading wizard. Most SEG-
Y files will be imported in a few clicks, and a number of exceptions can be set to load the
most problematic data. Nevertheless there are a few guidelines that must be honoured:

l The traces must be sorted either by inlines and then crosslines or by crosslines
and then inlines.

http://www.seg.org/resources/publications/misc/technical-standards
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l The gathers of pre-stack data must be consecutive and ordered by increasing off-
set (i.e. no common offset sorting).

l Inline/crosslines or coordinates (and offset) must be written in every single trace
header. Separate navigation data is not supported.

l The traces must have a fixed length.
l There is no support of extended textual headers.

Once the above criteria are respected, you will then enjoy a large freedom:

l Gaps can be present.
l The traces can start at any time/depth, even negative.
l The files can be merged during import, re-scaled using linear equations,and the
storage format can be changed.

Note: Please, read the entire chapter before asking for support. If you need

support please send us a screenshot of the first step, examine window, import

window and scan report together with a description of your problem.

SEG-Y Import Preparation

The generic wizard called the "SEG-Y tool" can load pre-stack and post-stack seismic
data, from one or multiple SEG-Y files (2D and 3D). This wizard must be launched from
the survey menu. It consists of two mandatory steps: The data selection (first step) and
the loading of the new file by providing the key parameters.
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SEG-Y Tool Window (3D and 2D)

Mandatory workflow in the first step:
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1. Select your (first) file using the file browser.
2. Choose the correct file type between:

3. If multiple SEG-Y files representing one 3D volume (pre-stack or post-stack) have
to be loaded you must specify the number of files to be merged during loading. The
input SEG-Y files must contain blocks or inlines. File names must be indexed like
file1.sgy, file2.sgy..., any file can be selected and the index must be replaced in the
input field by a wildcard (*):

In most cases you can press theNext button after you have done the two actions listed
above. Only if you have a proiri knowledge that the file might be having some problems
you would like to perform one of the following actions before pressing Next.

Optional actions in the first step:

1. Manipulating a SEG-Y file:The text, binary and the trace headers may be edited by
using this option. This is accessed by clicking on the Manipulate button.

The text header can be directly edited.
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The binary header can be edited by clicking on Change button and correcting the Byte
and Value fields (where required) in the pop-up window shown below.
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On the trace headers a Header Calculation can be performed to change their Value .
This can be done by selecting one of the trace headers from the list and pressing the

icon.

These calculation sets may be edited, deleted and saved for later use by using ,

and icons respectively. Any previously saved sets can be restored by pressing
. For visualization purposes one or more trace headers can be selected from the fol-

lowing table and plotted against a range of trace numbers using the icon.

For information about the supported operators, functions and constants, please refer to
the Mathematics attribute.
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If the option All is not ticked, the following window will pop-up for choosing the required
range of traces.
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Inline header value plot

All the trace headers for any particular trace number can be viewed by changing the
value in front of the Trc field. Finally, the modified SEG-Y file is outputted by specifying a
name and location to save.

2. Number of traces to examine: A set of traces may be examined at the beginning of the
file. Looking at the output is strongly recommended but not mandatory for a successful
import. This can be disabled by entering "0". Pressing Save as default will save the num-
ber of traces to examine in your user settings.

3. Overrule SEG-Y number of sample: If the number of samples per trace is not or incor-
rectly written in the line and/or trace headers you can overrule it here.

4. SEG-Y format: If the format of the data samples is not or incorrectly written in the line
header you can overrule it here.

5. Bytes swapped: Most header values and/or data samples are written using several
bytes for each word/sample. Therefore a correct byte order is a necessity. Thus, if the
trace headers don't seem correct or if the sample values are unexpectedly large num-
bers, byte swapping might be required.
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After pressing Next a popup question (SEG-Y revision) and the SEG-Y examiner win-
dow will appear. It is recommended to answer the questions and examine the traces
before moving on to the second wizard window.

SEG-Y Revision

After preparing the SEG-Y import you will be asked to revise the type of your SEG-Y file
(s). The time consumption and the smoothness of the import phase will depend on the
answer.

1. [No]: the file is NOT SEG-Y Rev.1 - treat as legacy (i.e. Rev.0) - For un-lucky users
the revision 1 flag might wrongly be set to "Yes" in the line header while obviously the
file does not comply with the SEG-Y revision 1 norm. It may happen when the software
blindly copies entire headers without refreshing all the necessary characters. "Rev.0" is
an older way of loading SEG-Y files: The inline and crossline offset (bytes) must be
present in the trace headers and their offsets must be provided to the software since it
may vary from file to file.

2. [Mostly]: It's Rev.1 but I may need to overrule some things - The file is 100% SEG-Y
Rev.1 but you would like to overrule some particular information e.g. Coordinates, Samp-
ling rate and Start time etc.

3. [Yes]: I know the file is 100% correct SEG-Y Rev.1 - For lucky people, this is by far the
most easy and quick way to import your SEG-Y file. No additional settings are required
except the final output volume/line name in the OpendTect database.
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After selecting appropriate option, press OK to reach the import window.
You can save the answer to this question in your survey settings by activating the option
"Don't ask again for this survey". If you set this flag by mistake and wish to go back you
need to edit the ".defs" file (in the OpendTect survey directory) with a text editor and
remove the line "SEG-Y Rev. 1 policy:".

SEG-Y Examiner

SEG-Y examiner window is used to examine the textual, line and first trace headers. It is
a useful tool that serves two purposes:

1- Examination of the headers so that, if necessary, SEG-Y settings can be found and
adjusted.

The plot between any individual trace header and the number of random traces
examined is a very good tool to visualize its range and inspect for any discrepancy.



- 244 -

2- Viewing the first traces in a 2D viewer.

It is strongly recommended to always display the traces in the 2D viewer. This is done

from the examine window by using the icon . The examine window will show the
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entire textual header, the words in the line header that are different from zero, and the
entire trace headers of the first traces. You can use the vertical scroll bar to browse
through the file headers and locate the information to import.

Optionally, the save button can be used to store the textual header.

Use the lateral scroll bar at the bottom to locate the header words that change with the
traces. They indicate traces, crosslines, offsets, coordinates etc. It is unlikely to see the
inline number vary in the first traces. However,it is often at the bytes preceding the cross-
line number. Increasing the number of traces to examine will help finding the inline num-
ber.

Please note that the examine window can stay open during import.

SEG-Y Import

The main import window will look different based on the type of SEG-Y file. At any

moment a partial or full scan of the input(s) can be launched using the icon on the
right-hand side.

If the file is Rev 1 standard then the import is almost complete: You must provide an out-
put name and can optionally sub-select a range of the volume to be loaded and/or
change the output format and/or re-scale the amplitudes. Pressing Ok will launch the
import. Please note that depth volumes can be imported in time surveys and vice versa
by using the depth/time toggle. They can be visualized using transformed scenes, provid-
ing that velocities are available.
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If the file is mostly Rev 1 but with changed parameters you will receive three additional
fields that can overrule the values to be found in the headers:
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l SEG-Y coordinate scaling: Please provide the scaler that must be multiplied to the
trace coordinates in order to get the loaded coordinates.

l Please provide the time assigned to the first sample of the traces, in milliseconds
or meters. Negative times are allowed.

l Sample rate: Please provide the sampling rate of your data in milliseconds or
meters/feet.

Those parameters constitute a SEG-Y setup that can be saved and retrieved using the
yellow folder icon on the right. This setup will not only contain the parameters but also
the path of the input files and settings of the preparation step. The setups are data
dependent therefore they are stored in your survey.

If the file is not Rev 1 you will get the overrule fields described above in a tab and two
additional tabs to provide the byte locations of either the pair inline/crossline or the pair
of X and Y coordinates. In the case of pre-stack data an additional tab will be present to
provide the offsets/azimuth byte locations.
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You need to look at the trace headers in the examine window and assign the correct
settings in this import window. Once again the entire import setup may be saved or
retrieved. Once this is done you must provide an output name and can optionally sub-
select a range of the volume to be loaded and/or change the output format and/or re-
scale the amplitudes. Pressing Ok will launch the import.

The import of 2D lines is somewhat different: Inlines and Crosslines are replaced by
trace numbers, that must be unique for each trace (therefore it can be the CDP but not
the Shot Point).
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Coordinates can be imported from one auxiliary file or specified manually and generated
during import coordinates if missing or wrong in the trace headers (see below on the
right hand-side). This can be done by toggling off the X-coord byte field.

Generate XYs

The coordinates are generated for each trace position by providing the X and Y coordin-
ates of the first trace, and a regular step in both directions. Units to be used are the same
as specified in the survey definition.

Input Auxiliary file

Optionally the coordinates can be specified using an auxiliary file. The format should be
an input ascii file with one position per line in a fixed column format without header:
File column should have the trace number, second column the X coordinate, third
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column the Y coordinate. Units to be used are the same as specified in the survey defin-
ition.

The line name is most often part of the input file name. It will be used only if a single line
is loaded. Otherwise the line name is extracted as a part of the filename (see further
below).

The Output data set name represents a 2D survey that comprises one or more lines. An
OpendTect survey can have many 2D surveys (data sets), that are group of 2D lines that
can be selected together for processing and interpretation.

There is no format/scaling for 2D lines. The SEG-Y data format defines the OpendTect
format. However, there is a trace sub-selection option to select either a trace "Range" or
"All".

A default attribute name "seis" will be given to each line of the loaded data set. This
can be changed by pressing "Select" and filling the empty "Attribute" field, like in the
example below:
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Multiple 2D lines loading must be enabled using the button "Import more, similar file" on
the last line before pressing "OK". Any line can be used to go through the wizard, and
the settings must be the same for all lines. If that is not the case then it is best to run the
wizard several times per group of lines of similar SEG-Y settings.

This additional window is used to specify the generic line name out of the SEG-Y file-
names. The line name must be replaced by "#L", while everything else (including the
path and the extension) is shown as text, like in the above example:
$DATAPATH/Line_#L.sgy

There will be one progress bar per input file during loading.
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Tip: It is a good practice to display the 3D seismic data on a z-slice to check

for any gaps in inline/cross-lines or null traces, after importing it.

SEG-Y Scan

SEG-Y Scan is a useful tool to get an idea about the content of a SEG-Y file, and to
check the loading settings. It is best performed on a limited number of traces (default is
100) when checking the loading parameters, and on the entire file when extracting geo-
metry and ranges.

At any moment a partial or full can be launched using the icon on the right-hand side
in the Import SEG-Y window.

SEG-Y scanning is used to derive the survey geometry for a SEG-Y file. A successful
scan will result in a successful loading, if the numerical values returned are in line with
the correct parameters (inline range, coordinate scaling ...).

Here is an example of output of a SEG-Y scan report:
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SEG-Y Scanned

Data duplication is a large problem when working with large datasets. All other import
tool generate new OpendTect files from ascii or binary files. This new type of SEGY
import works differently since it will not create any file but will link an existing SEG-Y file
to an OpendTect entry, selectable as any other OpendTect data.

This special import tool is only available for both stacked and pre-stack data. However, it
should be noted that for pre-stack data the performances for reading and processing may
be lower than with OpendTect pre-stack datastores that are optimized by importing the
usual way. The importation itself is 100% similar to the normal SEG-Y import. The only
difference is that there will not be any loading after completing the wizard.

Please note that since this tool links to an existing file, moving or renaming

the file outside OpendTect will break the link and make the dataset unavail-

able.

Simple File

The user can import simple ASCII or Binary file by using plain file Seismic I/O Plugin.
This can be reached via Survey > Import > Seismic > Simple File > 3D or 2D (Pre/Post-
stack) etc.

The input file must first be selected and its data format type specified, between ascii and
binary (4-bytes floats). All data must be in the 'local' format, because a blunt binary
read/write is performed.

(Part of) the input file can be visualized by pressing the examine button. The data must
consists of one trace per record (line). The samples are thus in columns, from shal-
lowest to deepest, with a regular step. The trace position and time/depth index can be
read from the input file, left of the trace, or can be provided. If provided, start, step and
number of samples are requested in the corresponding directions, assuming the input
file if regular and does not contain holes. Post-stack volume must be sorted by inlines,
crossline, (offset), Z (time or depth).

Optionally, the user can scale the cube before loading as well by mentioning the amount
of shift and the corresponding factor. Either pass or discard the null traces before load-
ing.
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The easiest way to see what the format looks like is by producing a little export file from
a bit of seismics. In the example below we exported inlines 500-501 and crosslines 600-
603, Z range 1000-1020 step 4 (which is 6 samples):

1000 4 6
500 600 1456 -688 -1502 4955 8935 1209
500 601 1429 -640 -967 5248 8362 527
500 602 1353 -424 -1040 5071 8059 -64
500 603 1428 -587 -1244 5139 8447 13
501 600 1450 -411 -1414 4792 8449 1117
501 601 1619 -456 -1243 4695 8271 702
501 602 1617 -213 -1272 4675 7903 393
501 603 1552 -248 -1088 4875 8004 204

Below are respective examples of the import for 3D post-stack, 2D post-stack, 3D pre-
stack, 2D pre-stack:
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Simple post-stack 3D and 2D Seismic File Import Window
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Simple Pre-stack 3D and 2D Seismic File Import Window

Import CBVS Cube

Seismic in CBVS format can be import either directly from cbvs file or from other survey
(s) as shown below

From file:
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This module enables exchange of data between the OpendTect projects. The original
CBVS (Common Binary Volume Storage) file can be located with a standard file
browser. Some CBVS volumes are stored in several sub files. These can be recognized
by the ^01 or ^02 (etc.) in the filename. To import the complete volume, select the base
file without any ^xx marks.

The Cube type needs to be specified in order to give it the correct label for the software.

The Import mode indicates if the file should only be left at its original place and just be
linked to the current survey (Use in-place), or if the volume should be copied entirely into
the current survey directory (Copy the data). Moreover, while importing, the volume can
be sub-selected (selected inlines/crosslines/time ranges) by pressing Select button in
front of the Volume subselection field. If the data contains the Null traces, either discard
or pass the traces by selecting the respective radio button. Before, importing the CBVS
volume, the scaling (16bit, 32 bit etc) can be applied to the volume. The Output Cube
field corresponds to the output volume name (that will be available in Manage Seismic
window) for the input file.

From other survey(s):
Seismic cubes in cbvs format can also be imported from other survey(s)
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Few changes can be made prior to import the file: The volume subselection, the type of
interpolation (sinc interpolation or nearest trace) and the stepout in inline and crossline.

GPR - DTZ

Ground penetrating radar offers an accurate solution to mapping the subsurface of the
earth. It locates features of interest and subsurface layers in real time. The GPR data
visualization and interpretation can be made in OpendTect, which enables the user to
import the files made by GSSI Ground Penetrating Radar (GPR) systems in the 'DZT'
format. The result is a 2D line in OpendTect.

Prior to loading a GPR data, the 2D survey should be setup according to the GPR
acquisition setup. The data files are then imported as 2D geometries. The following
Import GPR Seismics window allows the user to select one line and import the line
according to the given setup. The time stamps or sampling rate in OpendTect is defined
in milli-seconds. However, the DZT files are often sampled with nanoseconds sampling
rate. To adjusted this, there is an input field available i.e. 'Z factor' that allows re-scaling
of Z-axis or time. In order to visualize the data in OpendTect, this factor should be large
enough. The remaining parameters i.e. Start X,Y position or X/Y steps could be filled
according to the profile location.
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Tagged Seismic Data

The imported volumes may contain any data. However several types can be specified
during import and/or after:

l Depth poststack volumes/lines loaded in time surveys. A check box must be
toggled on during SEG-Y or simple file import.

l Time poststack volumes/lines loaded in depth surveys. A check box must be
toggled on during SEG-Y or simple file import.

l Velocity/anisotropy volumes must be tagged with respect to their type, when impor-
ted from an external file. The available types are:

o Vint: Interval velocity
o Vrms: RMS velocities (time domain only). A provided surface may
provide elevation statics in meters. For time surveys a statics velocity
must be provided in m/s, either from a velocity grid or using a constant
velocity.

o Vavg: Defined as the ratio between the depth and the travel time: Vavg
(TWT)=2*Z/TWT=Z/OWT.

o Delta: Thomsen anisotropy parameter of the same name.
o Epsilon: Thomsen anisotropy parameter of the same name.
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o Eta: Effective anisotropy parameter, combine from delta and epsilon.
This tag can also be used to grid another quantity (the software does
not actually check that eta values are input).

The assignment of velocity types (and properties) to a volume is called velocity edition.
This window can be opened in most windows wherever velocity volumes are used (an
exception is the attribute set window):
- Volume gridding
- Time-to-depth scenes
- Time-to-depth conversions
- Velocity conversions
- Application of velocity corrections on pre-stack gathers

The velocity volumes may be scanned to get the Vavg range at their first and

last sample. This allows the software to deduct and propose appropriate

time/depth ranges during conversions (on-the-fly and batch).

Import Velocity Functions
Velocity functions can be used to create volumes from irregularly sampled data, using
the volume builder (that is the only way after import to display the data ). Although
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designed to create velocity volume, it can be used for any other quantities that velocities:
All usual log types (density, sonic, impedance, ...), or quantities with a strong low fre-
quency component. Velocity functions are not appropriate for regularization of band-
passed data (seismic, relative impedance, ...).

Velocity functions can be imported in OpendTect using Ascii files. The import window is
launched from the OpendTect main menu (Survey > Import > Velocity functions > Ascii).
Select the input Ascii file. You may display the input file by pressing the Examine button.
The input file should be column sorted with one point per record (line).
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The amplitude type of the input data must be specified. This will be required for the inter-
polation of the values. Indeed the vertical interpolation will not be done directly on Vint
and Vrms amplitudes, but on the corresponding time-depth function.

l For the Interval velocity quantity (Vint), the amplitude of a point accounts for the
layer above it.

l Effective velocities (Vrms) can only be used in time surveys. They will be treated
with a simple Dix for the extraction of the time-depth relation.If this type is selcted,
you need to specify if it has statics or not.

l Vavg is the ratio at a given depth between depth and travel-time: Vavg = 2*Z/TWT
= Z/OWT. As a result a Vavg quantity holds entirely the data from time-depth pairs.

l Delta, epsilon and eta functions will be vertically interpolated with linear inter-
polation.

Any other quantity type could be tagged as delta, epsilon or eta and gridded using the
standard velocity gridding step of the volume builder.

The main work is to specify the presence of a file header and the file format definition.
The header, if present, can be of fixed length (number of lines), or delimited on its last
line by a keyword.
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Predefined and saved file formats are available by pressing the icon. Otherwise the
format must be manually specified. The Define button gives access to the format defin-
ition window.

You must specify in the format definition window the column numbers for the position, in
terms of an X/Y pair or an inline-crossline pair, the time/depth column, and the amplitude
value. If velocities are read, linked anisotropies may also be imported in the same velo-
city functions object. This is used during velocity analysis only. Amplitudes that should
not be read must all have the same numerical value, which is to be filled in as the
"Undefined value". The Z units can be seconds, milliseconds or microseconds (meters
of feet in depth surveys). Please note that all records must have an X-Y-Z position. Read-
ing may be stopped at a specific line by providing the adequate keyword.

It is recommended to save the format definition for a later use and QC, by clicking on the

icon . In pop-up window, write the name of the format and store it. The format can be
stored at different levels (All surveys, Current survey, Current OpendTect user level)
depending on the usage. Press OK when done.
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Import Wavelets
Wavelets can be used for synthetic-to-seismic tie, or convolution via the convolve attrib-
ute. Wavelets are also used to store all kinds of frequency-derived operators, like seis-
mic spectral blueing and seismic coloured inversion operators.
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Wavelets can be imported into OpendTect as Ascii files. The import window is launched
from the OpendTect main menu (Survey -> Import -> Wavelets -> Ascii). This will launch
theWavelet Import window. Select the input Ascii file. You may display the input file by
pressing the Examine button. The input file should be column sorted with one time/depth
sample position per record (line).

The main work is to specify the presence of a file header and the file format definition.
The header, if present, can be of fixed length (number of lines), or delimited on its last
line by a keyword.
Predefined and saved file formats are available by pressing the icon. Otherwise the
format must be manually specified. The Define button gives access to the format defin-
ition window.
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You must specify in the format definition window the column number where to read the
amplitudes, the sample rate, and the location of the center sample. The sampling interval
can be seconds, milliseconds or microseconds. The position of the center sample must
be given as the number of lines between the first sample and the center sample. Both val-
ues can be dynamically extracted from the header by providing keywords for each,
indexed using columns positions. Reading may be stopped at a specific line by provid-
ing the adequate keyword.

It is recommended to save the format definition for a later use and QC, by clicking on the

icon . In pop-up window, write the name of the format and store it. The format can be
stored at different levels (All surveys, Current survey, Current OpendTect user level)
depending on the usage. Press OK when done.

Import Wells
Wells can be imported in OpendTect via Survey > Import > Wells, from Ascii files. They
can be used for visualization only, to be tied with the seismic data, for performing lateral
correlation and/or train neural networks...
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From Ascii Files

Well depths in OpendTect are always referenced using their Measured Depth. The align-
ment with the seismic data in done using the track (deviation survey) data and time-
depth and/or checkshot data. The track data provides the relation between lateral
coordinates, TVDSS depths and Measured Depths. The checkshot data and time-depth
data provides the relation between Measured depths and travel times (TWT). Other
formats can be used during import, but will be converted.

Please see the figure below for a list of datum definitions:
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Track

The track import is loading the core part of the well, required for the visualization of the
well track, and further loading of the markers and logs. It requires the loading of the devi-
ation survey, and a depth-to-time model for seismic surveys in time. The import is done
from the menu Survey -> Import -> Wells -> Ascii -> Track. The input ASCII file(s) must
be column sorted with one point per record (line). Space- and tab-separated files are sup-
ported, comma-separated files are not.
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The file containing the track information must contain the true vertical depth sub sea (Z),
neither TVD nor TVD-SRD. The MD quantity (measured depth) is always referenced
with respect to the reference datum elevation (thus equal to zero at KB, RT or DF).

The file containing the time-to-depth model can either contain depth as TVDSS, TVD-
SRD or MD. If the Seismic Reference Datum is not equal to zero and the time-depth
model is using TVD-SRD then you must specify the SRD value in the advanced field.

Select the input Ascii file of the deviation survey first. Optionally, a vertical well can be
created by deselecting the check box at the left of this field, and entering the surface
coordinates, top and bottom depth (measured depth).
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The main work is to specify the presence of a file header and the file format definition for
the deviation survey. The header, if present, can be of fixed length (number of lines), or
delimited on its last line by a keyword.

Predefined and saved file formats are available by pressing the icon. Otherwise the
format must be manually specified. The Define button gives access to the format defin-
ition window.

You must specify in the format definition window the column numbers of the X and Y
coordinates (absolute values, not relative to the surface coordinates), in the same unit as
used when defining the OpendTect survey. The Z depths that must be provided are
TVDSS depths, in meters or feet, increasing downwards and equal to zero at a height of
zero (sea level, geoid). This is regardless of the reference datum elevation of the wells or
any seismic reference datum of the seismic data. Optionally the fourth column can con-
tain measured depths values to provide the link between MD and TVDSS. Data loading
can be stopped at a specific line by providing the adequate keyword.

The best way to ensure that the reference datum elevation is properly set is to

have the deviation survey file start at MD=0. The first lines of the file would

then look like:

X Y Z (TVDSS) MD
623255.98 6082586.87 -34.10 0.00
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X Y Z (TVDSS) MD
623255.98 6082586.87 0.00 34.10
623255.98 6082586.87 65.90 100
623255.84 6082591.69 440.86 475

In this example the surface coordinates are X=623255.98,Y=6082586.87 and
the reference datum elevation is equal to 34.10 m. Please note that the first
point of this track is above the sea level, likely to happen in onshore situation,
which is not a problem. The first line corresponds to the point with MD=0,
while the second point corresponds to the point where TVDSS=TWT=0. (but
both points are not mandatory to be present in the track file)

The track file determines the size of the usable and displayed well data. Any
log or marker outside of the track Z range will neither be usable nor be dis-
played. On the other hand the well track is not limited to the survey Z range,
especially it can be loaded outside the survey box.

It is recommended to save the format definition for a later use and QC, by clicking on the

icon . In pop-up window, write the name of the format and store it. The format can be
stored at different levels (All surveys, Current survey, Current OpendTect user level)
depending on the usage.

You also have the option to enter here the Reference Datum Elevation [KB] and / or the
Total Depth [TD] (both in the default survey unit).
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Next the depth-time model must be specified. A constant interval velocity can be used
instead of a file. The selection of a file will lead to the same need to provide the header
settings and file format definition.

Predefined and saved formats are again available by pressing the icon. Otherwise
the format must be manually specified. The Define button gives access to the format
definition window.

You must specify in the format definition window the column where depths and times are
located, and the type of data to be expected. Three types of depths are supported for
loading a check-shot/Time-depth curve from a file. The supported depths are: Measured
depth (MD), TVDSS, TVD rel SRD. Time values can be either one-way or two-way travel-
times. Times (lines) that should not be read must all have the same numerical value,
which is to be filled in as the Undefined value".

DT models are always stored using measured depths and two-way travel times in
seconds. Therefore any other input format will cause a conversion of the input data. Data
loading can be stopped at a specific line by providing the adequate keyword.

If you want to import a well track with TVDSS as Z input, please be aware that the meas-
ured depth of the track will always be ascending. This means that displaying horizontal
wells using TVDSS is not supported yet.

When loading a depth- time model please check that TWT

(TVDSS=0) =0 for MD=KB. This is by definition mandatory. Many

package break this relation while matching the well to the seismic

data.

Make sure that the time-depth model does not start like the fol-
lowing example, in format TVDSS(m)-TWT(ms):
0.00 0
0.15 60
0.30 60.5
0.45 61

This would cause serious extrapolation problems of the time-
depth model above TWT=0. It is highly recommended that the
2nd sample of the time-depth model corresponds to the start
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depth of your sonic log, unless the input is a measured checkshot
survey.

The Time/Depth model used during import can be either a check-
shot model or a "normal" time depth curve. More information can
be found in the well management chapter.

Similarly the depth-time model reading settings can be saved:

The Advanced/Optional button allows the user to provide optional additional parameters.

First surface coordinates can be provided, alternatively to the coordinates written in the
first line of the track file.
Then the seismic reference datum (SRD) can be provided. Please note that SRD is not
the Kelly Bushing (KB), Rotary table (RT) or drill floor (DF) elevations. Instead and des-
pite being written in the wells header, it is the elevation between the seafloor and
TWT=0 in the seismic volume.
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Logs

The import of well logs requires the deviation survey to be imported first. Then logs can
be imported or computed from the Well manager.

Markers

The import of well markers requires the deviation survey to be imported first. Then mark-
ers can be imported from the well manager.

Import Zero-Offset VSP

A zero-offset VSP data can be imported for a selected well via Survey > Import > Wells >
VSP (SEGY). The system will launch the SEG-Y Tool window. Browse and locate the
input file and fill the respective parameters that are described in the Section-Import >
SEG-Y. When done, press OK in the SEG-Y tool window to select the input file. In the
pop-up window, input VSP file is first selected by pressing the Select button for the SEG-
Y-input field. The system will return to Import Zero-offset VSP window. In this window, fill
the remaining parameters. Select the vertical sampling information (TIme or Depth, MD
or TVDSS). The input file can be re-sampled by overruling the sampling information.
This is done in the overrule SEG-Y sampling field.



- 277 -

Next step is to attach the VSP as a log on an already loaded well. Select the Add to the
well field accordingly and write a proper log name that will be the log name inside the
OpendTect project. Optionally, the input log can be sub-selected by providing a proper
range (Depth) in the Log-output interval. Press Go to import the VSP log.

Simple Multi-Well

Well depths in OpendTect are always referenced using their Measured Depth. The align-
ment with the seismic data in done using the track (deviation survey) data and time-
depth and/or checkshot data. The track data provides the relation between lateral
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coordinates, TVDSS depths and Measured Depths. The checkshot data and time-depth
data provides the relation between Measured depths and travel times (TWT). Other
formats can be used during import, but will be converted.

This utility window allows the quick creation of multiple vertical wells with a constant
velocity as depth-time model provider. The table window below can either be filled manu-
ally or by reading a file.

The following parameters are mandatory:
l Well name
l (Vertical) position along the X axis, in the same unit as the survey geometry.
l (Vertical) Position along the Y axis, in the same unit as the survey geometry.
l Reference datum elevation (KB or other): Altitude measured from sea level of the
point MD=0., positive upwards. Can be left to 0 if unknown.

l Total depth (TD): Largest measured depth in the well. This parameter is half
optional; If not provided the well track is created such that it will reach the survey
base.

The following parameters are optional:
l Seismic reference datum (SRD): Altitude measured from sea level of the point
TWT=0ms, positive upwards.

l UWI (Unique well identifier): You can input any number, string or combination.
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To read a file containing that information, press Read file and select the input Ascii file.
One line in this file should correspond to one line in the output table.

The main work is to specify the presence of a file header and the file format definition.
The header, if present, can be of fixed length (number of lines), or delimited on its last
line by a keyword.
Predefined and saved file formats are available by pressing the icon. Otherwise the
format must be manually specified. The Define button gives access to the format defin-
ition window.
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You must specify in the format definition window the column numbers of the X and Y
coordinates (absolute values, not relative to the surface coordinates), in the same unit as
used when defining the OpendTect survey. Reference datum elevation and TD should
also be provided, while the SRD and UWI are less frequently used. Please note that KB
and SRD both increase upwards and are positive above sea level, whereas MD is a
depth and increases downwards (MD is never negative).

It is recommended to save the format definition for a later use and QC, by clicking on the

icon. In pop-up window, write the name of the format and store it. The format can be
stored at different levels (All surveys, Current survey, Current OpendTect user level)
depending on the usage.

Bulk

The bulk import tool allows for the import of well-data for different wells from one or sev-
eral files. The data is matched against primarily the well name and, if available, against
the Unique Well Identifier (UWI). This has the following implications:

l The well name must appear on each line of the input file. If the well already exists,
then the UWI must match the database. The same applies for the UWI if it is used
in combination with the well name.

l The well name should not contain spaces, otherwise the matching with a given
column number will not work as expected.
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Bulk Well Track Import

This dialog allows you to import tracks of several wells from one single file. Please read
the note on the bulk well import tool. Apart from that, the specification for the input data is
identical to the simple track ascii import.
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Bulk Well Log Import

This dialog allows you to import several las files in OpendTect. It may be used to create
a track and dummy time-depth model if necessary, if the name of the well in the file does
not match the current well database. Survey geometry and time-depth models can be
later imported from the well manager.

Bulk Well Marker Import

This bulk import tool allows the import of markers from several wells from a single file.
Please read the note on the bulk well import tool.

In the Format Definition dialog (Click Define...):
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You will have the option to select either the well Name or UWI (Unique Well Identifier).
And also to set depth as either MD or TVDSS. You may also toggle on the 'Stop reading
at' choice and set a value here.

Bulk Well Time-Depth Model Import

Utilize this option for importing one or several time-depth models into OpendTect:

In the format definition, you can set the columns for Well Identifier, MD and TWT.
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This format definition can be saved for later use via .

Export
The following data can be exported from OpendTect:
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Export Faults

Export Faults:

Faults can be exported as Ascii file from window that can be launched via Survey >
Export > Fault > Ascii...

Faults Export Window

In this window, it is possible to specify the output format. First, select the input fault to
export. Then, select the way the coordinates will be written: X/Y or Inl/Crl. By default Z
values are stored in msec, unselect the option to store Z in second. Optionally it is pos-
sible to write a stick index and/or a node index. Finally, choose a name for the Output
Ascii file. Press Ok to start exporting the fault.
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Export FaultStickSets

Export FaultSticksets:

The FaultSticksSets are exported by selecting Survey > Export > FaultSticksSets >
Ascii... sub menu. It will launch export FaultStickSets window. In that window select the
input faultstickset and mention the output coordinates format (X/Y or Inline/crossline). By
default the option to export Z in msec is checked and it will add a z-column in the output
file. In a depth survey, the Z values are exported by default in meter and you need to spe-
cify if they are in feet. Optionally the sticks can be stored with a node/stick index or a
stick index only. Depending upon other packages requirements, an appropriate selec-
tion can be made for adding index information in the file. Locate the output file location
with an output name. If you want to add a line name in the output file name, set check to
the Write line name if picked on 2D field. Press OK to start exporting the fault sticks.
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Export Geometry 2D

Allows users to export an ASCII file with the geometry of one or several 2D lines can be
generated. By default, the output file contains trace numbers and X/Y locations.
This export facility may be very practical if you want to generate a base map from 2D
lines for a different software package.

Export Horizons
Horizons in OpendTect can be exported in 2D/3D Ascii format. (Or, if you have the rel-
evant Workstation Access, directly to other software.)
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Export Ascii 3D Horizons

In the pop-up window, select the input surface (horizon). The stored surface data are lis-
ted in the Calculated attributes list. You can select one/more calculated attributes to be
written in the output file. To de-select an attribute, use CTRL-key and left mouse click or
click in the empty space. You can make a sub selection of the Available patches. Each
patch will be stored in a different file with extensions ^1, ^2, etc.

Three types of ascii files are supported:
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l X/Y saves in x/y information.
l Inl/Crl saves inline crossline.
l IESX (3d_ci7m) saves in GeoFrame IESX format. In this case you need to choose
if the survey co-ordinate system as it is set up in OpendTect is in feet or in meter.
Optionally, the horizon name in the file can be edited by clicking on the Settings
button which appears on selection of the IESX format as output type.

If the output type selected is either X/Y or Inl/Crl, optionally Z can also be outputted. Z
can be in time (If time survey, units: in seconds, milliseconds or microseconds ; if depth
survey, units: Meter, Feet, Inches, -Meter or -Feet ) or Z can also be transformed and con-
verted to depth using either a linear relationship (Vo and dV/dt to be specified), a velocity
cube or a well (Z outputted in Meter, Feet, Inches, -Meter or -Feet if time survey, in
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seconds, milliseconds or microseconds if depth survey). Z is written as the last column of
the output file. Additionally, a single line or multi line eader can be included in the output
file. The standard value of undefined data can also be specified.

Finally, select the output file location with an appropriate file name. Press Go to start
exporting the horizon.

Export Ascii 2D Horizons
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2D Horizon Export Window

For exporting a 2D horizon, you begin by selecting the horizon and the required 2D
lines. If a header is needed it can be specified as either single line or multi line. Further,
if the undefined parts in the data have to be written a standard value needs to be spe-
cified. Similarly, the Z value can be explicitly output in milliseconds irrespective of the ori-
ginal format used in the survey, it will be stored in seconds otherwise.
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Export Mute Functions

The format definition will be a column sorted text file with time (or depth if depth survey)
and offset values, and with coordinates either in X/Y or Inline/Crossline.

Mute Function Export Window
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Export PickSets & Polygons

The export pickset module is used to export picksets or polygons. One can think of out-
lines of structures, picked faults, etc.
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Export Probability Density Functions

The selected OpendTect PDF data will be exported to an Ascii file, in RokDoc format.

Probability Density Function (PDF) Export Window

Export Seismics
The export seismic module is used to export 2D/3D seismic data as SEGY and/or as
simple File.
2D/3D Seismic data from OpendTect can also be exported to GeoFrame Workstation
(the option is present if the relevant Workstation Access plugin is installed.)
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Export SEG-Y

2D/3D Poststack and 3D Prestack data can be exported from OpendTect in SEG-Y
format:

The SEG-Y revision 1 default bytes locations will be used during export, but additional
positions can be used with the personal setting keywords listed on the right-hand side.
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The pick is a trace attribute stored in the OpendTect seismic files. It is most often not
used.
The reference number is most often the Shot Point for 2D data but could be used for any-
thing else. Please note that a SEG-Y scalar at bytes 201-202 apply for values stored in
bytes 197-200. The SP scalar will always be -10, thus the value written on bytes 197-
200 is 10 times the SP value.

All values listed above are encoded on 4 bytes by default. The byte length can be over-
ridden using the following personal key words, except for the coordinates:

l SEG-Y.Nr bytes for In-line
l SEG-Y.Nr bytes for Cross-line
l SEG-Y.Nr bytes for Offset
l SEG-Y.Nr bytes for Azimuth
l SEG-Y.Nr bytes for trace number
l SEG-Y.Nr bytes for Pick
l SEG-Y.Nr bytes for RefNr

The layout of the SEG-Y export window changes slightly based on the data type.

Export SEG-Y 3D

Stored 3D volumes can be exported from OpendTect in SEG-Y format.
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All fields are optional, except the output filename that must be provided. The export will
be launched when pressing Ok.

Volume subselection: Can be defined here in various ways.

Null traces: They can be either discarded or written in the SEG-Y file. For 3D
SEG-Y export there is a third option in addition to the two described pre-
viously, Add. It basically adds null traces where there is NO data present in
the seismic cube, such that the output SEG-Y cube will be without any gaps
for one individual inline or crossline.

Scale values: A linear scaling can be applied while exporting the data.

SEG-Y format: Please note that this option may clip your data if the output
format has less bytes than the input OpendTect format.

Text header: The SEG-Y textual header is automatically created, but may be
provided by the user, either from a text file or directly from a SEG-Y file.

Multi-Component Export:
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If the input cube contains multiple components, an additional window will pop-up on
pressing 'Run' and ask for which component to output (see below), since SEG-Y files
can only contain one component per file.

Tip: It is a good practice to display the 3D seismic data on a z-slice to check

for any gaps in inline/cross-lines or the presence of null traces, before export-

ing it.

Export SEG-Y 2D

Stored 2D data can be exported from OpendTect in SEG-Y format.
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All fields are optional, except the output filename that must be provided. For 2D you also
need to select a specific line. More lines can be exported if the option 'Export more from
same dataset' on the last line is selected.The export will be launched when pressing Ok.

Input Data Set: Select the data set to be exported.

Line name: The lines available in the data set are listed here. Only one line
can be selected.

Trace subselection: Can be defined here in various ways.

Null traces: They can be either discarded or written in the SEG-Y file.

Scale values: A linear scaling can be applied while exporting the data.

SEG-Y format: Please note that this option may clip your data if the output
format has less bytes than the input OpendTect format.

Text header: The SEG-Y textual header is automatically created, but may be
provided by the user, either from a text file or directly from a SEG-Y file.
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Export SEG-Y Prestack 3D

Prestack 3D data may be exported from OpendTect in SEG-Y format.

All fields are optional, except the output filename that must be provided.

Trace subselection: Can be defined here in various ways.

Null traces: They can be either discarded or written in the SEG-Y file.

Scale values: A linear scaling can be applied while exporting the data.

SEG-Y format: Please note that this option may clip your data if the output
format has less bytes than the input OpendTect format.

Text header: The SEG-Y textual header is automatically created, but may be
provided by the user, either from a text file or directly from a SEG-Y file.
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Export Simple File

Export 3D Simple File Format

The stored volumes in the OpendTect survey can also be exported as a simple Ascii or
binary file.
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Simple 3D Seismic File Export Window

Input Cube: Select the volume to export.

Volume Subselection: A part of the line can also be sub-selected. If the
entire line is meant to be exported: after clicking on Select..., define the num-
ber and time ranges. Leave the values default or select All in the trace subse-
lection window.

Scale values: The data can be scaled in the output. The output will be cal-
culated with: Output = Factor * Input + Shift

Null traces: Null traces can be discarded or left inside the line (Pass).

Output a position for every trace: If Yes then the output will contain a short
header information. If No, no header will be added.

(If Yes selected in the previous option) Position in file will be: In the
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output file, the position information can either be XY locations or Inline/cross-
line numbers

Put sampling info in file start: Select Yes to allow the sampling information
to appear at the beginning of the file.

File type: Select the appropriate output file type: Ascii or Binary.

Output file: Select/write the output file location.

Multi-Component Export:

If the input cube is a stored multi-component data, an additional selection box will
appear in the window. Select the desired component to be exported as an Ascii or Bin-
ary file.



- 304 -

Export 2D Simple File Format

A stored data set in the OpendTect survey can also be exported as a simple Ascii or bin-
ary file.

Simple 2D Seismic File Export Window

Input Data Set: Select the data set to be exported

Line name: The lines available in the data set are listed here. Only one line
can be selected.

Trace Subselection: A part of the line can also be sub-selected. If the entire
line is meant to be exported: after clicking on Select..., define the number and
time ranges. Leave the values default or select All in the trace subselection
window.

Scale values: The data can be scaled in the output file. The output will be
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calculated with: Output = Factor * Input + Shift

Null traces: Null traces can be discarded or left inside the line (Pass).

Output a position for every trace: If Yes then the output will contain a short
header information. If No, no header will be added

(If Yes selected in the previous option) Include trace number (preceding
X/Y): In the output file, it includes the trace numbers before X and Y loc-
ations.

Put sampling info in file start: Select Yes to allow the sampling information
to appear at the beginning of the file.

File type: Select the appropriate output file type: ASCII or Binary.

Output file: Select/write the output file location.

Export PreStack Simple File

In OpendTect, you can also export a simple seismic Ascii or Binary file from Pre-Stack
3D seismic data via Survey > Export > Seismic > Simple File > Prestack 3D.
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Input Data Store: Select the Pre-Stack seismic to export.

Volume Subselection: A part of the line can also be sub-selected. If the
entire line is meant to be exported: after clicking on Select..., define the num-
ber and time ranges. Leave the values default or select All in the trace subse-
lection window.

Scale values: The data can be scaled in the output. The output will be cal-
culated with: Output = Factor * Input + Shift

Null traces: Null traces can be discarded or left inside the line (Pass).

Output a position for every trace: If Yes then the output will contain a short
header information. If No, no header will be added.

(If Yes selected in the previous option) Position in file will be: In the out-
put file, the position information can either be XY locations or Inline/crossline
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numbers

Include: Optionally you can select to include Offset and/or Azimuth inform-
ation.

Put sampling info in file start: Select Yes to allow the sampling information
to appear at the beginning of the file.

File type: Select the appropriate output file type: ASCII or Binary.

Output file: Select/write the output file location.

Export Wavelets

Wavelet Export Window
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After selecting the wavelet to export, you can optionally also output the time (if time sur-
vey) or depth (if depth survey). Give an appropriate name and storage location, the wave-
let will be exported when clicking on Ok.

Manage
OpendTect keeps track of different files imported into or created by the system. Deleting,
renaming and, in the case of seismic files, also merging of files are controlled from the
Survey--> Manage menu. Seismic file, horizon, and well management is called from this
menu.

Some 'Manage' options can be reached directly from the main user interface:

All can be found via Survey > Manage...
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Manage Attribute Sets
The attribute set files can be managed from this window (See below). It is launched from
Survey > Manage > AttributeSets... In this section, you can modify the attribute set name,
set as default, remove etc. The window contains the buttons similar to the one from the
general selection window.
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Manage Bodies

Here you can rename, lock for editing and delete any Body by clicking on , and

respectively. Plus, you could also make any Body a default body by clicking on .

The four tools specific to 'Manage Bodies' are Body Operator, Body Region

Constructor, Estimate Body Volume and Switch Body Values.
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Body Operator

The icon enables the users to perform various operations on a geological body (or
combinations thereof), as listed below.

If you need to add to bodies, union operator enables you to merge two or more bodies as
in the figure below:

The result of the 'Union' operation (the two bodies are merged).
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If you want to know the shared portion of two bodies, you can use intersection as an oper-
ator:

The result of the 'Intersection' operation.

If the operator is Difference, the output will be a result of the below subtraction:
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The result of the 'Difference' operation (the final body is the volume resulting from Body 2
minus Body 1).

Body Region Constructor

This tool allows you to create a regional body from your dataset using boundaries
defined horizons and faults (or just a single wrapping horizon).
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Estimate Body Volume

The icon allows the user to calculate the volume of any body in the scene. The input
data is an (estimated) velocity appropriate to the position of the body.

Switch Body Values

The icon activates a window with dual functionality.

Firstly, if you have constructed a regional body using two horizons and a fault, creating a
kind of 'compartment', this tool allows you to 'flip' the body to the 'negative' of the one con-
structed.
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Secondly, previous versions of OpendTect had bodies with many different formats. This
tools can also be used to 'convert' these various formats into the standard format for 4.6.

Manage Color Tables
The Color Table Manager allows the user to edit various settings that are used within the
color tables when visualizing seismic data, logs, etc.
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For a full description of the various options and possibilities, please see the following
section: Color Tables

Manage Cross-Plot Data
The crossplot file management is used to rename, remove, merge etc the stored cross-
plot data files.

l is used to rename the selected crossplot data file.

l locks (read only) or unlocks the selected item.

l remove the selected crossplot.
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l make the selected crossplot as a default data for crossplotting. If pressed, the
selected item will be bounded by the signs (> Name <).

l merge another crossplot with the selected one.

To merge two crossplots with different or similar attributes, you need to select a first

crossplot and then after clicking on the icon, choose the second crossplot in the fol-
lowing window:

. When pressing Ok, opens the window where you have to provide different information.
If some columns have similar quantity in the two crossplots, it is possible to specify for
each column, which column from the crossplot2 matches a column from crossplot1, even
if they do not have the same name. If there is no match, just select None, then you can
decide to either add the unmatched columns or to ignore them.
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Then select the matching method:

l Exact match: same X,Y,Z
l Nearby match: almost same position or same depth.A horizontal and a vertical
search radius have to be provided

l Never match, add all new : add all positions, even with same or almost same
(X,Y,Z).

For all of them, the replacement policy for matching positions has to be specified : take
value from crossplot1, take value from crossplot2 or take the average of the two.
Undefined value can be kept or replace if possible.

Once the merging parameters have been defined, you can give an appropriate name
and save it in clicking on Ok.

Manage Faults
Fault management allows to manage the faults, different options are available: change
disk location, rename, remove, copy etc. The fault management window can be

launched either by pressing the icon from manage toolbar, or from menu bar i.e. Sur-
vey > Manage> Faults...
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This window will contain the list of faults interpreted and saved in the OpendTect project
as shown below.

Select the desired fault, then use the various tools:

l is used to rename the selected fault.

l locks the selected fault from interpretation.

l is used to trash (delete) the selected fault.

l is used to set a fault as default.

l copies the faults.
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The top filter is used to filter-out the objects with selected names. For

instance, to display all faults that start with letter F use "F*".

Manage FaultStickSets
This option allows the management of faultsticksets. The faultstickset management win-

dow can be launched either by pressing the icon from manage toolbar, or from
menu bar i.e. Survey > Manage> FaultStickSet...

This window will contain the list of faultstickset interpreted and saved in the OpendTect
project as shown below.
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Select the desired fault, then use the various tools:

l is used to change the current disk location of selected faultstickset .
l is used to rename the selected faultstickset.

l locks the selected faultstickset from interpretation.

l is used to trash (delete) the selected faultstickset.

l is used to set a faultstickset as default.

l copies the faultsticksets.
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The top filter is used to filter-out the objects with selected names. For

instance, to display all faultsticksets that start with letter F use "F*".

Manage Geometry 2D
2D Geometry is launched from Survey > Manage > 2D Geometry...

This window is used to manipulate the geometry of 2D seismic lines. The geometry con-
sists of X-Y coordinate pairs for each trace of the 2D seismic, identified with a unique
trace number (CDP most often). They are generally extracted from the SEG-Y trace head-
ers or from an auxiliary file during import.

This window can be used to alter the coordinates of already imported 2D data. The geo-
metry is separated from the actual 2D seismic data and 2D horizon that are solely ref-
erenced with respect to the trace number (CDP number). As a result the coordinates of
the geometry can safely be edited without having to re-import the 2D seismic data and
corresponding horizons.
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Select a line and click on the icon to start the line geometry editor.

Line geometry editor
This editing window can be used to alter any trace number, X, Y values. Click on a field
and type the new value. Changes will be saved on disk only after pressing Ok. Option-
ally one might want to update the geometry of the entire line by reading an text file (see
below).
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Line geometry import
Select the input Ascii file. To display the input file, press the Examine button. The input
file should be column sorted with one point per record (line).

The presence of a file header and the file format definition have to be specified. The
header, if present, can be of fixed length (number of lines), or delimited on its last line by
a keyword.
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Predefined and saved file formats are available by pressing on the icon. Otherwise
the format must be manually specified. The Define button gives access to the format
definition window.

You must specify in the format definition window the column numbers for the position, in
terms of an X/Y pair, and optionally the trace number column. The coordinate units must
be in the same units as the coordinates of the survey corner points. Inline/crossline value
may be used instead of X/Y but it is not recommended because of the grid spacing. Also
it is not recommended to alter (re-specify) the trace numbers since it may corrupt the
already loaded data. Reading may be stopped at a specific line by providing the
adequate keyword.
It is recommended to save the format definition for a later use and QC, by clicking on the

icon . In pop-up window, write the name of the format and store it. The format can be
stored at different levels (all surveys, this survey, Current OpendTect user level, levels in
increasing priority order) depending on the usage. Press OK when done.
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Manage Horizons
Manage either 2D or 3D horizons either via Survey > Manage > Horizons... or via the

icon.
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Horizon Manager 2D

To open the Manage 2D Horizons window, navigate through Survey--> Manage--> Hori-

zons--> 2D... or use the icon from the Manage toolbar. In the left panel of the window,
the available horizons are displayed. It the bottom panel, information on the selected hori-
zon is displayed (eg. location on disk, date last modified). At the base of the window the
available disk space is noted.
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Horizons can be renamed , locked , removed , copied , set as default

or viewed as a dataset group .

The following window is used to copy horizon surfaces and grids:
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The top filter is used to filter-out the objects with selected names. For

instance, to display all horizons that start with letter D use "D*".

Horizon Manager 3D

To open the Manage 3D Horizons window, choose the icon from the Manage tool-
bar. In the left panel of the window, the available horizons are displayed. In the right
panel, the available attributes linked to the selected horizon will be displayed. In the bot-
tom panel, information on the selected horizon is displayed (eg. location on disk, date
last modified). At the base of the window the available disk space is mentioned.
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Horizons can be renamed , locked , removed , copied , set as default

or merged . The top filter is used to filter-out the objects with selected names. For
example, to display all horizons that start with letter D use "D*".

The following window is used to copy surface data and grids:
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The following window is used to merge surface parts:

Select the horizon parts to be merged and select a mode for duplicate positions. Options
are take average, use top or use base. The duplicate positions will then be handled in
the following manner (dashed line portion represents removed data after merge):
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The new, merged horizon can optionally be tied to a level, i.e. a regional marker (see
below)

Stratigraphy
Assign stratigraphic markers to horizons with the Stratigraphy button.

Stratigraphic marker can be assigned to one or more horizons. The horizons will get the
marker color, this will facilitate for example the well to seismic tie.
For more details on how to define stratigraphic markers and the subsequent units go to
Manage Stratigraphy.

Relations
The Horizon relation window is used to resolve conflicts between horizons crossing
each other. Read Horizons .... is used to select all horizons that need checking. The hori-
zons are then sorted automatically from top to bottom. The Check crossings... button is
used to check the crossings between the listed horizons automatically and resolve them.
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Solving crossing conflicts
To solve crossing conflicts select the horizon that will be modified. The software will
check the number of positions where a conflict exits and modify the horizon by removing
the conflict points or by changing the values to be equal to the overlying/underlying hori-
zon.

To honor the requirement that horizons cannot coincide, the actual values are

not exactly equal, but they are within one sample position accuracy.

The figure below sketches what will happen to the lower (red) horizon if you select shift
or remove. The software verifies that removing and shifting operations are executed prop-
erly and the correct HorizonCube calculation results are reached.
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Manage Layer Properties
This window is also accessible from the Layer property selection window in the Layer
Modeling module. In this manager, different usable layer properties are listed with their
corresponding type. For example Delta and Epsilon properties belong to the Anisotropy
type. Click on the usable property in the right column to see on the left column what is
the type associated (highlighted).
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The two lists are hardcoded. However the user can ask for adding an extra property or
type in sending an email to support. Usable properties listed can be removed of the list if
they have no use in the current project.

Define/Edit usable properties

One usable property can be correspond only to one property type. For changing the prop-
erty type of a usable property, the usable property needs to be removed and added
again in association to the selected property type. To add a usable property, select a

property type and click on the in between the two list : it opens the property definition
window.For each property needs a name. Possible aliases can be specified. It is useful
to associate the correct log to a property: logs with different names can thus be related to
the same property. Default display parameters are set up : the colour and the typical
range value with the associated units.

Already defined usable properties can also be edited on clicking on the icon.

Optionally, the default value of any property can be defined by a specific equation that
can either be typed in or retrieved from a list of saved formulas on clicking on Formula...
Further formulas and equations may be utilized from the RockPhysics library, reached

via the icon.

http://opendtect.org/index.php/contact/support
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The edited Layer Properties are saved when clicking on Ok. There are also options here

to either Load or Save Maths Formulas.

Fixed Definition: A property that will never be modeled directly but will be
auto-computed in the background from other modeled properties. Formula for
such properties always remain consistent, irrespective of any geological set-
ting: Acoustic Impedance, Shear Impedance, Vp/Vs Ratio, Poisson’s Ratio,
Lambda-Rho, Mu-Rho etc.

The ‘fixed definition’ for these properties can be specified by ticking the
‘Fixed definition’ box and clicking on the Formula button, bringing up the
RockPhysics library:
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Storing levels

The level where it is saved is specified in the main window:

l For this survey only (default): save at the root of the survey, applicable for all users
only for this survey (if no parameters saved for the user).
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l As default for all surveys: save in dTect/data (where are all the surveys), applicable
for all users and all surveys (if no parameters saved for the user or this survey)

l As default for my user ID only: save in home/.od. If it exists, it has the priority on the
two others.

Once the parameters saved, the only way to access the default parameters provided by
OpendTect is to delete the Properties file where it is located. OpendTect will then access
its default properties file.

Manage PickSets & Polygons
In this window, all available picksets are shown. These picksets can be moved to a dif-
ferent location, they can be renamed, locked / unlocked, removed or set as default using
the icons on the right.
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Several pickset can be merge together using Merge Pickset Button.

The top filter is used to filter-out the objects with selected names. For

instance, to display all picksets that start with letter S use "S*".

Manage Probability Density Functions
The window allows to manage Probability Density Functions. PDF may be imported ,
extracted from crossplots or generated with user-defined specifications. Main uses of
PDF in OpendTect are Bayesian Classification and stochastic pseudowell modeling in
SynthRock.

PDFs can also be exported for external use.

PDFs can be discrete or continuous. A discrete PDF can have up to 3 dimensions, while
continuous PDF is not limited by number of dimensions. The example above shows a
discrete PDF with 3 dimensions, each taken from a well log. The icons on the right hand
side allow to perform the following actions, respectively from top to bottom: Rename,
Lock/Unlock, Remove, Set as default, Browse/Edit and Generate PDF.
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Browse/Edit Probability Density Function

By clicking on in the Manage PDFs window PDF may be edited with respect to the
names of the variables (Names tab, left), or in the table showing the stored values (Val-
ues tab, right). Changes applied in any of the two tabs will be saved only when pressing
OK button. A popup window will give the choice to overwrite, save as new or cancel
changes.
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The first icon right of the table ( ) launches a 2D viewer that displays the values seen
in the table. If the PDF has 3 dimensions, the left and right arrows may be used to nav-
igate through the bins of the third variable with increasing and decreasing values respect-
ively.

The second icon right of the table ( ) performs smoothing of the PDF data. Weighted
average of a central sample with 1/2 weight and N neighbouring samples (excluding
diagonal neighbours) each with 1/2N weight is calculated at every bin, where N=2, 4
and 6 for 1D, 2D and 3D PDF. This smoothing is rather gentle, and can be repeated mul-
tiple times for a more pronounced effect.

Generate Probability Density Functions

User-defined

A user defined PDF can be generated by clicking on the bottom icon ( ) in the Man-
age Probability Density Functions window.



- 344 -

Three types of PDFs can be generated: discrete Gaussian (Create an editable PDF
filled with Gaussian values), continuous Gaussian (Create a full Gaussian PDF), and dis-
crete empty (Create an empty PDF to edit by hand).

Discrete Gaussian and discrete empty PDF can have up to 3 dimensions, while con-
tinuous Gaussian can virtually contain any number of dimensions. Values of discrete
PDFs can be browsed, edited and smoothed after creation since they are stored in
tables. Continuous Gaussian PDF exists only in the description form, the corresponding
probabilities are computed on-the-fly.

Create an editable PDF filled with Gaussian values

The example below shows generation of a discrete Gaussian PDF with 3 dimensions.
Required parameters include dimension Names, Value ranges, Number of bins per
dimension, Expectations, Standard deviations as well as Correlation coefficients
between all dimensions (except for 1D). PDF is saved by specifying its name and click-
ing OK. It can be browsed, edited and smoothed through the Manage PDF window.
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Create a full Gaussian PDF

The next example shows generation of a continuous Gaussian PDF with 5 dimensions.
Dimension Names, Expectations and Standard Deviations are specified in the Dis-
tributions tab:
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Correlations tab allows to define Correlations by selecting dimensions, setting their cor-
relation coefficient and clicking Add button. Existing correlation can be selected from the
list and edited by updating its correlation coefficient and clicking Set (Set button will

appear instead of Add), or deleted by clicking theRemove selected correlation icon (
). PDF is saved by specifying its name and clicking OK. Continuous Gaussian PDF is
stored only in the description form which can be edited through Manage PDF window.

Windows for generation of 1D and 2D continuous Gaussian PDFs shown

below do not have Correlations tab

Create an empty PDF to edit by hand

This next example shows generation of an empty discrete 3D PDF. Dimension Names,
Value ranges and Number of bins per dimension are required. PDF is saved by spe-
cifying its name and clicking OK. After creating empty PDF, probabilities must be filled in
manually by clicking on the icon in the Manage PDF window and editing the table.
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From Crossplots

Alternatively, a PDF can be created using the Cross-plot tool by clicking on the icon
in Cross-plot window . This icon launches a pop-up dialog that can be used for selecting
attributes in order to create PDFs.

The number of PDF dimensions can be set to 1, 2 or 3 by clicking More and Less but-
tons. Note that all attributes from the Cross-plot table can be selected. Attribute ranges
are generated automatically to fit the extracted data distribution. These can be edited
before creating the PDF.
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Manage Seismics
Post-stack Seismic data should be managed from these windows. There are separate
managers for post-stack 3D and post-stack 2D. Access these via Survey > Manage >

Seismics... or via the icon.

They all use common management icons on their right hand side:

Change the location of the file on disk

Rename

Toggle read-only on/off

Delete

Set as the default object for its kind.

The top filter is used to filter-out the objects with selected names. For

instance, to display all volumes that start with letter S use "S*".

Manage 3D Seismics

The 3D Seismic file management window lists post-stack volumes loaded in the survey.
Information related to the selected volume is displayed in the central field and per-
sonal/survey-related notes can be added and saved in the bottom field.
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Alongside the standard actions (chnage disk location, rename, remove etc), the user

may also Copy the volume to another volume (different size, format, sampling rate,

...), Merge several overlapping or consecutive volumes and/or Browse in the
file.
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Copy Cube

Any volume can be copied into a new volume. The Volume subselection defines the
selection of the input cube to be copied and the Format / Scaling sub menu allows to spe-
cify how to store the new cube. Rectangular volumes are not required by OpendTect.
Therefore null traces are dismissed by default. They can be added back with the Null
traces > Add, within the inline/crossline range of the input volume. Larger volumes can
be obtained while using the Null traces > Add option and the volume subselection menu.
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If the input cube is multi-component (e.g spectral decomposition cube with different com-
ponents, right), an option will be available allowing the user to choose between all avail-
able components. All components is the default setting.

Copy - Volume Sub-Selection

This standard menu is available when importing/exporting a volume, line, or horizon,
copying a cube or horizon, or processing an attribute.
In all those processes, the output might be limited with respect to the available input
data. The limitation may be:

l A rectangular part of the survey, possibly with a larger horizontal and
vertical stepout

l An area limited by an OpendTect polygon. The area within the polygon
can be as well by decimated horizontal by using larger stepouts

l A table of positions from an OpendTect pickset or from a text file. The
text file should contain inline and crossline values without header

l All: This last option will output the maximum number of trace with
respect to the available data and possible stepouts
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1. The use of larger vertical stepouts will cause the data to be decimated in
the given direction. Please note that an anti-alias filter (using the frequency fil-
ter attribute) should be applied before decimating data. The copy-cube does
not do it.

2. The use of smaller vertical stepouts will cause the data to be interpolated
with a polynomial interpolation. This is mostly appropriate for seismic data.

3. Volumes tagged as Vint, Vrms or Vavg are not using a polynomial inter-
polation of the input amplitudes, as soon as Z start, Z stop and/or Z step are
changed. Instead they are converted to the corresponding time-depth relation
that is linearly interpolated (vertically), before back converting the inter-
polated TD function to the input type.

4. The copy-cube option does not do lateral interpolation of the data (but it
can decimate). Use the Velocity gridder step of the volume builder to laterally
grid a coarse volume.

Copy - Format & Scaling

This standard menu allows the change of the following elements:

l Change between storage type. Please note that this might clip your
data.

l Scale the values given a linear equation.

l Adjust the Z range to the survey range by repeating the bounding
samples up and down.

l Optimize the horizontal slice access. This will change the sorting mode
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in the volume on disk, and will cause inline/crossline accesses to be
significantly slower based on the volume size.

Merge Files

The icon is used to merge sub-volumes into one single volume. OpendTect pro-
cessing time can be reduced by distributing automatically or manually batch jobs over
multiple computers.

When merging two cubes, the duplicate traces can be stacked when merging e.g. two
seismic cubes (the merging cube will reduce noise) or the traces of the first cube can be
used. Priorities are set in alphanumerical order, as the volumes appear in the manager
from top to bottom.

Select the input files from the multiple entry list and specify the Output file name. The

user can remove the original files at a latter stage (use the Remove button in the
seismic file manager).
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Browse & Edit Cube Locations

Cbvs files can be browsed/edited (edit the cube locations, positions, trace samples, etc)

by pressing the icon. In the window that pops up (see below), sample values can be
changed by editing any cell (similarly to an MS Excel sheet). Editing is disabled if the
cube is write protected.
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Several options are available:

Brings you directly to a new position (inline/crossline).

Check selected trace information like: x/y coordinates, inline/crossline,
vertical z ranges, number of samples.

Switch to browse through Crosslines (and back to Inlines)

Step a preset number of inline/crossline positions to the left.

Step a preset number of inline/crossline positions to the right.
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View the currently highlighted trace(s).

Manage 2D Seismics

2D surveys in OpendTect are grouped in datasets. These datasets have their own man-
ager (shown below), separate from the Manage 2D Seismic Lines window.



- 357 -

In addition to standard rename/delete options, the following actions can be applied on

datasets: Copy all or part of the dataset to a new dataset, Access the 2D Lines

Manager (alternatively, double-click on the dataset name), Dump the geometry (pos-
itions) to a text file.

Manage 2D Seismic Lines

Accessed via the 'Manage 2D Seismics' window, either by double-clicking on a dataset

name or via the icon.

Lines can be renamed ( ) and deleted ( ). The following actions can also be made

on the lines: Merge of several lines to a new line, Extraction (projection) from

3D volumes along the 2D lines, Export of the geometry to GoogleEarth.
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Merge 2D Lines

Two 2D lines can be merged together to create a single 2D line. Go to Survey > Manage

> Seismics > 2D. In the pop-up window, click on the icon on the right of the window.

In the new window, the icon on the right opens the merging window. The merge can
be either of 2 lines with about the same geometry, or to append two (consecutive) lines
to each other.

There are three alternative merging methods:

l Match trace numbers: Assumes the lines are at the same location, con-
taining different attributes to be stacked and referenced using the same
trace number array.

l Match coordinates: Same as above, but with different trace number
arrays. Then the match will be based on coordinates, with a search
radius to match the traces. Please note that traces will be renumbered
in this mode.

l Bluntly append. Append the line specified at the "Add" field line after
the "First line". Please note that traces will be renumbered in this mode.
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Extract 2D Attributes from 3D Volumes

This extraction tool, started from the icon, can be used to project a 3D volume onto
2D lines. This allows then to display the 3D volume along the lines, and to use the data
from the 3D volume with 2D lines in the 2D attribute set.

All lines may be processed, or a selection of lines made in the lines manager before
going to this window. The settings are trivial: the 3D volume must be selected and an
attribute name must be provided.

Please note that the polynomial interpolation does not fit an application of this tool to 3D
seismic data.

Export 2D Geometry to Google Earth

This window (see below),launched with the icon, is to export the 2D lines geometry
in to a *.kml file. Different methods are supported (Start/End or both etc.) for labeling the
line-names in the Google Earth file. The line color field is also editable. The width rep-
resents the thickness of the lines. The Output file field specifies the output location and
name of the exported file (Format - kml).
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Export the 2D lines in a Google KML file.

Copy Data Set

This utility window can be used to copy (backup) a data set.

Pressing on the select button of the first line will allow the selection of which line (s)
should be copied to the new data set:
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Dump 2D Geometry

With this module, accessed via , an ASCII file with the geometry of one or several 2D
lines can be generated. By default, the output file contains trace numbers and X/Y loc-
ations.
This export facility may be very practical if you want to generate a base map from 2D
lines for a different software package.

Manage Seismics Prestack
Prestack seismic data should be managed from these windows. There are separate man-
agers for pre-stack 3D and pre-stack 2D. Access these via Survey--> Manage-->
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Seismics Prestack... or via the icon.

They all use common management icons on their right hand side:

Change the location of the file on disk

Rename

Toggle read-only on/off

Delete

Set as the default object for its kind.

The top filter is used to filter-out the objects with selected names. For

instance, to display all volumes that start with letter S use "S*".

Manage 3D Prestack

This window is opened via Survey--> Manage--> Seismics Prestack--> 3D...
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Most options are common to the other managers: change file location, rename, lock,
delete. 'Notes' may be anything of interest to the survey and may be added to, edited and
saved multiple times.

The options copy cube and merge blocks of lines work similarly to the 3D post-stack seis-
mic manager.
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Pre-stack data stores are present on the disk in a folder of the same name within the sur-
vey ("Seismics" sub-folder). This folder contains one file per inline for quicker access,
with auxiliary files. The manager will display information about the entire pre-stack data
store: Folder name, number of files etc.

A pre-stack specific option, accessible via , allows creation of a pre-stack data store
from two or more post-stack volumes. This can be used to create pre-stack data from a
partial stack volume for AVO attributes extraction. A specific offset must be set in front of
each volume.
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This option may also be employed in creating a multi-component cube for attributes with
more than one component. For example, using this option, a user may create a multi-
component Spectral Decomposition cube with each of the included frequencies given a
pseudo-offset value. In the example (below), a multi-component Spectral Decomposition
cube has been created, and for simplicity, the pseudo-offset used is a multiple of the fre-
quency component. [The actual value used in these pseudo is irrelevant in this case,
affecting only the width of the pre-stack display (which can be altered by right-clicking on
the pre-stack displayed in the scene and choosing 'Properties...']
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No new file is written to the disk. Therefore deleting a post-stack volume used

in the pre-stack data store will cause problems. Please use same option to

remove or modify the previously set multiple volume selection.

Manage 2D Prestack

This window is opened via Survey--> Manage--> Seismics Prestack--> 2D...
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Options found here are common to the other managers: change file location, rename,
lock, delete and set as default. 'Notes ' may be anything of interest to the survey and may
be added to, edited and saved multiple times.

Manage Sessions
Sessions in OpendTect are generally used to save and to retrieve the specific settings of
a scene. This can help the user to resume work from previous settings.
These sessions can be managed via: Survey > Manage > Sessions...

Sessions will save all settings of the displayed elements, and they can be
saved/restored at any time from Survey > Session.
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The following options are available:

Rename

Toggle read-only on/off

Delete

Set as the default object for its kind.

The 'Notes ' box is a free-text field where you may add notes related to the session, if
desired, and save them.
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Manage Stratigraphy

The Manage Stratigraphy window can be launched with the icon from OpendTect
Manage toolbar or via Survey > Manage > Stratigraphy... This window is designed to
arrange the stratigraphic markers and the geological sub-units. It is used as base for the
Layer Modeling.

The first time you open the manager, a pop up window gives the options to either: 1)
build a new stratigraphy from scratch or 2) to open an existing one (North Sea or Simple
Reservoir). These two saved stratigraphy description are saved by default in another
type of format. If edited, the edited version will be saved as classical stratigraphy descrip-
tion. Once the selection has been done, it is set as default. To re-access the selection

window click on the icon to create/open a new description.

The user can create a specific information about the project and the different regional
markers of his/her interpretation. This window is organized as units/sub-units bounded
by different stratigraphic markers. Markers are assigned to the category the most on the
right of the stratigraphic column. Depending upon user's description, markers can have
the same name as seismic horizons or well markers and the units the names of epoch-
s/eras.

To start, the user has two ways to display the stratigraphy tree: the time view and the tree
view. The time view is chosen to display the absolute geological time while the tree view
shows an overview of unit/sub-unit as leaves.

Stratigraphy window: The time view
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Stratigraphy window: The tree view

1- Regional Markers:
The regional markers can be associated to boundaries of stratigraphic units. These mark-
ers are added on the right-hand panel. Right click on ---None--- in the regional markers
panel. And in the pop-up menu select the Create New... option. In the CreateLevel win-
dow, write an appropriate name for the stratigraphic marker and optionally provide the
color. Press Ok to add the marker. They should have a coherent name. In the Well
Marker Manager, markers can be linked to a regional marker and will be then renamed
after it.. The inserted marker can then be assigned/linked as a top and base of the strati-
graphic unit.

2- Stratigraphic Units:
On the left hand side of this window, the units are classified in a way that the top and
base of each unit belong to certain marker. For the initial unit, right-click on <Click to
Add>, the stratigraphic unit editor will pop up:
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In this window, give a name of the unit area, the description, color, the age and lithology.
The minimum requirement for creating a new unit is simply to define the name.

To add a lithology: Click on "Edit" then give the name, and optionally specify porosity
then Add as new, click on Ok.

To add a sub-unit, right-click the unit name and select Create sub-unit, and define it in
the same manner as a unit. Description and lithology of the unit can be added now or
edited later.
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Stratigraphic unit properties: Properties such as unit/sub-unit description
and lithology can be defined or edited by right-clicking on the unit/sub-unit
name and selecting Properties. A unit/sub-unit specific lithologic name can
be entered directly into the Lithology field. For lithologies that may occur in
multiple units/sub-units, a lithology can be defined and made universally
available by clicking the Select button next to the Lithology field. In this
Select Lithology window, the lithology type can be named, and added to a list
that will be made available for all units/sub-units in this session. (Depending
on your Save settings, these lithologies can be available outside of this ses-
sion.) These options can also be defined when the unit/sub-unit is first
added.
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Save as: The defined stratigraphy can also be saved at different levels, e.g.
Survey levels , OpendTect data level, User level , or Global level . For
instance, if it is saved at Survey level, the stratigraphy will only be available
for this survey. Alternately, if it is saved at a higher level, it will not be limited
to only the survey in which it was defined.

Assign Marker boundary:
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This option links the regional markers with stratigraphic units. Right-click on
boundary or unit/sub- unit then click on Assign marker boundary select
regional markers top and bottom that are the appropriate boundaries for the
unit/sub-unit.

Manage Lithologies

The Manage Lithologies window can be launched by clicking on the icon in the
main Manage Stratigraphy window. It allows to define the list of lithologies possibly
present in the stratigraphic column. This list is then available when defining the different
units of the stratigraphy. For Layer Modeling, the lithologies listed for each units are used
in the layer description.

Following tasks can be performed:

l Lithologies can be added or removed

l Lithologies can be renamed
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l Lithologies can be ascribed various colors

l Lithologies can be specified as Porous/Non-Porous by toggling on/off
Porous (this is used if fluid substitution is carried out in further analysis
with SynthRock plugin)

Manage Contents

Manage Contents can be accessed by clicking on the icon in the Manage Strati-
graphy window.

This option is used to define a set of fluid contents. Afterwards, fluid(s) from the list can
be assigned to lithologies for each layer when defining Layer properties for Layer mod-
eling.

Layers & Synthetic Modelling

The icon starts the Layer/Synthetics modeling feature.
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Manage Wavelets
This window is available from the Survey > Manage > Wavelets... menu and from the

icon. It provides management tools for wavelets. The left panel shows the available
wavelets. The selected wavelet is visualized on the right panel. The storage information
of the active wavelet is shown in the lower panel. The following actions can be per-
formed:
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Options:

Alongside the standard 'Manage' options (Rename, Lock, Remove and Set as Default),
you may also, via this window:

Get a wavelet from another survey

Display a wavelet's properties dialog

Change polarity

Manually rotate a wavelet

Taper a wavelet

The Filter is used to filter-out the objects with selected names. For instance, to

display all wavelets that start with letter W use "W*".

Import Wavelet

When clicking on the Import button, the import wavelet dialog box pops up. Please follow
the instructions in Import Wavelet
section.
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Generate Synthetic Wavelets

Generate a wavelet

Two types of synthetic wavelet are available - "Ricker" and "Sinc".
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Statistical Wavelet Extraction

Statistical wavelets can be extracted from the seismic data.
The User first needs to choose the input seismic, i.e 3D volume or 2D line.

If 3D seismic is selected, the following window pops up:

It is recommended to use a sub-selection of the seismic data, e.g. every 10th inline/cross-
line, and to use horizons to guide the extraction. The extract length of the seismic data
should be at least 1 second TWT.

The wavelet length should never be too small (min 50ms), or too large (200ms max). A
rule of thumb is that the first side lobe should be fully contained in the wavelet.

The extraction is performed using the following workflow:
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1. Seismic traces are extracted and tapered
2. The auto-correlation of the seismic traces is computed, using the length of the

desired wavelet
3. The frequency spectrum of the auto-correlation is computed.
4. The square root of the modulus of the frequency spectrum is taken, the zero Hertz

component is muted to zero.
5. The inverse FFT is computed.
6. The zero phase wavelet is the real part of the inverse FFT output

The output phase rotation cannot be set in the current version. It is being implemented.

The Wavelet extraction in 2D line is shown below:

Rotate Phase

The phase of wavelets can be altered and saved using the following slider:



- 381 -

The new phase will be set when pressing "Ok".

Taper a Wavelet in Time or Frequency Domain

A wavelet tapering window is launched by pressing the icon from the wavelet man-
agement window. A wavelet is tapered in time or a frequency domain, depending what is
selected from the top of the panel (see below).
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In time domain, the selected wavelet is tapered by selecting a tapering percentage (%),
which is set from the slider available at the bottom of the window. This is done by mov-
ing the slider left or right. Additionally, the amplitudes at zero frequency can also be
muted by setting check to mute zero frequency check box.

In frequency domain, the tapering can be applied to both ends of an amplitude spectrum,
i.e. high and low frequencies. This is applied with a given slope (dB/Octave) value and
placing the slider to an appropriate min/max position (Hz). The red line in the amplitude
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spectrum shows the resultant tapering pass, which is updated according to the given set-
tings.

Merge Synthetic Wavelets

Two or more wavelets can be stacked using this option. The wavelets can be 'Normal-
ized' and/or 'Center' at maximum amplitude/energy.

Manage Wells
The Well Management window can be open from Survey > Manage > Wells... or from the

icon.
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The available wells imported in the project are listed on the left. Wells can be renamed,
locked, removed or set as default with the buttons in the centre of the window:

Renames the selected well

Toggles the well to be read only(locked)/editable(unlocked)

Removes the selected well
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Sets as a default

The well track, checkshot and time/depth model can be loaded and/or edited using the
lower left row of icons:

Well Track Editor

Checkshot Editor

Depth/Time Model editor

The well log tools can be used to remove spikes, to smooth and to clip the logs for the
loaded wells.

Well log tools

Markers can be imported and managed from the following icon:

Markers editor

Wells can also be exported to be seen on Google Earth using the icon. It is also pos-

sible to either import or create Multiple single wells from the icon .

When selecting a well on the left list, the loaded logs for this given well are listed on the
right hand side. They can be renamed, removed and exported with the buttons on the
right of the log list. The unit of measure of the logs can be checked or changed if needed
(this does not affect the log values). The logs themselves can be moved up/down within
the list. For removal and export, multiple logs can be selected.

Renames the selected log(s)

Removes the selected log(s)
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Exports the selected log(s)

View/Edit unit of measure for the selected log(s)

Edit Well log

Moves up the selected log in the list

Moves down the selected log in the list

Logs can be imported from Ascii files, click on Import..., or created using mathematical
expressions from the well management window, click on Create....

Other relevant information is indicated at the bottom of the window.

It is recommended to give logs the same name in all the wells. For example,

the master density log should be called RHOB in every well. This enables the

selection of one set of logs in all wells, ie: for use in the cross-plot tool. Please

note that logs names and marker names are case sensitive during multiple

selections.

The top Filter is used to filter-out the objects with selected names. For

instance, to display all wells that start with letter W use "W*". This works only

with text, not numbers or symbols.

Simple Multi-Well Creation

Multi-wells can be imported or edited through the Import > Well menu. This window con-
tains editable fields. The new wells can be created by either importing them or entering
directly the values and names. The Read file button can be used to import an ASCII file
containing all well information.

Select the input file (as shown below) and provide the appropriate format definition set-
tings. To provide the format definition, the selected input file can be examined by press-
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ing the Examine button. If the file contains the header lines, those lines can be elim-
inated by providing the file header information.
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The file format definition is provided by pressing the 'Define' button. In the format defin-
ition window, the default 'col:0' values can be modified according the the input file. When
the correct file format is defined, the wells can be imported by pressing 'OK' button in the
multi-wells creation window. By default the wells are loaded with a constant velocity.
The velocity data or the time-depth model can be provided while importing the Time-
depth model.

The simple multi-well file can now be imported and displayed after creation:
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Well Track Editor

This table shows the import relation between the X and Y coordinates (first two
columns), the TVDSS depths (Z, third column) and measured depths in the fourth
column. This table is fully editable: Double-click on a cell to edit it, type a new number
and press enter or select another cell. Please note that other values will be recomputed
to reflect the changes.

The "Update display" button allows to update the displayed well track in the scene
based on the modified table content. Optionally a whole new track file can be read from
a file to replace the existing data, like during track import.

During edition the depths can be displayed in feet. Please note that this flag will be kept
in the survey defaults and will apply in other windows. However it is only a display set-
ting and the data on disk will not be affected.
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The following window appears after having clicking on "Read new". The import settings
are fully similar to that of the import step.

Checkshot and Time-Depth Models

Wells in OpendTect can have two different types of Time/Depth models:
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1. An optional checkshot model, often the first available time/depth model or
a measured checkshot survey.

2. The Time/Depth model, that is always the active time/depth model for the
well, used for data extraction and visualization.

The main differences in usage are:

l If a Time/Depth model is flagged as being a checkshot model during import, the
Time/Depth model will be a copy of the Checkshot model.

l If a Time/Depth model is not flagged as being a checkshot model during import
there will be no checkshot model for this well.

l Checkshot models may be used during synthetic-to-seismic ties to constraint the
output Time/Depth model. On the contrary the time/depth model provides the
actual input mapping when starting the well tie.

Both types have a similar editing window. It shows the mapping between measured
depths and two-way traveltime, respectively in the first and second columns. Depths are
displayed either in meters or in feet (toggle at the bottom of the window), and times are
always displayed in milliseconds. These tables are fully editable: Double-click on a cell
to edit it, type and new number and press enter or select another cell. The "Update dis-
play" button allows the user to update the displayed well data (track, markers and logs)
in the scene to be updated based on the actual table content.
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The following window appears after having clicking on "Import" in the edit Checkshot or
Time-Depth model window. The import settings are fully similar to that the import step.
The Export button allows to export the table in the same format to an output ASCII file.

Manage Markers

Well markers can be manually provided or imported. They can be exported.
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Edit markers: Individual markers can to be added or deleted right-clicking the mouse on
an existing well marker in the marker table and choosing the appropriate command. To
edit the name or value, double click in the appropriate cell. Levels can be set according
to the stratigraphic framework, but please note that marker names and color will be
updated according to the framework when setting a level to a well marker. The Stra-

tipgraphy manager can be access from the icon.

Add markers: Markers can be loaded from a file by clicking the Import button. The fol-
lowing window will then be displayed:

Select the input Ascii file. The main work is to specify the presence of a file header and
the file format definition. The header, if present, can be of fixed length (number of lines),
or delimited on its last line by a keyword.
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Predefined and saved file formats are available by pressing the Open icon . Other-
wise the format must be manually specified. The Define button gives access to the
format definition window.

You must specify in the format definition window the column numbers of the marker
name and depth. Please mind the spaces in the marker names that can break the fixed
column format. For that reason it is recommended to have the depth in the first column,
and to specify column 2 as the position of marker names. Then all strings found in
column 2 and up will be used to form the marker names. Depths can be either measured
depths or TVDSS depths. Data loading can be stopped at a specific line by providing the
adequate keyword.

It is recommended to save the format definition for a later use and QC, by clicking on the

Save icon . In pop-up window, write the name of the format and store it. The format
can be stored at different levels (All surveys, Current survey, Current OpendTect user
level) depending on the usage. Press Ok when done.



- 395 -

Update display: After adding and/or editing the markers, they can be refreshed in the
main display by clicking on theUpdate display button.
Export markers: Finally, the edited markers may be saved to a new file/location by click-
ing on the Export button.

Logs Import

Logs can be imported from the Well Manger window.
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Import Logs: The file should be in LAS format, with either MD, or TVDSS. Alternatively,
the log files can be pseudo-LAS, meaning LAS (with one line of data per depth value)
with the header replaced by a one- line definition: "Depth Gamma Sonic" etc (without
quotes). Log names should be separated by blank characters (space or tab). For both
LAS and pseudo LAS, the following units can be recognized. The recognition process is
case insensitive.

Once the file has been selected all recognized logs will be listed in the Select logs sec-
tion. Only the highlighted logs will be imported. Be careful that two logs do not have the
same name. The depth interval can be limited to a subrange. The start depth, stop depth
and step written in the LAS files are not used; instead the depths found on the same line
as the amplitudes will be used.

In pseudo LAS, units should follow directly behind the log name in parentheses, e.g.
Depth(ft) Density(g/cc). Below are examples of text string that will match units:

l Time: s, msec, µsec
l Distance:m, feet, f, ft, in
l Density: kg/m3, g/cc, g/c
l Velocity:m/s, ft/s, f/s, feet/s, km/s
l Sonic: s/m, us/ft, µsec/f, us/m, usec/m
l Velocity(m/sec)*Density(Kg/m3): (m*Kg)/Sec*m3)
l Fraction (porosity, water saturation):%, PU, or blank for unitless
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l Permeability: k
l Gamma Ray: API
l Electric Potential: V
l Resistance: ohm
l Compressibility: 1/Pa
l Temperature: K, deg.C, deg.F
l Pressure: Pa, bar

Logs Creation

Logs can be created from log-log computations. Select one or more wells and click on
'Create' in the well management to open the log creation window as shown below:

There is an inbuilt list of functions which can be used for creating new logs.This is sup-
plemented by a Rock physics library containing more advanced resources.
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The same syntax as the mathematics attributes should be used, with the following
changes:

l The computation is done in the depth domain. No upscaling is performed.
l The various quantities (e.g. density) in the formula are matched with the input logs
on which the calculation is being performed. The units of these quantities can also
be changed, if needed.

l If "Fill empty sections" is not set for any log then the output will be defined where
all logs do exist. Otherwise the input log that must be filled will be interpolated. In
the shallow and deep parts the input log will be extrapolated by copying the data
from the first and last sample respectively. This interpolation/extrapolation is done
prior to computation.

l An automatic assignment of well logs based on the expression names is attempted
when pressing "Set".

l The inputs logs have probably different Z ranges. The output Z range will be a reg-
ular array defined by the 'Output sample distance'.

Rock Physics Library

A number of in-built advanced rock physics formulas can be selected to create various
types of logs from available well log data.
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The type of output log quantity is chosen from Property Type list (e.g. Density, Velocity
and Pressure). Afterwards, a specific formula out of a number of possible alternatives
can be chosen to compute the required log quantity. The choice of equation depends on
several factors such as the type of available log quantity and the region (e.g. a rock phys-
ics equations might work well in Gulf of Mexico but not in North Sea). After this selection
has been made, the formula will be displayed along-with a short description below it.

The standard values for variables of the selected formula is also displayed.

It is extremely important to keep in mind that the input log quantities (e.g.

Sonic) MUST be converted in to particular units for the formula to work. These

units are already selected by default and should NOT be changed. Same

applies on the output unit of measure as well.
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Logs Export

All or a selection of logs can be exported to an output text file. The input well must be

selected, then select the logs to be exported, and click on the export icon .

The logs can be exported with respect to MD and TVDSS depths, optionally also with
X/Y or Inline/Crossline positions. The depth range and step will specify the regular array
on which the input logs will be interpolated prior to the export. The output file will be a
column sorted Ascii file.

Export Well Surface Positions to Google Earth

The well locations (surface coordinates) can be exported in Google earth using the
icon. Select a selection of wells (CTRL-left click to select several wells) to be exported in
the popup window, and specify a filename for the kml file to be created. Press Ok, and
open this file in GoogleEarth.



- 401 -

Pre-load
In OpendTect, the user can pre-load seismics or horizons. The advantage is to allow for
faster display times in the scene. Your system must possess sufficient memory to store
the pre-loaded data.

Preload Seismics
The pre-load seismic data functionality is introduced inside the OpendTect to speed-up
the working efficiency with large volumes. A common practice is to add an inline/cross-
line/2D line in the tree and display it in the scene. Each time the line is displayed, the
stored volume is read. Therefore, the seismic volumes that are routinely used, can be
preloaded. Also if the same seismic data like attribute cube is pre-loaded, the efficiency
of displaying the data in the scene is improved.
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Seismic data can be pre-loaded in OpendTect by going to Survey > Pre-load > Seis-
mics...
Clicking on Seismics.., the pre-load manager pops-up to allow the user to Add, i.e select
the data to pre-load.

Pre-load seismic data manager

Preload manager is used to load a 3D volume, 2D lines, 3D Pre-stack volumes or 2D
Pre-stack lines in the memory. Each data can be unloaded separately in selecting it and
clicking on Unload Selected.

Additionally, after selected a pre-load data, the user can optionally save his/her set-
tings for the later use. These settings can then be opened for use later.
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Note: The functionality is available for all stored seismic (2D/3D-Pre/Post)

data in the relevant seismic data manager interface.
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Preload Horizons
For fast visualizations, multiple horizons (2D/3D) can also be loaded in to the memory.
Thus whenever the preloaded horizons would be displayed in the scene, it will take less
time in reading the file from the disk. Therefore, the functionality improves the visu-
alization speed. Press the 'Add ..' button to select the desired horizons to be loaded in
the memory. If you want to unload some horizons, select the horizons first and press
'Unload selected' button.

The Save and Open buttons are used to store/open the pre-loaded horizons
setup for a later use.
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Analysis

Attributes
In OpendTect, seismic attributes are calculated/evaluated by using Attribute-set Window.
In this window, many single/multi trace, pre/post-stack, dip-steered/non dip-steered attrib-
utes are available. Moreover, it also contains special filters (e.g. Gap decon, Frequency
filters, dGB-special filters etc). The attributes are explained individually in Appendix A.

Attribute Set Window
The attribute set window contains a set of seismic attributes definitions to be eval-
uated/calculated. While defining the attributes it is possible to work in the active scene.
Attributes can also be calculated after saving the attribute set. In broad sense following
workflows are applicable in OpendTect attribute calculation process (on sections and
horizons):

l Evaluate attribute
l On-the-fly attribute calculation
l Creating an attribute output (2D/3D)

In following figure, different attributes are defined as an attribute set. It is considered as a
routine practice in OpendTect environment (especially to define a meta-attribute). These
attributes can be: evaluated on sections and horizons, applied on-the-fly and created as
an output attribute. Importantly, some attributes show steering selection in the input para-
meter settings : the dip-steering plugin created by dGB provides various advanced
steered attributes.

http://www.dgbes.com/index.php/dip-steering.html
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OpendTect works with the concept of an "active" attribute set. At start-up, there is no act-
ive attribute set. To create a new one (New set...), or to select an existing set (Open set
...) , select the corresponding option from the File menu (See below). OpendTect is also
delivered with a collection of default attribute sets for some general testing (Fault, Chim-
ney,Salt default attribute sets). This set can be selected from the Default set option under
the File menu. To use a default set, the input seismic data and a SteeringCube (if
steered attributes are available in the default set) have to be selected.

Clicking any attribute in the list will show its parameter settings. Notice that OpendTect
uses SI units. For details on each of the attributes see Appendix A. Note that some of the
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parameter options depend on whether you are using 2D or 3D data as input. For
example, the inline and crossline stepout field will be replaced by a single trace stepout
field. Generally, an attribute set can only contain 2D attributes or only 3D attributes.
Mixed attribute sets are not possible.

When parameters of an attribute are updated, the modified attribute can be added to the
attribute set with a new Attribute name by clicking Add as new . Clicking on any other
attribute in the list means that the updated parameters are accepted, while keeping the
original attribute name. The Revert changes button only reverts changes to the original
state before clicking on another attribute in the set. When Ok is pressed, the (updated)
attribute set becomes the "active" attribute set. The attribute set is saved to disk when
Save on Ok is ticked. To save an attribute set under a different name, use the cor-
responding option under the File menu.

Allows for the creation of a new attribute set

Open an existing attribute set

Open one of the default attribute sets (provided within the OpendTect
package)

Import an attribute set from another survey

Reconstruct an attribute set from file

Save the attribute set

Save as...

Re-display the element with the current attribute

Evaluate the attribute (parameters)

Cross-evaluate attribute (parameters)

Cross-plot the attribute.
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File - Change input... can be used to change the input data of all attributes in the "active"
set simultaneously, which is useful in case, for example, a new seismic volume has
become available.

File - Auto Load Attribute Set ...
It is now possible to have an attribute set already open at start up using the " Auto load
Attribute Set " option in the File menu. This enables to choose the attribute set which will
be active the next time the survey is opened.

Attribute Set Toolbar
The attribute set toolbar comprises the following icons.

Also accessible via the File menu, these are, from left to right:

l New set clears the window to create a new attribute set. The attribute set name can
be specified when saving it (press OK, or select File - Save set menu option).

l Open set opens a previously saved set in the current project (from the directory
Attribs/).

l Open default attribute set. Filenames for input data must be re-specified.

l Import attribute set from another survey. Filenames for input data must be re-spe-
cified.

l Reconstruct set from job

l Save set saves the "active" attribute set in the Attribs/ directory of the current pro-
ject.

l Save as set saves the "active" attribute set in the chosen folder

l Redisplay element with current attribute is used for direct display of the selected
attribute on the active display element (shown in reverse video in the tree). The
main graphic interaction buttons and options remain active while the attribute set
window is open, so the active element can be changed. However no new element
can be added to the tree



- 409 -

l Evaluate Attribute allows the automatic variation and evaluation of attributes and
attribute parameters. If you have an "active" attribute and the current display ele-
ment is a slice (inline, crossline or Z slice) or a horizon, a new window will pop up
where it can be specified how to vary the parameters of the displayed attribute. For
example, Spectral Decomposition:

Here six slices are created, with time gates of [-4,4], [-8,8] etc.... Use the slider
to move through all the slices. When an attribute has been evaluated on a sur-
face, the parameter can be updated in clicking on Accept. Enable this by
checking Store slices on Accept.

As shown above, the "Evaluate Attributes" set contains a general selection of
various attributes. It is intended as a guide or starting point for a scan through
the wide range of different attributes and may be a starting point for an effect-
ive attribute analysis.

For more information on Evaluate Attribute, watch the tutorial on

the OpendTect YouTube Channel.

l Cross-evaluate attributes Allows for the cross-evaluation of parameters within the
attribute.

https://www.youtube.com/watch?v=STDUoDX8Cc0
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l Crossplot attributes allows to crossplot attributes from the current attribute set and
saved volumes. Multiple attributes can be selected. The attribute values are extrac-
ted at picked locations (see how to create a pickset). Once attribute values are cal-
culated, a crossplotting table is generated and crossplot(s) can be achieved.

Auto-Load Attribute Set
By default, no attribute set is loaded at startup. These settings can be over-ruled by
selecting a specific attribute set to be auto-loaded in the list each time the OpendTect
window is started. This can be set from the attribute set window under File > Auto Load
Attribute Set sub-menu. If selected, it will launch the auto-load attribute set window.
Selecting Yes will show the list of attribute set that can be be auto-loaded. Select one
attribute set and press Ok button. This will save the settings and next time, whenever the
OpendTect is started, the selected attribute set will be auto loaded. Such practice
becomes useful when working with attributes evaluation at different stages of a project
and that the same attribute set need to be updated.

Load Now will directly load the selected attribute set. If not selected, the attribute set will
be loaded the next time the survey is opened.

Please note that a similar function exists for sessions.
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Default Attribute Sets
OpendTect is provided with "Default attribute sets " to get you started. By selecting a
default attribute set, a window appears to select the correct input volume(s) and the cor-
rect SteeringCube (see images below). These attributes (except "Evaluate Attributes")
require the following dGB plug-ins:

l SteeringCube: attributes and filters are calculated along user-driven, or data-driven
directions

l Neural Network: Both supervised and unsupervised neural networks allow gen-
eration of meta attribute volumes that highlight any object of interest (e.g: Chimney,
Faults, Salt,...).

The OpendTect version comes out with new "default attribute-sets" in addition to the
already existing attribute sets like NN ChimneyCube, NN SaltCube, Unsupervised
Waveform Segmentation, dGB Evaluate Attribute, etc .

l Evaluate Attributes: This default attribute set contains the default defin-
itions of several basic attributes grouped together to give an idea of
attributes evaluation in OpendTect. This default attribute set can be
selected to start with OpendTect. After selection, only input seismic
data is required.

l dGB Evaluate Attributes: This default attribute set is similar to above
attribute set with additional dGB attributes (using dGB plug-ins). For
this set, both seismic and steering data are required as input.

l AVO attributes from Intercept-Gradient: This attribute set requires
two inputs; Intercept and Gradient (from AVO analysis) as first and
second inputs respectively. It computes attributes like Envelope, Fluid
Factor and Rp-Rs.

l AVO attributes from Near-Far: The input for this attribute set are the
Near and Far stacked data sets in the same order. This includes attrib-
utes like Envelopes and Enhanced pseudo gradients.

l Dip-steered median filter: This default attribute set contains the defin-
ition of dip-steered median filter. It cleans up the seismic data by remov-
ing random noise. Both seismic and steering data are required as input.

l Dip-steered Diffusion Filter: This filter is mainly used to sharpen
faults. Both seismic and steering data are required as input.

l Fault Enhancement Filter: This type of filter is used in the
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Fault/Fracture analysis, it dramatically sharpens the faults by sup-
pressing random noise. It is a combination of the diffusion filter and the
dip-steered filtered. Both seismic and steering data are required as
inputs.

l Fault Enhancement Filter (Expert): This is a more sophisticated ver-
sion of the basic Fault Enhancement Filter and uses similarity and dip-
steered filtering. It also requires both seismic and steering data as
input.

l Ridge Enhancement Filter: This filter detects lateral lineaments using
different steered similarities (in inline, crossline and diagonal dir-
ections)

l Ridge Enhancement Filter (Expert): This filter is an advanced version
of the above described filter and uses steered similarities in addition
with their second derivatives (in inline, crossline and diagonal dir-
ections).

l NN Fault Cube: dGB standard default attribute set containing the defin-
itions of all attributes that are used in neural network (NN) training to
create meta-attribute i.e. NN Fault Cube.

l NN Chimney Cube: dGB standard default attribute set containing the
definitions of all attributes that are used in neural network (NN) training
to create ChimneyCube (meta-attribute).

l NN Salt Cube: dGB standard SaltCube meta-attribute.

l NN Slump Cube: dGB standard SlumpCube meta-attribute.

l Unsupervised Waveform Segmentation: attribute set containing the
definition of attributes that are used in unsupervised waveform seg-
mentation (a.k.a UVQs).

l Seismic Filters Median-Diffusion-Fault-Enhancement: This is an
advanced version of the "Fault Enhancement Filter". It enables the user
to have much control on the input parameters by modifying the para-
meters of the dip-steered median filter, dip-steered diffusion filter and
fault enhancement filter.

l Fault Enhancement Attributes: expandable attribute set containing
the list of the attributes that are useful for fault visualization and fault
interpretation.

l NN Fault Cube Advanced:most superior FaultCube (meta-attribute)
attribute set that is used as input for neural network training to create



- 413 -

fault probability cube.

Default attribute sets window containing the list of all available default attributes

When one of these default attribute-sets has been selected, a window pop-ups (see
image below) to select the input seismic and optionally a steering (the attribute sets
based on AVO analysis, the Fault enhancement filter and the Ridge enhancement filter
require inputs as outlined in their respective descriptions).
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Input selection Window

Input Selection
Every attribute requires input data. Both stored data and already defined attributes can
be used as input to a new attribute. In other words, attributes can be embedded.
However, circular references are not possible.

Input Selection for 3D Attribute Sets

Select from the stored data or from the list of defined attributes in the "active" attribute
set.
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In case the input data is multi-component, it is possible to choose from the available com-
ponents as shown below (or include ALL).

The Filter section allows to quickly find the right input. e.g type *S will look for

all attributes/cubes started with S like Similarity.

Input Selection for 2D Attribute Sets

Select from the stored data or from the list of already defined attributes in the current
attribute set.
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If the selected stored data set is multi-component, the user will get an option

to choose which component to select as input data:

Import an Attribute Set from
Attributes are primarily stored in attribute set files of extension .attr Attribute definitions
can also be found in the parameter files of a processing job when an attribute was used
to process a volume or data set.

It is possible to import the attribute set of an attribute file from the menu: File > Import set
from file. Existing attributes are stored in the Attribs folder of each survey. Optionally,

attributes from another survey may also be imported: File > Import set. or by using
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Import set from file

Import set from another survey

Pressing select in the above window brings the user here:
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It is also possible to re-create the attribute set of existing processing file in the menu: File

> Reconstruct set from job file... (or ) brings the user here:

Existing jobs are stored in the Proc folder of each survey, with the extension par. There
are two options available to reconstruct the attributes definition: from an existing par-file
or from a created cube file. In first case (from par-file) select the input parameter (*.par)
file. In second case (find from created cube), another window pops-up in which the input
volume and the corresponding parameter file are selected. The file name is found auto-
matically.

Pressing 'Find from created cube...' will open up this search/select window:

Finds the attribute set from an existing (created) cube, which was calculated inside
OpendTect.
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When importing, new input volumes must be selected to replace the ref-

erences stored in the input files.

Calculate Attributes
The attribute evaluation process has been considered critically and thus several key

options are available for the user. For instance, Evaluate Attribute is considered as
intermediate (but not necessary) step to quickly analyze the different parameters of any
attribute within the working environment (View tutorial-Evaluate attributes). Similarly, the
user can create a list of seismic attribute definitions as a working set that later on can be
updated. The attribute set is then used to calculate the seismic attributes along lines/sur-
faces.

There are two possible ways of calculating seismic attributes in OpendTect: First, in
order to calculate the results of any attribute in the foreground, user(s) can do it on-the-
fly. Second possibility is to calculate attributes after evaluation by running a secondary
process in the background. In OpendTect, seismic attributes are applied on several ele-
ments (inlines, crosslines, Z slices, random lines, 2D lines, volumes, horizons etc).

The workflow to calculate the selected attribute is quite simple:

1. Define (or use existing) attribute Set and save. For details see earlier sec-
tions of this chapter.

2. Calculate on-the-fly or Create Seismic Output or Create horizon attribute
output.

3. If attribute is not calculated on-the-fly, retrieve results by displaying attrib-
ute in tree.

The example of first step is given in following figure. It highlights the sequential process
(notice green arrows form left to right) of on-the-fly attribute calculation. Firstly, several
attributes are defined. Secondly, by default, when a user presses Ok button in Attribute
Set window, the Save Attribute definition window will appear to save the attributes defin-
ition as an Attribute set. The attribute can then be applied on an inline (for instance) by
adding a blank attribute (right-click on inline number). Right-click on the blank attribute
and select the attribute (Select Attribute > Attributes > "User Attribute"). The listed attrib-
utes are those that are defined in the attributes set window. Selection of any one, would

http://www.youtube.com/watch?v=STDUoDX8Cc0
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start a process of on-the-fly attribute calculation. By following same workflow (as elab-
orated in figure) the same attribute can be calculated along other elements (e.g. cross-
lines, Z-slices, volumes etc).

Schematic flow of on-the-fly seismic attributes evaluation on an inline.

1. There are some attributes that can take too much time during the on-the-fly

calculation process.

This depends upon the type of attribute that how much calculation steps it con-

siders e.g. multi- trace (e.g. Similarity) attributes normally take more cal-

culation time than the single trace (instantaneous) attributes. Similarly, the

attributes with steering normally takes more time in calculation. So, each time

the attribute is displayed in the scene (as shown above), it is calculated in the

fore-ground. If the user is committed with the attributes results, this can be

resolved by creating seismic outputs (See Create Seismic Output and Create
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Horizon Output sections) in the background. This will also help to restore the

saved sessions quickly.

2. Additionally, multi- component output seismics- 2D/3D (like spectral

decomposition) are created by using create seismic output.

Another example of second step, is shown in following figures. The attribute

can be calculated along the horizon by following the same steps described

above, for inserting and displaying the attribute (as shown below). In this

example, Similarity is calculated on-the-fly along a horizon. This attribute nor-

mally takes time (depending upon amount of traces involved). So, user can

take benefit of saving the on-the-fly results that later on can be retrieved.

Schematic flow of on-the-fly seismic attributes evaluation at a horizon.

In order to save the calculated attribute as horizon data, right-click on the

attribute and select Save as Horizon Data.... In pop-up window edit the name

accordingly and press Ok. This will save the horizon attribute as its horizon

data. That can be managed later on by using horizon management window.

(see Management horizon)
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Result of calculated similarity attribute. Saving the horizon attribute as horizon

data

The stored attributes along horizon can be retrieved as horizon data. Right-

click on horizon and add blank attribute. Right-click on the newly inserted

blank attribute and locate Horizon data item in the sub-list of attribute (as

shown below). In the horizon data selection window, select the desired attrib-

ute. This will display the selected attribute in the scene.

Retrieving the stored horizon data (attribute) of a horizon.
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Volume Builder Setup

The volume builder setup is used to apply volume-based operations, unlike the
attributes that work trace-by- trace. The setup is launched via the Analysis > Volume
Builder menu. The setup is a very useful tool for gridding velocities or other rock prop-
erties.

The volume builder setup window contains several available steps that are applied
sequentially to generate a volume. Any particular step can be selected from the Avail-
able steps by double-clicking on it. The later steps may replace the earlier ones, there-
fore care must be taken when ordering and setting up the workflow.

Once your workflow is defined, you will need to save this setup. This can be done by writ-
ing the name of your setup.

The computation and storage of a volume processing setup can be found under
OpendTect's Processing menu: Processing > Create Seismic Output > Volume Builder...

Body Shape Painter
The body shape painter is used to define the inside and outside values for an
OpendTect body. The options for 'Inside Fill Type' are shown in the image below. The
same options are available for 'Outside Fill Type':
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Fill Types:
l Constant Value: Single, user-defined value:

l Previous step: takes the values of the previous step in the Volume Builder setup
(ie: a stored volume):

l Undefined Value: Equivalent to 'transparency'
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One example of use would be: if one wants to create a salt velocity cube, the values
inside can be filled with a salt velocity and outside can be set to previous step. If no other
step exists the undefined value is written.

Lateral Smoother
The lateral smoothing is a rectangular two-dimension smoothing filtering method of the
volume.

The average filtering will be done in the frequency domain by applying a 2D FFT to the
Z slices. This requires a rectangular dataset, while the input can be irregular. The fil-
tering type can be chosen between "Median" or "Average" which can optionally be
"Weighted". Positions without data or with undefined values are first replaced by the
option "Mirror edges" and "Undefined substitution". The "Undefined substitution" can be
done by taking Average values between the defined points, Fixed value (one value
needs to be specified which will be used everywhere) or using Interpolate between the
defined points.

Finally, this step can be saved by giving a name.
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Smoother
The smoother step is used to apply a three dimensional smoothing operator by spe-
cifying In-line, Cross-line and Vertical (ms) stepouts.
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Various operator shapes can be chosen (e.g. Hamming) and can be visualized by press-
ing on the View button. The CosTaper also requires specification of a "Taper Length (%)
".
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Horizon-based Painter - Advanced
The horizon-based painter is used to create a model between two surfaces. The initial
top and bottom values are necessary to be filled in the input. The intermediate values
are interpolated to a survey or a horizon. In this window, horizons have to be selected as
top/base values. The slope type is used in interpolation to define a slope.

The horizon-based painter paints velocities in a 3D area whose geometry is defined by
one or more 3D horizons.

The painted velocities are referenced to a specific time. This time can be either constant
(user-defined), or retrieved from a 3D horizon and not necessarily from one of the hori-
zons defining the limit of the body. For example, an intermediary horizon could be used.
Then velocities are painted from that reference time. The velocity must be provided as a
velocity/gradient pair. The values are once again either user-defined or extracted from a
surface data (grid) attached to a 3D horizon.

There is also a much simplified Horizon-based painter also available:
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Velocity Gridder
The gridding will create a volume out of a sparsely sampled dataset. The input source
MUST be tagged with a velocity type. Indeed the gridding is applied to the time-depth
relation hold by the velocity source and not on the amplitudes of the velocity source. This
preserves the time-depth relation and blocky-ness of interval velocity models. The grid-
ded time-depth relation is converted back to the input velocity type in the output volume.

However any other data type could be gridded by this module (Thomsen parameters,
temperatures, ...). These other types must be tagged as delta, epsilon or eta before being
used for gridding. The functions will be vertically interpolated using a linear 1D inter-
polation before the lateral gridding.

Two interpolation methods are available for gridding: inverse distance interpolation or tri-
angulation. The first method is designed for the interpolation of sparse dataset, while the
second algorithm should be preferred if the input exists on a regular (but coarse) grid. In
general gridding is always followed by some filtering.
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The input data can be either a (coarse SEG-Y imported) volume, stored (ascii) functions
or velocity picks (requires the Velocity Model Building plugin)

Clicking on the 'Properties ' button will allow you to change the selected input for this
step:

Velocity volumes have to be tagged to recognize their type.

Tip: If you have no velocity volume available, press 'Add' in the 'Edit Step' win-

dow and then, in the window that pops up (shown below), press 'Create':
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Here you may tag a volume with a velocity type, so that it can be used as

input for the gridding step. Or change the tag that the volume has. This can be

useful for interpolation of velocity cubes (for example, we strongly advise

against trying to interpolate Vint or Vrms, but Eta-tagged volumes can be inter-

polated):

Input Volume
This step is in general used to provide a background volume before using spatially con-
strained steps, for instance before the body shape painter or horizon-based painter.
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Voxel Connectivity Filter
Voxel Connextivity Filter is a special tool to create continuous bodies based on the amp-
litudes in a stored volume. A 'voxel ' is defined as the volume around one sample. It is
thus linked to the survey bin size and sampling rate.

This volume builder step must be preceded by a step providing the necessary

input data, like "Stored volume".

This volume builder step implies a volumetric calculation. The result of the

application on a single inline will differ from the result of the application to the

whole volume.

The filter is based on a user-defined amplitude selection to compute the bodies. The
samples interconnection is computed based on an amplitude criteria and geometrical
spreading settings. It is a very useful tool to visualize seismic attributes in 3D. Other
benefits of this tool are to get a volume of several bodies and visualize them in 3D or use
it as an input to supervised Neural Network. A general and most popular use of this tool
can be the DHIs detection. For instance, if creating a volume that represents DHIs only, it
may be interesting to clip the amplitudes to visualize the DHIs present in the seismic
data. For such case, when having the seismic amplitude attribute as a volume, this filter
can be used to create new DHI volume.

http://en.wikipedia.org/wiki/Voxel
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The voxel connectivity filter has a number of parameters to set:

Keep: Specifies the part of the input dataset used to compute the bodies,
based on their amplitudes.

l Values more than: The envelope of the amplitudes higher than the
given value define the bodies to be computed. Example: 0 will select all
positive amplitudes.

l Values less than: The envelope of the amplitudes lower than the given
value define the bodies to be computed. Example: 0 will select all neg-
ative amplitudes.

l Values between: The envelope of the amplitudes between inside the
given range define the bodies to be computed. Example: 9000, 14000
will select all values in between, like 12000.

l Values outside: The envelope of the amplitudes between outside the
given range define the bodies to be computed. Example: -10000,
10000 will select all values lower than -10000 or larger than +10000
(the extremes).
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Connectivity: Selects the method used to connect different voxels when
computing the bodies. Each sample in the input volume acts like a seed.

l Common Faces (6 neighbours): The propagation is done by strictly
using the 6 faces adjacent to the current seed.

l Common Edges (18 neighbours): The propagation is done by using the
6 faces and the 12 edges adjacent to the current seed.

l Full (26 neighbours): The propagation is done is all directions, using
the 6 faces, 12 edges and 8 corners adjacent to the current seed. This
is the default mode.

The easiest way to visualize the connectivity is to imagine the ref-

erence voxel as the central voxel in a 3x3x3 cube, such as the red

one in the first image. Then the second image shows the Face-,

Edge- and Full (corner) conecctions:
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Keep bodies larger than [voxels]: It defines the minimum number of voxels
required to output a body. Actually all bodies are computed in the first pass.
The smallest bodies are then dismissed. Minimum allowed is one.

Keep output: The following value(s) will be output on the samples inside the
computed bodies:

l Body-size rank:The output value is an integer with a constant, different
value for each body. The values are sorted by decreasing body size,
starting at zero: 0 is the largest body, 1 the second largest...

The example below is created using a similarity attrib-
ute to locate faults and fractures in a volume. It is set-
up to create bodies connecting low similarity values
(threshold of 0.5). All values that are above this
threshold are ignored. Furthermore, it is also ignores
the very small bodies (size < 10 voxels).
It shows number of connected bodies (purple being
the largest ones) in a volume. Such a result can dir-
ectly show which faults are connected and those that
are not. Visualizing such a VCF result can be a valu-
able method in performing direct interpretation.

l Body-size: The output value is the size in number of voxels of each
body. This gives an approximation of the real-world volume, when mul-
tiplying by the bin size. For example, a body of 2500 voxels (10 inlines,
50 crosslines, 5 samples), with a bin size 25m x 12.5m, at 4ms
sampling with a constant velocity of 2000 m/s: Vol = 2500 * 25 * 12.5 *
2000*0.004/2 = 10000 m3...
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In this second example, the same volume is being pro-
cessed for Body- size. It shows the same patterns sug-
gesting that the prediction is identical to the earlier result.
However, the predicted voxels are being filled differently.
Here the same bodies are defined by largest volume in
cubic meters (m3).
Generally speaking, areas of higher faults/fractures density
allow greater connectivity between bodies.This example
below shows this case.

l Value: The output value is a user-defined value specified in the "Kept
value" field underneath.

l Transparent: The output value is taken from the amplitude in the input
volume.

Rejected output: The value outside the computed bodies can be either the
undefined value or a user-defined value specified by the field "Rejected
value" underneath.

Name for this step: Provide a user-defined name for this volume builder
step that will appear in the Used-steps list of the Volume builder.

Well Log Interpolator
This gridding step is used to populate a 3D volume using well logs by interpolating
along Z-slices.
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Vertical Extension: Select the method of vertical extension from the fol-
lowing options:

Log extension if needed: Extend the logs (if required) to match the Selected
zone

Extract Between: Extract data from a marker-defined, depth-defined or time-
defined range. You may also toggle on the option to extract the data in time.
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Selected zone: Set the extraction zone suing either markers or start and end
of data (or combination thereof).

Distance above/below: Extend, if desired, the extraction zone above and
below the selected zone.

Algorithm: Choose between inverse distance or triangulation.

Search radius: For inverse distance only - set an optional maximum search
radius for the algorithm.

After the selection of well(s) and log, parameters and algorithm, provide a name for this
step at the bottom and proceed to the Volume Builder by pressing 'OK'.

Cross-Plot
The Cross-plot tool is designed to create two dimensional cross plots between 2D/3D
seismic data (attributes) and either other attributes or well data. The data can be ana-
lysed in multiple maners, using different kinds of colour coding and data selection tools.
It may be launched from the menu Analysis --> Cross-plot menu.

Cross-Plot Data Extraction
The crossplot data must first be extracted, either on (a subset of) the horizon or along
(deviated) well paths. 2D or 3D attributes can be used, and well logs if the extraction is
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done along the well paths. The extracted data will first be presented in a table before
actually selecting the features to cross-plot.

The extracted data can be saved in the cross-plot table window and reopened without
repeating the data extraction, from the menu Analysis --> Cross-plot --> Open.

Well-based Data Extraction

This window presents the attributes and/or logs that can be extracted along well path.
The output will be presented in table before being used for cross-plot. At least one well
must be selected, and one attribute or one log. It is also possible to select only attributes,
or only logs.

The well track and time-depth model provide the locations where to extract the data. Val-
ues will be vertically extracted along a specially built measured depth axis. This axis is
such that the step between two consecutive depth samples is constant but with few
jumps, such that the Z difference (time or depth depending on the survey type) between
consecutive depths is around the survey default sampling rate. Therefore at shallow
level 1 seismic sample can correspond to 4 meters, then 8 meters at intermediate
depths, 12, 16 and so on.

l Attribute values are vertically interpolated along that created MD axis, since they
are unlikely to be along the Z axis defined by the survey geometry. A polynomial
interpolation is performed.

l Log values are extracted in the depth domain around the depth to be computed,
plus or minus half of the distance to the previous and next depths. All collected val-
ues are then processed (up-scaled) using a provided "Log resampling method"
(see below).
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3D Data extraction for Well vs. Attributes Cross-Plot
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2D Data extraction for Well vs. Attributes Cross-Plot

The following specific extraction parameters are available:

l Extract between: It is used to limit the z-range (depth or time) of the data to extract.
There are three options supported:Markers, Depth and Time.

If Markers is selected (which is default), the Start/Stop markers should also be
selected from the combo boxes that are available below the extract between field.

If Depth is selected in the extract between field, the start/stop (m) field will be
toggled on. In the later fields, starting and stopping depth range is typed in to
restrict the data extraction into an interval.

Similarly, if Time is selected in the extract between field, the start/stop (ms) field
will be toggled on.
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Finally, the step-out for extracting both Attributes andWell data samples has to be
defined. This can be defined in meters (default), feet (if the survey is in feet) or mil-
liseconds. The Extract in time check box is usually toggled on if you want to define
the data extraction step-out in TWT. It is advisable to check this box when extract-
ing data for crossplotting against seismic volumes.

l Distance above/below: It is used to modify the vertical range of the extraction win-
dow using a relative distance from the provided well markers, in depth. A negative
number will decrease the extraction window, a positive number will increase it.

l Log resampling method: Logs will be up-scaled using this method. 'Average'
should be used for most of the logs.Median, most frequent and nearest sample are
more fit for discrete logs like lithology, but can also occasionally be used for other
types.

l Radius around wells: All traces that can be reached within the search radius will
be extracted. If several traces around a well are found, the same extracted log
value is posted in front of the collected attributes values. This option will only
duplicate all data if no attributes are extracted. The default value is the survey bin
size, use value "0" to extract only the nearest trace, i.e. one value per well per
depth.

l Filter positions: See the location filters section in the same chapter.

Attribute-based Extraction Window

Attributes based data extraction window is used to extract an attribute data (stored
volumes or a defined attribute) within a volume defined by a range, polygon, surfaces,
body or a well path with lateral extension. The same window (shown below) could also
be used to extract an attribute data along a time slice or along a surface.

Note that at least one attribute must be selected prior to data extraction. "Attributes" list
shows all attribute currently loaded in the window, and the stored volume under brack-
ets. For multiple attributes selection, use the left mouse button by holding and dragging it
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up/down-ward. For 2D data extraction one or more attributes along-with their cor-
responding "Line names" (at least one) should be selected.

3D data extraction for Attributes vs. Attributes Cross-plot
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2D data extraction for Attributes vs. Attributes Cross-plot

The volume/horizon based extraction is performed by selecting locations according to
one of the following criteria:

l Range: It is selected to extract the data on a regular 3D volume or a grid (if it is a
time slice). The steps are the increments in the corresponding range. To extract
dense data points for a crossplot, smaller steps should be used. Note that the lar-
ger steps will decrease the amount of extracted data. Cubes coarser than the
requested grid will not be interpolated, undefined values will be posted to the
cross-plot table instead. For 2D data extraction this is the only possible option and
only the time range can be specified.

l Polygon: The lateral extent for a crossplot data could also be defined by a poly-
gon. Once the Polygon option is chosen, the desired polygon is chosen by press-
ing the Select button. The inline/crossline steps are the increments in the
inlines/crosslines range within the polygon. The time range is also an additional
constrain in data extraction that defines a vertical restriction window for a poly-
gonal type of volumetric crossplot.

l Table:Only positions listed in a table will be used for the extraction. The table
might be an OpendTect pickset, or a column-sorted ASCII file with inline, crossline
and Z values in the first three columns respectively.
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l Surface: Used for data extraction along a 2D/3D horizon, or between horizons.
Please note that the attributes will be interpolated if extracted along an horizon. If
the extraction is done between two horizons (volume based extraction using a
user-defined Z step), it will not interpolate the attributes. The "Extra Z" values
increase or decrease the extraction window size, and work similar as the attribute
set time gates (relatively). The left value applies to the top horizon and the right
value applies to the base horizon.

l Body: It is used to restrict the data extraction within a selected 3D body. The radio
boxes inside/outside are used to extract the data either inside or outside the selec-
ted body. If it is outside, the further ranges are sub-selected in theWithin bounding
box field.

l Well: It is used to extract attribute data along the selected well paths. The data
would be extracted vertically and according to the (TWT/depth dependent) survey
setup. The time gate is defined by providing a time range with time steps (vertical
sampling rate).

l Location filters can be added in order to add one or several restrictions to the
area of extraction.

Location Filters

The filters should be used to further limit the amount of data to be extracted for making
cross-plots. Several filters can be used simultaneously.
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Filters are of two types:

The first two filters, Random and Subsample, are not position related. The Random filter
passes a certain percentage of random samples selected in the main extraction window,
while the Subsample filter will pass a finite (user-defined) number of samples. For
instance, for the Random option, if the value is 1, only 1% of all extracted data would be
selected for cross-plotting.

The last four - Range, Polygon, Table and Surface (see previous section for definitions)
are position based filters. These are used to define sub-areas that will complement the
extraction settings provided in the main extraction window. Multiple filters can be chosen
out of these. Thus, the points satisfying the main extraction settings and all defined filters
will be used for the extraction of attributes.

Cross-Plot Table
The crossplot table displays the extracted data. It is used to edit and plot the data for a
crossplot. A row in the table corresponds to one extracted data point, annotated by its
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position (X, Y and Z) and followed by the collected attributes values (forming at vector,
from left to right: logs, attributes, stored data). The star adjacent to an attribute name indic-
ates sorted column. Empty cells represent attributes than could not be extracted with the
provided the settings for data extraction.

The table enables the manipulation and edition of the collected data, prior to making
cross-plots. For instance, it is possible to sort the data from an attribute, and to delete the
first or last rows, before plotting the data. Please note that the table window is inter-
actively linked with the cross-plot window. Any editing done in the cross-plot window will
reflect in the table window that remains open and active while working in the cross-plot
window.

Standard workflow: Save , edit, click in a column and then , click in another

column and then , launch the cross-plot window .

You can select a column by either clicking on its title cell or by clicking on any

single cell.

The toolbar contains the following editing tools:

l Saves the data shown in the table to a file (simple text file or OpendTect
object). OpendTect object is a special format to retrieve (open) the cross-plot. The
format is called position vector data and the data is saved in the survey sub-dir-
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ectory (/Features/*.pvds). The Text file selection outputs the data to an ASCII
(column sorted) file that later on can be used in 3rd party softwares e.g.Excel.

l Open/Retrieve the stored crossplot data. An alternative short-cut is present in
the menu Analysis -> Cross-plot -> Open Crossplot.

l Assigns the X-axis of the cross-plot to a selected/highlighted column.

l Assigns the Y-axis of the cross-plot to selected/highlighted column.

l Removes the selected Y-axis for cross-plotting.

l Removes the selected rows in the table.

l Moves the selection of the primary Y-axis one column to the left. The cross-
plot gets updated accordingly.

l Moves the selection of the primary Y-axis one column to the right. The cross-
plot gets updated accordingly.

l Sorts the selected column to an increasing order, from top to bottom.

l Add an empty column in the table. In the pop-up window, the column name is
provided. The mathematical operation is done to compute the data for the new
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column. An example is the Acoustic impedance data computed from the velocity
and density logs available in the crossplot table. For further information on the
mathematical operators, please find the description on the Mathematics attribute in
the Appendix.

l Removes the selected column from the crossplot.

l Displays selected percentage of the data. If a lot a data was extracted
not all will be displayed in the table. Nevertheless the sort and remove lines tools
may still apply to all the extracted data, upon request of the user.

l Toggles on/off the display of the coordinates.

l Toggles on/off the display of Z values.

l Shows histogram and statistics on the selected column.

l Allows to achieve vertical variogram analysis. A variogram describes the spa-
tial continuity. The vertical variogram can be computed for any of the attribute or
log from the extracted data. To achieve a variogram analysis from well log, the log
data is resampled at the variogram processing step and de-trended prior to the vari-
ogram computation itself. In the pop-up windows, the different parameters can be
defined: the maximum range (maximum distance allowed between the pairs for the
analysis), the step and the minimum pairs per log distance. Once these parameters
provided, the variogram is computed and the analysis can be performed.
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Variogram analysis: Set parameters (left), main window(right) :
blue = real data, green = model

A synthetic variogram can be set in changing the sill, the range
and also the variogram model (exponential, spherical, gaussian).
The objective is to get a synthetic variogram that best describes
the real variogram. The data can be analyzed for each well or for
all of them. The analysis results can be used when achieving
inversion.

l Launches the crossplot window.

Cross-Plot Window
The cross-plot window shows the data previously extracted and shown the cross-plot .
The window may start empty if insufficient data was selected in the table window.
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The cross-plot window contain three toolbars to perform various tasks:

Crossplot manipulation toolbar

l Take the snapshot of the cross-plot.

l Gives access to the main crossplot window properties: scaling, statistics,
regression line, density plot parameters.

l Creates multivariate from the cross-plot data.

l Colour code the points with respect to a .

l Colour code the points with respect to the wells they were collected.

Crossplot display toolbar
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l Is used to update the amount of displayed scattered points in a
cross-plot. It increases the efficiency to display the data quickly. Normally, a huge
data slows down the machine performance, when displayed as scattered points.
To avoid this, this option is used to display a selected percentage of the points.
Moreover, the percentage is only set for the data that has values; undefined values
are ignored in the percentage.

l The scattered points of individual/all wells are displayed.

l Used to show a coloured density cross-plot. Normally, if the displayed
scattered data points are too large, it consume huge memory to display the data. In
that case, the density plots are useful. In a density plot the data will not be filtered
out in the display (% point displayed) as in the case of a scattered point display. In
the cross plot properties window, there is a tab available for the . In that tab, a user
can set a number (currently displayed data) to display the data. When this plot is
ON, there will be a colour table displayed that can be changed. The colour spec-
trum designates the distribution of the points per pixel.

l Used to Toggle on/off the second Y-axis (Y2) scattered points. It may be noted
that when the second Y-axis (Y+) is selected to be cross plotted against Y1 and X,
the data points may become too large to be displayed. Therefore, in this case, the
system will prompt a warning to display a given percentage of the data (% points
displayed).

Crossplot selection toolbar

l Is inactive, if a cross-plot is created with one Y-axis. It allows to make
section of the scattered points. The selection settings (Select only Y1/Y2, both) are
important to remove unwanted points from the extracted data. When dual Y-axis
are cross-plotted, a user can select individual or both Y-axis points by changing
this option.

l Toggles a pan/selection mode. Selection mode is used to select the scattered
points. When pan is toggled on, rest selection options (see below) become inact-
ive, which avoids editing/manipulation of the cross-plotted data.

l Used to display the selected scattered point in an active scene. The selection
of the data points is done by using selection mode. By using this option, the selec-
ted scattered data can be saved as a pickset/body. Right-click on an pick in a
scene and from the pop-up menu select 'save as a pickset' or 'create body' option.

l Selection mode (rectangle/polygon). The selection is made by holding the left-
mouse button down and selecting the desired area within the cross-plot.
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l Used to de-select the selected data points (using selection mode tools).

l The unwanted data points can be removed by using selection mode and this
trash button. In order to remove the data points of Y1, Y2 or both, use selection
mode tools to select an area within which the data is to be removed. After that
press this button to remove the data.

l Used to select the data from a cross-plot and display the corresponding selec-
ted data in the spread-sheet (Well/Attribute data window).

l You can do multiple selections by adding new groups (see below). It is
launched using this manage selection button. The multiple group selection allows
you to select different clusters/trends on a crossplot in the form of groups. Second
and subsequent selections are made by clicking on a group name and holding the
CTRL key down from a keyboard prior. Then the corresponding polygon (with a
given colour) is drawn over the crossplot display area. It is a very useful tool for
reservoir prediction and characterization.

l This option is used to by using a mathematical logic over a range. It restricts
the selection according to the range set in the Refine Selection window (a pop-up
window invokes when this button is pressed). For instance, a user may want to
remove a data (x0) within a range of 3-4 from a cross-plot in which 1-2 values are
overlapping. To do that, press this button to launch Refine Selection window. In the
Enter Ranges field, an equation can be set i.e. X0 > 3 and X0 < 4. Where X0 is
desired data in a cross-plot. After this a section can be made within a cross-plot to
remove values within the polygon according to the equation.
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Cross-Plot Properties

The properties window (accessed via )can be used to adjust the scale, view stat-
istics, add regressing lines etc.

Scaling Tab: Sets the clipping state for each axis, or the amplitude range for the chart.
Default: 0, which means that the window is adjusted to fit the entire amplitude dis-
tribution.
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Statistics Tab: Shows the parameters of a least square fit between the attributes used
as X and Y1 (values and errors). The regression line can be displayed in the cross-plot
window, as well as the correlation coefficient.

User Defined Tab: Sets a user-defined regression line, that can be displayed as well in
the cross-plot window. A simple line can also be drawn in the cross-plot window, in
which case the corresponding coefficients will be displayed in this tab.

Display Properties Tab: Sets user-defined marker size, marker shape and the Y-axis
color.
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Density Plot Tab: This tab is used to set the minimum points for the automated density
plot. Scatter plots will not be allowed below that number. The tab settings define the bin
size prior to counting the number of occurrences.

The following pictures shows an example of density plot. Please note that an additional
colorbar has appeared. Units are the number of points that correspond to the color.
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Probability Density Functions

Probability Density Functions (PDFs) can be created from the cross-plot toolbar icon
. This icon launches a pop-up dialog that can be used for selecting attributes in order

to create PDFs. The PDFs are stored in OpendTect Format, that can later be used for
running Bayesian classifications.
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Please note that all attributes from the table can be selected. Attribute ranges are gen-
erated automatically to fit the extracted data distribution. These can be edited before cre-
ating the PDF.

Overlay from a Third Attribute

Scattered points can be coded with respect to the amplitudes of an attribute using that
option. The popup window requires the selection of that third attribute, and colorbar spe-
cifications (type and amplitude range)

Well-based Color Coding

The scattered points in the cross-plot window can be coded with respect to the wells
along which the data points were originally extracted. The following utility window can
be used to control the colour associated to each well:
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The configuration above gives the following result:
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Selection Settings

The selections made interactively in the cross-plot window can be further refined and
managed in this window.

The 'Refine' option ( )utilizes mathematical logic to restrict the selection according to
the range set in the Refine Selection window (a pop-up window invoked when this but-
ton is pressed). For instance, a user may want to remove a data (x0) within a range of 3-
4 from a cross-plot in which 1-2 values are overlapping. To do that, press this button to
launch Refine Selection window. In the Enter Ranges field, an equation can be set i.e.
X0 > 3 and X0 < 4. Where X0 is desired data in a cross-plot. After this a section can be
made within a cross-plot to remove values within the polygon according to the equation.
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The 'Manage Selection' option ( ) can be used to do multiple selections by adding
new groups (see below). It is launched using this manage selection button. The multiple
group selection allows you to select different clusters/trends on a crossplot in the form of
groups. Second and subsequent selections are made by clicking on a group name and
holding the CTRL key down from a keyboard prior. Then the corresponding polygon
(with a given colour) is drawn over the crossplot display area. It is a very useful tool for
reservoir prediction and characterization.

The selected scattered points can then be displayed in the active scene by clicking on
OK. This allows an interactive display of the cross-plot in a scene. The displayed points
(i.e. picks) can be saved in the OpendTect survey either as a Pickset or as a Body.
Right-click on any point in the display, it will launch a pop-up menu (see below).

l Properties: It can be used to edit the size of the points.
l Create Body: Create a Body from the selected picks.
l Save as Picksets: To store the selected points as a pickset.
l Remove selected points: Removes the selected data.
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You can do multiple selections by adding new groups (see below). It is launched using
this manage selection button. The multiple group selection allows you to select different
clusters/trends on a crossplot in the form of groups. Second and subsequent selections
are made by clicking on a group name and holding the CTRL key down from a keyboard
prior. Then the corresponding polygon (with a given colour) is drawn over the crossplot
display area. It is a very useful tool for reservoir prediction and characterization.

In the column name, a new name should be given that would be added in the crossplot
data table. Show selectedness as an overlay, if checked, would display the colour coded
selection ranging (between 0-1) as an overlay in the crossplot area. The colours rep-
resent the chosen colortable. Show selectedness in 3D scene would display the points
within the selectedness range in the 3D scene.

The user can manage the groups (or selections) by saving them (Save groups)

Furthermore, the user can also manage the groups (or selections) by opening (Open
groups) the saved groups.
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The Selectedness is a special data selection. It is a measure of how likely a point is to
be selected in a particular selection. If a point is present in and around the center of a par-
ticular selection that has higher selectedness values. Whereas those belonging in the
border regions are less likely to belong to that selection and thus it will have lower selec-
tedness values. It is a measure of which points are better representative of a particular
selection. The value of Selectedness ranges from 0-1. The points outside the selection
has undefined values. It is added as a separate attribute in the table and can be seen in
the form of an overlay attribute. To mark selectedness, one group is needed to be selec-
ted by using the selection mode.

Open Crossplot
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This option allows you to open previously saved or imported crossplot data and will dir-
ectly open the data in the crossplot table.

Wells
TheWells element in the Analysis menu gives you access to three features: Edit logs...,
Tie Well to Seismic... and Rock Physics...

Well Log Tools
The well log tools can be used to remove spikes, smooth and clip the logs. it can also

accessed by using the icon in the Manage Wells window. Multiple wells can be
selected at once along-with the various logs. The logs can be extracted between:

Markers: The bounding markers have to be specified. If necessary, the dis-
tance above/below these bounding markers (from where the actual extraction
of the logs is going to start/stop) can also be specified:
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Depth range: The logs can be directly extracted between a particular depth
range:

Time range: The logs can be directly extracted between a time window. The
extraction may be done in time domain by toggling on 'Extract in time'.

On pressing Go the extracted logs are displayed and 'smoothing', 'clipping'
and 'spike removal' can be performed on these well logs:
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Smooothing: A window size (samples) should be defined in which the
smoothing of the well log data will be performed.

Clip: Percentage Clip rate has to be defined.

Remove spikes: De-spiking of the logs can be done by specifying a window
size (samples) and the Threshold for the Grubbs algorithm. Further, the
removed spike values can be replaced by 'Undefined values', 'Interpolated
values' or can be manually specified.

Finally, the edited logs can be saved with an extension or can be overwritten.
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Tie Well to Seismic
Launch the Well-Seismic Tie window from the main menu or, optionally, the Well-Seis-
mic Tie window can be launched from the tree.

Well to the seismic tie is a major task for interpretation projects. It is used to correlate the
well information (logs) to the 3D seismic volume or 2D seismic lines. This enables the
comparison (crossplots, ...) of well-based and the 2D/3D seismic data.

Well-to-Seismic tie workflow:

1. Data preparation:
l Import the seismic volume or 2D line.
l Extract a wavelet.
l Import the wells: Each well requires a track, checkshot or time-depth curve and
sonic log.

l Import the additional data: 3D/2D Horizons, well markers, additional time-depth
curve if a checkshot was loaded.

l Edit the log database: Fill the missing sonic parts, create a density log from the
sonic (constant value or Gardner's equation) if not available.

2. Synthetic-to-seismic tie
l The module is launched from the Analysis menu or via the right-click menu of each
well.

l The input fields must be selected.
l Based on the available data the density and sonic logs will be combined into
impedance and reflectivity, depth-time converted (includes an upscaling) and con-
volved with the wavelet. The result is a synthetic seismic traces for the well. This
trace will be compared with a composite seismic trace extracted in the volume
along the (deviated) well path, on the nearest trace. Both synthetic and composite
seismic traces are cross-correlated, and the output value is an indication of the
alignment and matching quality.

l The alignment will be carried out either by shifting the synthetic trace up or down,
or by selecting several locations in both seismic traces, specifying and applying a
shift function that varies with the travel time.The applied changes must be
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validated, before being converted into a new time-depth function that replaces the
previous one. No changes are being applied to the well logs.

l At each step of the tie a deterministic wavelet can be estimated using the time-con-
verted reflectivity log and the composite seismic trace. This deterministic wavelet
should vary per well, and is known to link the well data to the seismic data more
reliably.

Well-Tie Selection Window

The tie well to seismic window is used to select the necessary data for the Well-Seismic
tie workflow. Please have a look at the introduction to see how to prepare the necessary
data.
Well tie can be used to tie the well with the 3D seismic volume or 2D seismic line.

Well to 3D seismic tie window
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Well to 2D seismic tie window

In both the 2D and 3D windows, there are additional features accessed via the following
icons:

l Opens the Calculate New Log window

l Displays the particular log in the log viewer

l Opens theWavelet Manager window

Well-Tie Checkshot Editor

In OpendTect, CheckShot corrections are applied before launching the Well to Seismic
Tie window. If you have no depth/time model or have not selected any existing one, you
will be proposed to correct the sonic integrated depth/time model, provided you imported
a CheckShot model for your well.
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The choices given are "None", "Automatic" or "Use editor". In the first case, the time
depth curve will be computed directly from the sonic log without any correction (note, this
is also the default mode if you do not have any CheckShot). In the automatic mode, the
time/depth curve will be calibrated to the CheckShot without any user interaction. In the
last case, you will be allowed to edit the calibration yourself using an editor window.

When clicking on 'Run', the 'Apply Checkshots correction' window pops up.
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The above window is divided in two panels. On the left one, the sonic 'Integrated
Depth/Time Model' (red) and the 'Checkshot Curve' (blue) are plotted. The right panel
displays the drift curves. The original 'Drift Curve' (red) shows the variations between the
CheckShot and the sonic integrated model.

By adding points to the right display you can additionally generate a new 'User defined
Drift Curve' (green). This is done by clicking the icon. Once this is done, select the
correction to apply, either from the Original or from the User Drift Curve and push the
Apply button. The newly computed depth/time model will appear in green on the left
panel. You can modify the drift curve and re-apply the corrections until you are satisfied
with the depth/time model. Push the OK button and the main well tie window will appear
using the new calibrated depth/time model.

Well-Tie Display Panel

The display panel is the main window where the wells are tied to the seismic data. This
module is primarly used to update the current (loaded) time-depth curve. Previous, inter-
mediate and final TD curves can be exported to ascii at any moment using the following

icon .

A secondary output of the synthetic-to-seismic tie is the estimated wavelet, that is estim-
ated at any time and must be saved explicitly.

The view is separated in three frames, from left to right:

l The sonic (red) and density (blue) logs.
l The computed impedance (red) and reflectivity (blue) logs.
l The computed/extracted synthetic and composite seismic traces.

The raw logs are shown before upscaling. The vertical axis of all 3 frames is

in travel time.

Key points:

l The time-depth conversion and synthetic seismic traces computation is done using
the current time-depth curve and checkshot (if available).

l The checkshot data acts as a strong constraint, i.e. any input and output time-depth
curve will be forced to honour the checkshot.

l The time of the depth TVDSD=0 will always remain at TWT=0 even when applying
a bulk shift: The difference is absorbed between the point TVDSS=0 and the first
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sonic log sample. The reference datum elevations definitions are summarized in
the well track import chapter.

Display panel for the well-seismic tie.

At the bottom right corner of this display panel, there are several tracking controls. The
options are used to pick an event to match the seismic and synthetic traces. After picking
the event, press Apply Changes to reflect the changes and update the time to depth
model.

Launches the Edit Time/Depth model window. In the pop-up window, press Export
button to export the time-depth model as an ASCII file.

Launches the save option.

You can either save the created logs:
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Or save the synthetic trace as a seismic volume.
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Takes the snapshot of the display panel

Display settings/properties for the panel. The settings are similar to that of the nor-
mal 2D-viewer model

Zoom-in

Zoom-out

Toggles interact mode ON/OFF
Pick seeds on the seismic or synthetic to update the time to depth model.

Change in depth/time model
l Choose a tracking mode (e.g. maxima, minima, zero-crossings etc.) and select
events in the synthetics/seismic displays by first selecting the Pick mode button.
Events can not be picked separately. Each event in the synthetics must be linked
with an other event in the seismic.
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l Once all the events are selected on both synthetics/seismic displays, press Apply
changes button. The depth/time model and the whole computational workflow will
be recomputed. If needed, repeat the operation.

l The Display additional information button will open the Cross-checking parameters
window, and provide useful cross-checking tools, such as correlation coefficient
and estimated wavelet in a specific depth range. The estimated wavelet displayed
here can also be saved:

l

l The depth/time table can be saved between each state by pushing the Save but-
ton, in the toolbar to the right of the synthetics/seismic displays, and saving with an
appropriate name. The View/Edit Model button allows the user to import a depth/-
time table.

l Once a good correlation has been established, click on Ok/Save and save the
depth/time model.

Well-Tie Crosscheck Parameters

The cross-checking window is launched from the well ties display panel (Section- Well
Tie: Display Panel) by clicking on the Display additional information button. The window
contains the initial and estimated wavelet information. The wavelet can be computed
between the two levels (start-end of data in time/depth or markers) that are provided at
the top of this window. The window contains further key information: wavelets plot and
the correlation coefficient. By changing the compute data between option, the correlation
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coefficient is auto-updated, this is done by using either Markers (Default) or Time/Depth.
After achieving a high and positive correlation coefficient, the estimated wavelet can be
saved. Importantly, the negative correlation coefficient shows that the polarity of the
estimated wavelet is reversed. To avoid that the reference/initial wavelet's polarity has to
be reversed.

Check-crossings window and correlation panel

To save the estimated wavelet, press the icon in the well tie main window .

The wavelet properties ( ) can beshown as a graphical display of the wavelet, its amp-
litude spectrum and phase spectrum.
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Save the estimated wavelet

The user can also click on to open a slider interface for shifting phase of the wave-
let:

Rotate Wavelet: Using the slider, the user can edit the phase of a wavelet.

Taper Wavelet: This option enables the user to taper a wavelet by clicking on . The
User will see the real-time changes in the amplitude spectrum.
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Layer Modelling
Pseudo-wells are stratigraphic columns with attached well logs, but without geo-
graphical location. Any pseudo-well can be seen as a possible realization of a newly
drilled well in the area. The pseudo-wells generation is achieved following a model that
has to be defined. To achieve Layer Modeling, preliminary an extended well data
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analysis has to be carried out. The stratigraphy must be defined and then the well logs
behavior have to be known in order to be used in the modeling.During the modeling pro-
cess, the stratigraphy description is fixed and cannot be edited.

The Layer Modeling is accessible from the Analysis menu but also from the Manage
Stratigraphy window.

Basic modeling can be achieved in OpendTect. More advanced modeling are available
in SynthRock plugin.

The Layer modeling workflow is divided into three main steps:

1. Model definition: using the stratigraphy description, properties are
assigned to the different lithologies within each units. These properties are
fixed or can vary. The model definition is used to generate the pseudo-wells.

2. Synthetic and Log generation: the pseudo-wells are generated and their
associated properties can be displayed. With a wavelet extracted from the
real seismic, zero-offset synthetics are generated. Using a ray tracer syn-
thetics can be computed for different offsets and restricted angle stacks can
be created. Thus their behavior with varying offset can be analyzed.

3. Pseudo-well data analysis: the properties from modeled logs and synthetic
seismic can be compared and analyzed layer by layer, lithology by lithology.
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Example of a basic blocky model

Basic Modelling - Introduction
Each layer in the stratigraphy column is characterized by different rock properties. The
model, based on the stratigraphy, is assigning properties to each lithology, layer by
layer. The model is built using a blocky approach. The different properties are selected
within a list. Their value can either be constant or vary within a given range.

Layer Description
First of all, the Layer Succession has to be defined and will be used to create the
pseudo-wells.
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Layer Modeling Window (in red : Layer Description elements)

To start defining layers properties, the user has to click on "click to add" on the left rect-
angle. Once one layer has been defined, click on Ok and the layer appears in the left
rectangle. To add a layer, click-right on the rectangle and select "Add above/below": you
can then define a new layer. "Edit Layer" is also accessible from this right-click menu.

The description can be saved in clicking on the icon and later be accessed in click-
ing on the icon.

1. First of all the properties to be defined for the modeling have to be selected
within a list. The properties in the list have been defined in the Layer prop-

erties Manager which is accessible from the icon and can be edited.
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The selection can always be edited in clicking on the icon . To be able to
generate synthetics, Density and Pwave velocity are selected by default. For
the moment, it is not possible to combine properties together. So for example
to get the Acoustic Impedance, you have to model the Acoustic Impedance
log.

2. The Layers have been defined in the Stratigraphy Manager. To each litho-
logy of each layer are assigned properties and if within the survey this prop-
erty is expected to remain constant or to vary within a given range. The
thickness of each layer can also stay constant or be varied. The variation is
linear.
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The thickness is a default property. When defining a thickness range, the
starting thickness can be set to a negative value: it will appear as a truncta-
tion in the pseudo-wells.
The fluid content can also be specified.It had to be specified previously in the
Content manager.

When clicking on OK, the Layer Description will appear on the left rectangle. To edit the
properties of one or more layer, just click on it.

Synthetic- and Property-Log Generation
The property logs of the pseudo-wells only need the Layer Description to be created. To
generate synthetic traces for each pseudo-well, three elements have to be provided:

1. To generate the synthetics: Wavelet
2. To generate synthetics for a range of offset :

l Ray tracer parameters
l Layer properties: The density, P-wave and S-wave have to be given, com-
puted or derived from other quantities that have been modeled.
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Once the Layers are defined, the parameters to generate the pseudo-wells must be
defined (red rectangle)

The pseudo-wells are generated when clicking on Go, in the lower left side of the win-
dow. The number of pseudo-wells to be generated is user-defined.

Synthetic Layer Properties

The synthetic seismic generation requires different quantities : Density, P wave velocity

and S wave velocity. These quantities can be specified in clicking on the icon : they
can be computed using formulas and the appropriate modeled quantities. If the quantity
has been modeled, it can be used as Defined quantity .
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Possibilities to compute the layer properties

Wavelet

The wavelet can be selected from the one already available in the project and listed or a

new one can be created in the Wavelet manager accessible from the icon .

Some workflows need to have the synthetic with the same amplitude that the real seis-
mic. The purpose to the scaler is to scale the wavelet by comparison between the syn-
thetic seismic computed at a given horizon and the real seismic extracted in a defined
time window regarding this same horizon. To do so click on Scale.
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First of all you need to select your reference seismic as Input Cube, then the reference
horizon for the extraction of the real seismic data. The reference for the extraction in the
synthetics is the reference stratigraphic level selected in the main window. The extrac-
tion must be done at a level interpreted in the pseudo-wells and in the real seismic. It is
possible to restrict the extraction to an area defined by a polygon. Also the reference
level in the pseudo-wells does not necessary correspond to a specific event in all the
wells, on the contrary horizons are most often interpreted following a same event. Thus it
is possible to snap the synthetics to a specific event. Finally the extraction window
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around this reference level has to be specified. It will depends on the thickness of the
interval of interest of your data. Once all these parameters have been given, you can
extract values.

The histograms for the synthetics and the the real seismic are displayed side by side to
be easily compared. A same pick is identified in the two cases and the difference
between the two amplitude values is used to determine the scaling factor. The scaled
wavelet can then be saved and used afterwards.

Ray Tracing

The ray tracer, available via the icon, allows the creation of synthetics for different
offsets and to perform different angle stacks. The source/receiver depths have to be
provided. The offset range has also to be specified. The arrival times are calculated by
ray-tracing through a horizontally layered isotropic earth model.
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Ray Tracing parameters in the simple and advanced mode

In the advanced mode, the surface coefficient can also be defined if known as well as
the spreading geometry.
When pressing Go , the synthetics for different offsets are computed. The view is set to
be Free view by default, you are then able to display a single offset or a limited offset
stack in ticking the Stack option.

When one offset is displayed, it is possible to make the offset vary from a given Step

using the arrows .

From the icon , it is possible to display the gathers for the different models.

For further information, please refer to Appendix E - Synthetic Data Generation

Display

There are several display options within the Layer Modelling feature:

• By default the property logs are displayed regarding the block. When

toggled on the icon, the representation is one color per lithology. The
property displayed is selected in the selection menu in the lower part of the
window.

• When the icon is on, if the user zoom on the synthetics, it will not affect
the property logs view. The icon is on by default.

• The stratigraphic level is a marker. The marker position has been modeled
and so its position within the pseudo-well can be displayed. In the real wells,
markers come from the log data and geological information. It does not neces-
sarily correspond to a given seismic event. On the synthetic from the pseudo
wells, it is possible to snap a selected marker to a seismic event (pick,
trough, zero-crossing...). This has to be done carefully as some information
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can be lost: there may be lateral variations of the rock properties that may
impact on the phase of the seismic.

• Synthetics display parameters are accessible when clicking on
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The "Wiggle Variable area" section concerns the display of the synthetic log
itself. The "Variable density" section concerns the background, i.e the inter-
polation between the synthetic traces.

Layer Properties

Once the simulation has been run, the pseudo wells will have been generated and these
well properties are then displayed in the lower section. The synthetics are also gen-
erated and display in the upper half of the window. When clicking on a given pseudo-
well, a line appears to show the selected pseudo-well and right-clicking on a particular
layer of this selected pseudo-well gives a menu to various options.
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For this selected pseudo-well, the Properties... option gives access to the characteristics
of this specific layer in term of thickness and modeled properties. In the layer-based mod-
eling (basic or stochastic), these values can be manually modified. The fluid content can
also be edited. Changes are saved when clicking Ok and the display is automatically
updated.

In the SynthRock plugin, in the Profile mode, a similar window is available on right-click-
ing on any trace on the lower rectangle where a selected property is displayed for the dif-
ferent pseudo-wells. In selecting Inspect values, the window opens. In this case it is an
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informative window: the different property values can not be changed. The fluid content
however can be edited. The lithology in this case is unknown as it is based solely on
well log(s).

Remove Layer

The existing layers of a model can be removed at any time, by right clicking on the left
hand side pane, containing the simulation information.

Thereafter, the regeneration of the pseudo-wells can be done by clicking on .
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Export Synthetic Datasets

The synthetic seismic data (both post-stack and pre-stack), the layer property synthetics
in Time (e.g. AI, Density etc.) and the stratigraphic levels/markers, from all modeling mod-
ules (i.e. Basic, Profile and Stochastic) can be exported along 2D lines. The stratigraphic
levels/markers in the modeled pseudo-wells are essentially exported as 2D horizons.

This is achieved by clicking on the icon at the top right of the modeling window (see
below).

Export of the synthetics can be done onto an already existing 2D line or a new line cre-
ated on the fly.

Selecting an existing 2D line

If the 2D line is created on the fly, the Geometry for line has to be defined as well. It can
be done by defining a straight line between two X-Y coordinate pairs.

Creating a straight 2D line between two X-Y coordinate pairs
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The 2D line can also be created, on the fly, along an existing polygon.

Creating a 2D line along a polygon

Finally, the 2D line can also be created along an existing random line.

Creating a 2D line along a random line

Now, a selection on post-stack data, 2D horizons and pre-stack data can be made for
exporting along the 2D line.
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For post-stack data, user can select synthetic seismic and various layer property syn-
thetics (e.g. Acoustic Impedance, Density etc.).

Post-stack data selection for export

Similarly for 2D horizons, various levels present in the pseudo-wells can be selected.

2D horizon data selection for export
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and finally (if any) pre-stack data can be selected.

Pre-stack data selection for export

Optionally, a prefix and/or postfix can be specified for various data items. Pressing Ok
will export the selected data items along the 2D line.

Cross-Plots

The cross-plot tool in the Basic layer modeling can be started from the icon . It
allows to analyze seismic and layer attributes from the modeled data. On the main win-
dow, the user select the attributes to be extracted and the extraction parameters.The
extraction window is related to a reference level. Its length is user-defined. The appro-
priate extraction window size has to be defined regarding the interval of interest. The
user has to provide a step that corresponds to the sample rate within the extraction win-
dow.
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Once the attributes and the extraction parameters defined, the crossplot window opens
and is similar to the one available for the classic seismic/well analysis.

Wavelet Scaling

If the wavelet has not been scaled to the real seismic, a pop up window will first appear
prior to access to the attribute selection window.
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The user has 3 choices :

• [Start tool] to start the Scale wavelet window
• [Mark scaled] if the wavelet is considered as scaled or does not need to be
scaled
• [Ignore] if the attributes that are going to be extracted will not need a scaled
wavelet

Once the wavelet is scaled or marked as scaled, it will be remembered and the window
will not appear again.

Seismic Attributes

The seismic attribute selection/definition is comparable to the main attribute window: the
same attributes are available. An attribute can be selected in the list of Available types

and add to the Defined attributes using the button. The parameters of the attribute
have to be specified. Synthetic seismic generated from the models can be used as input
data. All the listed attributes are not necessary using synthetic seismic.

Layer Attributes

For each modeled property, data can be extracted either along the log using a defined
extraction window or by layers:
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• Sliding: the property value is extracted within the extraction window where
a calculation window slides along the well. The size of the calculation win-
dow is defined by the step provided by the user on the first crossplot window.
The output is the nearest sample, the average, the median, the RMS or the
most frequent. At the end the attribute has [number of pseudo-wells* round up
(Extraction window size/Step)] samples.

• Integrated: Different lithologies have different properties. In the Layer
Description, the behavior of each lithology has been defined for the mod-
eling. The modeled properties can then be extracted and easily compared
with the crossplot tool. Each modeled property can be extracted at the dif-
ferent level of the framework, for one or more lithology of one or more layer.
One value corresponds to one model. The output will be the average, the
median, the standard deviation, the minimum or the maximum of the extrac-
ted data for each model. The number of sample depends on the step and the
thickness of the extraction block. The thickness of the block may vary from
one pseudo-well to another depending on the model definition. Thus the num-
ber of sample can vary from one pseudo-well to another. For one attribute,
the number of sample is equal to the sum of the round up (Extraction block
thickness/Step) of each pseudo-well.
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In both case, it is possible to transform the attribute value in applying the function power,
log or exponential. The attribute is extracted on each pseudo-well.
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Processing

Create Seismic Output
The Create Seismic Output option leads to a number of further choices, detailed in the
following subsections:

Attributes
In this module any (attribute) volume can be calculated and saved to disk. In case of 2D
attributes, the output is a new data set. The volume output module can be run in batch
mode, allowing to continue working in the main window while the processing is running.

This module creates, for example, attribute cubes, neural network cubes, or filtered data
cubes.
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2D - Create Output

A data set attribute can be created through the following procedure: Processing > Create
Seismic output > Attributes > Single Attribute > 2D

First, Select the output quantity : it can be either a stored 2D volume or an attribute from
the active 2D attribute set.
Note that only attributes from the current attribute set can be selected in the "Select
quantity to output" window. To output an attribute from another attribute set, you must
select this attribute set in the attribute module.

Though the default is set to 'All Lines ', a selection of lines can be specified by clicking
'Select':
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Optionally, the output can be scaled with a Shift and a Factor:

Output = Factor * Input + Shift

Null traces can be discarded.

It is also possible to choose between Single Process and Multi-Job/Machine processing:

And to set the job priority (if deemed necessary):

3D - Create Output

To create a 3D seismic output from an attribute, follow the path Processing > Create
Seismic Output > Attributes > Single Attribute > 3D.
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First, Select the output quantity. Optionally, a sub-volume can be specified.
Note that only attributes from the current attribute set can be selected in the 'Select out-
put quantity ' window. To output an attribute from another attribute set, you must select
this attribute set in the attribute module.

Null traces can be discarded.

It is also possible to choose between Single Process and Multi-Job/Machine processing:

And to set the job priority (if deemed necessary). This is equivalent to the 'Nice level' on
Linux, determining how much priority the process will take on the remote machine:
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Optionally, the output can be scaled with a Shift and a Factor:

Output = Factor * Input + Shift

Storage:OpendTect can store data internally in 8-, 16-, 32-, and 64-bit seis-
mic data formats. 8-bit signed has a data range between -127 and +127. 8-bit
unsigned ranges between 0 and 255. Similarly, 16- bit signed ranges
between -32767 and +32767 (unsigned 0 - 65535). The data is stored in the
same byte-format as the input by default (Storage is set to 0 - auto). This is
chosen when specifying the Format/Scaling.

Adjust Z range to survey range: this option adjusts the new scaled seismic
to the survey range.

Optimize horizontal slice access: For better performance when loading
time slices, set this option to 'Yes'. This compromises some speed in loading
crosslines, but it loads time slices significantly faster.

Processing: OpendTect batch jobs for 3D volumes can be processed on a
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single-, multiple machines, or Clustering. For more information look at batch
processing.

Multi Attribute

Multi-attribute output enables the user to create a volume with several attributes. 'Avail-
able Attributes ' lists all possible components of the possible multi-attribute output and
any combination can be selected. Once moved across into the 'Selected Attributes' list,
these attributes are processed into a single volume.

It is not necessary to check the boxes next to the attributes in the Selected

Attributes list in order for them to be included in the output volume. All attrib-

utes in the 'Selected' list are included by default.
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Also note that a Spectral Decomposition attribute will show a list of all pos-

sible outputs in the 'Available attributes' field:

On loading the volume onto an inline (for example), the user is prompted to select which
of the available attributes he wishes to use:

The component of the multi-attribute cube that is actually being displayed in the scene is
appended on the volume name in the tree:
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Multi-Cube Data Store

Multi-components cubes for some attributes (e.g Spectral Decomposition, Steering attrib-
utes) can be created.

First, create your attribute in the attribute engine.

Create the volume output: Go to Processing > Create Seismic Output > Attribute > Multi-
cube data store and select a volume that contains multiple components (here, Spectral
Decomposition as example):

Select a component of the cube and assign it a 'pseudo-offset' value. Repeat this pro-
cess of pseudo-offset assignment for all of the components that you wish to be present in
the output, name it and press 'Go'.

Multi-component cubes can be exported as SEG-Y or simple ASCII file but only one com-
ponent per output. The choice of which component is given to the user during the export
process.
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How to display the Multi Component Volumes?

Whenever displaying a multi-component attribute volume on an inline/crossline, the com-
ponent selection dialog box (below) will pop up. In this dialog one or more outputs to be
displayed on the same section must be selected.

Once several components are selected and displayed for an element (e.g. an inline),
place the mouse in the scene, and use the keyboard's PAGE-UP/PAGE-DOWN keys to
view the next/previous slice in real-time.

Along Horizon

To create a seismic output in a time interval relative to a single horizon, the quantity to
output has first to be selected from the list of stored data or attributes from the current
attribute set. Specify the horizon and the Z interval relative to this horizon. A sub-area
can be specified.

The Value outside the computed area is the undefined value. The standard undefined
value in OpendTect is 1e30, but any other value can be specified.

Optionally, the horizons can be interpolated. The interpolation can be full or partial.

A calculation parameter file is automatically created with a default name in the Store Pro-
cessing Specification field. This file allows to re-start the calculation process easily if
needed. The 'Execution Options' can be set to use either single or multiple machines pro-
cessing.
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Between Horizons

To create a seismic output between two horizons, first the quantity to output has to be
selected from the list of stored data or attributes. Specify the horizons that form the upper
and lower boundaries of the output volume. A Z shift to be specified can be applied to
the upper boundary and/or to the lower boundary. A sub-area can be specified.
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The Value outside the computed area is the undefined value. The standard undefined
value in OpendTect is 1e30 or Undef, but any value can be specified.

In Extra options, horizons can be interpolated. The interpolation can be full or partial.
When partial, only the gaps smaller than a user-defined number of traces are filled. A
fixed Z interval length can be added to the leading horizon when the second surface is
missing or in case of conflict during the interpolation. To constraint the interpolation, the
Z limits for the output cube can also be specified.

For 'Execution Options', please see: Batch Execution

2D to 3D Conversions
There are several ways to convert data between 2D and 3D:
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Create 2D Grid

The Create 2D from 3D option is an interactive tool for creating 2D-lattices from a 3D
volumes.

This option can be used to create a 2D grid with a fixed grid spacing. When selected, the
Create 2D Grid window is launched (see below). Here, specify the input 3D seismic
volume and the output data set name. The output grid is generated according to the dip
(parallel) and strike (perpendicular) direction of the selected volume. The prefix labels
are used as prefixes to the output line names, stored to the specified new data set name.
The grid spacing is the constant spacing between the two lines. At the bottom, the total
number of parallel and perpendicular lines will be updated according to the grid spacing.
By pressing Ok, a batch process will start to generate the 2D grid. When the batch pro-
gram is finished, the lines and data can be displayed in the scene

• Input Cube: 3D seismic data for conversion into 2D line-set.
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• Volume Subselection: Restricts the extent of the 3D volume (optional). Choose
inline/cross-line/time ranges for the selected volume.
• Create Grid from: Define the output grid geometry and orientation of the 2D lines. If
Inl/Crl is selected, the inline/cross-line orientation (or geometry) of the selected 3D data
will be used within the defined inline/cross-line/z-range and corresponding steps. Option-
ally, the inline/crossline range can be edited manually by using loosely spaced
inline/cross-line numbers separated by commas.

Another option is to define the 2D grid geometry based on a Random Line. The grid can
be created both parallel- and perpendicular to the direction of the random line. Set the
fixed spacing in the line spacing(m) fields.

• Prefix: Label the 2D-line names.
• Output Data Set: Output for the 2D line-set. Provide a name for the line and the seis-
mic data (attribute).
• Extract Horizons: Convert existing 3D horizons into 2D horizons by checking the box
(optional). In the Select horizons list, select one or more horizons and, if desired, set a
prefix for these selected horizons.
• Execution Options: Launches the 'Batch Execution Parameters' window and gives
the option to execute the job remotely:
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Extract 2D from 3D

Extract 3D data onto selected 2D lines. Input data is required in the form of a stored 3D
volume. One or more 2D lines can be selected for the 3D data to be extracted onto. The
output data set requires naming:

If just one line is selected, you may also sub-select a trace range.

Angle Mute Function
This module creates angle-based Z-Offset functions from velocity volumes. The primary
input is a velocity model that provides the time-depth relation.
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If you have no velocity volume available, click 'Create '. This will bring up a
window in which you can select a volume and tag it with a velocity type:

Vertical 1D ray-tracing is performed assuming a fully flat, isotropic earth model. The
travel-time 0ms corresponds to the depth of the Seismic Reference Datum, defined in the
survey definition window.
The offset range must be provided since the angle mute computer is not aware of any
prestack datastore. It does not necessarily need to match the prestack data. The output
function will have one point at the start and stop of the Z range, and one point at each off-
set specified by the offset range parameters.
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The main output parameter is the incidence angle in degrees at which the mute function
must be computed. By default the functions will be computed on a relaxed grid, every
20th time the inline/crossline stepout. This can be changed by selecting other "Volume
subselection" parameters. In general it is not necessary to decrease that stepout.

Advanced Angle Mute Paramaters

The ray-tracing can be performed in two ways:

• Simple: The ray is going directly from the source to the depth of the target layer, and up
to the receiver in the same way. This does not account for ray bending, or velocity inver-
sions.

• Advanced: Will honour the ray bending according to Snell's law and thus velocity
inversions as well. To reduce the processing time, the layers may be blocked: Con-
secutive layers with similar Vp, (and density, Vs if present) values are concatenated
together. The ray is propagated in a straight line inside a concatenated layer.
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Bayesian Classification
Bayesian classifications are used to link several attributes based on one or several Prob-
ability Density Functions.

First, one or several PDF(s) need to be provided.More will allow to select more PDFs.

After clicking on Next >>, the PDF(s) can then optionally be normalized based on a priori
weights per PDF. The a priori weights can be provided by attribute volumes which will
vary at every sample location.
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The processing will be based on (inverted) stored volumes that should correspond to the
variables used for generating the PDF. Please note that OpendTect cannot make this
check.

If only one PDF was used as input, the Bayesian classification volume will generate two
volumes:

1. A probability volume "P:PDF name"
2. A determination strength volume, mainly for QC.
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If more than one PDF were used as input, the Bayesian classification volume will gen-
erate:

1. A probability volume "P:PDF1 name"
2. A probability volume "P:PDF2 name" (one for each input PDF)
3. Two classification volumes : Class (with the most likely class) and Confidence (the dif-
ference between the two most likely)
4. A determination strength volume, mainly for QC.

Create from Well Logs
The Create seismic output from wells option writes loaded logs as seismic volumes.
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The dialog is accessed from the Processing menu in the main toolbar; choose the
Create fromWells.. option.

Select the well(s) in the left and the log(s) in the right list, note that several wells and logs
can be selected at once.

The log extraction can be done either between markers or by selecting a depth range.
For the latter, select start/stop depths in meters. For extraction between markers select
the wanted markers and add distance above/below (optional) for including intervals
above and/or below the marker depths.

The logs need to be resampled in order to display correctly on seismic sections and
volumes. Choose a resampling method from the dropdown list:

• Take Nearest Sample
• Use Average
• Use Median
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• Use RMS
• Use Most Frequent

Next, choose how many traces should be duplicated around the well track. Essentially
this will determine the dimension and geometry of the output cube. Finally give a name
(suffix) to the CBVS volume (seismic volume), the volume itself will automatically be
named according to logs selected in the list.

Pre-Stack Processing
Prestack processing can be applied using different methods. It is the only place where
pre-stack data can be output in OpendTect based on another pre-stack datastore.
Open the Pre Stack processing window: Processing > Create Seismic Output > Pre-
Stack Processing

The processing can be done by a number of sequential steps. Either select a pre-
defined set up (as above, which may be further 'Edit-ed') or press 'Create'...
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Which brings you to the following window...

To use a preprocessing step, select it in the preprocessing methods and click on Add. It
will then be listed in the used preprocessing methods, click on Properties to define the
step parameters. Move up or Move down to change the preprocessing steps order for the
processing.

The following sections describe the available different steps.

Mute

Mute functions may be applied to Prestack gathers . This window will allow you to
choose the mute definition, as well as to specify settings such as:
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l Mute type:Outter (top) or Inner (tail)

l Taper length (in samples)
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Automatic Gain Control

Automatic Gain Control (AGC) is one of the processing methods available for Prestack
gathers. It will adjust the amplitude level using a sliding window of user-defined size
(window width). Optionally, part of the lowest energy may be discarded from the amp-
litude level computation (in percent of the amplitude distribution).

Super Gather

A Super Gather may be used to laterally stack the traces in order to increase signal-to-
noise ratio of Pre-stack gathers. The stack is controlled by an inline/crossline stepout,
and the Shape (Cross or Rectangle). The computation is similar to a (non-steered)
volume statistics attribute with a zero time-gate.

Angle Mute

This processing method computes and applies a mute function. See the processing
method documentation. The only difference is that this method reads the offset range
from the input prestack datastore, such that there is need to specify it. See here where
and when the input velocity source needs to be edited.

The application of the computed mute function is strictly identical to the application of a
stored mute function.
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The ray-tracing can be performed in two ways:

• Simple: The ray is going directly from the source to the depth of the target layer, and up
to the receiver in the same way. This does not account for ray bending, or velocity inver-
sions.

• Advanced (not in the GPL version): Will honour the ray bending according to Snell's
law and thus velocity inversions as well. To reduce the processing time, the layers may
be blocked: Consecutive layers with similar Vp, (and density, Vs if present) values are
concatenated together. The ray is propagated in a straight line inside a concatenated
layer.
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SEG-Y Scanned Re-Sort
The SEG-Y Scanned re-sort uses a scanned SEG-Y file and outputs it as a new file and
re-writes the file-header. This tool is useful in case information in the header is poor or
poorly sorted.

In the Type field select the type of volume, either Pre-Stack or 3D volume.

Next, select the scanned input file and optionally area sub-selection. Note that a SEG-Y
file must be scanned prior to resorting. Choose a name for the output file and (optionally)
restrict the number of inlines to be written per file. In case the latter option is used, mul-
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tiple files will be written to disk, either using sequential numbers or the inline ranges
included in the separate files.

Velocity
Under 'velocity' sit two velocity-based conversion options:

Time-Depth Conversion

To create an time-depth converted output, follow: Processing > Create Seismic Output >
Time-Depth Conversion...

Time-depth conversion is done by applying Dix's equation, based on a interval- or RMS
velocity volume. A velocity model and input time volume must be provided, and the dir-
ection of the conversion has to be set.

It is also possible to convert from Depth to Time. Instead of an input Time volume, a input
Depth model has to be provided.
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Velocity Conversion

This tool is started from Processing > Create Seismic Output > Velocity conversion. It
can be used to convert interval velocity volumes to RMS velocity volumes and vice
versa. The conversion is applied using Dix's formula. Please note that for this reason it
can only be applied in the time domain.

Volume Builder Output
Volume-builder creator window can be launched from Processing > Create Seismic Out-
put > Volume Builder. It is used to create the output volume that has been defined in a
volume builder setup. Optionally, if the initial volume builder setup is not defined, press
the Edit button to define the setup. Press 'Ok' to launch a batch processing window.
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Create Horizon Output
This menu is used to create 2D/3D-grid based output. The data is stored as horizon data
(or attribute) to the selected horizon.

Attribute
Some attributes consume significant calculation time e.g. curvature, spectral decom-
position etc. It also depends on the size of the input seismic volume. Therefore, to create
on-the-fly a horizon data in a scene may take significant time. Following Processing >
Create Horizon output > Attribute (2D or 3D), the attribute calculation is there processed
in the background (batch processing) and thus other tasks can be done at the same time.
By using a Horizon output, horizon attributes can be created at desired horizons inde-
pendently.



- 533 -

Select the quantity to output (2D/3D) from the list of stored data or attributes. The attrib-
ute is (by default) saved with its own name, but it can be edited. Select the horizon on
which the selected attribute will be calculated.

The parameter file, which is automatically created in the Store Processing Specification
field, can have any name (a default name is provided) so that the calculation process
can be easily re-started if needed. The batch processing can be achieved using a single
or multiple machines. More information on this window is provided in single machine
batch processing section. After the batch processing is finished, the result will be avail-
able as a horizon data: right-click on a blank horizon's attribute in the tree to select the
horizon data (Select Attribute > Horizon Data).

If the option for 'Fill undefined parts' is toggled on, then the 'Settings' button can be used
to enter the interpolation settings:

For the 'Execution Options ', please refer to the following topic: Batch Execution Para-
meters

Stratal Amplitude
Stratal Amplitude is a processing tool available to compute statistics (min, max, rms, etc.)
from an attribute along a horizon or between two horizons. The window can be launched
from Processing > Create Horizon output > Stratal Amplitude. The output will be stored
as horizon data (grid) saved on the top or base horizon.
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This feature operates based on a single-trace calculation only (ie: no step-

out). For multi-trace calculations (using step-out), you are advised to use the

Volume Statistics attribute.

In this window, select the input attribute from which the values will be extracted. The
extraction may be guided by a single horizon (Single Horizon) or between two horizons
(Double Horizon).

Single Horizon is used to extract amplitude along a horizon within fixed win-
dow relative to the pick.

Double Horizon is an option of amplitude extraction between two horizons.
In this case, the Z-offset parameters (see below) may be defined to increase
or decrease the area defined by the horizons.
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Z-offset is the offset window specification above (negative values) or below
(positive values) a horizon to restrict or extend the calculation interval. For
example:

Settings to extract the average amplitude between 16 and 24 ms above ('-'
values) the selected horizon.

Settings to extract the average amplitude between 8 and 32 ms below (for
positive values there is no need to prefix with a '+' sign) the selected horizon.



- 536 -

Settings to extract the average amplitude 8ms equally around the selected
horizon.

Area subselection is used to specify the area within which the attribute is
output.

Amplitude options are the available statistics for amplitude extraction. Five
amplitude statistics are available: Min, Max, Average or RMS and Sum.

Output fold as an extra attribute optionally outputs data fold, i.e the number
of point used for the processing, as separate horizon data.

Isopach
In OpendTect isopach maps can be quickly calculated. The Create isopach window is
launched either from the Processing > Create Horizon Output > Isopach or from the right
click menu of any horizon loaded in the tree: Workflows > Create Isopach. In this win-
dow, select two horizons between which the isopach has to be computed. The isopach
map will be saved as a horizon data of the first selected horizon in the window or the hori-
zon .
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(Re-)Start Batch Job

Batch jobs in OpendTect are stored under a job name in a file containing the inputs, para-
meters, log file and other relevant information. This information can be read by clicking

on the 'Information' icon, :
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Jobs may also be removed using the icon.

Batch Execution: The batch job may be executed as a Single Process or as a Multi-
Job/Machine Process. When opting for 'Single Process ', the user may use his local
machine or choose to send the whole job to a remote machine for processing:



- 539 -

'Execute remote' toggled on to send the job to a remote machine. The job priority can be
changed (-19-lowest to +19 highest).

Multi-Job/Machine option. Selecting this options brings up the Multi-Machine Processing
window.

If a job is selected that was created in OpendTect prior to the 5.0 upgrade, a

warning will pop-up, stating "Pre 5.0 Job". These jobs can not be (re-) pro-

cessed. Attempting to do so will bring up the Error message: "Can not run

selected job".

GMT
GMT (Generic Mapping Tools) is an open source collection of more than 60 tools for
manipulating Geographic and Cartesian data sets. It can produce Encapsulated Post-
script File illustrations ranging from simple x-y plots, via contour maps, to artificially illu-
minated surfaces and 3D perspectives views. OpendTect supports an open source
plugin that uses GMT tools to create scaled maps.

For more details please visit the official GMT website.

http://gmt.soest.hawaii.edu/
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Initial Setup
To launch GMT tools, click on the icon in the OpendTect main toolbar. The first time
you launch the GMT mapping tools, a warning message will pop up, if GMT is not
already installed on your computer. This can be downloaded from the GMT website.

After successful installation of the package, the GMT user interface will be launched:

GMT User Interface

Create Postscript Maps
Several tabs have been arranged to specify the respective settings. The later part of this
section shows a typical OpendTect example of a postscript map.

http://gmt.soest.hawaii.edu/
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l Basemap: This tab is used to set the scale of the map and other map
settings.

l Contours: It is used to create a horizon contour map.

l Faults: It is used to post the intersection of faults with constant times or
the intersection with a surface.

l Wells: It is used to post wells in the map.

l Locations: It is used to post pickset data in the map overlay.

l Polyline: It is used to add polygons (e.g. lease boundaries) in the map
overlay.

l Random Lines: It is used to post Random Line(s) in the map.

l 2D Lines: It is used to post 2D-Line(s) in the map.

l Coastline: It is generally used to draw coastal lines.

l Clipping: It is used to set up polygonal clip paths.

l Advanced: It is used to use customized GMT commands.

For all the sections it is possible to Reset the parameters and thus go back to the default
ones. For all the section (except Basemap), Add will add the defined object to the map
overlays and Replace will update it if the object has been previously defined.

In the Map overlays are listed all the elements that have been defined to be displayed on

the final Basemap. You can modify the order in using the icons or remove an object

using the icon. The map will be created only when clicking on Create Map.

Basemap settings
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The basemap tab is filled with default parameters including the X/Y range from the Sur-
vey setup. You can go back at any point to the default X/Y range in clicking on Reset to
Survey.
The map can be renamed. The scale can be modified. Scale, map width and height are
linked : any change of the scale, map width or height will affect the other two parameters.
The label interval can be also be modified. The grid lines can be shown if you toggle on
Draw Gridlines.Optionally you can also add Remarks.
Once the different parameters defined, give an appropriate name to the output file and
specify the disk location and press Create Map button. View Map will display the map.

Create a Contour Map
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In Contour Map tab, first of all, select the horizon on which you want to create contours.
The different parameters are then filled by default. It is possible to edit the value range
and/or the number of contours. This will change the step. If you modify the step, it will
automatically change the number of contours.
It is possible to change the display parameters. The contours can appear as simple con-
tour lines or the space between the contours can be filled using a selected colourbar.
Once the parameters all defined, press Add button: the selected 2D data set(s) will
appear on leftMap overlays panel.

'Attribute' allows the user to select either Z-values (default option) or any of

the Horizon Data saved to this horizon.

Insert faults
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Insert Wells location

In Wells tab, specify:

1- Select OpendTectWells

2- Optionally, edit the settings (symbols, size, color etc)

3- Press Add button... the selected Wells will appear on left Map
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overlays panel.

Insert locations

Create a Polyline

In Polyline tab, specify:

1- Select Polygon
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2- Give a Name to the Polyline

3- Optionally, edit the settings (symbols, size, color etc)

4- Press Add button... the selected Polygon will appear on left
Map overlays panel.

Insert random lines

Insert 2D lines
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In 2D Lines tab, specify:

1- Select 2D line(s)

2- Name the line(s) (group).

3- Edit the settings (symbols, size, color etc)

4- Press Add button... the selected 2D line(s) group name will
appear on leftMap overlays panel.

Insert coastline

Clipping
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The final map will be restricted to the inside or outside of a given polygon.

Insert advanced commands

Typical output:
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Madagascar
A generic user interface exists to Madagascar, an open source seismic processing pack-
age that is very popular in seismic R&D communities. In the builder, seismic pre- and
post-stack input and output files are either OpendTect or Madagascar formatted. The pro-
cessing flow is constructed as a sequence of Madagascar programs, using their para-
meters. These programs are selected from a list of available programs (presently over
300), with a search field included to guide the user.

Madagascar processing results can be further analysed in OpendTect.

1- First Madagascar must be installed in order to use this interface between

OpendTect and Madagascar.

2- It's not possible to view Madagascar plots directly from the OpendTect user

interface on Windows. If the user wants to see the plot, she/he has to make

her/his own arrangements like starting the xserver etc ...

http://www.ahay.org/wiki/Main_Page
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Problems may occur occasionally when using Madagascar on a Windows

system.

Madagascar Installation
Madagascar is an open-source, standalone software. To be used with OpendTect, Mad-
agascar must first be installed, otherwise, when starting Madagscar , the next window
will display an error message and missing program boxes.

The Madagascar package needs to be installed (see install) and the RSFROOT variable
has to be set to the installation directory. In order to get the full UI, ensure that the text
doc is installed. This can be done with:

$RSFROOT/bin/sfdoc -t $RSFROOT/doc/txt

On Windows , Please ensure the following to be able to use the Madagascar link in
OpendTect:

1. In Advanced System Settings -> Environment Variables, the
variable RSFROOT must be set to the Madagascar installation
folder. Setting this variable only in the Cygwin environment is not
enough.

2. The variable PATH must include the Cygwin bin folder (e.g.
C:\cygwin\bin).

Madagascar Processing Window
The Madagascar processing window can be launched from the OpendTect toolbar by

pressing the Madagascar icon.

http://www.ahay.org/wiki/Installation
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Select the input cube to be processed, and then choose a program or combination of pro-
grams. Programs are organized into groups of programs. Once one program is selected,
a description of program's functions are shown in the neighboring frame.
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The different steps, as well as a synopsis, of the computation are provided. The descrip-
tions of each program are available on the Madagascar site.

Toolbar
The toolbar is composed of the file option and three shortcut items.
The file option is as follows:

The toolbar contains three shortcuts to create, open, and save the flow:

http://www.ahay.org/wiki/Main_Page
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This creates a new processing flow.

This will open a saved flow.

This will save a newly created flow.

Processing Input
The first step is to select an input cube.

The input can be a 3D volume, a Prestack volume, a Madagascar volume, or None. It is
possible to choose a volume sub-selection.

Madagascar Processing Output
The final step is to chose an output volume type.
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Similar to the input selection, it can be a 3D volume, a Prestack volume, a Madagascar
volume, or None.

Batch Processing
Though Batch Processing does not actually appear in the pop-out menu under Pro-
cessing, this is a convenient place in this User Documentation to present the information
on these processes.

Single Machine Batch Processing Window
In single mode processing, the data can be processed either on a local machine or on a
remote host. All relevant information on the progress of the calculation will be stored,
(see Job information file).

'Execute remote' toggled on to send the job to a remote machine. The job priority can be
changed (-19-lowest to +19 highest).
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Multi-Machine Batch Processing Window
The multi-machine batch processing window controls on which machines a volume out-
put or SteeringCube batch job will be processed. Jobs are distributed over the Used
hosts on a line-by-line basis (the number of inlines per job can be specified). Hosts can
be Added and/or Stopped at all times. Processed results are stored in a Temporary stor-
age directory.

At the end of the processing sequence, OpendTect will merge all processed lines and
store the data in the output file that was specified in the Volume output or Create Steer-
ingCube window, and it will delete the temporary disk files. If for any reason OpendTect
fails to perform this data transfer, this can also be done manually in the File - Manage
module. The temporary data store appears with a name starting with Proc_. Select this
item and copy it to a new cube.

It is possible that at the end of a multi-machine batch job not all data was processed suc-
cessfully. Some jobs may have failed (e.g. because one of the hosts was temporarily not
available). OpendTect will come back with a warning message stating which jobs (i.e.
which inlines) have not been processed yet. It is then advised to re-submit these jobs
until all data are processed. The Auto-fill option automatically scans and fills gaps in the
processed volume.

The Nice level sets the priority the process gets. With the nice level set on 19 for
exemple the process has very low priority and other processes that run on the same com-
puter get priority. If the nice level is set to 1 the process gets the highest priority.

The Processes menu allows to set the Run, Pause, or Go - Only between options. The
Go - Only between option, pauses and runs the processes at user-defined times.

OpendTect calls the system utilities of the 'hostent' (sethostent, gethostent, etc.) type to
get a table of hosts that can be selected. How the Operating System builds the lists is
dependent on the particular system setup; most likely /etc/hosts and/or the NIS tables
are consulted. OpendTect supports multi-threading which means that all processors of
multi-processor machines will be used.

Though we support multi-threading, not all calculations can be run this way

due to some of the algorithms involved (ie: recursive calculations). See the fol-

lowing table:

Multithreaded: Not multi-threaded:
BG Steering* Constant Steering
Central Steering Convolve (Wavelet option)



- 556 -

Convolve (all except Wavelet option) DeltaResample
Curvature Energy (Gradient option)
Dip Angle Event Steering
Velocity Fan Filter (=DipFilter) FaultDip
Energy (all except Gradient option) FingerPrint
Event GapDecon
FreqFilter* HorizonCube Curvature
Frequency* HorizonCube Dip
Full Steering HorizonCube Spacing
HorizonCube Data Horizon
HorizonCube Density Match Delta
HorizonCube Layer Maths (recursive expression)
Hilbert Perpendicular Dip Extractor
Instantaneous** SampleValue

Local Fluid Contact Finder Scaling (scaling type AGC and stats
type = detrend)

Maths (except when expression is recursive) Shift
Polar Dip
Position
PreStack
Reference
Scaling (all except scaling type AGC and stats
type = detrend)
Semblance
Similarity
Spectral Decomposition*
SpectrogramDip (create SteeringCube, FFT
steering)
Texture
Tutorial
Volume Statistics

Multi-machine processing on Windows OS

The new system works with a Daemon Service running in background on every remote
machine to be used for processing. The communication works with TCP/IP and requires
some configurations to actually make things working.
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Mapping of Survey folder:We assume a DataRoot folder ($DTECT_DATA)
to be in a centralised server. This folder has to be mapped on the same drive
in every PC to be used as hosts. For example, we have 4 PCs (A,B,C,D). A is
a server and the ODData is in drive D. Then map D:ODData on e.g. S: on B,
C and D. PCs B, C, and D can then be used as your processing nodes.

OpendTect installation: You need to have OpendTect installed on all hosts,
and make sure they all use the same survey at the same time (have access
to). For example if B is using F3_Demo and want to process something in
F3_Demo. then it has to be made sure that the rest of the two PCs also use
the same folder as long as the processing is needed.

BatchHosts file: Add the IP addresses of C and D in the BatchHosts file
inside the application data folder. (See also here)

Start the daemon: If launching process from B to the other two, then B is his
local machine, C and D are remote machine. In this case the Daemon ser-
vice ( odremoteservice ) application has to be launched from binwin folder ( 
win32/win64 ) only in the remote machines and not in the local machine ( B ).
Please note the odremoteservice.exe not to be run directly instead a launch-
ing tool will be found in win32mmod_remote_service_manager. Use od_
remote_service_manager to launch the daemon which will also add ano-
tification icon to the system tray. Once the service starts, the remote
machines are ready.

Start processing: Select the PC's B, C and D from the list of machines in the
multimachine launch window and start processing:
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Select machines to use for processing from the list

Multi-machine batch processing progress window
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For more information, please refer to the OpendTect YouTube Channel for
the webinar on: Multi-Machine Processing Set-Up

Batch Log File
A batch log file is produced for every volume output run. The information is streamed to a
file if the batch job is executed on a remote computer. If the processing is done locally
the log file is either streamed to a new, dedicated window, or to the standard output win-
dow. Every N traces the program will output a symbol to reflect the progress. There are
five symbols the program can use. Which symbol it uses depends on the speed in num-
ber of traces times N per sec (given towards the end of a line in brackets after the per-
centage of traces processed) and the estimated remaining time until completion. The
symbols indicate the following:

• a period (.) means 1 trace processed

• a colon (:) means 10 traces processed

• an equal sign (=) means 100 traces processed

• a pipe marker (|) means 1000 traces processed

• an asterisk (*) means 10000 traces processed

https://www.youtube.com/channel/UCiaLX2p5rCcovOK_NAwpaOQ
https://www.youtube.com/watch?v=9bEXxZ0RyxU
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The following options are available:

Stops the process.

Saves the log file.

Brings you to the help menu.

Cluster Processing
Batch jobs can be run from OpendTect to cluster management tools. So far dGB has suc-
cessfully tested SLURM which is easy to install and even easier to use.

Cluster processing is enabled by following this prerequisites:

• The environment variable DTECT_CLUSTER_PROC is set to yes before
starting OpendTect

• The cluster management tool must be up and running. In the case of
SLURM it means that the daemon 'slurmctld' should be running on the mas-
ter computer and that the daemon 'mlurmd' must be running on every node.

• This cluster management tool (SLURM) bin directory is included in your
PATH variable

Cluster processing is started by choosing "Cluster" in the 'Submit' options menu of the
volume processing window. Only 3D attributes can make use of cluster computing so far.

A new window will pop up that will list a number of directories use for the storage of tem-
porary files. The jobs will be split using a user-defined number of inlines. The field
named 'Cluster Processing command' represents the name of the binary from the cluster
management tool used to run a process.

You can run the "Main script file" (default: ~/yoursurvey/Proc/clusterprocscript) from a
command line which will run each job one-by-one using the above command and will
also launch the UI to show progress and do post-processing merging of temporary data.

https://computing.llnl.gov/linux/slurm/
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Scenes

The OpendTect main window can have multiple scenes, most of them opened using this
menu. The scenes behave like sub-windows within the main window: Each scene has
its own tree and can be minimized, maximized, reduced or enlarged in size, without ever
going out of the main window. The trees of different scenes can be move on top of each
other and sorted as tabs, or completely separated from the main window (they are utility
windows).

The Cascade option will restore a default size for each scene and sort them starting on
the upper left corner of the main window.

The Tile option is a shortcut to maximize each scene by sharing the space of the main
window equally:

• Auto: The scenes are sorted automatically along the best fitting grid.

• Horizontal: The scenes are arranged along a single line.

• Vertical: The scenes are arranged along a single column.

If all scenes are maximized the active scene will be annotated on the left in the Scenes
menu. Clicking on another scene will make that one active.
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Time- and Depth-Converted Scenes
OpendTect can display time data in the depth domain and depth data in the time
domain.

This is done using a user-selected velocity volume and computing the new Z range
(depth or time) based on the original Z range (time or depth respectively). In all trans-
formed scenes each and every display elements is re-positioned on-the-fly.

Pressing 'Create ' will pop up a dialogue that allows you to specify the velocity type for a
given volume:
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(See Tagged Seismic Data for more detail.)

The only exception is 3D volume for which the on-the-fly transformation can be slow.
Therefore time volumes can be depth converted (i.e. they become stored volumes) using
an additional option in the right-click option of inlines and crossline, in the transformed
scene:

Please note that depth-stored volumes can also be imported via SEG-Y by settings the
appropriate tag in the SEG-Y import wizard.

Flattened Horizon Scenes
This option will generate a new scene flattened about the selected horizon. The Z range
has the same unit as the original scene, but it is now relative to that horizon and no
longer absolute.
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Wheeler Scenes
The Wheeler Scene is a transformation (flattening) of HorizonCube into relative geo-
logical time (RGT). Therefore, before adding a Wheeler Scene, the HorizonCube will
need to be selected. You will be prompted for this if not already selected.

http://opendtect.org/index.php/products/commercial-products/horizoncube
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This option is only available if the SSIS plugin is installed.

http://opendtect.org/index.php/products/commercial-products/ssis
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View

Work Area
The Work area dialogue is opened from the 'view' menu. The Work area sets the area
bounded by the survey box. Displayed items will be cropped automatically to fit the set
inline, cross-line and z-ranges.

Z-Scale
The Z-scale option allows scaling of the survey box vertically.
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There are three options for Z-scaling: The slice bar, setting scaling according to current
scene "Fit to scene" and resetting the scaling "To Home".

You can set any position/orientation of the scene by clicking on as default

Home.

Stereo Viewing

The Stereo viewing menu allows setting the stereo viewing on/off. Note that in order to
use Red/Cyan stereo, appropriate glasses are needed. The offset between the red and
cyan view can be manipulated with the Stereo Offsetmenu. The Quad buffer option has
special hardware requirements in order to get passive stereo view on a screen with dual
and polarized projection.
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Toolbars

All elements available in the main OpendTect window can be switched on/off here. See
Toolbars for the various actions of the buttons on the toolbars.
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Utilities

Settings
The settings for Fonts,Mouse, Keyboard, etc., can be changed from Utilities--> Settings--
>

Look and feel

This option brings up an interface containing several tabs for defining various settings in
OpendTect:

These are explained in detail below:
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General:

Default Icon Size is 32. For systems with smaller screens (esp. laptops) it may

be useful to reduce this value to 28 or even 24. In combination with reduction

of Font size, this can prevent windows be 'oversized' for the screen.

Visualization:
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In the visualization tab , you may choose for OpenGL shading, also for
volume rendering, or switch off this option.You may also define the texture
resolution factor to one of these three settings:

Users facing data visualization issues may significantly improve their results

by turning off the shading and setting the resolution to Standard.

Fonts:
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Clicking on any of the listed buttons brings up a standard font definition win-
dow:

Processing:
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Please see the following sections for full details of Batch Processing and
Cluster Processing.

Horizons:
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Using this option, one may set both the default resolution and default colort-
able for horizons. This is an especially helpful option for orientation in the
early stages of a project when many horizons are loaded.

As with many of the other settings, a restart is required to apply these
defaults.

Mouse Controls
The mouse buttons can be set differently. System administrators can implement user-
defined mouse button actions. See the Application Management Documentation for
more details.

Keyboard Shortcuts
The user can define his/her own keyboard shortcuts to move a slice forward/backward.
The user can use one key (set the first key to no-button) or a combination of control or
shift key, plus another key which can be selected from a long list.
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Advanced Settings
The ADVANCED user settings are used to change the default settings of specific
keywords. The user can specify his/her own settings and/or setup or edit the Survey
defaults settings.

These settings can be found in the .od/ directory from the user home directory. Depend-
ing on the platform used, this is located in:

l /home/username/.od for Linux users
l root > Documents and Settings > username>.od in Windows 2000, XP and 2003
l root > Users > username >.od in Windows Vista and 7
l Users > username > .od for Mac users

To list the type of Personal settings and/or Survey defaults you have, please type in linux
console l ~/.od/*DTECT_USER*

Personal Settings

A user can update the Personal Settings by specifying a keyward (a variable name) and
its value. The value column becomes editable if left mouse button is double clicked in a
cell. A brief description on the available variables (and their values) is given below:
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Most of the changes are updated after restarting the OpendTect, other are act-

ive directly.

Pre-defined Keywords:
Press Select existing button to pop-up the pre-defined keywords. After selection of any
variable, the values should be updated. The values are updated by pressing 'OK' button.

l Company:Write the company name. Keyword - Company, Value: Text
(e.g. dGB Earth Sciences).

l Default DATA directory: It enables a user to setup a default
OpendTect data directory. The value is a path pointing to a data dir-
ectory e.g. /disk/ODData/.

l Fonts: The fonts for the OpendTect controls and graphics are set by
selecting the Font.* or Graphic.* keywords. The wild card character (*)
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refers to the text followed by the Font/Graphic word. All of these key
words refer to a font dialog that may have a specific value. For instance,
a value is written as Times New Roman`12`Normal`No [Font, Size,
Style, Others]. The following keywords can have the similar values:

Font.def.Fixed width, Font.def.Graphics large, Font.def.Graphics medium, Font.def.Large
control, Font.def.Small control, Font.for.Annotations, Font.for.Title, Graphics large font
size, Graphics small font size.

l Icons.size: It is a size of OpendTect icons. Its value can be a numeric
number e.g. 20, 24, 32 etc.

l In-line byte: This will enable the user to setup the inline byte location

l Pre-stack Viewer Settings (3D PS Viewer.*)With value=1,the
Prestack viewer will change in autowidth mode

l Bold font:With Value set to 'Yes', the font is set to bold

l Cross-line byte: This will set up the default croosline byte location

l Display UnitID: This will enable the user to display the help window ID

l MultiMachine.Nr inline per job: A user may overrule the number of
jobs (i.e. number of inlines) for each machine while running multi
machine batch processing. By default the value is 3

l Nr Processors: It is a numeric number to specify the number of pro-
cessors to be used for a processing. For instance, '0' means to use all
processors

l dTect.Measure LineStyle: This is a standard settings for the distance
measurement tool available in the Graphics Toolbar

l Seg-Y headers: Default file location to dump a SEG-Y headers. The
value is the output path together with a file name (e.g. /disk/SGY_
dump.txt).

l SEG-Y.Examine.Number of traces: Set a minimum numeric value
(e.g. 100) as a default setting to examine any seg-y file

l Ui.ToolTips.enable: Refers to enable a tool tip guide. Set Yes/No in
the value

l dTect.Ask.*: Set to prompt a warning message settings (Value:
Yes/No) for several windows. This include a prompt while closing
OpendTect, closing Attribute Set window, storing picksets, store
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session

l dTect.Auto Attribute set: Set an attribute name that will be auto
loaded if the OpendTect is launched

l dTect.Average even median:

l dTect.Color table.Name: A default color table for the user. The default
is Red-White-Blue. The value is a color table name

l dTect.ColorBar.show on top: Set a value to Yes/No to set the color
table on top of OpendTect or not

l dTect.ColorBar.show vertical: Set a value to Yes/No to set the default
orientation of the color table (vertical - Yes)

l 2D Viewer Settings (SeisView.*): 2D Viewer Display Properties of
Wiggle Variable Area

The following keywords can have the similar values:

SeisView.Display.WVA.Clipping, SeisView.Display.WVA.Display Null traces,
SeisView.Display.WVA.Draw wiggles, SeisView.Display.WVA.Interpolate,
SeisView.Display.WVA.Left color, SeisView.Display.WVA.Min Pix/Trace, SeisView.Dis-
play.WVA.Overlap, SeisView.Display.WVA.Reftime color, SeisView.Dis-
play.WVA.Reverse order, SeisView.Display.WVA.Reverse polarity,
SeisView.Display.WVA.Right color, SeisView.Display.WVA.Show reftime, SeisView.Dis-
play.WVA.Var Area.

l dTect.DTECT_SHOW_HELP: This will allow the user to show ID on
the help window icon

l dTect.Disp.Default clip perc: Set a default clipping value (1-100 %) to
clip the seismic data

l dTect.Default symmetry zero:This will set the colorbar symmetry
around zero

l dTect.Dont load plugins: This enables the User to load or not the plu-
gins

l dTect.Dump OI Menu: This is a special setting to export a OpendTect
scene. Set the value Yes/No to make this option available

l dTect.Icons.size: Set a default numeric value for OpendTect icon's
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size

l dTect.ProcessVolumeBuilderOnOK: This setting deals with Volume
Builder setup. By default the value is Yes i.e the setup process the
volume based on the available volume builder setup

l dTect.Show inl progress: Set Yes/No to show or hide the inline pro-
gress bar while displaying the data

l dTect.Use VolRen shading: Set Yes/No for volume rendering shading

l dTect.Use shading: Set Yes/No for shading

l dTect.Zoom factor: Set a value for wheel zooming factor. Default
value is 1

l dTect.KeyBindings.Default:

l dTect.Select Plugins: This feature allows the user to select or not the
plugins

l dTect.VolRen shading: Set Yes/No for shading

l dTect.Use startup session: This option enables the user to directly
start a session when opening a specific survey in OpendTect

l dTect.Maximum Visualization Texture Size: Set the maximum size
for the individual visualization data 'chunks'. Default is 4096 (though
this may be decreased to 2048, 1024, 512...)

The following files are used to store the Personal settings:

l settings.DTECT_USER: This file is used to setup Personal settings
l settings_coltabs.DTECT_USER: This file is used to edit colorbar display prop-
erties

l settings_snapshot.DTECT_USER: This file allows the user to edit the snapshot
properties like resolution, height, width etc ..

l settings_flatview.DTECT_USER: This file enables the user to edit the 2D viewer
properties like Variable Density, Wiggle Variable Area.

l settings_welldisp.DTECT_USER: This file enables the user to edit the well dis-
play properties

l settings_welltie.DTECT_USER: This file is used to edit the Well to Seismic tie
properties like Velocity/Density names, Wavelet ID etc..

l qtsettings.DTECT_USER: This file will allow the user to edit the QT properties
l settings_3DPSViewer.DTECT_USER: This file will allow the user to edit the 3D
PreStack viewer properties
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l settings_GMT.DTECT_USER: This file will allow the user to edit the GMT prop-
erties

l survey.DTECT_USER: This file is used to edit the Default Survey. Typing cds
from a linux console will bring the user back to his/her default survey

Survey Defaults

This option enables the user to setup/edit the Survey default settings. The value can be
changed by double clicking in a cell.

Depending on the user, several settings are available. Let us describe few:

l 3DAttrset.Auto ID: This setting shows the ID value of the default auto-
load attribute set

l Default.Cube: This will show you the default cube ID. If there is no
value, this will mean that no Default Cube was set in that survey. To set
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a Cube as default, go to "Manage Seismic Data" in the main OD inter-

face then click on the 'set as default' icon after a cube has been
selected

l Default.2D Cube: This will show the ID value of the default 2D Data
Set

l Depth in feet: Change the Value to 'No' if the Depth is in meter

l SEG-Y Rev.1 policy:When importing the SEG-Y,If the value is set to 1
the window will pop up asking a user to confirm the Rev1. With the
value = -1 no confirmation pop-up window

l Show depth in feet: This option enables the user to show the depth in
meter if the value is set to 'No'. Setting the value to "Yes' will display the
depth in feet

l Z Scale: This shows the value of the survey Z-scale

l Z Stretch: This setting shows the ID value of the stretch

Tools

Batch Programs
To run the batch program go to: Utilities > Tools > Batch programs

Choose the batch program you need to run, the available are: cbvs_browse, cbvs_dump,
lmhostid, glxinfo, ivfileviewer. The text box will show comments and details.

If another OpendTect batch program is chosen, fill in the required and (if needed) the
optional parameters (indicated by the square brackets "[ ]").



- 582 -

The batch program will start in a new xterm window. For example, if a batch program is
cbvs_browse like shown below, the cube to browse should be selected to run a batch
program.

Position Conversion
Position Conversion is an utility that can be used to convert the position pairs from
Inline/Crossline to X/Y, and vice versa. This utility can be launched either directly from
Utility > Position Conversion ... or from Survey selection menu (Survey > Select/Setup).

In the position conversion window, there are two modes available for coordinate con-
version: Manual/File. In Manual mode, the user specifies an inline/crossline pair (or X/Y
pair), then press the corresponding arrow key to obtain the position in the other domain.

In File mode, the user browses the input file and create a new output file. By specifying
the corresponding type conversion (XY to IC or IC to XY) and pressing the GO button,
the desired conversion is written on output file.
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Create Plugin Development Environment
With this option the user can create the OpendTect developer environment to develop a
plugin to OpendTect. The source code and all other relevant files are copied into a user
specified directory (chosen from the Package Manager during the installation setup).
More information can be found in the Programmer manual from the Help menu.
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Command Driver
The Command Driver offers automated control of the current OpendTect application from
a command script. The command script is a replacement for a series of keyboard and
mouse interactions performed by the user. It can be used to automate parts of the work
flow, and helps to speed up executing repetitive tasks or giving automated demon-
strations in OpendTect.

The Command Driver was created as a tool to make automated testing of the OpendTect
releases possible. That means it is not optimized for usage as a scripting tool. It is clear,
however, that power users have been starting to use the Command Driver tool for this
purpose.

The list of available commands, their syntax, and semantics can be found in the Com-
mand Driver Manual.
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Installation

Update (Installation Manager)
The Installation Manager is available for download via the appropriate platform link on
this page of our website: http://opendtect.org/index.php/products/download

http://opendtect.org/index.php/products/download
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The installation manager is a wizard to install/upgrade the existing OpendTect (Current /
Previous) releases. The release type field is used to select the release that is needed to
be installed/upgraded. The installer gives you the choices as seen below:
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The information following in this section deals with online installation or upgrade. For cre-
ating offline installation packages, please see Offline Installation

The figure above suggests to select the package type of OpendTect. To read more about
OpendTect packages type, please refer to our web-page of licensing types.

The OpendTect Installation Manager identifies the platform on which it is run-

ning. This information is then anonymized prior to it being sent to OpendTect.

We use this anonymous data solely for the purpose of getting a picture of

OpendTect usage and thus improving our support capabilities.

http://opendtect.org/index.php/products/triple-licensing-policy


- 588 -

Package Manager

The last window of the wizard is the OpendTect Package Manager (see above figure).
Multiple items can be selected from the list by checking the boxes (or not). Optionally,
the relevant package combination could also be selected from the top list box.

The installation manager will automatically recognize the previously installed version at
the selected path and will prompt it in the Installed version field.

To read more about a particular item in the list, select the item by clicking on it and read
the description on to the right panel. For example, Dip-Steering:
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If, for any reason, you should choose to abort the installation mid-download,

you will see the following window appear:

This gives you various options, including increasing the time-out from its

default setting, changing the download server or changing the Proxy settings.
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Utilities Menu

On the top left corner of the package selection window there is a Utilities menu, which
offers some useful functions for the installation manager:

Export Download List

This option allows the user to download the list of URLs of the individual packages from
the download site. This list is stored in a text file which can be used later to download
these files directly without the help of the installer program. After downloading, user can
run his/her own unzipping scripts to install the packages manually. This facility was only
developed for the Linux users. Windows users can use this feature, provided they can
prepare their own installation scripts for the installation.

Rollback

Rollback tool allows you to restore your previous version of the installation. If after updat-
ing the software you feel uncomfortable with some of the new features and want to go
back to your previous installation, you have to use this tool. As this tool will change your
entire installation so you have to use it cautiously.

Show Log File

The installation manager keeps track of all the action it is executing in a log file. This log
file can be viewed from this tool. This is useful for debugging purposes. If you face any
trouble during the installation process you can send this file to OpendTect support if
needed.
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Offline Installation

You may also choose to create packages for offline installation. These packages are cre-
ated in such a way as to function cross-platform. For example, you may download the
Linux 64bit package onto a Windows machine and then transfer and install it onto the
Linux system or vice-versa.

You will need to select the OpendTect version and toggle to 'Prepare offline installation
packages'. You may either choose your download directory or leave the default.
You will first be prompted to select the package type of OpendTect. To read more about
OpendTect packages type, please refer to our web-page describing licensing types:

On completion of the download, you will be reminded of the location in a pop-up window
and informed of how to launch the installation package:

http://www.opendtect.org/index.php/download.html
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Windows offline pop-up info

Linux offline pop-up info

The 'Platform' option refers to the intended installation platform, and not the

platform of the machine currently being used to download the packages (if dif-

ferent).

(For information on how to verify packages installed offline, please see the link below:

Package Verification

We generate signature files for all packages. Normally, a package is a zip file down-
loadable from our website:

For OpendTect version 4.6.0, please visit: http://www.opendtect.org/relman/4.6.0/
For OpendTect version 5.0, please visit: http://www.opendtect.org/relman/5.0.0/

For each zip-file, there is a zip.sig file containing a digital certificate that can be used to
verify that the package has not been tampered with during transit.

To verify a package, download the corresponding zip.sig file and place it in the same dir-
ectory as the package file. gpg (or pgp) must be used (an encryption program). These
programs are normally installed in most linux installations, and can be found
at http://www.gnupg.org

http://www.opendtect.org/relman/4.6.0/
http://www.opendtect.org/relman/5.0.0/
http://www.gnu.org/
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dGB's public key has to be downloaded to your keyring. This is only necessary for the ini-
tial verification. To obtain the key, use gpg itself:

gpg --keyserver pgp.mit.edu --search-keys "support@dgbes.com"

You may chose any keyserver you want, as they all share data. Once you have located
our key, import it to your keyring.
Secondly, to avoid warning messages, edit the key and tell gpg that you trust it:

gpg --edit-key support@dgbes.com

and then type "trust" as command. Once you have our key installed, you are ready to
verify the packages. This is done by gpg:

#bash-> gpg --verify demosurvey.zip.sig

This will check that demosurvey.zip has not changed since the file demosurvey.zip.sig
was generated in our office. A positive output may look like this:

gpg: Signature made Thu Oct 4 08:46:01 2012 CEST using DSA key
ID A02F407E
gpg: checking the trustdb
gpg: 3 marginal (s) needed, 1 complete (s) needed, PGP trust
model
gpg: depth: 0 valid: 1 signed: 0 trust: 0-, 0q, 0n, 0m, 0f, 1u
gpg: next trustdb check due at 2022-03-13
gpg: Good signature from "dGB Earth Sciences B. V. (Software
package signing key) "

Auto-Update Policy
The auto-update policy can be defined and changed by a user. By default the option is
set to  [Inform] when the updates are available. On Windows, this can be changed to 
[None] Never check for updates should you prefer.
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On Linux, there are two additional options - [Manager] and [Auto]:

Connection Settings
To enter the proxy information, the correct proxy server information must be added in
the Connection Settings before running the installation. This is done in the following dia-
log. This dialog is also available directly through the Installation Manager on clicking
the Proxy Settings button.

Plugins
The plugins window lists the plugins that are currently loaded (or not) into OpendTect,
and provides relevant license information.
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Developers might want to use the option "Load a plugin" to manually load their plugin.
The developers documentation describes how to add a plugin to the automatic loading
procedure.

In OpendTect, there are several commercial plugins available. Each plugin adds extra
functionality to OpendTect. To load a new plugin, browse to the appropriate file. More
information on plugin design is available in the Programmer manual.

In general most plugins are loaded automatically at startup, based on the chosen
options:

http://dgbes.com/index.php/products/commercial-products
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If you choose to toggle off the option "Show this dialog at startup" all plugins will be
loaded at startup. It is recommend to install only the plugins for which you do have a
license and to load them all automatically at startup.

Setup Batch Processing
In order to utilize OpendTect's capability for Multi-Machine Processing (MMP), a
BatchHosts file must be used. This file must contain the list of remote machines (host
machines or nodes) and some relevant details about these machines. Two BatchHosts_
example files come with the installation inside the OpendTect data folder, which may be
amended for use. OpendTect will use this file to communicate to the remote hosts and
launch processes remotely on them. Follow the example file format to add the list of
remote machines and their details in the respective fields.

In order to minimize complications, the Setup Batch Processing tool can be used to cre-
ate a tailor- made BatchHosts file (via Utilities- - > Installation- - > Setup Batch
Processing...):
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This tool allows the user to enter the details necessary for functioning MMP. On pressing
'Close', the file is saved. These include:

IP address: IP address of the node machine(s)

Hostname: Hostname of the node machine(s)

Display name: Free-text field. Text entered here appears in the Multi-
Machine Processing window.

Platform: Select platform type.

Survey data root: Location of the survey (the path to the survey data root
folder from the host machine)

Advanced Settings: Here you may change the first port value (in the case
that it is blocked/in use). Linux users may decide to change the shell com-
mand from the default ssh to rsh. The Nice level sets the priority on the host
machines, 19 being nicest and 1 being least nice). Finally, the Default Data
Root can be set per platform:
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Add new host.

Remove selected host.

Move host up or down.

Test hosts. Will perform tests to ensure that the server and nodes can
communicate to the necessary extent to perform the MMP. (ie: can the nodes
find the data root folder and read/write into it)
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For more information on this topic, please refer to OpendTect's YouTube Channel where
you may find the webinar: Multi-Machine Processing Setup.
Alternatively, refer to the webinar on this page: http://opendtect.or-
g/index.php/support/tutorials/tutorial-videos/webinars

Licenses
Under Utilities--> Installation--> Licenses you will see two sets of options, differing per
platform:

License options under Windows

http://www.youtube.com/channel/UCiaLX2p5rCcovOK_NAwpaOQ
https://www.youtube.com/watch?v=9bEXxZ0RyxU
http://opendtect.org/index.php/support/tutorials/tutorial-videos/webinars
http://opendtect.org/index.php/support/tutorials/tutorial-videos/webinars
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License options under Linux

For information about floating or server-based licenses, please refer to:
http://opendtect.org/lic/doc/flexnet_installation_guide.html

For more general information about OpendTect licensing options, please
see: http://opendtect.org/index.php/support/licenses

A more complete explanation of OpendTect license Installation can be found in the
License Installation Webinar , available on OpendTect's YouTube Channel or via:
http://opendtect.org/index.php/support/tutorials/tutorial-videos/webinars

Install demo/node-locked license

Plugins to OpendTect can be run either by using a license server or by using demo (eval-
uation) licenses. This second case is case called "node-locked license installation".

http://opendtect.org/lic/doc/flexnet_installation_guide.html
http://opendtect.org/index.php/support/licenses
https://www.youtube.com/watch?v=y5gEfHc2Vlc
https://www.youtube.com/channel/UCiaLX2p5rCcovOK_NAwpaOQ
http://opendtect.org/index.php/support/tutorials/tutorial-videos/webinars
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Use the following window to specify the path to the node- locked (demo/evaluation)
license files that were given to you:

Here you can install each of the licenses by simply clicking ‘Select’, choosing the appro-
priate license file and clicking ‘Ok’ in the file selection window. Once you have selected
all the licenses you are evaluating, click ‘Ok'. Your installation will be confirmed and you
will be prompted to re-start OpendTect:

In addition to the core functionality, you may click 'Request Evaluation License ' to bring
you to the following web- form on the dGB website: http://dgbe-
s.com/index.php/contact/request-a-demo

And, on Windows only, use the 'License Manager Tools ' button to pop up the Flexera
LMTools window for more direct access to it features:

http://dgbes.com/index.php/contact/request-a-demo
http://dgbes.com/index.php/contact/request-a-demo
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Clear License Installation

This option (Windows only) will clear:

l Demo or node-locked licenses installed via any route, including the 'Install demo
license' option.

l Floating (or 'server') licenses that may have been installed (without stopping the
license server).

Once cleared, you will be prompted to restart:
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Users of Linux systems wishing to clear their license installation will need to do the fol-
lowing:

l Locate the .flexlmrc file in your HOME directory (eg: $HOME/.flexlmrc)

l Check in the file for specific lines referring to the OpendTect vendors
(DGB, ARKCLS, SITFAL)

l If the file contains lines relevant to other software, then just delete the
individual lines. Otherwise, you may choose to delete the file.

This method also applies to both demo/node-locked and floating licenses and will also
not stop the server.

Show HostID

Clicking this option will pop up a simple dialogue showing the HostID of the machine:

Additionally, on Windows, accessing the HostID of the machine can be done via the
LM Tools (available via the Start Menu or directly from
..\OpendTect\5.0.0\bin\win64\lm.dgb\lmtools.exe):
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The option 'Save HOSTID Info to a file' will simply save the information displayed above
into a .txt file for reference.

Show Log File
The user can check the log file from Utilities > Show log file. This will show the log of low
traffic signals e.g. warning messages if a plugin (or license) is not properly loaded.
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Help

From this drop-down menu, some of the various help aids can be accessed. This
includes the OpendTect User Documentation (F1) and the dGB Plugins User Docu-
mentation (F2).

About gives you some basic information, as seen here:

http://www.opendtect.org/500/doc/od_userdoc/Default.htm
http://www.opendtect.org/500/doc/dgb_userdoc/Default.htm
http://www.opendtect.org/500/doc/dgb_userdoc/Default.htm
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Appendix A - Attributes and Filters
OpendTect attributes and filters are divided into 'dip-steering attributes' and 'no-steering
attributes'.

A comprehensive list of all the attributes and filters available in the free, open source
OpendTect core software is shown below (the so-called 'no-steering attributes'):

Note that other attributes and filters are only available if the corresponding plug-in has
been installed. Information on commercial dGB plugins, please read the dGB Plugins
Documentation.

Attributes related to Earthworks & ARK CLS plug- ins are documented in their cor-
responding UserDocs. These can be found by using following link:

http://www.opendtect.org/index.php/support.html and clicking the User-Documentation
icon.

Convolve (2D/3D) -- Attribute that returns a filtered response
Delta Resample -- Attribute that enables residual alignment of seismic volumes
Energy -- Response attribute that returns the energy of a trace segment
Event -- Attribute that quantifies an events shape or distance relative to a next event
Fingerprint -- Attribute that computes the similarity between a user-defined vector of attrib-
utes and the equivalent vector taken at each position in a cube
Frequency -- Response attribute that returns frequency properties
Frequency Filter -- Attribute that returns filtered data using FFT or Butterworth filter types
GapDecon -- Attribute that aims to attenuate repetitions of primary reflections (multiples)
Grubbs Filter -- Attribute that removes outliers from normally distributed data
Horizon -- Attribute that enables advanced calculations on horizons
Instantaneous -- Attribute that returns a value at a single sample location
Log -- Attribute that returns a well log value.
Match Delta -- Attribute that extracts time shifts between similar events in different seis-
mic volumes
Mathematics -- Attribute that returns the result of a user-defined mathematical expression
Position -- Attribute that returns any attribute calculated at the location where another
attribute has its minimum, maximum or median within a small volume
Prestack -- The pre-stack attribute can be used either to extract statistics on the gathers
and their amplitudes, or to extract AVO attributes
Reference -- Attribute that returns the definitions of the extraction position
Reference shift -- Attribute that moves the extraction position in 3D space
Sample Value -- Attribute that returns the input value at the sample location
Scaling -- Attribute used for scaling of amplitude
Similarity -- Multi-trace attribute that returns trace-to-trace similarity properties

http://www.opendtect.org/500/doc/dgb_userdoc/Default.htm
http://www.opendtect.org/500/doc/dgb_userdoc/Default.htm
http://www.opendtect.org/index.php/support.html
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Spectral decomposition -- Frequency attribute that returns the amplitude spectrum (FFT)
or waveletcoefficients (CWT)
Texture -- Group of attributes that return statistical properties of a Grey-Level Co-occur-
rence Matrix (GLCM)
Texture - Directional -- a multi-trace attribute that returns textural information based on a
statistical texture classification.
Velocity Fan Filter -- Attribute that returns energy with apparent velocities/dips inside a
specified Min/Max range
Volume statistics -- Attribute that returns statistical properties

Convolve (2D & 3D)
Name
Convolve (2D/3D) -- Attribute that returns a filtered response.

Description
The input data is convolved with a three-dimensional kernel specified by Filter type and
associated parameters. Lowpass, Laplacian, and Prewitt are well known filters in image
processing.

Input Parameters

Lowpass
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Lowpass is an arithmetic averaging filter which is used to smooth seismic data. The
smoothness is determined by the Filter size. The shape parameter specifies whether the
input samples are collected in a sphere or a cube centered around the evaluation point.
The output is the sum of the sample values divided by the number of samples.

Laplacian

The Laplacian filter is an edge enhancement filter. The sharpness is determined by the
Filter size . The shape parameter specifies the input samples to the filter. In a 3x3x3
Laplace filter, the output is calculated by multiplying the central sample value with 26
and subtracting all surrounding sample values. The convolution is characterized by the
following kernel:

l (-1,-1,-1) (-1,-1 ,-1) (-1,-1,-1)

l (-1,-1,-1) (-1,+26,-1) (-1,-1,-1)

l (-1,-1,-1) (-1,-1 ,-1) (-1,-1,-1)
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In case all sample values are equal and non-zero (either positive or neg-
ative), the effect of this operation is zero.

Prewitt

Prewitt is a contrast enhancement filter. This filter computes the gradient in different dir-
ections from a 3x3x3 input cube. The Output is returned in the specified direction (inline,
crossline, or Z-plane). A 3x3x3 Prewitt kernel to calculate a horizontal gradient is given
by:

l (1,0,-1) (1,0,-1) (1,0,-1)

l (1,0,-1) (1,0,-1) (1,0,-1)

l (1,0,-1) (1,0,-1) (1,0,-1)

Note that the inline gradient returns the difference in amplitude in the inline direction.
This is best visualized on a crossline. Similarly, a crossline gradient is visualized best
on an inline.

A 3x3x3 Prewitt kernel that returns the vertical gradient is given by:

l (-1,-1,-1) (-1,-1,-1) (-1,-1,-1)

l ( 0, 0, 0) ( 0, 0, 0) ( 0, 0, 0)

l ( 1, 1, 1) ( 1, 1, 1) ( 1, 1, 1)

Wavelet
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This option enables the user to convolve the data with a wavelet. In this context, a wave-
let is the time series response of a filter. The wavelet should be imported into OpendTect
first or it can also be created in OpendTect (From Wavelet management or ARKCLS
Spectral blueing attribute).

Delta Resample
Name
Delta Resample -- Attribute that enables residual alignment of seismic volumes

Description
This attribute is used to make shifts inside seismic volumes. By defining an input cube
and a delta cube, which represents the shifts that should be applied to the input data, a
correctly aligned output volume can be generated. The delta cube can be generated by
using the attribute "Match Delta". Note that you must use the Z-unit of the input cube.
Also note that you must apply a negative shift to move the cube down and a positive shift
to move the cube up. Using the "Delta Resample" attribute is very useful in case of work-
ing on, for example, multi-azimuth volumes which frequently show some degree of mis-
alignment. This technique can also be very useful for time-lapse seismic data and NMO-
corrected data. Only after aligning, a correct comparison can be made between two dif-
ferent volumes.

Input Parameters
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The delta cube can be generated by using the Match Delta attribute. An advanced option
in the attribute engine is that, when the input is periodic and contains phases, it is pos-
sible to define a (maximum) period. The box "Input is periodic" should be clicked and the
period should be defined in the box. However, a situation like that is very exceptional
and, in 99 out of 100 cases, the shift can be applied without using this option.

One of the side-effects of this residual alignment is that existing horizons are not con-
sistent with the data any more. The horizons should be re-snapped to the aligned seis-
mic data by using the option "Algorithms" when right-clicking a horizon in the tree. The
third option "Snap to event" enables the user to make the horizon consistent again. Only
after snapping the horizons can the user, for example, calculate horizon-steered attrib-
utes or performing waveform segmentation.

Flattening or Unflattening a Cube:
Another useful application for this attribute is to flatten or unflatten a cube. The example
given below outlines how you would unflatten a cube that you have flattened (for
example, using the Flattening option under the Horizon Workflows fold-out):

You would create a cube that would have, as a function of the position only, the Z dif-
ference between flattened and unflattened volume. For example, you may have set the
TWT of the flattened cube to 1000 ms. Using the Horizon attribute you would read the
TWT values of the horizon, let's say 1300ms for a particular trace. The shift is thus
defined with a mathematics attribute as:

shift(ms) = ( FlatTWT(s) - HorTWTAttrib ) * 1000 = ( 1 - 1.3 ) * 1000 = -300

Applying this shift attribute as 'Delta Cube' for your flattened volume (your 'Input Cube')
will undo the flattening (in this case, with a negative value, thus shifting the cube down).
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Energy
Name
Energy -- Response attribute that returns the energy of a trace segment

Description
This attribute calculates the squared sum of the sample values in the specified time-gate
divided by the number of samples in the gate. The Energy is a measure of reflectivity in
the specified time-gate. The higher the Energy, the higher the Amplitude. This attribute
enhances, among others, lateral variations within seismic events and is, therefore, useful
for seismic object detection (e.g. chimney detection). The response energy also char-
acterizes acoustic rock properties and bed thickness.

Input Parameters

Output
Energy, Sqrt(Energy) and Ln(Energy)

Examples

Seismic data showing anomalously high values



- 614 -

Energy attribute (time-gate [-28,28]) enhances anomalously high values (yellow)

Event
Name
Event -- Attribute that quantifies an events shape or distance relative to a next event

Description
The event attribute is a useful tool when determining the quality of horizons in seismic
data that can also be applied to in-lines, cross-lines, or z-slice elements. A sketch of the
several event attribute applications is shown below:
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Input Parameters
In the single event mode , the algorithm searches for the extremum and quantifies the
shape around the event in terms of either Peakedness, Steepness or Asymmetry.

l Peakedness: The ratio between the Extremum value and distance
between next and previous zero crossings (ZC)

l Steepness: The slope of tangent to the seismic trace at a zero crossing

l Asymmetry: The asymmetry of event. Mathematically it can be
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presented as: (L-R)/(L+R) where L is the distance between previous ZC
and extremum and R is distance between next ZC and extremum

In the multiple event mode, the event type needs to be specified from the Event type
drop-down list:

l Extremum

l Maximum

l Minimum

l Zero Crossing

l Negative to Positive Zero Crossing

l Positive to Negative Zero Crossing

l Maximum within the gate

l Minimum within the gate

Output
The output is either the distance between the chosen event and the next/previous similar
event or the amplitude of the event. The output is determined by the checkbox below the
event type drop-down list.
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For the event types Maximum within the gate and Minimum within the gate, a time-gate
(in milliseconds) needs to be specified. The algorithm computes the distance, within the
specified time-gate from the current point, e.g. on a horizon, to the nearest maximum or
minimum.

The Event attribute is for example useful while quality-checking horizon grids. The attrib-
ute can also aid in finding the distances between two events and using it as an estimate
of relative thickness changes between them. The adaptive use of Volume Statistics
along with the Event attribute can also bring relative changes to derive meaningful geo-
logical aspects.

Fingerprint
Name
Fingerprint -- Attribute that computes the similarity between a user-defined vector of attrib-
utes and the equivalent vector taken at each position in a cube.
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Description
This attribute computes the similarity between a user-defined vector of attribute values
and the equivalent vector taken at each sample position inside the cube. The reference
vector can be constructed from one or more positions. A statistical property (average,
median, variance, minimum or maximum) is calculated after the construction of the vec-
tor. Also, it is possible to construct the vector manually by editing the attribute values of
the fingerprint vector. The similarity between the fingerprint vector and the equivalent vec-
tor at the evaluation point is computed as the normalized Euclidean distance between
the two vectors and ranges between 0 (vectors are not identical at all) and 1 (vectors are
100% identical).

Note: If you want to insert/remove the reference attributes, right click in the empty area of
Reference attribute window.

Advanced options
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In order to compare vectors, you can use the "Advanced" option to obtain the ranges for
the input values. The ranges are automatically calculated using random picks when you
press the button "Calculate parameters". You can also use a pickset to find the ranges or
even manually introduce them. In the "Advanced options" window, a weight can be
assigned to each individual attribute. The default value of the weight is set to 1.
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Example of result application fingerprint attribute

Frequency Filter
Name
Frequency Filter -- Attribute that returns filtered data using FFT or Butterworth filter types

Description
The specified Input Data is bandpass filtered with the commonly used Fast Fourier
Transform or Butterworth filter.

Input Parameters
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The difference between using the FFT or Butterworth filtering method is that, for the FFT,
one considers the complete trace while for the Butterworth filter, only a "small" segment,
depending on the selected number of poles, is taken into account. The user should keep
in mind that using the Butterworth Filter results in a small shift in the seismic data.
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The curves of the Butterworth filter for various numbers of poles

The Filter type is set to LowPass, HighPass or BandPass according as it is dis-
criminating against frequencies above or below a certain limiting frequency or outside of
a given band of frequencies. The top frequency tapering applied to the extracted data in
the time domain.

Frequency Taper:
Additionally, a frequency taper can be applied by setting the min/max Hz tapering win-
dow. This could be done by toggling Specify Frequency TaperON. Press the View but-
ton to specify an appropriate frequency taper.
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Frequency taper settings in the attribute definition (for filter type: 'BandPass').

Once the Frequency Taper is displayed (red line in a pop-up window), a spectrum on
any inline/crossline can be viewed by pressing the Preview Spectrum button. It will
prompt to select an inline/crossline ("Select line from Data"). In that dialog select either
inline or crossline radio button and press Next. Sub select the part of inline/crossline and
proceed. A blue coloured amplitude spectrum will be displayed (as shown below). Now
adjust the parameters (Slope or Start/Stop Frequency) and finalize the frequency taper
settings.
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Interactive display of the frequency taper parameters (for filter type: 'BandPass').

Frequency
Name
Frequency -- Response attribute that returns frequency properties

Description

Input Parameters
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The specified time-gate is transformed to the Fourier domain and the requested output is
calculated. The time-gate is tapered with the specified Window/Taper prior to Fourier
Transform. The shape of the various tapers is shown in the figure below.
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If Normalize is enabled, the frequency spectrum is normalized with regard to its area.
This will make it possible to compare attributes from areas with high and low energy.

Output
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All possible Frequency outputs are in X-axis, Y-axis = Amplitude values

Dominant frequency
Returns the dominant frequency from the frequency spectrum-- the frequency with the
highest amplitude

Average frequency
Returns the arithmetic mean of the frequency spectrum.

Median frequency
Returns the weighted median value of the frequency spectrum, which is the frequency at
half the spectral area on each side. The median frequency might be somewhat more
robust than average frequency, at the cost of lower precision.

Average frequency squared
Returns the average of the squared frequencies.

Maximum spectral amplitude
Returns the maximum amplitude of the frequency spectrum, i.e. the amplitude of the dom-
inant frequency.

Spectral area beyond dominant frequency
Returns the spectral area beyond the dominant frequency (see figure below).

Absorption quality factor
Returns the area beyond the dominant frequency weighted by frequency.
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Frequency slope fall
Returns the peakedness of the spectrum. It is defined as: 1+(MSA-Spectral Area) /
(MSA+Spectral Area). A value approaching zero indicates a flat distribution while a
value approaching one indicates a peaked distribution.

GapDecon
Name
GapDecon -- Attribute that aims to attenuate repetitions of primary reflections (multiples).

Description
The type of multiple removal algorithm chosen for this application is the well known
inversed filtering method also known as Gap deconvolution. This filter aims to attenuate
a user-defined part of an auto-correlation function. The underlying idea is that multiples
in the data are secondary reflections, i.e repetitions of the primary reflections that show
up in the auto-correlation function at a time that corresponds with the extra travel time.
The filter can be applied on-the-fly or in batch-mode to produce a filtered output cube.
The user defines the GapDecon attribute from the list and specifies a number of input
parameters.
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l Correlation window = the window for calculating the auto-correlation
function.

l Examine = pressing this button will open a new window where the user
selects a subset of the data (e.g one inline, or one cross-line) on which
the result of the auto-correlation will be calculated and displayed for fil-
ter design purposes. This result can be used to determine the lag and
gap size (see example below).

l Lag-size = the window length in the auto-correlation function that is
unaffected by the filter. This window contains the wavelet-shape inform-
ation.

l Gap-size = the window length in the auto-correlation function that the fil-
ter aims to blank. This window contains repetitive (multiple) information.

l Noise level = random noise that can be added to stabilize the filter
derivation. The noise level is set to 1% by default.

l Stepout = a moving average across neighbouring traces that is applied
prior to the calculation of the auto-correlation function. This trace aver-
aging results in a smoother end-result. The higher the stepout, the
smoother the result.

l Input is = The user can set the input to minimum or zero phase; if the
input is zero phase, a phase rotation of 90 degrees is applied before
applying the GapDecon filter.

l Output is = The user may set the output to zero phase, then the inverse
90 degrees rotation is applied after the filtering.

l Check parameters = check whether the (multiple) energy has indeed
been removed. A QC of the parameters : the GapDecon-filter with the
selected parameters, lag 44 and gap 100 (see example below), is
applied on a user defined line and the auto-correlation of the filtered
data is displayed in a 2d-viewer to check whether the parameters are
correct. If they are not correct, the parameters can still be changed.

Spiking Deconvolution.
The Gap Decon attribute can also be used for Spiking Deconvolution or Whitening. The
goal of Spiking Deconvolution is to flatten the output spectrum. This is achieved by short-
ening the embedded wavelet and attempting to make it as close as possible to a spike
(zero-lag spike). One should keep in mind that the frequency bandwith of the data might
limit the extent to which this whitening is possible. At higher frequencies, Spiking Decon-
volution might cause an increase in noise.
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Example

In the attribute defined above, we define an auto-correlation window between 300ms
and 1200ms. After pressing 'Examine ' we can see that the following parameters could
give us the result we desire: a lag of 44 ms and a gap of 100ms. Pressing 'Check Para-
meters' shows the effect this would have if we were to output this attribute with the cur-
rent parameter settings:
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Grubbs Filter
Name
Grubbs Filter -- Attribute that removes outliers from normally distributed data.

Description
Grubbs' test , (also known as the maximum normed residual test), is a statistical test
used to detect outliers in a univariate data set assumed to come from a normally dis-
tributed population. It is based on the assumption of normality. That is, one should first
verify that the data can be reasonably approximated by a normal distribution before
applying. The test detects one outlier at a time. This outlier is expunged from the dataset
and the test is iterated until no outliers are detected.

Please note: Multiple iterations change the probabilities of detection, and the test
should not be used for sample sizes of six or less since it frequently tags most of the
points as outliers.

For a full definition, including formulas, please see the Wikipedia entry.

Input Parameters

Horizon
Name
Horizon -- Attribute that enables advanced calculations on horizons

Description

http://en.wikipedia.org/wiki/Grubbs'_test_for_outliers
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This attribute is designed to extend the use of horizon data and can be used for several
purposes. When applying it to a horizon only, it will give similar results as calculating
attributes on the horizon.
However, when using the output of this attribute as input to a mathematical expression,
the output can vary from just a simple thickness calculation to a highly advanced com-
bination of several attributes. You can think of this attribute as different to the other attrib-
utes in OpendTect in the sense that it takes horizon data and converts it into seismic
data which can be applied as input in volumes.

Input Parameters

As shown above, there are two possible outputs, namely Z (depth) and horizon data. For
each position on the horizon, the value (Z or horizon data) is used as output along the
complete trace.

Instantaneous
Name
Instantaneous -- Attribute that returns a value at a single sample location.
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Description
Instantaneous attributes are computed sample by sample, and represent instantaneous
variations of various parameters. Instantaneous values of attributes such as trace envel-
ope, its derivatives, frequency and phase may be determined from complex traces. (see
figure below)

Complex Seismic Trace Attributes (From Taner et al.,)

The imaginary part of the complex trace is computed via the Hilbert transform. Possible
outputs are:



- 635 -

Instantaneous Amplitude (Trace Envelope)
Outputs the instantaneous amplitude (or envelope) of the selected data volume at the
sample location.
It can be used as an effective discriminator for the following characteristics:
Mainly represents the acoustic impedance contrast, hence reflectivity,
Bright spots, possible gas accumulation,
Sequence boundaries,
Thin-bed tunning effects,
Major changes in depositional environment,
Spatial correlation to porosity and other lithologic variations,
Indicates the group, rather than phase component of the seismic wave propagation.

l Amplitude 1st derivative: Time derivative of the instantaneous amp-
litude i.e time rate of change of the envelope. It shows the variation of
the energy of the reflected events. It is used to detect sharp interfaces
and discontinuities.

l Amplitude 2nd derivative: Second derivative of the envelope. It
provides a measure of the sharpness of amplitude peak. It can be used
to identify all reflecting interfaces within the seismic bandwidth.

Instantaneous Phase
Calculates the instantaneous phase at the sample location, it emphasizes spatial con-
tinuity/discontinuity of reflections by providing a way for weak and strong events to
appear with equal strength.
This attribute is of central importance since it describes the location of events in the seis-
mic trace and leads to the computation of other instantaneous quantities.
The instantaneous phase makes strong events clearer and is effective at highlighting dis-
continuities of reflectors, faults, pinch-outs, angularities and bed interfaces. Seismic
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sequence boundaries, sedimentary layer patterns and regions of onlap/offlap patterns
often exhibit extra clarity
The instantaneous phase relates to the phase component of wave-propagation, it is also
used to compute the phase velocity.

l Cosine phase: Cosine of the instantaneous phase, also called nor-
malized amplitude. It has the same uses as instantaneous phase with
one additional benefit: It is continually smooth. By providing the +/-180
degree discontinuity that occurs with instantaneous phase, the cosine
of instantaneous phase can be further processed (e.g, filtered and
stacked) using conventional seismic processing tools. Amplitude peaks
and troughs retain their position, but with strong and weak events now
exhibiting equal strength

l Envelope weighted phase: Instantaneous phase, weighted by the
envelope over the given time window

l Rotate Phase: Phase output is rotated through a user-specified angle

Instantaneous Frequency
Outputs the instantaneous frequency at the sample location.
The instantaneous frequency attribute responds to both wave propagation effects and
depositional characteristics, hence it is a physical attribute and can be used as an effect-
ive discriminator.
Its uses include:
Hydrocarbon indicator by low frequency anomaly.
Fracture zone indicator, since fractures may appear as lower frequency zones.
Bed thickness indicator. Higher frequencies indicate sharp interfaces such as exhibited
by thinly laminated shales, lower frequencies are indicative of more massive bedding
geometries, e.g. sand-prone lithologies.

l Envelope weighted frequency: Instantaneous frequency, weighted by
the envelope over the given time window

l Phase acceleration: Time derivative of the instantaneous frequency

l Thin bed indicator: Difference between instantaneous frequency and
Envelope weighted frequency

l Bandwidth: The absolute value of the envelope time derivative

l Q factor: Instantaneous frequency divided by the bandwidth

Hilbert (Quadrature Amplitude)
The quadrature trace is the imaginary part of the complex seismic trace (see image
above), and can be computed from the real trace via the Hilbert transfrom.

http://en.wikipedia.org/wiki/Hilbert_transform
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Both the real trace and its quadrature counterpart share the same amplitude spectrum;
the quadrature however is phase rotated by 90 degrees. Zero-crossings on the real trace
transform to peaks and troughs on the quadrature trace and peaks and troughs on the
real trace transform to zero-crossings on the quadrature trace.
The quadrature is used in various mathematical combinations to compute other complex
trace attributes such as instantaneous phase and instantaneous frequency. it is sensitive
to energy, frequency, and phase.

Log
Name
Log -- an attribute that returns a well log value.

Description
This attribute takes the value form an input well log and returns this value throughout the
volume at the corresponding Z value.

Input Parameters
Firstly, the 'Input Well' is chosen and, secondly, one of the associated logs from the auto-
filled 'Select Log' list.

Output
There are five possible outputs:

Examples
Below is a shot of the Gamma Ray log from F03-4 displayed on inline 441 (F3 Demo
dataset), as 'Take Nearest Sample':



- 638 -

Match Delta
Name
Match Delta -- Attribute that extracts time shifts between similar events in different seis-
mic volumes

Description
This algorithm extracts the time difference delta t between peaks in different seismic
volumes. A search window is set to avoid loop-skips. After extracting all delta t values,
they are interpolated. The resulting cube is the delta cube in ms or meter/feet which can
be used for the Delta Resample attribute.
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Extraction of delta t from two neighboring traces.

In a little more detail, the algorithm proceeds along these lines:

1. For each trace, all peaks are found.

Result: a list of peaks and the time of occurrence.

2. Each peak is coupled with a counterpart if it is found to be within the spe-
cified search window. (If none are found, there is no addition to the list of dif-
ferences.)

Result: a list of time differences (deltas)

3. The delta list is interpolated (linear, constant extrapolation at the ends)

Result: a delta value for each sample

After using this attribute, it will be clear that there are many 'jumps' and 'skips' in the dis-
played sections. Because we know that the deltas should not vary that quickly - not
going from trace to trace, but also not going from sample to sample, these can be effect-
ively removed by utilizing a double filter: first a rather large median filter over many
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traces and a 2 to 3 samples, then an average or FFT-based filtering in all directions. The
resulting output should now be relatively 'noise-free'.

Input Parameters

Besides the reference and the match cube, a maximum time-window must be defined in
order to avoid loop-skips.

Mathematics
Name
Mathematics -- Attribute that returns the result of a user-defined mathematical expression

Description
The Mathematics attribute is a way to combine data from stored data and attributes into a
new data.
The input data can be volumes, 2D lines or well logs. The output data has always the
same dimension (3D, 2D, 1D respectively) as the input, with the exception that 3D and
2D attributes can also be computed along surfaces (horizons and faults). The math-
ematical expression is calculated at each sample position.

Input Parameters
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A mathematical expression is specified in the Formula text field with variables, con-
stants, numerical values and/or recursive operators.

l Constants must start with the letter C and be following by a number: C1,
C5, C9... The number does not necessarily start at 0 and does not have
to be consecutive. Constants can be evaluated just like stepouts and
time gates for the other attribute. They are not available for logs cre-
ation

l Variables expressions can be any string: seis, energy, sim, ... They can
be called with a number between brackets like seis[-1] or seis[4], in
which case the value represents a shift in number of samples. seis[-1]
represents seis on the sample above, seis[4] represents seis four
samples below

l Recursive expressions are a way to call back the result of the math-
ematical formula on a sample above for computation. This result is
called with the expression OUT[-i] (case insensitive) where i is a num-
ber of samples

There is no limit in number of variables/constants used in an expression.

There are special constants for which it is not necessary to provide the numer-

ical value: DZ is the sampling rate of the input data, Inl and Crl are respect-

ively the inline and crossline numbers of the current trace. The special

constant are case sensitive.
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Mathematics attributes containing a recursive equation should only be

applied to the full volume/lines, not along a surface because of the integration

length.

Parentheses ( ) are allowed. Once the mathematical expression has be entered you
must press Set. Then a table will appear where you will be able to assign data to the vari-
ables and values to the constants and recursive settings: Start time (or depth) of the
recursive function and value at this time.

Supported operators are:

+, -, *, /, ^, >, <, <=, >=, ==, !=, && (and), || (or), |xn |(absolute value), cond ? true stat :
false stat.

Supported mathematical functions are:

sin(), cos(), tan(), asin(), acos(), atan(), ln(), log(), exp(), sqrt(), min(), max(), avg(), sum(),
med(), var(), rand(v) and randg(std).

Where avg is the average, med is the median, and var is the variance of the input para-
meters. The input parameters in parentheses should be separated by a comma.
The function rand(v) gives a random number from a uniform distribution between 0 and
v. The function randg(std) generates a random number from a Gaussian (normal dis-
tribution) with standard deviation std and expectation 0.

Supported constants are:

pi (3.1415927), undef (The OpendTect undefined value: 1e+30), e (2.71...), DZ (Z step),
Inl (Inline number), Crl (Crossline number), XCoord (X Coordinate), YCoord (Y Coordin-
ate), Z (Z value), THIS, seis[-1]

In addition it is possible to make logical operations using IF .. THEN .. ELSE statements.
The following syntax must be used:

CONDITION ? OUTPUT IF TRUE : OUTPUT IF FALSE

The three parts can be any set of variables and/or constants. IF..THEN..ELSE state-
ments can be embedded like here:
CONDITION1 ? TRUE : (CONDITION2 ? TRUE : FALSE)
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Other options

Predefined functions, constants, and operators can be inserted into the 'Formula ' field
using a combination of the drop-downs, followed by the ' Insert ' button. These are
grouped so:

The grouping 'Other' contains the above.

Pressing this button, , will open the 'Rock Physics ' library of formulas.
Clicking 'Ok' in this additional window will directly insert the chosen formula into the 'For-
mula' field.

Formulas in Mathematics can be saved ( ) and loaded from a stored location ( ).

Examples of expressions

l X0 == X1 returns 1 if X0 equals X1, 0 is returned if the statement is
false, i.e. X0 is not equal to X1

l X0 != X1 returns 1 if X0 is not equal to X1 and 0 if X0 equals X1

l X0 && X1 returns 1 if X0 and X1 are not equal to 0. If one of these
equals zero a 0 is returned

l X0 || X1 returns 1 if X0 or X1 is not equal to 0. If both are zero a 0 is
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returned

l |X0| returns the absolute value of X0

l X0 > 1 ? X1 : X2 means if X0 is larger than 1 return X1, else return X2

l sin(X0) returns the sine of X0

Let's say you have one input cube, say 'Cube1' and one attribute already defined,
Energy40, which is the Energy per sample calculated in a [-20,20] ms window around
the current sample. Then, you could define 'Damped amplitude' as;

l Select Mathematics attribute

l Enter formula: seis / energy

l Press Set

l Select 'Cube1' for seis and 'Energy40' for energy

l Provide a name for the attribute, and press Add as new

Additional examples

1 - Centred differentiation example: Centred differentiation can be coded
using the formula (seis[+1]-seis[-1])/(2*DZ) where DZ is the sampling rate.
Please note that for lateral shifts the reference shift attribute must still be
used.

2 - Recursive filters can be created using the syntax "OUT[-i]". The most gen-
eral form of recursive equation is the following:

y[n] = a0*x[n] + a1*x[n-1] + a2*x[n-2] + ...
+ b1*y[n-1] + b2*y[n-2] + ...

where x[] is the input volume, y[] is the output volume and the a's and b's the
coefficients. n is the current sample number.

In the mathematics attribute the current sample index "n" does not need to be
specified. Therefore the equation above can be entered as:
c0*x0 + c1*x0[-1] + c2*x0[-2] + c3*OUT[-1] + c4*OUT[-2] + ...
where OUT[-1] stands for y[n-1] and OUT[-2] stands for y[n-2]
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For each instance of OUT[-i] a starting value and attached time/depth must
be provided.

Two examples of low pass and high pass recursive filters are provided in the
default attribute set "Evaluate attributes":
"Single pole low pass recursive filter" and "Single pole high pass recursive fil-
ter". Best results are achieved when providing an input of impedance or velo-
city type.

3 - The phase rotation is an attribute available in the Evaluate attribute set
and in the dGB Evaluate attribute set.

This attribute allows the user to apply a phase rotation of any angle to the
data.

It applies the formula: seis*cos(c0*PI/180)-hilbert*sin(c0*PI/180)
where seis is the seismic data
hilbert is the Hilbert transform of the seismic data
c0 is the applied angle for the rotation

c0 is in degrees.

Position
Name
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Position -- Attribute that returns any attribute calculated at the location where another
attribute has its minimum, maximum or median within a small volume.

Description
The input attribute is the criteria used to determine the position at which the output attrib-
ute has to be calculated. The stepouts and time-gate define the volume in which the
input attribute is evaluated. In case of a 2D attribute as input, the inline/crossline stepout
is replaced by a single trace stepout.

The Operator determines which position is returned from this analysis; the position of the
minimum, maximum, or median of the input attribute. This position is the position at
which the output attribute will be calculated.

Examples
The position attribute can be used for several purposes. For example, one can determ-
ine where in a small volume the energy is minimal and output the frequency at the loc-
ation of this lowest energy. Also, application of the position attribute is an important step
for Fault Enhancing Filtering. In this case, the user takes the Minimum Similarity as Input
attribute and as Output, for example, filtered data (using Max as Operator). The stepout is
set to, for example, 1 in both inline and crossline direction and the time-gate is defined
[0,0]. The result below shows a sharply defined fault:
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Before applying the position attribute After applying the position attribute

Prestack
Name
Prestack -- The pre-stack attribute can be used either to extract statistics on the gathers
and their amplitudes, or to extract AVO attributes.
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This attribute requires pre-stack data as input, but will output post-stack data. The fol-
lowing workflow is used in the above example:

l Pre-processing is applied to the gathers, like mute and AGC

l The data is extracted in the offset range [500, 3000] m and sorted per
CDP and depth sample

l For each CDP and depth a crossplot of amplitude vs. square root of the
offset is made

l A least square regression is computed

l The intercept value is returned



- 649 -

The pre-processing of the gathers is optional. When used it must be setup in a separate
window either by selecting an existing setup or creating a new one.

The offset range is used to define the extraction window. It requires absolute offset val-
ues, in meter or feet (depending on the survey unit definition). Optionally if angles were
used instead of offsets while loading, then angle ranges can be used. Once again they
have to be in the same unit as in the input trace (SEG-Y) headers.

After optional pre-processing and data extraction, a vector of amplitudes is available for
each CMP/CIG, at each depth. From each vector either statistics or a least-square regres-
sion can be made.

Statistics:

The above list of statistics can be returned. The highlighted output option provides the
fold of each bin, while average or RMS may be used to generate full or partial stacks
(partial stacking occurs if the offset range defined is not full). At the foot of this list are
also: Sum, SquareSum and MostFrequent

Least Square:

The Least-Square calculation type is cross-plotting the extracted amplitudes, computing
a least-square regression and returning one of its property.
Before the crossplot the amplitudes can be transformed using the following axis trans-
formation (left hand-side):
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Similarly the offset values that are associated with those amplitudes can also be trans-
formed (right-hand side). This is useful, e.g. to have the sin2 of the angle as x-axis.

AVO attributes will become AVA attributes if the X axis becomes Azimuth (i.e. angle).
Please note that the azimuths (angles) must be provided in the trace headers when
extracting AVA attributes.

The extractable AVO (Least-Square) attributes are Intercept, Gradient, their standard
deviation and the Correlation Coefficient. It is also possible to have angle/offset con-
strained AVO attributes; by specifying the required angle/offset range instead of using
the full range. Please note that further transformations can be achieved using the output
as input to another attribute.

Reference
Name
Reference -- Attribute that returns the definitions of the extraction position

Description
The X, Y, Z, Inline number, Crossline number, Sample number, Inline index, Crossline
index and Z index position of the reference (extraction) point is returned.
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Output

l X: outputs the X-coordinate

l Y: outputs the Y-coordinate

l Z: outputs the depth according to the survey setup (e.g. miliseconds,
meters or feet)

l Inline nr: outputs the inline number

l Crossline nr: outputs the crossline number

l Sample nr: outputs the sample number starting from 0 ms or the top of
the survey when the survey has a negative start time. The first sample
has sample number 1. If the survey has 4 ms sampling and starts at 0
ms, at 400 ms the sample number is 101. If the survey has 4 ms
sampling and starts at 2500 ms, the first sample has sample number
626. If the survey has 2 ms sampling and starts at -200, the sample num-
ber at 0 ms is 101

l Inline index: outputs the number of inlines from the edge of the survey
starting at 1 (e.g. If you have an inline range of 2000 to 3000, the inline
index will range from 1 to 1001)

l Crossline index: outputs the number of crosslines from the edge of the
survey starting at 1 (e.g. If you have a crossline range of 2000 to 3000,
the crossline index will range from 1 to 1001)

l Z index: outputs the sample number from the top of the survey starting
at 1. (Note: this attribute is identical to sample number if the survey has
a negative starting time or starts at 0.)
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The Reference attribute replaces the old Reference time attribute. Attribute

sets containing the old Reference time attribute will be automatically updated

to the Reference attribute, with Z as output, which gives an identical output.

Reference Shift
Name
Reference shift -- Attribute that moves the extraction position in 3D space

Description
The Input attribute is extracted at the shifted position. The original reference (extraction)
point has inline/crossline co-ordinates (0,0). Relative number 1 means the next inline or
crossline, respectively. In case of input of a 2D attribute, the inline/crossline shift is
replaced by a single trace shift. The vertical shift is specified in milliseconds using the
Time option. There is also the option to use Steering while calculating the Reference
shift.

The Input attribute is extracted at the shifted position. The original reference (extraction)
point has inline/crossline co-ordinates (0,0) and Time 0.

The attribute will take the value from the shifted position and display it at the original ref-
erence point. Say that an original position (inl:0,crl:0,Time:0) has a shift of (25,25,100)
applied to it, then this will take the output value at (25,25,100) and display it at (0,0,0). (In
case of input of a 2D attribute, the inline/crossline shift is replaced by a single trace/time
shift - ie: 25,100.)
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It is important to remember that the vertical element of the shift is 'positive upwards' and
'negative downwards'.

Think of a time-shift of +100:
Original TWT = 500
Shifted TWT = (500 + 100) = 600
The value from TWT = 600 will be displayed at TWT = 500, giving the impres-
sion of a upward shift.

Think of a time-shift of -100:
Original TWT = 500
Shifted TWT = (500 - 100) = 400
The value from TWT = 400 will be displayed at TWT = 500, giving the impres-
sion of a downward shift.

Think of an horizontal shift of (Inl:5,Crl:8):
Original position = 100,150
Shifted position = 105, 158
The value from 105,158 will be displayed at 100,150.

Shifting the reference position is a form of directivity that is useful in multi-attribute ana-
lysis. Examples of use:

l calculating reflectivity in an Acoustic Impedance volume. Values extracted at +4
and -4 ms would be as input to a Mathematics attribute to perform the actual cal-
culation.

l highlighting flat spots - one may consider attributes that are extracted in a hori-
zontally aligned window.

l measuring differences across a fault plane and comparison of such values.

Sample Value
Name
Sample Value -- Attribute that returns the input value at the sample location

Description
'Sample value' gives the value of the input volume at the sample location. It's only use is
witihn the SynthRock Crossplot tool where it can be used to select a stored volume.

http://opendtect.org/index.php/products/commercial-products/synthrock
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Scaling
Name
Scaling -- Attribute used for scaling of amplitude

Description

Input Parameters
The amplitude of the Input Data can be scaled in five modes:

l Using a time/depth variant weighting function

l Using weight(s) extracted in static time/depth window(s)

l Using Automatic Gain Control (single dynamic window)

l Using Squeeze ('non-clipping' limiter of range input)

l Using Gain Correction (correct/apply gain)

Output
The output amplitudes are always the ratio of the input amplitudes over a weighting func-
tion w(i), i being the sample index.
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1. Z^n scaling
The weight function is defined by Z^n where Z is the time/depth of the current
sample and n is a user-defined exponent:

w(i) = Z(i)^-n where is Z is the time or depth of the ith sample.

The exponent is a float and thus it can be negative, positive and equal to
zero (unity operator). An exponent larger than zero will apply a correction pro-
portional to the depth, while an exponent smaller than zero will apply an
inversely proportional correction with depth. The output amplitude is the nor-
malized sum of the input amplitude using a weight equal to Z^n.

2.Window(s) scaling
The weight function is a step function: w(i) is constant over a static time/depth
window, equal to the "basis" value than is computed from the input amp-
litudes using the following mathematical definitions:

l The Root Mean Square (RMS)
l The arithmetic mean
l The maximum
l A user-defined value (float)
l Detrend. This option removes the trend but rather than doing so fol-
lowing a constant α, it will detrend following αɣ + β. (See: http://en.wiki-
pedia.org/wiki/Trend_estimation for further info.)

Please note that the window time/depths are float and do not need to be on a
sample. The time/depths will be round to the nearest sample when defining
the extraction window. Unlike most of the window definitions in the attribute
engine you must provide in this scaling attribute absolute time/depths values
and not values relative to the actual sample. A weight of 1 (no scaling) will be
given to the samples not covered by a user-defined time gate. The weights
are cumulative: If several windows overlap the output weight will be the sum
of the "basis" output for the samples belonging to multiple windows.

http://en.wikipedia.org/wiki/Trend_estimation
http://en.wikipedia.org/wiki/Trend_estimation
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3. Automatic Gain Control scaling
The AGC is a special case of the window scaling. In this case the window is
defined relative to the actual sample and the "basis" is the energy value in
that sliding window. The window width is a total size, i.e. the relative width
corresponds to +/- half of the total window width. The low energy mute will
mute the output samples that have an energy lower than a ratio of the trace
energy distribution: The energy of the input trace is computed and the output
values are sorted per increasing energy value.

Given 1000 samples, the energy of sample 250 (for a low energy mute at
25%) corresponds to the mute level: If the energy computed in the AGC win-
dow is lower than this level the value 0 will be output. Otherwise the sum of
the squares over the number of (valid) samples will be output. Undefined val-
ues are not used for the computation and a zero is output if all values of a
time window are undefined. In other words, the energy of all elements within
the defined window are calculated and then ranked, then the (user-defined)
percentage of the lowest energy levels are muted out.
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4. Squeeze
The purpose is to put a limit to the value range of the input. Rather than clipping the
value (which would be equivalent to a simple Mathematics formula like 'x0 > c0 ? c0 :
x0'), the value can be squeezed into a range.

The first parameter is the 'Value range'. it defines the hard limits to the value range. One
of these limits may be empty, signifying 'unlimited'.

The second parameter is the 'Untouched range'. If no limits are entered there, Squeeze
will degrade to a simple clipping operation. If specified, it will squeeze rather than clip,
constraining the squeezing to the ranges outside this range.

For example, Value range [0,10] and untouched range [2,8]. Values outside the [2,8]
range will be modified to fit between [0,10]. This means the values in the range [-infin-
itiy,2] will be squeezed into the range [0,2] via a hyperbolic function. That function is con-
tinuous in value (and first derivative) at 2. Similarly, values higher than 8 will go
somewhere between 8 and 10.

Example application: predicted porosities. Predictions of porosity tend to have values
below 0. To counter this, you could squeeze all values below 1%. Use value range [0, ]
and untouched range [1, ]. If you also want a more fuzzy upper limit, starting at 25% to
absolute maximum 30, you may specify [0,30] and [1,25].

This is shown in the attribute set below:
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5.Gain Correction
This attribute is used to correct for any undesirable gain applied previously or to apply a
new gain function on the seismic data. This is applied by first selecting the input data for
gain correction and clicking on Analyse button.

The newly popped Select data window requires specifying a number of random traces in
the 'Nr of Traces for Examination' field for visually analyzing and defining the gain beha-
vior in time/depth. The volume from which these random traces will be selected is out-
lined by modifying the inline, crossline and time ranges. Finally,OK is pressed to begin
the examination of the random traces.
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The Analyse Gain window has the 'Z' range (in seconds) of the seismic data as the hori-
zontal axis, while the left vertical axis shows the 'Scale Factor' and the right vertical axis
is the 'RMS Amplitude'. The amplitude scale can be set to 'Linear' or 'dB' (i.e. decibel) for
visualization purposes. Further, the 'Scale Range' could be changed to use a different
scale. The 'Gridline step' could be changed as the name says to modify the gridline
steps.
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Finally, a 'Gain correction trend' can be defined by moving the red curve such that for
any particular 'Z' interval a specific 'Scale Factor' range is used to scale the seismic amp-
litudes in that interval. For defining boundary points of these intervals user can double
click on the red curve and move the curve as desired.

Pressing OK will save the 'Gain correction curve'.

Semblance
Name
Semblance -- Attribute that returns a value (semblance coefficient) which is a measure of
multichannel coherence.

Description
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Semblance is, essentially, a measure of how similar a particular trace is to a group of
traces within a user-defined correlation window. This attribute will calculate the semb-
lance coefficient and return a value between 0 (completely dissimilar) and 1 (identical).
This is done by summing the squares of the energies within the stack and dividing by the
sum of those energies.

Whereas the Similarity attribute works by comparing pairs in given positions,

Semblance uses all points within the window to create the score.

Input Parameters
The size of the correlation window is defined by the Time Gate and Stepout, with the
'Extension' defining its shape.
Steering may be used to enhance the results, if the DipSteering plugin is installed (with
a valid license.)

Time-Gate:
Defines the size of the vertical element in the correlation window (ie: the
trace length to be used in the calculation).

Stepout:
Applies for 'Extensions' of shape Full block, Cross, All Directions and Diag-
onal. Defines the extent of the horizontal element in the correlation window
(see 'Extension' below for more detail).

Trace Position:
Applies for 'Extensions' of shape None, Mirror 90 degrees and Mirror 180
degrees. Defines the positions of the traces to be used in the correlation win-
dow (see 'Extension' below for more detail).

http://opendtect.org/index.php/products/commercial-products/dip-steering
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Extension shapes:

l None: Semblance is calculated using only the traces defined in 'Trace
positions'.

l Mirror 90 degrees: Semblance is calculated using two additional traces:
the defined trace pair (as in 'None') and the trace obtained by 90° rota-
tion. (Not available for 2D data)

l Mirror 180 degrees: Semblance is calculated using two additional
traces: the defined trace pair (as in 'None') and the trace obtained by
180° degree rotation.

l Full Block: Semblance is calculated using all possible traces in the
column defined by the time-gate/step-out. Beware of potentially long
processing times with large time-gates/stepouts.

l Cross: Semblance is calculated using all possible traces in the '+' -
shaped column bounded by the time-gate/step-out.

l All Directions: Semblance is calculated using all possible traces in the
'✴ ' -shape bounded by time-gate/step-out. This is the extension found
to be most useful: it gives a degree of accuracy almost equal to that of
'Full Block' but with significantly less processing time (depending on
the step-out, up to a factor of 10).

l Diagonal: Semblance is calculated using all possible traces in the 'x' -
shaped column bounded by the time-gate/step-out.

References
For a very concise explanation of semblance, please see: http://wiki.seg.or-
g/wiki/Dictionary:Semblance

http://wiki.seg.org/wiki/Dictionary:Semblance
http://wiki.seg.org/wiki/Dictionary:Semblance
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Similarity
Name
Similarity -- Multi-trace attribute that returns trace-to-trace similarity properties

Description
Similarity is a form of "coherency" that expresses how much two or more trace segments
look alike. A similarity of 1 means the trace segments are completely identical in wave-
form and amplitude. A similarity of 0 means they are completely dis-similar.

In OpendTect, we favor a different approach. We first try to find the direction of best
match at every position, which is a result by itself: the dip. By using this dip we can then
calculate the best Similarity between adjacent traces. Similarity is based on fundamental
mathematics: the samples of the trace are seen as components of a vector, and the Sim-
ilarity is defined in terms of distance in hyperspace.

The point about using the Similarity is that it's mathematically simple; it is very clear what
is going on. Then, by combining different kinds of similarities and other attributes, you
can always get much better results with lots less computing time.

Consider the trace segments to be vectors in hyperspace. Similarity is then defined as
one minus the Euclidean distance between the vectors, normalized over the vector
lengths.

The trace segments is defined by the time-gate in ms and the positions specified in rel-
ative co-ordinates. In case of using input from 2D data, the trace positions are defined by
a trace step-out only, not by inline and crossline stepout. The Extension parameter
determines how many trace pairs are used in the computation. This is visualized in the
image below.
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Definition of trace positions relative to the reference point at (0,0).

Input Parameters

Extension Definitions

l None: Only the similarity between the pair of traces defined in 'Trace
positions' is calculated.

l Mirror 90 degrees: Two similarities are computed: one for the defined
trace pair (as in 'None') and one for the pair obtained by 90 degree rota-
tion. (Not available for 2D data)

l Mirror 180 degrees: Two similarities are computed: one for the defined
trace pair (as in 'None') and one for the pair obtained by 180 degree
rotation.

l Full Block: Similarities between all possible trace pairs in the rectangle
defined by the step-out are computed.

l Cross: Similarities between all possible trace pairs in the '+' -shape
defined by the step-out are computed.

l Diagonal: Similarities between all possible trace pairs in the 'x' -shape
defined by the step-out are computed.

l All Directions: Similarities between all possible trace pairs in the ' ' -



- 666 -

shape defined by step-out are computed. This is the extension found to
be most useful: it gives a degree of accuracy almost equal to that of
'Full Block' but with significantly less processing time (depending on
the step-out, up to a factor of 10).

The attribute returns the statistical property specified in Output statistic. The Steering
option enables the user to follow the local dip to find trace segments that should be com-
pared instead of comparing two horizontally extracted trace segments. The Steering
option supports five different modes of data-driven steering: None, Central, Full, Con-
stant direction Steering and Browse dip.]

Similarity "None" Steering: This option is used when non SteeringCube algorithm is
used. This is ok in the case the layering is mainly horizontal (with less dip).

However, in very complex geology, the similarity result using "None" as steering option
will deteriorate. Full steering should be used instead. The Dip- Steering plugin is
required.

http://opendtect.org/rel/doc/User/dgb/chapter2.2_create_steering_data.htm
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Another steering option to use is the "Browse dip". This is a similarity feature acting as a
'Coherency' attribute.
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It enables the calculation of 'Similarity' by comparing one trace with the next trace.
Then a value between 0 (not similar at all) to 1 (completely similar) is awarded. In order
to compare traces, two variables should be specified:
The 'Maximum dip' represents the maximum dip in microseconds per metre (μs/m), rel-
ative to an event in one trace, in which the algorithm will look for similar events along the
neighbouring trace. Default is 250.
The "Delta Dip" is a variable which represents the window in microseconds per metre
(μs/m) which is shifted along the neighbouring trace to detect similar events whithin the
earlier specified 'Maximum Dip'. The closer the value to 1 the more precise the results
will be. The default value is 10. Using this value will result in a good balance between
calculation time and quality of the results, this also depends on the quality of the data
itself.

Mathematical description
Let us assume two vectors X, Y of length N=15 samples:
Xi, i=1,15
Yi, i=1,15

The similarity is 1 minus the Euclidean distance between the vectors divided by the sum
of the length of each vector. Please note that the length of a vector is its L2 norm, also
called RMS value:
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Examples

An example timeslice is highlighting fault structure: (a) Dip-steered Filtered Seismic, (b)
Non-Steered minimum Similarity, (c) Steered minimum Similarity. Notice that the defin-
ition of faults has been improved with the Similarity attributes. The steered minimum Sim-
ilarity (c) is highlighting precise fault definitions as compared with the result of non-
steered minimum Similarity (b).

Spectral Decomposition
Name
Spectral decomposition -- Frequency attribute that returns the amplitude spectrum (FFT)
or wavelet coefficients (CWT)

Description
Spectral Decomposition unravels the seismic signal into its constituent frequencies,
which allows the user to see phase and amplitude tuned to specific wavelengths. The
amplitude component excels at quantifying thickness variability and detecting lateral dis-
continuities while the phase component detects lateral discontinuities.

It is a useful tool for "below resolution" seismic interpretation, sand thickness estimation,
and enhancing channel structures.

Input Parameters
The user can choose between two types of transform:
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l FFT the Fast Fourier Transform. The FFT requires a short window
(time-gate) and a step-size between the analyzed frequencies. This
step can be interpreted as the frequency resolution.

l CWT the Continuous Wavelet Transform. The CWT requires a wavelet
type.

When choosing the CWT, you can set the wavelet type:

l Morlet

l Gaussian

l Mexican Hat

In FFT only, the signal within the time-window will be transformed into frequency
domain. The given step determines the output resolution, if necessary zeros will be
added to acquire this resolution. The amplitude spectrum is calculated for the requested
frequency. The time-window slides from top to bottom to cover the complete signal. In an
ideal situation, the time-window encompasses one seismic event, which may be a super-
position of multiple geological events which interfere in the seismic trace.
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Output and Examples
The CWT is defined as the sum over the signal multiplied by a scaled and shifted wave-
let. The wavelet is shifted along the signal and at each position the correlation of the
wavelet with the signal is calculated. The result is called a wavelet coefficient. The given
frequency corresponds to the central wavelet frequency. The step determines the output
resolution, which is especially interesting when evaluating this attribute.
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Spectral Decomposition (CWT) applied to a horizon. Notice that each index frequency is
describing the specific parts of channels (NNE-SSW oriented). Also thinner and thicker
parts of horizon along channels are highlighed clearly.

Time-frequency spectrum
The output frequency is best determined using the time-frequency spectrum panel. This
panel displays the spectral decomposition output for all frequencies between 0 and the
Nyquist frequency of the data, computed with a step of 1Hz. One must first select a pos-
ition for this single trace analysis:

The time-frequency is then displayed in a 2D panel like this:



- 673 -

Color blended display:
RGB(A)* blending attribute display is used to create a normalized color-blended display
that often show features with greater clarity and enhances a detail map view. Tra-
ditionally, it is used to blend the iso-frequency responses (Spectral Decomposition), but
a user can blend three/four different attributes that define a spectrum that is comparable.
For instance, spectral decomposition outputs the amplitude at discrete frequencies. So, it
renders the same output (unit=amplitude). Depending upon a geological condition or the
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objective, FFT short window or CWT (continuous wavelet transform) can be chosen.
Results are best displayed on time/horizon slices, volume.
(* RGB(A)- Red, Green, Blue, (Alpha) -channel)

A color blended map view (image on right) of the spectral decomposition (red-10hz,
green-20Hz, blue-40hz). Compare the results with the coherency map (image on left).
Note that the yellowish colored fault bounder region is thicker as compared to the sur-
rounding regions. The faults throw (red- color) are also clearly observable. Coher-
ency/similarity together with color blended spectral images can reveal better geological
information.

Texture
Name
Texture -- Group of attributes that return statistical properties of a Grey-Level Co-occur-
rence Matrix (GLCM)

Description
The texture attributes implemented in OpendTect are described in detail in the GLCM
Texture Tutorial by Mryka Hall-Beyer.

GLCM texture attributes come from image processing and were developed to capture
roughness / smoothness of an image. The attribute response is calculated in two steps:
First the GLCM is computed for an area (volume) around the evaluation point. Secondly
a statistical property from the GLCM is returned. The GLCM is a 2D matrix that captures
how often the neighbor values A and B occur in an image. Look at the GLCM as a matrix
of N x N dimensions that captures the amplitude response of the reference position in

http://www.fp.ucalgary.ca/mhallbey/tutorial.htm
http://www.fp.ucalgary.ca/mhallbey/tutorial.htm
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the columns and the amplitudes of the neighboring position in the rows. N is the range of
all values the data can have. Let's say we have a data set in which amplitudes can have
values 0,1,2,or 3 (GLCMmatrix is 4 x 4). We then fill the matrix by comparing each amp-
litude in the input area (volume) with its direct neighbor and increase the occurrence of
the corresponding matrix cell. The matrix is made symmetrical by comparing neighbors
in both directions: reference vs neighbor and neighbor vs reference, and it is normalized
by dividing through the total number of occurrences. The normalized GLCM matrix is a
kind of a probability matrix that tells us how probable it is to find pairs of neighboring
amplitudes in the area (volume) around the evaluation point.

In OpendTect the GLCM is computed on re-scaled data. The input data is re-scaled lin-
early to 4-bits (values ranging from 0 to 15; GLCM 16 x 16), or to 5-bits (values from 0 to
31; GLCM matrix 32 x 32). To re-scale the data the user must give the clipping range of
the input data. Neighbors are compared in the inline and cross-line directions. The mat-
rix is further filled by looping over the user-defined time-gate. Note that when dip-steer-
ing is used the input extraction area (volume) follows the local stratigraphy, which leads
to better responses in dipping strata.

Texture attributes in seismic interpretation are typically used in facies analysis. They can
be used in their own right, or (when you have access to the Neural Network plugin) as
inputs to a neural network to create 3D seismic facies volumes. This can be done in a
supervised approach (MLP network), or in an unsupervised approach (UVQ network).

Input Parameters
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Time-gate, step-out and Dip-steering (optional; requires Dip-steering plugin) settings
determine the input area (volume) for which the GLCM matrix is computed. Larger step-
outs results in smoother outputs that will follow the stratigraphy better if dip-steering is
used.

GLCM-size is the size of the GLCMmatrix. 32 x 32 may give somewhat sharper outputs
at the expense of more CPU time.

Input Data Minimum and Maximum define the clipping range of the data, which is
needed to rescale the data to 4-bits (16 x 16), or 5-bits (32 x 32).Input data range is auto-
matically calculated from the compute option.In the "analysis" window number of traces
need to be selected which computes the scaling range from the selected input traces.

Output
OpendTect supports three groups of Texture Attributes:

1. Contrast group: Measures related to contrast use weights related to the dis-
tance from the GLCM diagonal along which neighboring values are equal.
Attributes in this group: Contrast, Dissimilarity, Homogeneity

2. Measures related to orderliness. Attributes in this group: Angular Second
Moment (ASM), Energy, Entropy

3. Group using descriptive statistics of the GLCM texture measures. Attributes
in this group: GLCM Mean, GLCM Variance, GLCM Standard Deviation,
GLCM Correlation

In all equations given below N denotes the size of the GLCM matrix; i refers to the
column and j to the row. P is the GLCM Probability matrix.

Contrast

When i and j are equal, the cell is on the diagonal and (i-j)=0. These values represent
amplitudes entirely similar to their neighbor, so they are given a weight of 0.
If i and j differ by 1, there is a small contrast, and the weight is 1.
If i and j differ by 2, contrast is increasing and the weight is 4.
The weights continue to increase exponentially as (i-j) increases.

Dissimilarity
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In Dissimilarity the weights with which GLCM probablities are multiplied increase lin-
early away from the diagonal (along which neighboring values are equal).

Homogeneity

Dissimilarity and Contrast result in larger numbers for more contrasting windows. If
weights decrease away from the diagonal, the result will be larger for input areas
(volumes) with little contrast. Homogeneity weights values by the inverse of the Contrast
weight, with weights decreasing exponentially away from the diagonal.

Angular Second Moment

ASM and Energy use the GLCM probability as a weight for itself. The name for ASM
comes from Physics, and reflects the similar form of Physics equations used to calculate
the angular second moment, a measure of rotational acceleration. High values of ASM
or Energy occur when the input area (volume) is very orderly.

Energy

See above.

Entropy
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Entropy is the opposite of energy; it is a measure of chaos. In physics (thermodynamics)
entropy refers to the quantity of energy that is permanently lost to heat ("chaos") every
time a reaction or a physical transformation occurs. Entropy cannot be recovered to do
useful work. Because of this, the term is used in non technical speech to mean irre-
mediable chaos or disorder. Also, as with ASM, the equation used to calculate physical
entropy is very similar to the one used for the texture measure.

GLCMMean

The left hand equation calculates the mean based on the reference pixels, i. The right-
hand equation calculates the mean over the the neighbor pixels, j. These two values are
identical because OpendTect computes a symmetrical GLCM, where each amplitude is
counted once as a reference and once as a neighbor.

GLCM Variance

Variance is a measure of the dispersion of the values around the mean. It is similar to
entropy. It answers the question "What is the dispersion of the difference between the ref-
erence and the neighbour pixels in this input area (volume)?"
GLCM Variance in texture measures performs the same task as does the common
descriptive statistic called variance. It relies on the mean, and the dispersion around the
mean, of cell values within the GLCM. However, GLCM variance uses the GLCM, there-
fore it deals specifically with the dispersion around the mean of combinations of ref-
erence and neighbor amplitudes, so it is not the same as variance of input amplitudes
that can be computed with the "Volume Statistics" attribute.

Variance calculated using i or j gives the same result, since the GLCM is symmetrical.

GLCM Standard Deviation
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There is no particular advantage to using Standard Deviation over Variance, other than
a different range of values.

GLCM Correlation

The Correlation texture measures the linear dependency of input amplitudes on those of
neighboring amplitudes.

GLCM Correlation is quite a different calculation from the other texture measures
described above. As a result, it is independent of them (gives different information) and
can often be used profitably in combination with another texture measure. It also has a
more intuitive meaning to the actual calculated values: 0 is uncorrelated, 1 is perfectly
correlated.

GLCM Correlation can be calculated for successively larger window sizes. The window
size at which the GLCM Correlation value declines suddenly may be taken as one defin-
ition of the size of definable objects within an image.

If the input is completely uniform the GLCM variance is 0 and the correlation function is
undefined. OpendTect will in that case return the value 1.

Examples
DS in the examples below stands for Dip-Steering.

Seismic Contrast: 3 x 3 x [-8,8], DS Dissimilarity: 3 x 3 x [-
8,8], DS
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Homogeneity: 3 x 3 x [-8,8],
DS ASM: 3 x 3 x [-8,8], DS Energy: 3 x 3 x [- 8,8],

DS

Entropy: 3 x 3 x [-8,8] GLCMMean: 3 x 3 x [-8,8], DS GLCM Variance: 3 x 3 x
[-8,8], DS

GLCM Standard Deviation: 3
x 3 x [-8,8]

GLCM Correlation: 3 x 3 x [-
8,8], DS

References
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l Chopra, S. and Alexeev, V., 2005. Application of texture attribute ana-
lysis to 3D seismic data. CSEG Recorder, Sep. 2005 pp 29-32.

l Hall-Beyer, M. GLCM Texture Tutorial. Available: Online [Accessed 9
Oct. 2012].

Texture - Directional
Name
Texture - Directional -- a multi-trace attribute that returns textural information based on a
statistical texture classification.

Description
Texture- Directional uses the grey level co-occurrence matrix (GLCM) and its derived
attributes are tools for image classification that were initially described by Haralick et al.
(1973). Principally, the GLCM is a measure of how often different combinations of pixel
brightness values occur in an image. It is a method widely used in image classification of
satellite images (e.g. Franklin et al., 2001; Tsai et al., 2007), sea-ice images (e.g. Soh
and Tsatsoulis, 1999; Maillard et al., 2005), magnetic resonance and computed tomo-
graphy images (e.g. Kovalev et al., 2001; Zizzari et al., 2011), and many others. Most of
these GLCM applications are for classification of 2D images solely. The application of
GLCM for seismic data has been a minor topic in comparison to common seismic attrib-
utes such as coherence, curvature or spectral decomposition. Today, a high percentage
of the available seismic data is 3D seismic. Therefore, it is important for the classification
of seismic data to adapt the GLCM calculation to work in the three-dimensional space.
Few authors have described the application of GLCM for 3D seismic data with various
approaches to this topic (Vinther et al., 1996; Gao, 1999, 2003, 2007, 2008a, 2008b,
2009, 2011; West et al., 2002; Chopra and Alexeev, 2005, 2006a, 2006b; Yenugu et al.,
2010; de Matos et al., 2011; Eichkitz et al. 2012, 2013, 2014).
The calculation of GLCM-based attributes can be done in separate space directions. For
the 2D case 4 space directions exist. For the 3D case the number of possible space dir-
ections is extends to 13. The principal workflow of GLCM-based attribute calculation con-
sists of transformation of the amplitude cube into a grey level cube, the counting of pixel
co-occurrences within in a given analysis window, and the calculation of attributes
based on the co-occurrence matrix. In Figure 1 the principal calculation of 2D GLCM in
four space directions is shown for a sample image.

http://www.fp.ucalgary.ca/mhallbey/tutorial.htm
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Figure 1: Example for the calculation of grey level co-occurrence matrix-based attributes
using eight grey levels for a randomly generated 2D grey-scale image (a). The grey-
scales of the image can be represented by discrete values (b). The number of co-occur-
rences of pixel pairs for a given search window are counted and a grey level co-occur-
rence matrix (c) is produced. Based on this co-occurrence matrix, several attributes can
be calculated. In this example, the grey level co-occurrence matrices are determined for
the horizontal (d), the vertical (e), the 45° diagonal (f), the 135° diagonal (g), and for all
directions at once (h). The first step in calculation is the determination of co-occurrences
(column 2). Zero entries are marked in light grey and the highest value of each matrix is
marked in dark grey. It is evident that calculations in single directions lead to sparse
matrices. The GLCM is normalized by the sum of the elements to get a kind of probability
matrix (column 3). Finally, the probabilities are used for the calculation of GLCM-based
attributes. In column 4 the results for Entropy, Contrast, Homogeneity, Entropy, and
Cluster Tendency are shown.

In the case of 3D data the number of possible directions increases to 13. In Figure 2 a
simple Rubik’s cube is taken to explain the 13 possible directions for a 3D dataset. This
Rubik’s cube is build-up of 27 small cubes. The small cube in the center (the turning
point in a Rubik’s cube) is the point of interest for which the calculations are performed.
This center point is surrounded by 26 neighboring cubes. If we now take the center point
and draw lines form it to all neighboring cubes, we get 13 directions on which the neigh-
boring samples are placed.
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Figure 2: The number of principal neighbors for one sample point can be best explained
by looking at a Rubik’s cube (a). The center of the Rubik’s cube (core mechanism for
rotating the cube, red box in (b)) has in total 26 neighboring boxes (including diagonal
neighbors). These boxes are aligned in 13 possible directions. Analogous to this, a
sample point within a seismic sub-volume has 26 neighbors aligned in 13 directions (c).
In the developed workflow it is possible to calculate the GLCM along single directions,
along combinations of directions (e.g. inline direction, crossline direction, …), or all dir-
ections can be calculated at once (after Eichkitz et al., 2013).

Input Parameters

Input Data
The input for the GLCM-based attribute calculation can be any seismic amp-
litude 3D cube/2D section. In the process of GLCM calculation this amplitude
cube is converted to a grey level cube.

Compute Amplitude Range
For the transformation of the amplitude cube to a grey level cube the range of
the amplitude values is needed. This can either be inserted manually, or be
computed. In the case of computed amplitude range, the amplitude range will
be symmetrical around zero.

Number of Grey Levels
The number of grey levels used for the transformation of amplitude cube to
grey level cube. Higher numbers generally improve the quality of the GLCM
output. Common numbers for the grey levels are 16 to 256.

Number of Traces
The number of traces defines the horizontal analysis window. This horizontal
analysis window is always symmetrical around the center trace. Number of
traces equal 1 means 1 trace left and right of the center trace (thus 3 traces).

Vertical Search Window
The vertical search window defines the number of samples included in the
search window. The vertical size of the analysis window should be according
to the average wavelength (Gao, 2007). This is typically in the range of 15
samples (+/- 7 samples).

GLCM Attribute
In total 23 GLCM-based attributes can be calculated (see below in Mathem-
atical description)

Direction of Calculation
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The GLCM-based attribute calculation can in principal be done in 13 space
directions for 3D input data (4 space directions for 2D data). The algorithm
allows the calculation in single directions or the combined calculation of sev-
eral directions (inline, crossline, time-/depthslice) or all 13 space directions
can be calculated at once. Multiple directions give smoother results, but
subtle features might be missed. Detailed analysis of single directions might
give information about fracturing or facies distribution of the subsurface.

In this process azimuth of 0° is equal to inline direction; azimuth of 90° is
equal to crossline direction. Dip of 0° is equal to horizontal direction, dip of
90° is equal to vertical direction.

Figure 3: Definition of directions.
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Steering
GLCM attribute calculation can be done with or without steering. The integration of dip
steering generally improves the signal-to-noise ratio in calculated attributes.

Figure 4: Texture attribute window within OpendTect.

Mathematical description
The GLCM is a measure of how often different combinations of neighboring pixel values
occur within an analysis window. For a 2D image the immediate neighboring pixels can
be in four different directions (0°, 45°, 90°, and 135°). For the calculation of 2D GLCM the
following equation is used:

where i and j vary from 1 to Ng (number of grey levels).
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In this equation G(x,y) are the center sample points and G(x+dx, y+dy) are the neigh-
boring sample points. Usually, the distance between center and neighboring samples is
one, but in general greater distances could also be taken for the calculation. It is, in prin-
cipal also possible to combine the four principal directions to form an average GLCM. By
this approach the spatial variations can be eliminated to a certain degree (Gao 2007). In
the case of 3D data the number of possible directions increases to 13. The 3D case
implies a modification of the above given equation:

Similar to the 2D case, it is possible to calculate the GLCM in single directions, to com-
bine several directions, or to calculate an average GLCM. Previous works on 3D GLCM
calculation use 2D GLCM calculations in various directions and combine the results of
these calculations to form a pseudo-3D GLCM attribute cube.

Based on the grey level co-occurrence matrix, it is possible to calculate several attrib-
utes. Haralick et al. (1973), in their work, describe 14 attributes that can be calculated
from the GLCM. In literature a few more attributes based on the GLCM have been
developed (e.g. Soh and Tsatsoulis, 1999; Wang et al., 2010). For the calculation of any
of these GLCM-based attributes it is necessary to normalize the GLCM to generate a
kind of probability matrix. This is done by dividing each matrix entry by the sum of all
entries. The different GLCM-based attributes can be divided into three general groups.
The first group is the contrast group and includes measurements such as contrast and
homogeneity. All the attributes from this first group are basically a function of the prob-
ability of each matrix entry and the difference of the grey levels (i and j). Therefore, these
contrast group attributes are related to the distance from the GLCM diagonal. Values on
the diagonal (where i and j are the same) result in zero contrast, whereas the contrast
increases by increase of distance from the diagonal.

The second attribute group is the orderliness group, which includes attributes such as
energy and entropy. Attributes in the orderliness group measure how regular grey level
values are distributed within a given search window. In contrast to the first group all attrib-
utes from this group are solely a function of the GLCM probability entries.

The third attribute group is the statistics group, which includes attributes such as
Haralick et al.’s (1973) measure of mean and variance. These are common mean and
variance calculations applied onto the GLCM probabilities.
The following tables summarize all GLCM equations:
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Examples
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Velocity Fan Filter
Name
Velocity Fan Filter -- Attribute that returns energy with apparent velocities/dips inside a
specified Min/Max range.

Description
The velocity fan filter passes energy with apparent velocities (for Time surveys) or appar-
ent dips (for Depth surveys) inside the specified Min/Max velocity/dip range. The filter
supports three options:

l pass low velocities/dips (i.e. suppress high velocities/dips)

l pass high velocities/dips (i.e. suppress low velocities/dips)

l pass velocities/dips within a specified cone.

Therefore, this attribute can be used to filter out or enhance certain dip/azimuth events.

Input Parameters
The Filter size is the size of the 3D kernel. Filter size 3 means the data is convoluted
with a 3x3x3 kernel. To reduce edge effects it is recommended to apply a cosine square
taper. A Taper length of N means (100-2N)% of the specified velocity range will be flat.
Azimuth filter is a special option that allows the dipping energy to be passed inside the
specified Azimuth to pass direction only.
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The different shapes of the filter ( low pass, high pass, interval velocity/dip) are shown
below:
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Note: Please be aware that in Time surveys, flat events have infinite velocity, and ver-
tical events have a zero velocity. The opposite is observed in Depth surveys where not
velocities but dips are used: Horizontal events have zero dip, while vertical events have
90 degrees dip.

Display F-K Panel:

This option allows you to display a two-dimensional Fourier transform over time and
space where F is the frequency (Fourier transform over time) and K refers to wave-num-
ber (Fourier transform over space).
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Examples

An example of a velocity fan filter (high-pass) applied on a time slice. By applying the
appropriate filtering parameters, the random noise has been suppressed thus enhancing
the amplitudes visibility. Also notice the comparison of this filter with the DSMF (Dip-
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Steered Median Filter) that is almost same with an assumption of high pass of velocities
in the middle image.

Volume Statistics
Name
Volume statistics -- Attribute that returns statistical properties

Description
This attribute extracts data from a cube or line using a small 3D probe and returns a stat-
istical property from the samples collected.

Input Parameters
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The probe is defined using relative times/depths and trace stepouts with respect to the
actual location. The probe can be:

l Cube: The three dimensions listed above define the 3D cube.

l Cylinder: The cylinder option requires the same settings as the cube,
but traces outside of the ellipsoid will not be used.

l Optical stack: The probe is not 3D but a 2D vertical plane in the dir-
ection of the data, or perpendicular to it. This settings is useful only
when applied on random lines where the azimuth is different from the
inline and crossline direction.

Please note that the probe direction can be reduced by using:

l A [0,0] time gate: The probe becomes a flat rectangle or disk. Only one
sample per trace is used at the actual time/depth.

l A 0 stepout: Only one sample is used in one or both directions.

Output
The following statistical properties can be output:

l Average

l Median

l Variance = Square root of the standard deviation

l Min, Max, Sum

l Norm Variance
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l Most Frequency

l RMS: Root Mean Square

Please note that undefined values collected by the probe will not be used for the com-
putation. In the case of a stack only the valid values will define the number of values.
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Appendix B - Command Driver Manual
Introduction
Command Driver control window
Execution from command line
Window management
Search keys
Identifiers and expressions
Command specifications
Expressional specifications
Repetitive task example
Standard test scripts
User history recording

Introduction
Around 2006, it became clear that OpendTect was growing so fast that extensive testing
of every part was becoming a real big task. This is a well known issue in the Agile devel-
opment literature. The usual approach is to implement automated testing.

When designing the implementation, the main issues we had to cope with were:

l A dynamic user interface that is defined by relations between fields.
Therefore, the exact layout of windows can change considerably by
small changes

l Small changes or fixes in algorithms can produce slightly different out-
puts for the same input

l A test system should be programmable, not just be a replay of pre-
viously run tasks

Therefore, we couldn't use approaches based on replay of clicks, or comparison of out-
puts with known previous runs. Instead, we create a series of screen snapshots that can
quickly be inspected by the test manager.

This resulted in a Command Driver based on the following principles:

l Fields are addressed by names, wildcards supported

l Operations are defined to select, fill, push, manipulate, ...

l Additional flow control operations can be used

l Scripts can call other scripts
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l Variables can be set or used from the environment

Examples:

ListClick "Calculated attri*" "F03-2" Double

Include "$SCRIPTSDIR$/EvalutionEnergyAttrib.odcmd"

Almost immediately we noticed that finding out the names of the fields was very hard
without some tool. Therefore, we made the 'Tooltip name guide', which will put
OpendTect in a state where the name of a field is shown as a tool tip (overriding any
existing tool tip). When it became clear that our automated test facility would be used as
a scripting system for power users, we implemented a tool to record actions.

A webinar held in March 2010 gave an extensive overview on the use of OpendTect's
Command Driver plug-in. A forty-minutes flash video is available here: Command Driver
webinar

The Command Driver control window
Provided that the CmdDriver plug-in has been (auto)-loaded, one can access the Com-
mand Driver control window in two ways. Firstly, it can be launched from the menu bar of
OpendTect Main Window:

Utilities->Tools->Command Driver ...

Secondly, this so-called Command Controller also pops up when pressing Ctrl-R with
the mouse pointer inside any OpendTect window or dialog. This is particularly useful if
the Command Driver menu bar is greyed out or menu access is blocked after a modal
dialog has been popped up. Only a few Qt-borrowed QDialogs like the QMessageBox,
QFileDialog and QColorDialog will nevertheless prevent any user input to the Command
Controller, and have to be clicked away first.

http://www.youtube.com/watch?v=aWzoDH_treY
http://www.youtube.com/watch?v=aWzoDH_treY
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"Command Controller (Ctrl-R)"-window in run-mode and record-mode respectively.

The Command Controller has a combobox to switch between two appearances. One for
running and one for recording a command file. The TooltipNameGuide checkbox can be
(un)checked at both appearances. It sets a tooltip mode that displays the hidden name of
any uiObject pointed to. Tooltip names are displayed double-quoted on a cyan back-
ground. Go to the Survey->Select/Setup window for a small demo-example. Click the '
(X,Y) <=> I/C' -button and unveil the hidden names of buttons and input fields with your
mouse pointer. OpendTect (plugin) developers might have a look in the file $WORK/s-
rc/uiIo/uiconvpos.cc to see how these names are annotated in the code.

Running the Command Driver requires selecting an input command file with the exten-
sion '.odcmd', or the obsolete '.cmd'. Filenames without a full path are defined relative to
the 'Proc'-directory of the current survey. The 'Edit'-button launches a simple text editor to
view and edit the input command file directly from OpendTect. One can also specify an
output log file to have the Command Driver write its progress and error messages. The
'Examine'-button launches a scroll window to view this log file even while running. The
Command Driver starts running when pushing the 'Go'-button, after which 'Pause' and
'Abort'-buttons allow a temporary stop or premature termination.

The Command Recorder is able to record a sequence of user interface actions per-
formed by the user. One has to specify an output command file with the extension
'.odcmd'. Filenames without a full path are defined relative to the 'Proc'-directory of the
current survey. The 'Examine'-button launches a scroll window to view which commands
are written during recording. Recording starts after pushing the 'Start'-button. Next per-
form a sequence of user actions and push the 'Finish'-button. The Command Controller
will automatically switch to run-mode afterwards, so that one can play back the recorded
script in order to verify its correct operation. View the log file for eventual errors. Finally,
the recorded script can be edited to avoid these errors, improve robustness and general
applicability, and insert auxiliary commands.

Executing scripts from the command line
One does not necessarily have to run a command script from OpendTect's user inter-
face. One or more scripts can also run straight from the command line, and with that they
might be called from shell scripts as well. An example of the command line syntax on
Linux:

start_dtect cmd=/full_path_1/my_script_1.odcmd ... cmd=/full_
path_N/my_script_N.odcmd

This line opens a new instance of OpendTect and starts running the given scripts in
there. OpendTect will not automatically close when all scripts are finished. If necessary,
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this must be done from the last script using the 'Close All' command. Note that command
line execution is only possible if your OpendTect auto-loads the Command Driver plug-
in at startup.

The user can also create command scripts named 'autoexec.odcmd'. If available, these
scripts will be run at start-up before any script specified on the command line. The first
autoexec-script to be run is searched in the settings directory. This is the '.od'-sub-
directory of your personal home directory, unless the DTECT_SETTINGS or DTECT_
WINSETTINGS environment variable specifies otherwise. The second autoexec-script
to be run is searched in the 'Proc'-directory of the start-up survey. Next, the command
line scripts will be run in order. Moreover, every time a new survey is selected in
OpendTect, the 'Proc'-directory of this new survey will also be searched for an autoexec-
script to be run at that moment.

Apart from the availability of autoexec-scripts, their execution can always be disabled by
adding 'cmd=noautoexec', 'cmd=nosettingsautoexec' or 'cmd=nosurveyautoexec' as an
extra argument on the command line. Command line argument 'cmdlog=/full_path/my_
odcmdlog.txt' will override the location of the output log file. Its default name is 'odcm-
dlog.txt' and it is located in the 'Proc'-directory of the start-up survey, if writable, or in the
personal user directory otherwise.
To run a command file other than 'autoexec.odcmd' on Windows, one has to create a
DOS batch file. That file must contain a command line similar to this:

X:\full_ path_ 0\bin\win64\od_ main cmd="X:\full_ path_ 1\my_
script_1.odcmd" ...

Go to your OpendTect installation folder to ascertain the right name and location of the
OpendTect executable (i.e. which disk, bin-path, win32 / win64, and '.exe'-file name?).
Executing your DOS batch file will open a new instance of OpendTect and run the given
script at startup.

Windowmanagement
Commands always apply to the current window. This is OpendTect Main Window when
starting the driver. Any modal window popping up will automatically become the current
window. Modeless windows that pop up can be appointed current window by using the
Window-command. In case a modal current window closes, its parent will become the
current window. If a modeless current window closes, the latest former current window
still existing will be restored as current window.

Subwindows in the workspace of another window cannot become current window. No
commands can be addressed to the progress window popped up by a uiTaskRunner,
since the driver will await its decease before executing a next command. Neither
addressible are the Command Controller window and its descendants.
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QDialog windows popping up are a special case. OpendTect is borrowing the QMes-
sageBox, QFileDialog, QFontDialog, and QColorDialog from Qt. It is impossible for the
command driver to manipulate the contents of these windows. The only QDialog parts
that can be manipulated by the driver are those buttons resulting in closing the QDialog.
One may use the standard commands Button, Ok, Cancel and Close for this aim. The
special commands ColorOk, FileOk and FontOk will be available to specify the desired
color, file, or font from the command script directly, meanwhile closing the QDialog.

Neither can the command driver manipulate the contents of windows popped up by
batch programs that were launched from OpendTect. An example of this is the multi-
machines processing window. Except for manual intervention, there is no workaround
yet.

A higher form of window management is provided by the so-called window assertions.
These are square-bracketed window names in between the command lines. All com-
mands succeeding a window assertion are expected to be executed in the asserted win-
dow. If the current window does not match the latest window assertion, this results into
the detection of an error. A window assertion is cancelled either by the next window
assertion or by an empty assertion: [].

The benefit of window assertions is in error recovery. If OpendTect does not pop up a
window that was expected by the command file or does pop up a window that was not
expected by the command file, the Command Driver is able to proceed under guidance
of these window assertions. This already solves a lot of cases in which the flow of
OpendTect happens to be mildly data or environment dependent. For example, if an
error message like "File already exist! Overwrite?" appears but is not handled in the com-
mand file (or the other way around), the Command Driver can continue as it was most
probably intended by the user: close the window and write the file. Another example is
any command to switch on/off a button or menu item. If it happens to be switched on/off
already, window assertions enable the Command Driver to skip all commands following
from that switch as well.

Although not compulsory, it is advised to make systematical use of window assertions. It
also improves the readability of your command file. See any file generated by the Com-
mand Recorder to get an idea.

When using window assertions in combination with control flow commands, the most
easy-going and efficacious method is having each individual command (If, ElseIf, Then,
Fi, For, Rof, DoWhile, Od, Do, OdUntil) both preceded and succeeded by the window
assertion in force. Wrongly omitting a window assertion around a control flow command
will not result in an assertion violation error, but it does severely reduce the possibilities
of the Command Driver to recover in case of other errors.
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Search keys
Many commands supported by the Command Driver use search keys to address window
names, names of buttons, input fields and other GUI-elements, item names of menus,
lists, trees and tables, etc. The matching of these search keys is strict where necessary
and accommodating where practical. The matching process honors the following prin-
ciples:

The asterisk '*' is used as a wildcard character. It may appear any number of times in the
search key to match an arbitrary substring.

Any sequence of white space characters like spaces, tabs, newlines, etc. will be
removed at the beginning and at the end of both the match name and search key, and
compressed into one single space when found in between.
The ellipses found at the end of menu item names and button texts are ignored. Any dot
after the last non-white space character of the match name and search key is removed.

Underscores denoting keyboard shortcuts in menu item names, tab item names and but-
ton texts are ignored. The ampersands denoting these shortcuts in Qt- interface pro-
gramming code should not appear in your search key, unless you want to match an
actual ampersand of course.

If the name to match contains a symbol interpreted by the Command Driver as some-
thing special, the symbol must be preceded by the escape character '@' in your search
key. Symbols for which this may apply include '*', '#', '$', '`', '"', '[' and ']', depending on the
context in which the search key occurs. Escaping of symbols that do not have a special
meaning is unnecessary but harmless. In the rare case that the match name happens to
contain '@' characters preceding a symbol, these themselves have to be escaped in the
search key. Alpha-numerical and white space characters are not considered symbols, so
a single '@' character in a search key like "jaap.glas@dgbes.com" does not have to be
escaped.

One example to demonstrate the use of escape characters. The table column header "*
[All lines]" will be matched exactly by the search key "@* [All lines]". The asterisk must
be escaped to prevent it from being interpreted as a wildcard for postfix matching, while
the brackets do only need escapes when occurring inside window assertions.

Any pair of bracket-like characters enclosing a name to match are ignored, unless the
search key does explicitly specify them. Outer character pairs that may be stripped
include "...", [...], <...>, and >...<. This matching protocol is recursive. If the match name
and search key do not match, eventual outer brackets of the match name are removed,
and the whole matching process is repeated.

The Case-command allows the user to determine whether upper-case and lower-case
alphabetical characters will match each other. The default is case-insensitive.
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Identifiers and expressions
Command scripts may contain identifiers to store data and (re)use its values. Every iden-
tifier consists of a letter followed by any sequence of letters, digits and underscores ('_').
Identifiers are treated case insensitive. Identifiers can represent constants, script vari-
ables, environment variables, built-in function names, or user-defined procedure names.

The Command Driver has only one internal data type. All identifier values are rep-
resented as character strings. The string can be a boolean value, an integer value (even
octal or hexadecimal), a fixed or floating point value, one single character or indeed a
whole character string. The operator or built- in function using the identifier will define
into which data type the string has to be converted, and will produce an error if the con-
version fails. User-defined procedures should do the same. Boolean values are actually
mapped onto numbers, where 0 is false and 1 is true, and any other number is also inter-
preted as true.

Predefined identifier constants include FALSE==0, TRUE==1, PI==3.14159265..., and
UNDEF==1e30. Command actions may assign either SUCCESS==1, FAILURE==0, or
WARNING==-1 as return value. Any 'Is...On'-question command returns ON==1, OFF-
F==0, or UNSWITCHABLE==-1 as an answer.

Expressions are assembled from identifiers, numbers, string constants ( "..." ), par-
entheses, built-in functions, and about twenty mathematical and logical operators (see
Expressional specifications). The assign command ( <ident> = <expr> ) stores the eval-
uated result of an expression into an identifier.

The value of an identifier can be substituted anywhere in the command script by putting
the identifier between dollar-signs ( $<ident>$ ). Identifier substitution is the only and
most flexible method to give command actions a variable meaning. Multiple substitutions
in one command are allowed, but nested substitutions will be misinterpreted. Assign the
result of the inner substitution to an auxiliary identifier, and use that one in the outer sub-
stitution.

In order to keep the parsing of command actions tractable, few commands will directly
accept expressions as argument(s). Apart from the assign command, the only ones are
control flow commands: If, ElseIf, For, DoWhile, OdUntil, Return, and any user-defined
procedure call with value parameters. If you want to use an expression in an arbitrary
command action, assign the expression result to an identifier and substitute its value.

Identifier substitution can also be used to simulate array variables (e.g. array[index]). The
Command Driver does not explicitly support them, but index substitution can be applied
for that purpose: array_$index$.
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The predefined directory identifiers BASEDIR, DATADIR, PROCDIR, APPLDIR,
USERDIR, SCRIPTSDIR, SNAPSHOTDIR, IMPORTDIR and EXPORTDIR are envir-
onment variables that can be substituted in file-path specifications. Their purpose is
defining a file-path relatively to either OpendTect, the current survey, user directories,
etc. The Command Driver will automatically change Unix-style file-paths into Windows-
style file-paths on Windows-platforms and vice versa. The special identifier FILEIDX rep-
resents an integer variable that is automatically incremented after every occurrence in
the command stream. It may be substituted in file-paths to generate unique filenames,
although meanwhile more sophisticated methods exist as well (see Repetitive task
example).

The scope of any identifier used in the body of a command script is global. The scope of
any identifier used inside a user-defined procedure is local by default, and may shadow
a global identifier with the same name. Attach the scope operator '@' in front of an iden-
tifier to force access to its global namesake. That is all for (re)assigning an identifier or
(re)defining a procedure. Two extra scope rules apply for reading an identifier or calling
a procedure. If an unscoped identifier value is locally undefined, the search will continue
at the global scope level directly. If an unscoped procedure call is locally undefined, the
search will continue at the previous scope level, and recursively descend to the global
level as long as no definition is found.

Command specifications
Any text editor can be used to produce or modify OpendTect scripts. Every command file
has to start with the following four-lines header. The correctness of version number, date
and time is not vital for a successful execution of the command file.

dTect V4.0

OpendTect commands

Mon Apr 20 09:20:09 2009

!

The Command Driver expects one command per line and one line per command by
default. Multiple commands on one line must be separated by a semicolon (';'). Long
commands exceeding the width of one line may be broken by adding a backslash ('\') as
last non-white character on the line. Never put a break before white space, since pre-
ceding white space on the next line will be considered indentation. Instead of using a
backslash break, one can also leave the Enter-key unpressed at all and simply have the
line run through the right margin. Empty lines and (commentary) lines starting with a '#'-
symbol are allowed and ignored.

One can make a quick start by having the first command file generated by the Command
Recorder, and start editing from there.
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The specification of available commands is currently written in a top-to-bottom sequen-
tial form. This means that command arguments are explained only at their first appear-
ance. Placeholders between angular brackets are used to specify the command syntax.
If a syntax placeholder is not defined at a particular command, it has already been
defined at an earlier command or is considered atomic. The online user documentation
will provide a hyper- link in the former case. Our tabular representation might cause
lengthy command (argument) specifications to be formatted over multiple lines. Beware
that the Command Driver itself will not accept this, unless the lines are explicitly broken
by backslashes. All syntax definitions are using the following tags:

<abc> syntax placeholder
| exclusive-or between alternatives
? zero or one occurrences
* zero or more occurrences
+ one or more occurrences

<action> I. Basic commands (also generated by
Command Recorder)

Window "<winname>"

<winname> = <search-
str><disambiguator>?
<searchstr> = (<wildcard>?<textstr>)*<wild-
card>?
<wildcard> = '*'

<disambiguator> = '#'<selnr>
<selnr> = <posint> | <negint>

Switches the focus between different win-
dows on screen. Any window not having a
modal child displayed may be specified as
the new current window. This command is
needed to access modeless windows,
since only modal windows that pop up will
automatically become the current window.
Window names may contain one or more
wildcards to match arbitrary substrings. If a
(wildcarded) window name matches more
than once, a number can be attached to dis-
ambiguate the search. Windows are
numbered in order of appearance. A neg-
ative number will count the windows in
reverse.

'[' <winname>? ']'

This window assertion tells the Command
Driver what is supposed to be the current
window when the commands succeeding
the assertion are processed. A mismatch
will result into an error. The latest assertion
is cancelled by either a next assertion or
the empty assertion: [ ]. If a window asser-
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tion refers to a modeless window, it will be
set as the new current window. This makes
the Window-command above obsolete in
case window assertions are used.

Menu "<menupath>" <onofftag>?

<onofftag> = (On | 1) | (Off | 0)

<menupath> = <pathstr>
<pathstr> = <itemname> (  <sep><item-
name> )*
<sep> = '`'

<itemname> = <search-
str><disambiguator>?

Selects a menu (sub)item by providing the
whole menu path. Checkable menu items
are toggled, unless the optional On/Off-
argument specifies their desired state. Any
search name provided to the Command
Driver, including menu (item) names, may
contain one or more wildcards to match
arbitrary substrings. If a (wildcarded) item
name matches more than once in a (sub)
menu or any other list, a number can be
attached to disambiguate the search. A
negative number will count the matching
items in reverse. To give a few exotic
examples: the menu path "Survey`*#-1"
would select the last item of the Survey-
menu, while the path "Survey`#1" would
refer to its first empty-named item.

Button "<keystr>" <onofftag>?

<keystr> = <objname>( <sep><objname> )
*<disambiguator>?
<objname> = <searchstr>

Press a (push/radio/check/tool)-button by
providing one or more search keys. Mul-
tiple search keys are not allowed for QDia-
log windows. Checkable buttons are
toggled, unless the optional On/Off-argu-
ment specifies their desired state. The best
search key is of course the button name,
but some objects do not have a (visible)
name and lots of times names are not
unique. Therefore, a key may just as well
refer to another object in the neigh-
bourhood of the button to click. The list of
possible buttons will be narrowed down for
every next key provided. If the referred
object is closer to one button than another,
the latter will be dropped. The vicinity cri-
terion is based on the youngest common
ancestor of referred object and button in
the object tree. If the user is unable to spe-
cify a set of keys that leaves exactly one
button, as a last resort one of the remaining
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buttons can be selected by attaching a dis-
ambiguation number after the last key.
Beware that the order of those buttons will
be fixed, but unlike menus not always in a
left-right top-down fashion. The buttons will
be counted in reverse in case the dis-
ambiguator is negative.

ButtonMenu "<keystr>" "<menupath>"
<onofftag>?

Selects an item from the menu attached to
a button. Some tool-buttons contain a left-
clickable arrow part to have such a menu
appeared. Checkable menu items are
toggled, unless the optional On/Off-argu-
ment specifies their desired state. Selec-
tion of the button is analogous to the button
selection described above. Selection of the
menu (sub)item is analogous to the Menu-
command.

Input "<keystr>" <inpdata>? <entertag>?

<entertag> = Enter | Hold

<inpdata> = "<inputstr>" | <number> |
FilePath "<filepathstr>"

Inputs a string or number into one of the
fields of the current window. The field
selection is analogous to the button selec-
tion described above. The Hold-option
only triggers actions defined on changing
the input field, while the Enter-option also
triggers actions defined on pressing the
enter/return-key afterwards. The latter is
the default. If no input data is provided, the
current contents of the selected field will be
entered. The FilePath-option forces the
input string to be treated as a file-path con-
cerning platform independence. This will
happen automatically in case the input
string contains any directory identifier sub-
stitute ( $...DIR$ ), or in case the input field
comes together with a Select-button and
perhaps an Examine-button into a graph-
ical element called uiFileInput.

Spin "<keystr>" <spinsteps> <entertag>?

<spinsteps> = <posint> | <negint>

Clicks a spinbox any number of steps
upward (positive) or downward (negative).
The spinbox selection is analogous to the
button selection described above. The
Hold-option only triggers actions defined
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on changing the spinbox value (after each
step), while the Enter-option also triggers
actions defined on the spinbox losing its
focus afterwards. The latter is the default. If
no number of steps is provided, the spin-
box will keep its current value while losing
its focus. Multiple steps are only supported
as long as no action triggered in between
does pop up a modal window. One can
also edit the input field of the spinbox dir-
ectly by using the Input-command instead.

Slider "<keystr>" <percentage>
<nrsteps>?

<nrsteps> = <posint>

Shifts a slider towards the specified per-
centage of its range displayed on screen.
Beware that the relationship between this
percentage and the actual scale rep-
resented by the slider is not necessarily lin-
ear. It is optional to perform the shift in
more than one step, but it may yield nice
animations on screen. Multiple steps are
only supported as long as no action
triggered in between does pop up a modal
window. Selecting the slider is analogous
to the button selection described above.

Wheel "<keystr>" <degrees> <nrsteps>?

Rotates a thumbwheel a specified number
of degrees upwards/downwards or left-
wards/rightwards. The number of degrees
will only have a direct meaning if the
thumbwheel represents an angular scale. It
is optional to perform the rotation in more
than one step, but it may yield nice anim-
ations on screen. Multiple steps are only
supported as long as no action triggered in
between does pop up a modal window.
Selecting the thumbwheel is analogous to
the button selection described above.

Combo "<keystr>" <itemsel>

<itemsel> = "<itemname>" | <selnr>

Sets the selected item of a combobox,
either by its name or by its ordinal number
in the list. The list will be traversed in
reverse if the number is negative, so for
instance -1 refers to the last item. Using a
selection number is just a shortcut for com-
posing an item name "*#<selnr>" from
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merely a wildcard and a disambiguator.
The selection of the combobox itself is ana-
logous to the button selection described
above. The Input-command may be
applied to edit the input field of the current
item of an editable combobox.

ListClick "<keystr>" <itemsel>
<mousetag>?

<mousetag> = <ctrl-
click>?<doubleclick>?<leftrightclick>?

<ctrlclick> = Ctrl
<doubleclick> = Double
<leftrightclick> = Left | Right

Clicks and (de)selects precisely one item
in a listbox. Selection possibilities for list-
box and item are analogous to combobox
selection. The optional mousetag is defin-
ing whether the item is (de)selected by
means of optional control- or double-click-
ing of either the left or right mouse button.
Left is default in all cases. Beware that the
mousetag is one united word and order
counts. Some listboxes pop up a menu
when (right)-clicking on an item, in which
case one has to apply the ListMenu-com-
mand instead. Single-selection listboxes
will only select the clicked item and
deselect all others. Multi-selection list-
boxes act different in the following cases.
Control-clicking toggles the selected state
of the clicked item, while any other item
keeps its current state. Right-clicking an
already selected item leaves the whole
selection unchanged.

ListButton "<keystr>" <itemsel>
<mousetag>? <onofftag>?

(Un)checks the button in front of a listbox
item. The check-button is toggled unless
the optional On/Off-argument specifies its
desired state. (De)selection of item and list-
box is fully analogous to the ListClick-com-
mand. Beware that mousetags with Double
or Right are known not to have a (lasting)
effect on the check-button.

ListMenu "<keystr>" <itemsel>
<mousetag>? "<menupath>" <onofftag>?

Selects a (sub)item from the menu
attached to a listbox item. Checkable menu
items are toggled, unless the optional
On/Off-argument specifies their desired
state. The selection of both listbox and
item is analogous to the ListClick-com-
mand. However, since OpendTect is nor-
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mally hiding its popup menus under the
right mouse button, the default for no
mousetag at all is set Right over here.
Selection of the menu (sub)item is ana-
logous to the Menu-command.

ListSelect "<keystr>" <firstitemsel>
<lastitemsel>? <onofftag>?
<firstitemsel> = <lastitemsel> = <itemsel>

Selects any number of items in a multi-
selection listbox. Selection possibilities are
more comprehensive than those at the
ListClick-command. Now all items match-
ing a given (wildcarded) item name can be
specified. One can also specify the whole
range between a first and a last item at
once. The list will be traversed cyclically in
case the first item succeeds the last.
Without the optional On/Off-argument, all
specified items will be selected and all
other items deselected. With the On/Off-
argument set however, only specified
items will be selected/deselected respect-
ively, while unspecified items keep their
current state.

TableClick "<keystr>" <tableitemsel>
<mousetag>?

<tableitemsel> = <headitemsel> | <cellsel>

<headitemsel> = <headtag> <itemsel>
<headtag> = RowHead | ColHead

<cellsel> = <rowsel> <colsel> | Cell <item-
sel>
<rowsel> = <colsel> = <itemsel>

Clicks either a row-head, col-head or cell
in a table, and select precisely the one
row, column or cell attached to it. Selection
possibilities for the RowHead-, ColHead-
and Cell-options are analogous to the item
selection for list- and comboboxes. The
Cell-option puts all cells row-after-row in a
virtual list for this purpose. Another way to
address a single cell is by selecting both
its row and its column. Also these row and
column selections are analogous to the
item selection just mentioned. If the row or
column selection is not made by number
but by name, then the search for a match
will start in its header. In case the table
shows no header or no row/col-head is
matching, then the search will proceed in
the next column/row until a match is found.
The selection of the table itself is ana-
logous to the button selection described
above. The option specifying a left, right or
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double mouse-click will be Left by default.
Some tables pop up a menu when right-
clicking a cell, in which case one has to
apply the TableMenu-command instead.

TableFill "<keystr>" <cellsel> <inpdata>

Fills one cell in a table with new text data.
Alike the Input-command, this might be a
text string, a file-path string or a number.
The selection of both table and cell is ana-
logous to the TableClick-command, except
that table headers cannot be filled.

TableMenu "<keystr>" <cellsel>
<mousetag>? "<menupath>" <onofftag>?

Selects a (sub)item from the menu
attached to a table cell. Checkable menu
items are toggled, unless the optional
On/Off-argument specifies their desired
state. The selection of both table and cell
is analogous to the TableFill-command.
Selection of the menu (sub)item is ana-
logous to the Menu-command.

TableExec "<keystr>" <cellsel> <action>

Executes a local command driver action
within one cell of a table (instead of within
the current window). The selection of both
table and cell is analogous to the
TableFill-command. Only those commands
accepting a keystring argument might be
appropriate actions to execute within a
cell. For example, if the top-left cell of a
table contains a single combobox, its selec-
tion can be made as follows:

TableExec "my table" 1 1 Combo "*" "my
item"

Tables with cells containing multiple user-
interface objects of the same or different
kind can be handled too.

TableSelect "<keystr>" <tableitem-
rangesel> <onofftag>?

<tableitemrangesel> = <head-
itemrangesel> | <cellrangesel>
<headitemrangesel> = <headtag>
<firstitemsel> <lastitemsel>?

Selects any number of rows, columns or
cells in a table. This command is the table-
equivalent of the ListSelect-command.
Selection possibilities are more com-
prehensive than those at the TableClick-
command. Now all row-heads, col-heads
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<cellrangesel> = <firstcellsel> <last-
cellsel>?
<firstcellsel> = <lastcellsel> = <cellsel>

or cells matching a given (wildcarded) item
name can be specified. One can also spe-
cify the whole block between a first and a
last row, column, or cell at once. The table
will be traversed cyclically in case the first
(cell) row or (cell) column succeeeds the
last. Without the optional On/Off-argument,
all specified cells will be selected and all
other cells deselected. With the On/Off-
argument set however, only specified cells
will be selected/deselected respectively,
while unspecified cells keep their current
state.

Tab "<keystr>"? "<tabname>"

<tabname> = <itemname>

Puts a tab on top of the stack by name.
Since windows with more than one tab-
stack will be rare, its selection is optional.
The selection is analogous to the button
selection described above.

TreeClick "<keystr>"? <treenodesel>
<mousetag>?

<treenodesel> = "<treepath>" | PathCol
"<treepath>" <colsel>
<treepath> = <pathstr>

Clicks and selects precisely one node in a
tree. The selection of a tree node is ana-
logous to the selection of a menu (sub)
item. In which column to click is optional,
but it will be the first one by default. This
column selection is almost analogous to
the column selection for tables. If the selec-
tion is not made by number but by name,
then the search for a match will start in the
column header, and next proceed at the
selected tree node if not successful. Selec-
tion of the tree itself is analogous to the but-
ton selection described above. It is
optional because the current window will
often contain only one (data) tree. The data
tree with the lowest scene number is guar-
anteed to be the default for OpendTect
Main Window. The option to specify a left,
right or double mouse-click will be Left by
default. Any tree node might pop up a
menu when right-clicking on one of its
columns, in which case the TreeMenu-com-
mand has to be applied instead.

TreeExpand "<keystr>"? "<treepath>" (Un)expands the subtree of a node in a
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<onofftag>?

tree. The expander is toggled unless the
optional On/Off-argument specifies its
desired state. The selection of both tree
and node is analogous to the TreeClick-
command, except that column selection is
not an issue here.

TreeButton "<keystr>"? "<treepath>"
<mousetag>? <onofftag>?

Presses the button in front of a node in a
tree. The button is toggled unless the
optional On/Off-argument specifies its
desired state. The selection of both tree
and node is analogous to the TreeClick-
command, except that column selection is
not an issue here.

TreeMenu "<keystr>"? <treenodesel>
<mousetag>? "<menupath>" <onofftag>?

Selects a (sub)item from the menu
attached to a column of a tree node. Check-
able menu items are toggled, unless the
optional On/Off-argument specifies their
desired state. The selection of tree, node
and column is analogous to the TreeClick-
command. Selection of the menu (sub)item
is analogous to the Menu-command.

CanvasMenu "<keystr>" "<menupath>"
<onofftag>?

Selects a (sub)item from the menu popping
up at a canvas area. Checkable menu
items are toggled, unless the optional
On/Off-argument specifies their desired
state. Selection of the canvas area is ana-
logous to the button selection described
above. Selection of the menu (sub)item is
analogous to the Menu-command.

Ok
Cancel

These are special commands that 'Ok' or
'Cancel' a dialog. Usually, this has the
same effect as pressing the Ok- or Cancel-
button.

Close <closeoption>?

<closeoption> = All | <subwinsel>
<subwinsel> = "<keystr>"? "<winname>"

Clicks on the Close-button in the title bar of
the current window. The All-option will
close all OpendTect windows at once. This
option is compulsory in case OpendTect
Main Window is the current window, so
that OpendTect cannot be killed by acci-
dent. The optional subwindow selection is
available to close a window in the work-
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space of the current window by name.
Since windows with more than one work-
space will be rare, selection of the work-
space is optional. This selection is
analogous to the button selection
described above.

Show <subwinsel>? <showtag>
<showtag> = Minimized | Maximized |
Normal

Clicks on the Minimized-, Maximized- and
Restore-buttons in the title bar of the cur-
rent window. The optional subwindow
selection is available to resize a window in
the workspace of the current window by
name. Since windows with more than one
workspace will be rare, selection of the
workspace is optional. This selection is
analogous to the button selection
described above.

ColorOk <colorsel>

<colorsel> = "<rgbtcolorstr>" | <color>
<transparency>?
<color> = "<rgbcolorstr>" | <R> <G> <B> |
<colortag>

<rgbtcolorstr> = <rgb-
str><sep><transparency>
<rgbcolorstr> = <R><sep><G><sep><B>

<R> = <G> = <B> = <transparency> =
<byte>

<colortag> = Black | Blue | Brown | Cyan |
Green | Grey | Lilac | Lime | Magenta |
Olive | Orange | Purple | Pink | Red |
White | Yellow

Specifies the desired color while closing a
QColorDialog window. One may specify a
color either by its RGB-values (0-255) or a
color tag. In case the QColorDialog offers
the possibility to specify transparency, the
value of the optional t-channel (0-255) is
passed as well. Its default value is 0 (non-
transparent). The RGB-values and optional
t-channel can also be specified in one com-
posite RGB(t) color string.

FileOk "<filepathset>"

<filepathset> = <filepathstr> (  <sep><-
filepathstr> )*

Specifies one, or more file-paths while clos-
ing a QFileDialog window. The command
will yield an error message if their number,
type (file/directory), extension, and/or writ-
ability is not in agreement with the current
mode of the QFileDialog. File-paths will be
interpreted platform independently. Both
absolute and relative file-paths are accep-
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ted. The current directory of the QFileDia-
log will be taken as base directory in the lat-
ter case. Also a set of directory identifiers
has been predefined for substitution ( 
$...DIR$ ) in file-paths. The FileOk-com-
mand does not provide the functionality of
the QFileDialog-button "Create new
folder". If a file-path specifies a non-exist-
ing file or directory, its parent directory
must exist.

<action> II. Auxiliary commands (to be inserted by
the user)

Include "<filepathstr>"

Inserts another command file into the com-
mand stream. The file-path will be inter-
preted platform independently. In order to
specify the file-path relative to either
OpendTect, current survey, or user dir-
ectories, one of the predefined directory
identifiers can be substituted ( $...DIR$ ).

GreyOuts <greyoutstag>

<greyoutstag> = Count | Skip

Specifies whether to count or skip disabled
(greyed out) user interface objects, tabs,
menu and tree items. 'Skip' is the default.
'Count' means that also grey-outs will be
counted when using selection numbers.
Furthermore, it allows (question) com-
mands to retrieve information from grey-
outs. Command actions trying to manip-
ulate a grey-out will be penalized.

Case <casetag>

<casetag> = Sensitive | Insensitive

Switches between case-sensitive and
case-insensitive searching in menus, win-
dows, lists, etc. Insensitive is the default.
The command parsing itself (command
names and options, function names, iden-
tifier names) is case-insensitive by nature
and will ignore this setting.

OnError <errortag>

<errortag> = Stop | Recover

Switches between different procedures to
handle an error. The Stop-option will exit
the driver immediately. The Recover-option
will make use of window assertions to
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safely proceed execution in specific cases.
The default option is Recover.

LogMode <logtag>

<logtag> = Basic | Normal | All

Regulates the amount of warning and error
messages in the log file. The All-option will
show any message generated. The
Normal-option is the default. It shows all
parsing messages, but action messages
are only shown if the action result is not
assigned to an identifier. The Basic-option
will also omit all warning messages.

Snapshot "<imagefilepathstr>"
<frametag>?

<frametag> = CurWin | ODMain | Desktop

<imagefilepathstr> = <file-
pathstr><imageext>
<imageext> = .bmp | .jpg | .jpeg | .png |
.ppm | .xbm | .xpm

Writes a snapshot of the current window
(and its environment) to file. The default
grabbing area is bounded by the CurWin-
frame, but can optionally be enlarged
towards the ODMain-frame or the whole
Desktop-frame. The snapshot filename
must have one of the prescribed image
extensions. The file-path will be interpreted
platform independently. Both absolute and
relative file-paths are accepted. Also one of
the predefined directory identifiers may be
substituted ( $...DIR$ ) in the file-path.

Sleep <seconds> <sleeptag>?

<sleeptag> = Regular | Extra

Sleeps a period of time so that spectators
can distinguish the consecutive steps from
a command file on screen. The Regular-
option will sleep until further notice
between every two commands with a visual
effect. The Extra-option is the default and
will take an (additional) nap only once.

Wait <seconds> <sleeptag>?

Tells the next command to wait a period of
time only if it is uncertain whether it has fin-
ished processing. This can happen to any
command closing a modal dialog that was
already open when the Command Driver
started. The Regular-option will allow this
waiting time to every command until further
notice. The Extra-option is the default and
will allow an (additional) wait only to the
next command.

Pause "<textlines>"?

<textlines> = <textstr>( <sep><textstr> )*

Temporarily hold the execution of the com-
mand script and have the Command Con-
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troller pop up a message dialog with a
'Resume'-button so that the user can
decide when to continue. Specifying lines
of text is optional.

Guide "<textlines>" (  <guidetag> "<win-
name>" )?

<guidetag> = Existent | Inexistent |
Accessible | Inaccessible

Temporarily hold the execution of the com-
mand script and have the Command Con-
troller pop up a dialog requesting the user
to take action. The text lines describe which
actions the user has to perform. The Com-
mand Driver will automatically resume if
some window matching a given name is no
longer (in)existent or (in)accessible. If this
option is not specified, the user gets a
'Done'-button to have the Command Driver
resume manually.

Comment "<textlines>"

Inserts comment lines into the log file. Com-
mand lines starting with a '#'-symbol are
containing comments that are not shown in
log files.

<action> III. Control flow commands (to be inser-
ted by the user)

Assign <ident> <expr>

<ident> '=' <expr>

<ident> = <scope>?<identstr>
<identstr> = <letter><identchars>*
<identchars> = <letter> | <digit> | '_ '
<scope> = '@'

<expr> = <ident> | <number> | "<textstr>" | '
(' <expr> ') ' | <functioncall> | <oper-
atorexpr>

<functioncall> = <funcname>' (' <expres-
sions>? ')'
<funcname> = <ident>
<expressions> = <expr> ( ',' <expr> )*

Assigns the evaluated result of an expres-
sion to an identifier. The command syntax
is available in both procedural style and
operator style. Identifiers consist of a letter
followed by any sequence of letters, digits
and underscores. Expressions are
assembled from identifiers, numbers, string
constants, parentheses, built-in functions,
and about twenty mathematical and logical
operators. Notice that a function call allows
no space between the function name and
its opening parenthesis. All functions, oper-
ators and predefined identifiers are listed
below in Expressional specifications.

If <expr> <actions> Executes a number of command actions if a
boolean expression evaluates to true. The
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( ElseIf <expr> <actions> )*

( Else <actions> )?

Fi

ElseIf- and Else-branches are optional, but
note that the terminating Fi-command is
compulsory.

For <ident> '=' <expr> ( To <expr> )? ( 
Step <expr> )?

<actions>

Rof

Initializes an identifier with the evaluated
result of a numerical expression and
repeats a number of command actions as
long as the identifier value does not exceed
the evaluated result of the optional To-
expression. After every loop iteration, the
identifier is incremented by the evaluated
result of the optional Step-expression. The
default step is 1, but even negative values
are allowed. Only the Break-command can
escape from a For-loop in absence of a To-
expression. Note that the terminating Rof-
command is compulsory.

DoWhile <expr>

<actions>

Od

Repeats the execution of a number of com-
mand actions as long as a boolean expres-
sion evaluates to true. Note that the
terminating Od-command is compulsory.

Do

<actions>

OdUntil <expr>

Repeats the execution of a number of com-
mand actions until a boolean expression
evaluates to true.

Break Escapes immediately from the innermost
For-, While-, or Until-loop.

Continue
Skips the remaining actions in the current
iteration of the innermost For-, While-, or
Until-loop.

Try <ident> <action>

<ident>? '~' <action>

Tries to execute a command action and
assigns its result to an identifier. The com-
mand syntax is available in both procedural
style and operator style. The possible out-
comes are success (1), failure (0) and warn-
ing (-1), for which the identifier constants
SUCCESS, FAILURE and WARNING
have been predefined. The operator style
syntax is also usable without identifier for
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the side-effect, because error messages
will be temporarily ignored.

Questioncmd < questioncmd > <ident>
<questionargs>

<ident> '?' <questioncmd><questionargs>

Stores the answer from a question com-
mand into an identifier. The command syn-
tax is available in both procedural style and
operator style. All question commands
implemented so far are listed below in
Table IV to VII.

Def ( <returnpar> '?' )? <procname>'(' <val-
pars>? ')' <varpar>*

<actions>

Fed

<returnpar> = <varpar>
<procname> = <ident>
<valpars> = <identstr> ( ',' <identstr> )*
<varpar> = <identstr>

Specifies a user-defined procedure in
which a number of command actions are
executed. Note that the terminating Fed-
command is compulsory. Nested procedure
definitions are allowed. A definition may
occur anywhere, as long as it precedes the
first call to it. The course of a procedure
depends on an optional number of value
parameters (between the parentheses) and
variable parameters (behind the par-
entheses). Procedure names can only be
overloaded if there is a difference in the
number of value or variable parameters.
Distinction on data type is not possible, hav-
ing only one internal (string) type. The
optional return parameter is not counted at
overloading, but acts like a variable para-
meter apart from that. It can be applied to
give the procedure a more function-like
appearance. Unlike built-in functions how-
ever, this does not at all mean that pro-
cedure calls can be used as (sub)
expressions.

Return <expr>?

Escapes immediately from the current pro-
cedure. In case its definition includes a
return parameter, it will be assigned with
the optional expression that is returned.

( <ident> '?' )? <procname>'(' <expres-
sions>? ')' <ident>*

Calls a user-defined procedure specified
earlier by means of the Def-command
above. Its optional value parameters will
accept expressions. Its optional return and
variable parameters only accept identifiers,
and these might be modified. Notice that a
procedure call allows no space between
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the procedure name and its opening par-
enthesis.

End Finishes the command stream immediately.

<questioncmd> <questionargs> IV. Question commands (to be inserted
by the user)

IsMatch "<searchstr>" "<textstr>" <case-
tag>

True (1) if the text string matches the search
key according to the rules described in the
Search keys paragraph, false (0) otherwise.
The identifier constants TRUE and FALSE
have been predefined for convenience. If
the optional case-sensitivity of the match is
not specified, the global settings defined by
the Case-command will apply. The options
are 'Insensitive' or 'Sensitive'.

IsWindow "<winname>"? <winproptag>?

<winproptag> = Existent | Accessible |
Modal | QDialog | <showtag>

True (1) if a specified window has a par-
ticular boolean property, false (0) oth-
erwise. The optional property tells whether
the window is either existent (default),
accessible, modal, maximized, minimized,
normal or a QDialog. The optional selection
of the window is analogous to the Window-
command. By default, the current window
will be selected.

IsMenuItemOn "<menupath>"

On (1) if the selected menu (sub)item is
checked, off (0) if it is unchecked, and
unswitchable (-1) if it is not checkable at all.
The identifier constants ON, OFF and
UNSWITCHABLE have been predefined
for convenience. The selection of the menu
(sub)item is analogous to the Menu-com-
mand.

NrMenuItems "<menupath>?"

Returns the number of (enabled) items in
the selected (sub)menu. The GreyOuts-com-
mand defines whether disabled items are
counted as well. Selection of a sub-menu is
analogous to the selection of menu items in
the Menu-command. The root menu is
denoted by an empty menu-path (""). Zero
is returned if the menu-path leads to a leaf
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menu item.

GetMenuItem "<menupath>" <formtag>?

<formtag> = Text | Number

Returns the text or number of a selected
menu (sub)item. In which form is optional
and 'Text' by default. In the 'Number' case,
the GreyOuts-command defines whether
disabled items are counted as well. Selec-
tion of the menu (sub)item is analogous to
the Menu-command.

IsButtonOn "<keystr>"

On (1) if the selected radio-, check-, or tool-
bar button is checked, off (0) if it is
unchecked, and unswitchable (-1) in case
of a push button or a non-checkable toolbar
button. The identifier constants ON, OFF
and UNSWITCHABLE have been pre-
defined for convenience. The button selec-
tion is analogous to the Button-command.

GetButton "<keystr>" <buttonformtag>?

<buttonformtag> = Text | Color

Returns the text or color of a (push/ra-
dio/check/tool)-button. In which form is
optional and 'Text' by default. The RGBt
color string format returned in the 'Color'
case is defined at the ColorOk-command. If
the button has no text or color, an empty
string or transparent white is returned
respectively. The button selection is ana-
logous to the Button-command.

IsButtonMenuItemOn "<keystr>" "<menu-
path>"

On (1) if the selected menu (sub)item of a
button is checked, off (0) if it is unchecked,
and unswitchable (-1) if it is not checkable
at all. The selection of button and menu
(sub)item is analogous to the ButtonMenu-
command.

NrButtonMenuItems "<keystr>" "<menu-
path>?"

Returns the number of (enabled) items in
the selected (sub)menu of a button. The
GreyOuts-command defines whether dis-
abled items are counted as well. The selec-
tion of button and sub-menu is analogous
to the ButtonMenu-command. The root
menu is denoted by an empty menu-path
(""). Zero is returned if the menu-path leads
to a leaf menu item.

GetButtonMenuItem "<keystr>" "<menu- Returns the text or number of the selected
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path>" <formtag>?

menu (sub)item of a button. In which form is
optional and 'Text' by default. In the 'Num-
ber' case, the GreyOuts-command defines
whether disabled items are counted as
well. Selection of button and menu (sub)
item is analogous to the ButtonMenu-com-
mand.

GetInput "<keystr>" <inputformtag>?

<inputformtag> = Text | FilePath

Returns the current content of a selected
input field. In which form is optional and
'Text' by default. Selection of the input field
is analogous to the Input-command. In case
the input field comes together with a Select-
button and perhaps an Examine-button into
a graphical element called uiFileInput, the
'FilePath' option forces the current filename
to be preceded by the absolute file path to
the current selection directory. Otherwise
an empty string will be returned.

GetSpin "<keystr>" <spinformtag>?

<spinformtag> = Text | Value | Minimum |
Maximum | Step

Returns the text, value, minimum, maximum
or step of the selected spinbox. In which
form is optional and textual by default.
Selection of the spinbox is analogous to the
Spin-command.

GetSlider "<keystr>" <sliderformtag>?

<sliderformtag> = Text | Value |Minimum |
Maximum | Percentage

Returns the text, value, minimum, maximum
or percentage of the selected slider. In
which form is optional and textual by
default. Beware that the returned per-
centage of the range displayed on screen
will not necessarily have a linear rela-
tionship with the returned value. Selection
of the slider is analogous to the Slider-com-
mand.

GetWheel "<keystr>" <wheelformtag>?

<wheelformtag> = Text | Angle

Returns the text or angle (in degrees) of the
selected thumbwheel. In which form is
optional and textual by default. Selection of
the thumbwheel is analogous to the Wheel-
command.

NrComboItems "<keystr>"
Returns the number of items in a selected
combobox. The selection of the combobox
is analogous to the Combo-command.

CurComboItem "<keystr>" <formtag>? Returns the text or number of the current
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combobox item. In which form is optional
and textual by default. The selection of the
combobox is analogous to the Combo-com-
mand.

IsComboItemOn "<keystr>" <itemsel>

On (1) if the specified combobox item is cur-
rently selected, and off (0) if it is currently
deselected. Specification of the combobox
and its item is analogous to the Combo-
command.

GetComboItem "<keystr>" <itemsel>
<formtag>?

Returns the text or number of a selected
combobox item. In which form is optional
and textual by default. Selection of the com-
bobox and its item is analogous to the
Combo-command.

NrTabs "<keystr>"?

Returns the number of (enabled) tabs in a
selected tab-stack. The GreyOuts-com-
mand defines whether disabled tabs are
counted as well. The optional selection of
the tab-stack is analogous to the Tab-com-
mand.

CurTab "<keystr>"? <formtag>?

Returns the text or number of the current
tab. In which form is optional and 'Text' by
default. In the 'Number' case, the GreyOuts-
command defines whether disabled tabs
are counted as well. The optional selection
of the tab-stack is analogous to the Tab-
command.

IsTabOn "<keystr>"? "<tabname>"

On (1) if the selected tab is currently on top,
and off (0) if it is currently underneath.
Selection of tab-stack and tab-name is ana-
logous to the Tab-command.

GetTab "<keystr>"? "<tabname>"
<formtag>?

Returns the text or number of a selected
tab. In which form is optional and 'Text' by
default. In the 'Number' case, the GreyOuts-
command defines whether disabled tabs
are counted as well. Selection of tab-stack
and tab-name is analogous to the Tab-com-
mand.

IsCanvasMenuItemOn "<keystr>" "<menu-
path>"

On (1) if the selected menu (sub)item in the
pop-up menu of a canvas area is checked,
off (0) if it is unchecked, and unswitchable
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(-1) if it is not checkable at all. The selec-
tion of canvas area and menu (sub)item is
analogous to the CanvasMenu-command.

NrCanvasMenuItems "<keystr>" "<menu-
path>?"

Returns the number of (enabled) items in
the selected (sub)menu popping up at a
canvas area. The GreyOuts-command
defines whether disabled items are counted
as well. The selection of canvas area and
sub-menu is analogous to the Can-
vasMenu-command. The root menu is
denoted by an empty menu-path (""). Zero
is returned if the menu-path leads to a leaf
menu item.

GetCanvasMenuItem "<keystr>" "<menu-
path>" <formtag>?

Returns the text or number of the selected
menu (sub)item in the pop-up menu of a
canvas area. In which form is optional and
'Text' by default. In the 'Number' case, the
GreyOuts-command defines whether dis-
abled items are counted as well. The selec-
tion of canvas area and menu (sub)item is
analogous to the CanvasMenu-command.

IsShown <subwinsel>? <showtag>

True (1) if a selected subwindow in the
workspace of the current window is min-
imized, maximized, or normal size respect-
ively, and false (0) otherwise. Specification
of size property and optional subwindow is
analogous to the Show-command. Not
selecting a subwindow will yield the size
properties of the current window itself.

<questioncmd> <questionargs> V. List question commands (to be inser-
ted by the user)

NrListItems "<keystr>"
Returns the number of items in a selected
listbox. The selection of the listbox is ana-
logous to the ListClick-command.

CurListItem "<keystr>" <curtag>? <list-
formtag>?

<curtag> = Framed | Selected <list-
formtag> = Text | Number | Color

Returns the text, number or background
color of the current listbox item. In which
form is optional and 'Text' by default. The
RGBt color string format returned in the
'Color' case is defined at the ColorOk-com-
mand. If there is no current listbox item, an
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empty string, zero or transparent white is
returned respectively. By default, the cur-
rent listbox item is the one that is 'Framed'.
Optionally, if precisely one item is 'Selec-
ted' (i.e. highlighted), it can be requested as
current listbox item instead. The selection
of the listbox is analogous to the ListClick-
command.

IsListItemOn "<keystr>" <itemsel>

On (1) if a specified item in a listbox has
been selected (i.e. highlighted), off (0) if it
has been deselected, and unswitchable (-1)
if the listbox does not support item selection
at all. The specification of listbox and item
is analogous to the ListClick-command.

GetListItem "<keystr>" <itemsel> <list-
formtag>?

Returns the text, number or background
color of a selected listbox item. In which
form is optional and 'Text' by default. The
RGBt color string format returned in the
'Color' case is defined at the ColorOk-com-
mand. Selection of both listbox and item is
analogous to the ListClick-command.

IsListButtonOn "<keystr>" <itemsel>

On (1) if the button in front of a listbox item
is checked, and off (0) if it is unchecked.
Selection of both listbox and item is ana-
logous to the ListButton-command.

IsListMenuItemOn "<keystr>" <itemsel>
"<menupath>"

On (1) if the selected menu (sub)item of a
listbox item is checked, off (0) if it is
unchecked, and unswitchable (-1) if it is not
checkable at all. The selection of the list-
box, its item and the menu (sub)item is ana-
logous to the ListMenu-command.

NrListMenuItems "<keystr>" <itemsel>
"<menupath>?"

Returns the number of (enabled) items in
the selected (sub)menu of a listbox item.
The GreyOuts-command defines whether
disabled items are counted as well. Selec-
tion of the listbox, its item and a sub-menu
is analogous to the ListMenu-command.
The root menu is denoted by an empty
menu-path (""). Zero is returned if the menu-
path leads to a leaf menu item.

GetListMenuItem "<keystr>" <itemsel> Returns the text or number of the selected
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"<menupath>" <formtag>?

menu (sub)item of a listbox item. In which
form is optional and 'Text' by default. In the
'Number' case, the GreyOuts-command
defines whether disabled items are counted
as well. The selection of the listbox, its item
and the menu (sub)item is analogous to the
ListMenu-command.

<questioncmd> <questionargs> VI. Table question commands (to be
inserted by the user)

NrTableRows "<keystr>"
Returns the number of rows in the selected
table. The selection of the table is ana-
logous to the TableClick-command.

NrTableCols "<keystr>"
Returns the number of columns in the selec-
ted table. The selection of the table is ana-
logous to the TableClick-command.

CurTableItem "<keystr>" <curtag>? <table-
formtag>?

<tableformtag> = Text | Number | Color

Returns the text, number or background
color of the current table item. In which form
is optional and 'Text' by default. The RGBt
color string format returned in the 'Color'
case is defined at the ColorOk-command. If
there is no current table item, an empty
string, zero or transparent white is returned
respectively. Like the CurListItem-com-
mand, the current table item is by default
the one that is 'Framed'. Optionally, if pre-
cisely one item is 'Selected' (i.e. high-
lighted), it can be requested as current table
item instead. The selection of the table is
analogous to the TableClick-command.

CurTableRow "<keystr>" <curtag>?
<tableformtag>?

Returns the row-header text, number or
background color of the current table row. In
which form is optional and 'Text' by default.
The RGBt color string format returned in the
'Color' case is defined at the ColorOk-com-
mand. If the table has no row header or no
current row, an empty string, zero or trans-
parent white is returned respectively. Like
the CurListItem-command, the current table
row is by default defined by the item that is
'Framed'. Optionally, if precisely one (entire
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row of) item(s) is 'Selected' (i.e. high-
lighted), the row at issue can be requested
as current table row instead. The selection
of the table is analogous to the TableClick-
command.

CurTableCol "<keystr>" <curtag>? <table-
formtag>?

Returns the column-header text, number or
background color of the current table
column. In which form is optional and 'Text'
by default. The RGBt color string format
returned in the 'Color' case is defined at the
ColorOk-command. If the table has no
column header or no current column, an
empty string, zero or transparent white is
returned respectively. Like the CurListItem-
command, the current table column is by
default defined by the item that is 'Framed'.
Optionally, if precisely one (entire column
of) item(s) is 'Selected' (i.e. highlighted), the
column at issue can be requested as cur-
rent table column instead. The selection of
the table is analogous to the TableClick-
command.

IsTableItemOn "<keystr>" <tableitemsel>

On (1) if a specified item in a table has been
selected (i.e. highlighted), off (0) if it has
been deselected, and unswitchable (-1) if
the table does not support item selection at
all. The specification of table and item is
analogous to the TableClick-command. A
row-head or col-head item is considered
selected only if all table cells in that row or
column are selected.

GetTableItem "<keystr>" <cellsel> <table-
formtag>?

Returns the text, number or background
color of a selected table cell. In which form
is optional and 'Text' by default. In the 'Num-
ber' case, the table cells are counted row-
by-row. The RGBt color string format
returned in the 'Color' case is defined at the
ColorOk-command. Selection of both table
and cell is analogous to the TableFill-com-
mand.

GetTableRow "<keystr>" <tableitemsel>
<tableformtag>?

Returns the row-header text, number or
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background color of a selected table item.
In which form is optional and 'Text' by
default. The RGBt color string format
returned in the 'Color' case is defined at the
ColorOk-command. Selection of both table
and item is analogous to the TableClick-
command. If the selected item is not a row-
head item itself, it refers to the row-head
item straight above it.

GetTableCol "<keystr>" <tableitemsel>
<tableformtag>?

Returns the column-header text, number or
background color of a selected table item.
In which form is optional and 'Text' by
default. The RGBt color string format
returned in the 'Color' case is defined at the
ColorOk-command. Selection of both table
and item is analogous to the TableClick-
command. If the selected item is not a col-
head item itself, it refers to the col-head item
left next to it.

IsTableMenuItemOn "<keystr>" <cellsel>
"<menupath>"

On (1) if the selected menu (sub)item of a
table cell is checked, off (0) if it is
unchecked, and unswitchable (-1) if it is not
checkable at all. The selection of the table,
its cell and the menu (sub)item is ana-
logous to the TableMenu-command.

NrTableMenuItems "<keystr>" <cellsel>
"<menupath>?"

Returns the number of (enabled) items in
the selected (sub)menu of a table cell. The
GreyOuts-command defines whether dis-
abled items are counted as well. Selection
of the table, its cell and a sub-menu is ana-
logous to the TableMenu-command. The
root menu is denoted by an empty menu-
path (""). Zero is returned if the menu-path
leads to a leaf menu item.

GetTableMenuItem "<keystr>" <cellsel>
"<menupath>" <formtag>?

Returns the text or number of the selected
menu (sub)item of a table cell. In which form
is optional and 'Text' by default. In the 'Num-
ber' case, the GreyOuts-command defines
whether disabled items are counted as well.
The selection of the table, its cell and the
menu (sub)item is analogous to the
TableMenu-command.
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<questioncmd> <questionargs> VII. Tree question commands (to be inser-
ted by the user)

NrTreeItems "<keystr>"? "<treepath>?"

Returns the number of (enabled) items in a
selected tree node. The GreyOuts-com-
mand defines whether disabled items are
counted as well. The optional selection of
the tree is analogous to the TreeClick-com-
mand. This also holds for its tree node,
except that column selection is not an issue
here. The root node is denoted by an empty
tree path (""). Zero is returned if the tree
path leads to a leaf tree item.

NrTreeCols "<keystr>"?
Returns the number of columns in a tree.
The optional selection of the tree is ana-
logous to the TreeClick-command.

CurTreeItem "<keystr>"? <curtag>?
<formtag>?

Returns the text or number of the current
tree item. In which form is optional and tex-
tual by default. In the 'Number' case, the
GreyOuts-command defines whether dis-
abled items are counted as well. If there is
no current tree item, an empty string or zero
is returned respectively. Like the
CurListItem-command, the current tree item
is by default the one that is 'Framed'. Option-
ally, if precisely one item is 'Selected' (i.e.
highlighted), it can be requested as current
tree item instead. The optional selection of
the tree is analogous to the TreeClick-com-
mand.

CurTreePath "<keystr>"? <curtag>?
<formtag>?

Returns the path to the current tree item. In
which form is optional and textual by
default. The 'Number' case is especially
useful if 'Text' would yield an ambiguous
tree path. The GreyOuts-command defines
whether disabled items are counted as well.
If there is no current tree item, an empty
path ("") is returned. Like the CurListItem-
command, the current tree item is by default
the one that is 'Framed'. Optionally, if pre-
cisely one item is 'Selected' (i.e. high-
lighted), it can be requested as current tree
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item instead. The optional selection of the
tree is analogous to the TreeClick-com-
mand.

CurTreeCol "<keystr>"? <formtag>?

Returns the column text or number of the
current tree item. In which form is optional
and textual by default. Note that the current
tree item is merely column-specific in case
of the default 'Framed' setting. The optional
selection of the tree is analogous to the
TreeClick-command.

IsTreeItemOn "<keystr>"? "<treepath>"

On (1) if a specified item in a tree has been
selected (i.e. highlighted), off (0) if it has
been deselected, and unswitchable (-1) if
the tree does not support item selection at
all. Specification of the tree and its node is
analogous to the TreeClick-command,
except that column selection is not an issue
here.

IsTreeItemExpanded "<keystr>"?
"<treepath>"

True (1) if a specified item in a tree has
been expanded, false (0) if it has been col-
lapsed, and unexpandable (-1) if it is a leaf
node. Beware that an expanded tree node
can have a collapsed ancestor. Spe-
cification of the tree and its node is ana-
logous to the TreeClick-command, except
that column selection is not an issue here.

GetTreeItem "<keystr>"? <treenodesel>
<formtag>?

Returns the item number of a tree node or
the text in one of its columns. In which form
is optional and textual by default. In the
'Number' case, the GreyOuts-command
defines whether disabled items are counted
as well. The selection of the tree, its node
and column is analogous to the TreeClick-
command.

GetTreePath "<keystr>"? "<treepath>"
<formtag>?

Returns the path to a selected tree node. In
which form is optional and textual by
default. In the 'Number' case, the GreyOuts-
command defines whether disabled items
are counted as well. It can be used for con-
verting a path from one form to another. Spe-
cification of the tree and its node is
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analogous to the TreeClick-command,
except that column selection is not an issue
here.

GetTreeCol "<keystr>"? <treecolsel>
<formtag>?

<treecolsel> = <colsel> | PathCol
"<treepath>" <colsel>

Returns the text or number of a selected
tree column. In which form is optional and
textual by default. In the 'Number' case, the
GreyOuts-command defines whether dis-
abled items are counted as well. Selection
of the tree, its column and an optional node
is analogous to the TreeClick-command. If
the column selection is made by name, the
search for a match will start in the column
header. If not successful, it proceeds at the
specified tree node in the 'PathCol' case, or
traverses all tree nodes breadth-first oth-
erwise.

IsTreeButtonOn "<keystr>"? "<treepath>"

On (1) if the button in front of a tree node is
checked, and off (0) if it is unchecked. Selec-
tion of both the tree and its node is ana-
logous to the TreeButton-command.

IsTreeMenuItemOn "<keystr>"? <treen-
odesel> "<menupath>"

On (1) if the selected menu (sub)item
attached to a column of a tree node is
checked, off (0) if it is unchecked, and
unswitchable (-1) if it is not checkable at all.
The selection of the tree, its node and
column, and the menu (sub)item is ana-
logous to the TreeMenu-command.

NrTreeMenuItems "<keystr>"? <treen-
odesel> "<menupath>?"

Returns the number of (enabled) items in
the selected (sub)menu attached to a
column of a tree node. The GreyOuts-com-
mand defines whether disabled items are
counted as well. Selection of the tree, its
node and column, and a sub-menu is ana-
logous to the TreeMenu-command. The root
menu is denoted by an empty menu-path
(""). Zero is returned if the menu-path leads
to a leaf menu item.

GetTreeMenuItem "<keystr>"? <treen-
odesel> "<menupath>" <formtag>?

Returns the text or number of the selected
menu (sub)item attached to a column of a
tree node. In which form is optional and
'Text' by default. In the 'Number' case, the
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GreyOuts-command defines whether dis-
abled items are counted as well. The selec-
tion of the tree, its node and column, and
the menu (sub)item is analogous to the
TreeMenu-command.

Expressional specifications
The logical and mathematical operators to be applied in Command Driver expressions
are almost equivalent to those used in OpendTect's mathematics attribute definitions.
Only the |x| operator is not provided to keep the parsing of expressions straightforward.
Use the abs()-function instead. The AND-operator, OR-operator and conditional operator
only evaluate their second (or third) sub-expression if needed for the result. For example,
the reciprocal expression ( x==0 ? UNDEF : 1/x ) will not generate a division-by-zero
error. The list of operators is sorted in order of precedence.

Precedence Associativity <operatorexpr>
VIII. Logical and math-
ematical operators (to be
used in expressions)

1 right-to-left ! <expr> Logical not
right-to-left + <expr> Unary plus
right-to-left - <expr> Unary minus

2 right-to-left <expr> ^ <expr> Raise to power
3 left-to-right <expr> * <expr> Multiplication

left-to-right <expr> / <expr> Real division
left-to-right <expr> | <expr> Integer division
left-to-right <expr> % <expr> Modulo

4 left-to-right <expr> + <expr> Addition
left-to-right <expr> - <expr> Subtraction

5 left-to-right <expr> < <expr> Less than
left-to-right <expr> <= <expr> Less than or equal
left-to-right <expr> > <expr> Greater than
left-to-right <expr> >= <expr> Greater than or equal

6 left-to-right <expr> == <expr> Equality (numerical if pos-
sible, string otherwise)

left-to-right <expr> != <expr> Inequality (numerical if pos-
sible, string otherwise)

7 left-to-right <expr> && <expr> Logical AND
8 left-to-right <expr> || <expr> Logical OR
9 right-to-left <expr> ? <expr> : <expr> Conditional operator (if-then-
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else)

The mathematical and statistical functions to be applied in Command Driver expressions
are a superset of those used in OpendTect's mathematics attribute definitions . Many
other (string) functions have known equivalents in the C-library of the C++ programming
language.

<functioncall> IX. Mathematical functions (to be used in
expressions)

abs( <expr> ) Absolute value
acos( <expr> ) Arc cosine
asin( <expr> ) Arc sine
atan( <expr> ) Arc tangent between -PI/2 and PI/2
atan2( <y_expr>, <x_expr> ) Arc tangent of y/x between -PI and PI
ceil( <expr> ) Smallest integer not less than
cos( <expr> ) Cosine
exp( <expr> ) Exponent
floor( <expr> ) Largest integer not greater than
ln( <expr> ) Natural logarithm
log( <expr> ) Base-10 logarithm

rand( <max_expr>? ) Uniform random value between 0 and
optional maximum, 1 by default

randG( <stddev_expr>? ) Gaussian random value with mean 0 and
optional standard deviation, 1 by default

round( <expr> ) Round to nearest integer

sgn( <expr> ) Sign (1 if greater than zero, 0 if zero, -1 if
less than zero)

sin( <expr> ) Sine
sqrt( <expr> ) Square root
tan( <expr> ) Tangent
trunc( <expr> ) Round to integer in direction of zero

<functioncall> X. Statistical functions (to be used in
expressions)

avg( <expressions> ) Average
max( <expressions> ) Maximum
min( <expressions> ) Minimum
sum( <expressions> ) Sum
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var( <expressions> ) Variance
med( <expressions> ) Median

<functioncall> XI. String functions (to be used in expres-
sions)

curWindow() Title of current window

isAlNum( <expr> ) True (1) if all characters are alpha-numer-
ical, false (0) otherwise

isAlpha( <expr> ) True (1) if all characters are letters, false (0)
otherwise

isDigit( <expr> ) True (1) if all characters are digits, false (0)
otherwise

isInteger( <expr> ) True (1) if representing an integer, false (0)
otherwise

isLower( <expr> ) True (1) if all characters are lower-case let-
ters, false (0) otherwise

isNumber( <expr> ) True (1) if representing a number, false (0)
otherwise

isSpace( <expr> ) True (1) if all characters are white space,
false (0) otherwise

isUpper( <expr> ) True (1) if all characters are upper-case let-
ters, false (0) otherwise

strCat( <expressions> ) String concatenation
strLen( <expr> ) String length in characters

strSel( <str_expr>, <firstpos_expr>, <last-
pos_expr>? )

Character selection. Last position is
optional. Negative positions count in
reverse.

sepStrCat( <expressions> ) Concatenation of separation-strings (menu-
and tree-paths, RGB(t) color strings)

sepStrLen( <expr> ) Number of separated substrings

sepStrSel( <str_expr>, <firstpos_expr>,
<lastpos_expr>? )

Selection of separated substring(s). Last
position is optional. Negative positions
count in reverse.

toLower( <expr> ) Converts all letters to lower-case
toUpper( <expr> ) Converts all letters to upper-case

wildcard( <selnr_expr>? )

Matching substring for a wildcard in the
latest successful wildcarded command
action. Default selection number is 1. A neg-
ative number counts the wildcards in
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reverse.

wildcardStr( <selnr_expr>? )

The whole matching string around a wild-
card in the latest successful wildcarded
command action. Wildcard selection is ana-
logous to the wildcard()-function above.

All predefined identifier constants and environment variables are listed below. The Com-
mand Driver will automatically change Unix-style file-paths into Windows-style file-paths
on Windows-platforms and vice versa. Redefining any predefined identifier will result in
a warning, but is not forbidden. It allows the command script to overrule the values of the
directory identifiers ( $...DIR$ ) as set by the system environment in which OpendTect is
running. Or you can reset the "increment"-identifier FILEIDX with the start value you like.
Beware that most of the predefined identifier constants are unfit for change. They are
only there to make command scripts more readable. The Command Driver will keep
using the original values internally! For example, you can exchange the values of TRUE
and FALSE, but the function call isAlpha("a") still returns 1. Therefore, an expression
like isAlpha("a")==TRUE would suddenly get an opposite meaning.

<ident> $<ident>$
XII. Predefined identifiers (to be
used in substitution and expres-
sions)

TRUE
FALSE

1
0 Logical constants

PI 3.14159265 ... Trigonometric constant

UNDEF 1e30

OpendTect's undefined value.
Treated as such by all logical, math-
ematical, and statistical operators
and functions defined above.

SUCCESS
FAILURE
WARNING

1
0
-1

Possible results of 'Try'-command

ON
OFF
UNSWITCHABLE

1
0
-1

Possible results of any 'Is...On'-
question command

BASEDIR Base data directory ( setenv
DTECT_[WIN]DATA )

DATADIR $BASEDIR$/<cur_sur-
vey> Survey directory

PROCDIR $DATADIR$/Proc Processing directory

APPLDIR Installed software directory ( setenv
DTECT_[WIN]APPL )
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USERDIR Personal home directory ( setenv
DTECT_PERSONAL_DIR )

SCRIPTSDIR $PROCDIR$ Overruled by setenv DTECT_
SCRIPTS_DIR

SNAPSHOTSDIR $DATADIR$/Snapshots Overruled by setenv DTECT_
SNAPSHOTS_DIR

IMPORTDIR $DATADIR$/Import Overruled by setenv DTECT_
IMPORT_DIR

EXPORTDIR $DATADIR$/Export Overruled by setenv DTECT_
EXPORT_DIR

FILEIDX 1000++

Integer variable that is auto-
matically incremented after every
occurrence in the command stream.
It may be substituted in file-paths to
generate unique filenames.

Repetitive task example
One of the recurring user questions about OpendTect is whether there is a quick way to
do some kind of repetitive task. Loading a huge amount of wells, importing multiple 2D
line SEG-Y data, etc. Such a service can only be offered by OpendTect itself if the task is
very simple, common and straightforward. For example, one does have the possibility to
select multiple horizons with the mouse in order to load them in one go. However, if the
repetitive task is more complex, unique, or variant, the workflow can be automatized by
means of a command script.

The current Command Driver capabilities are demonstrated by automizing a case raised
by Magnus Lidgren. His scene contained a big number of 2D lines, and a number of
attributes on each line. He needed to generate a picture for every attribute of every 2D
line, and wanted to avoid doing that manually.

Automizing a repetitive task consists of three stages. Firstly, the Command Recorder is
applied to record the mouse and keyboard actions needed to perform the task once.
Secondly, a text editor is used to modify the recorded script. Some of the recorded
actions have to be generalized, and a few new commands have to be added to make the
script iterative. These commands are listed in Table III. Thirdly, the Command Driver is
applied to run the modified script, initially to debug it and finally to perform the repetitive
task.

Listed below is the recorded command script that makes a snapshot of one attribute on
one 2D line. The passages that need to be generalized have been printed in red.

[OpendTect Main Window]
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TreeMenu "2D Seismics`LS 5k`i5007`Seis" "Display in a 2D
Viewer as`VD"

[2D Viewer - Line: i5007]

Button "Save image"

[Create snapshot]

Button "Screen" On

Input "Select filename" "/d43/-
jaap/surveys/Demo2D/Snapshots/dump.png" Hold

Button "Ok"

[2D Viewer - Line: i5007]

Close

[OpendTect Main Window]

Listed below is the modified command script after it has been generalized and made iter-
ative. All changes with regard to the originally recorded script have been printed in
green.

Def res ? dumpAttribute( setnr, namenr, attrnr )

[OpendTect Main Window]

res ~ TreeMenu "2D Seismics`*#$setnr$`*#$namenr$`*#$attrnr$" \

"Display`2D Viewer - VD"

If res==FAILURE ; Return ; Fi

pic_name = strCat( wildcard(1), "_", wildcard(2), "_" )

pic_name = strCat( pic_name, wildcard(3), ".png" )
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[2D Viewer - Line: *]

Button "Save image"

[Create snapshot]

Button "Screen" On

Input "Select filename" "$SNAPSHOTSDIR$/$pic_name$" Hold

Button "Ok"

[2D Viewer - Line: *]

Close

[OpendTect Main Window]

Fed

For setidx = 1

For nameidx = 1

For attridx = 1

res ? dumpAttribute( setidx, nameidx, attridx )

If !res ; Break ; Fi

Rof

If attridx==1 ; Break ; Fi

Rof

If nameidx==1 ; Break ; Fi

Rof

The command script example above demonstrates a number of more advanced Com-
mand Driver features:
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l Def-inition of procedure(s) to modularize, reuse and/or hide command
sequences.

l "Try"-command ( res ~ ... ) to check whether a command executes.

l Wildcards ('*') to match arbitrary substrings.

l Disambiguators ('#') to select the n-th match out of multiple matches.

l Substitution ( $...$ ) of identifier values into command actions.

l Backslash ('\') to spread a long command over multiple lines.

l If-command to execute command actions conditionally.

l Use of predefined identifiers: constant FAILURE and environment vari-
able SNAPSHOTSDIR.

l Semicolons (';') to separate multiple commands on one line.

l Return-command to terminate a procedure immediately.

l Use of assignment and built-in function calls ( pic_name = strCat(...,...)
).

l Wildcard(.)-function to get matching strings from the latest successful
wildcarded command action. Note that these strings must be secured
before the next use of a wildcard ( i.e. in window assertion [2D Viewer -
Line: *] ).

l (For)-loops to make a script iterative.

l Call to a user-defined procedure ( res ? dumpAttribute(...,...) )

l Break-command to escape from loops immediately.

Note that different operators are used to store the result of an expression (=), a command
action (~), or either a user-defined procedure (?) or a question command (?) into an iden-
tifier. This eases the parsing of commands by the Command Driver, and it should make
the user aware that the allowed complexity of (sub)-expressions does not go beyond the
built-in function calls. The results of command actions, user-defined procedure calls, and
question commands have to be assigned to auxiliary identifiers first.

The introduction of question commands allows the body of the previous script to be writ-
ten in a different style. An identifier can take the answer to one of the many questions
(Nr..., Cur..., Is..., Get...) from Table IV to VII about some property of a user-interface ele-
ment. Instead of applying the Break-command to escape from loops when the procedure
call to dumpAttribute(...,...) fails, now the number of items to iterate over can be asked
and set before entering a loop ( nritems ? NrTreeItems ... ). Note that a procedure defined
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with a return parameter can also be called without. Listed below is the restyled body of
the command script above.

nrsets ? NrTreeItems "2D Seismics"

For setidx = 1 To nrsets

nrnames ? NrTreeItems "2D Seismics`*#$setidx$"

For nameidx = 1 To nrnames

nrattrs ? NrTreeItems "2D Seismics`*#$setidx$`*#$nameidx$"

For attridx = 1 To nrattrs

dumpAttribute( setidx, nameidx, attridx )

Rof

Rof

Rof

Standard test scripts
In the 'doc' directory of the release, you can find a 'Scripts' subdirectory. It contains the
standard test scripts for OpendTect. These test scripts all work on a survey 'F3_Demo',
the demo data set for OpendTect.

The directory contains several scripts, many of which can be run stand-alone, but cer-
tainly not all. There is also an execute-all script: 'AllScripts.cmd'. Another composite
script is 'AllAttributes.cmd', which will make snapshots in the Snapshots directory. This
Snapshots directory is created automatically; the location is your_ surveys/F3_
Demo/Snapshots. The snapshots are created as an index followed by the file name.

Another script is 'ExportData.cmd'. While running this script an 'Export' directory is auto-
matically created as a subdirectory of 'F3_Demo'. All the exported data will be stored in
the above directory.

Some scripts are dependent on PlugIns like SSIS, VMB etc. These scripts are located in
dgb/doc/Scripts. To run these scripts you should make sure the related plugins are
loaded.
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User history recording
The CmdDriver plugin also offers the possibility to record the user action history in the
background from the moment OpendTect is started. It will be stored in the file user-
history.odcmdin the Proc directory of the starting survey. It is not guaranteed that the
Command Driver can offer a full reproduction of the past by running this file, since not all
possible user actions are covered yet. Mouse actions performed in 3D scenes or 2D
viewers are recorded nor executed for the time being. Actions performed in the Com-
mand Controller window are recorded, but not executed as long as the difficulty of call-
ing the Command Driver recursively has not been solved. Nevertheless, the recorded
history can be of great help in reproducing a bug or crash reported by the user.

In order to enable recording of the user history, the user setting dTect.User history buffer
must be set with a value other than zero. The magnitude of this value defines the size (in
characters) of the buffer in which the user actions are stored temporarily. A positive size
value means flushing the content of the buffer to file every time it overflows. A negative
size value means dropping the oldest content once the buffer starts overflowing, and
flushing only the newest actions to file when OpendTect finally exits or crashes. The
menu item Utilities->Settings->Advanced->Personal settings will pop-up a dialog in
which this user setting can be added or adapted.
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Appendix C - SEG-Y Checklist
This document contains examples of SEG-Y loading problems and proposes solutions
for the most often encountered problems.

In all cases, the SEG-Y import tool must be launched from the survey menu (Import -->
Seismics --> SEG-Y). Enter the settings needed for the first step and press OK. In the
next window (main import window) press scan and perform the scan. An examine win-
dow will pop up. Display the first traces in the 2D viewer.

You should have on your screen:

l The main import window

l The examine window

l The scan report

l The first traces displayed in a 2D viewer

Once you have this on screen check the most appropriate situation in the list below:

1. The textual header is not readable

2. The line header in not readable

3. None of the trace headers are readable

4. The first trace header is readable but no other - zero sample
rate - last trace incomplete

5. The examine/scan reports incorrect coordinates

6. The loaded volume contains wrong amplitudes

7. The loaded volume contains holes - traces were rejected

8. The loaded volume is shifted with respect to the others - does
not start at zero

Excel utilities

1. SEG-Y file size computation

2. SEG-Y trace numbers computation



- 746 -

SEG-Y checklist

The textual header is not readable
The top of the examine window may look like any of those two windows, although there
is an enormous variety in textual headers:
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The left picture is a very common empty (automatically filled) textual header. Sometimes
an operator fills the empty parts, but you can expect mistakes to occur. The second pic-
ture is a textual header from an OpendTect exported SEG-Y file. All the fields were dir-
ectly copied from the project database (additional edits are possible).

Every SEG-Y file begins with 40 times 80 characters encoded in ASCII, or EBCDIC for
old files. The main difference between them is that your favorite text editor (wordpad, vi
or text edit) will not be able to translate EBCDIC encoded characters if you open the
SEG-Y file with it, while if you open an ASCII SEG-Y textual header you will see the
same as in the OpendTect examine window, without the line breaks.

l Problem: If you do not see the above described structure youmight not
be reading a SEG-Y file at all, but maybe a seismic file written in a dif-
ferent format (binary, SEG-D, ...).

Solution: Translate your file if possible.

l Problem: Some characters in the textual header are weird.

Solution: They were badly translated from EBCDIC to ASCII (or
the opposite), either when writing the file or when reading it. Unfor-
tunately there is no 1 to 1 translation between EBCDIC and
ASCII, therefore this issue cannot be solved. That is why EBCDIC
coding has been banned from the SEG-Y revision 1 norm.

The line header is not readable
The line header overview is provided in the top part of the examine window below the
textual header. Use the right scroll bar to reach it. Only the non-zero values are shown,
on the contrary to the other headers where the entire content is reported. A correct line
header will look like this in the OpendTect examine window:
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The title line, field names (first column), byte offsets (second column) and explanations
between brackets (fourth column) are provided by OpendTect. Only the numbers in the
third column originate from the file. The byte numbers indicate where those values were
found.

Look at the field isrev1 (301): If the value is zero your file is revision 0 compliant. If the
value is equal to 1 then your file in (normally) revision 1 compliant. This enables to
answer to the revision 1 question.

l Problem: If none of the values are reasonable but contain a lot of 256
and 16777216, or in general if none of the numbers make sense, the
file might be byte-swapped (i.e. written using "little-endian" byte order-
ing instead of "big-endian"). See example below:

Solution 1: In that case cancel the import window (that will bring
you back to the first step), and put the "Byte swapped" parameter
to "all".

Solution 2:.If this is not enough then the textual and/or line head-
ers might be corrupted. Try to re-create your SEG-Y file if pos-
sible.

None of the trace headers are readable

l Problem: The line header is truncated: The line header should be 400
bytes long. It will not be possible to deduct the start position of the first
trace if any of the first 3600 (=3200 + 400) bytes are missing. If the line
header is truncated then you should see a lot of non-standard entries in
the examine window, like in the example below:
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Solution: Use the excel utilities to determine if your file may be
missing some bytes. If that is the case you need to re-create your
file unless you know exactly how many bytes are missing and
how to lengthen your line header.

l Problem: The bytes are swapped.

Solution: See above.

The first trace header is readable but no other - zero sample rate - last trace incom-
plete
This happens when the trace size could not be computed successfully. The trace size is
function of the sample size (format) and number of samples. The problem then occurs
when either of those variables was not correctly written in the headers.

l Action 1: Check if the sample size (format) is correct in the line header:
The sample format is reported in the examine window in the line
header in front of the "format" field. It must report a value of 1, 2, 3, 5 or
8. If not the following warning will be shown when scanning the file or
loading it:
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A value of 1, 2, 5 represents a sample size of 4 bytes.
A value of 3 represents a sample size of 2 bytes.
A value of 8 represents a sample size of 1 byte.

Furthermore the warning "Err: Warning: replacing zero sample rate with survey default"
is printed (but that is not the only cause) if the actual sample size is larger than the
sample size deducted from the headers of overruled.

On the contrary the warning "last trace incomplete" is printed (but that is not the only
cause) if the actual sample size is smaller than the sample size deducted from the head-
ers or overruled.

Solution: Overrule the SEG-Y format to another format until the
line header and all trace headers are readable in the examine win-
dow. Scan your file and check the output amplitudes since three
different formats are available for a sample size of 4 bytes. A
proper display of the data in the 2D viewer will indicate a suc-
cess.

l Action 2: Check if the number of samples was correctly extracted from
either the line or trace headers: The number of samples is reported at
multiple positions in the SEG-Y file:
In the examine window in the line header overview in front of the "hns"
field.
In each trace header at byte offset 115 (field "ns").
OpendTect will only use the number of samples defined in the trace
headers. Therefore the line header field "hns" might be missing or in
contradiction with the trace headers, with no consequence upon the
data loading as long as the trace headers "ns" field are correctly writ-
ten.

Solution: Overrule the SEG-Y number of samples to another
value until all trace headers are readable. The excel utilities might
be helpful to check the correct value and to check if the file is not
missing some bytes.

The examine/scan reports incorrect coordinates
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The coordinates may be found in each trace headers on bytes 73 (CDP-X) and 77
(CDP-Y) or 181 and 185 respectively with SEG-Y revision 1 files. However those values
will be scaled during scan and loading by the scaler coordinate that should always be
found on bytes 71-72.

l Problem: The coordinates found in the trace headers do not make
sense: Your file might contain coordinate trace header encoded as
floats instead of integers. This is not allowed by any SEG-Y standard,
although still being encountered sometimes.

Solution: Get a SEG-Y compliant file.

l Problem: The unscaled coordinates are reasonable but after scan/-
loading the scaled coordinates are not correct.

Solution: Overrule the scaler coordinate to the right value in the
import window. You need to specify a number that when mul-
tiplied by the trace header coordinate will return the actual
(scaled) coordinate. Therefore the trace header scalco "- 10"
would have to be overruled by 0.1 in order to get the same scal-
ing.

Please note the it is not possible to apply a static shift (easting/northing) to the coordin-
ates, however this is not needed by OpendTect. Nevertheless you can load the SEG-Y
file first and apply your shift to the survey coordinates afterwards in the survey definition
window.

The loaded volume contains wrong amplitudes
This is linked to the sample format not being correctly set. The three formats 1, 2, 5
code the data on four bytes. You may need to switch and overrule between 1, 2 and 5.

The loaded volume contains holes - traces were rejected
Neither a SEG-Y file nor and OpendTect volume need to be rectangular, i.e. they do not
need to contain all traces of rectangular survey. This is normal, except if you expect a
rectangular volume. Please note that the default setting in OpendTect is to dismiss null
traces, i.e. traces where all samples have a zero value.

l Problem: The warning "during import 123450 traces were rejected"
appers when loading the file.

Solution 1: Display the loaded file. The warning sometimes pops
up by mistakes such that your file may be already correctly
loaded.

Solution 2: Make sure that the survey area is large enough to
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accommodate your new volume.

l In general: .

Solution: Use the excel utilities to compute the number of traces
you can expect to have in your SEG-Y file, and compare it with
the actual number of loaded traces, reported in the scan report.
OpendTect will be able to load all full traces until the first missing
byte is found in the input file or until the end of the file, even if the
end of the file is in the middle of a trace. In that case only the last
non-complete trace will not be acccessible.

The loaded volume is shifted with respect to the others - does not start at zero
Sometimes the first sample does not correspond to the time or depth 0. If that is the case
the corresponding time or depth should be reported in each SEG-Y trace header at bytes
109-110 (delrt) and/or 105-106 (laga) with the opposite polarity like in this example:

"laga" is equal to -200, delrt is equal to 200: both mean that the first sample corresponds
to time 200ms.

l Problem : The start time is not specified in the trace headers but is
expected to be different that zero.

Solution: Overrule the start time parameter in the import window.

l Problem: An incorrect start time was applied during loading.
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Solution: Either re-import the file by overruling the start time or
use the reference shift attribute to apply a static shift to your
traces.

Please note that in all cases you must have a priori knowledge of the start time.

Excel utilities
The following two utilities can be used to:

l Compute the SEG-Y file size based on the sample format, number of
traces and number of samples. A successful application will be the
indicator of a SEG-Y file without missing bytes.

l Compute the number of traces present in the SEG-Y file based on its
size, the sample format and the number of samples per trace, assuming
a constant trace length. If the returned number os an integer the SEG-Y
file does not contain holes (except for a very unlikely occasion).

How-to use them: Double-click on the pictures below, open the file and fill the variables.
The sample format must be specified using the list box.

Please note that extended textual headers are not supported.

SEG-Y file size computation

SEG-Y trace numbers computation
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Appendix D - Wacom Digitizing Tablets
Introduction
Pen Device
Basic Interaction
Draw Polygons
Create Bodies
Interpret Horizons
Manually Edit Horizons
Interpret Faults
Supported Platforms

OpendTect is the first Seismic Interpretation System to support Wacom Digitizing Tab-
lets. Workflows for horizon tracking, fault interpretation, drawing of polygons & bodies
etc. have been adapted to benefit from the superior hand-eye co-ordination offered by
the pen/tablet combination device.
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Introduction
OpendTect combined with a Wacom Tablet has become a key application for hand-eye
coordination. It has proven to be vital in manual interpretations with OpendTect. Many of
the OpendTect interpretation- workflows were modified in version 4.2 for optional use of
a tablet device. This documentation is thus written to provide a brief introduction on seis-
mic interpretation on a tablet. The documentation assumes basic familiarity with the
OpendTect environment.

Several aspects of 3D interpretation will be covered:

l How to use the Wacom Pen device instead of a conventional mouse

l How to draw interpretations in OpendTect with a Wacom tablet

l Polygon/Picksets

l Horizon Interpretation

l Fault Interpretation

Before you start using the documentation, a general introduction will be given on the pen
device and the features which are supported by OpendTect.

Pen Device
The following list describes how the pen device replaces traditional mouse features:

l Mouse clicks are replaced with the clicks being made by the tip of the
pen device

l The mouse drag function is replicated by dragging the tip of the pen on
the tablet device

l The right/left/double click buttons are supported via the DuoSwitch
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The only thing required is to hold the pen device in your hand and begin interpreting the
seismic data. If you want to draw a seismic object e.g. a horizon/polygon, you will simply
need to drag the tip with a light pressure on the tablet. Light pressure here simply means
that you touch the tablet screen using the tip of the pen. The tablet is pressure sensitive
and will automatically detect that the user is intending to draw on screen. It will convert
the screen coordinates back to the survey coordinates and will store the object.

Furthermore, the Eraser can be used to remove (parts of) the interpretation (specifically,
the seeds). The eraser feature is accessed either by clicking on the node/seed to remove
it, alternatively by rubbing it over the interpretation (drawn lines). The DuoSwitch is used
to launch pop-up menus or for double clicking on an element. The single left mouse-but-
ton click is accessed through the tip of the pen (by 'tapping' on the screen).

Precautions:

l When the pen is not in use, please place it back in the pen stand

l Please avoid using the mouse while the pen device is in your hand.
You may either use a pen supported by the Wacom tablet or regular
installed mouse

Basic Interaction

Menus/Icons:
The menus/icons are clicked using the tip of the pen device. The tip is tapped over the
(sub ) menu/icon to launch the corresponding dialog/application.

Display an Element:
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To display an element in a scene, you will need to use the Tree of OpendTect. For
instance, to display an Inline, simply place the tip of the pen at inline and select the Add
option.

Pop-Up Menus:
Pop-up menus are launched using the lower button of the DuoSwitch. The pop-up menu
options are selected by tapping the item with the tip of the pen.

Lines/Seeds/Points:
The lines, seeds or points (Picksets) in OpendTect are drawn by dragging the tip of the
pen over the displayed element in the 3D scene, similarly to drawing with a pen on reg-
ular paper. The drawn line/point data can be removed interactively using the Eraser at
the end of the pen.

Draw Polygons
The first example in this tutorial is creating a simple polygon on a horizon on the tablet
device. Although the workflow is simple, several options and features are introduced so
that you will familiarize yourself with other important features simultaneously. Please fol-
low the steps set out below:

In the following workflow, use the pen device instead of mouse.

Tap/Press/Select in this workflow refers to the tip of the pen device.
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1. Hold the pen device in your hand

2. Drawing a polygon on a seismic horizon:

First, display a seismic horizon. Tap the tip of the pen
on the Horizon element in the tree; a pop-up sub-
menu appears

Select Load

The Horizon Selection dialog is then launched from
where you can select one or more saved horizons

Select a horizon by tapping on it, or multiple horizons
by tapping and dragging

Press Ok to display the selected horizon(s)

Once a seismic horizon on which you want to draw a
polygon is displayed, you can continue to the next
steps; drawing a polygon

3. From the tree, tap on the Pickset/Polygon element

4. From the pop-up menu select New Polygon

5. The Polygon Creation dialog box is opened, type a name for
the new polygon. For typing, you may use either the conventional
keyboard attached to your computer or the virtual keyboard sup-
ported in OpendTect. The virtual keyboard is launched using the
lower DuoSwitch button (equivalent to the right-click button on a
conventional mouse) whilst pointing the pen at the name field.
Once done typing, simply close the virtual keyboard: the new poly-
gon name is automatically inserted in the field
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6. Hit Ok in the parent Polygon Creation dialog

7. A blank polygon is added in the tree, with the given name (step
5)

8. Optional: before drawing on the horizon, change to map-view
by selecting View North-Z in the main toolbar to the left

9. Make sure the polygon element in the tree is active (tap it) and
start drawing the polygon on the horizon. Two methods are avail-
able: (1) drag and release, in which you will have to drag the pen
over the area where you want to draw a polygon or (2) tap pen,
where you tap on the horizon to insert seeds, the seeds are then
connected automatically

10. Whilst drawing the polygon, unwanted points can be removed
with the eraser at the end of the pen

11. Finally, close the polygon: Right click (lower button on the
DuoSwitch) on the polygon name in the tree and select Close
Polygon option from the pop-up menu.

Create Bodies
Bodies are easily created after drawing a polygon. The workflow requires a combination
of a saved polygon and top & bottom horizons between which the body will be created.
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1. Display a stored (Load) or draw (New) a polygon by following
the workflow above

2. From the polygon pop-up menu (use the lower DuoSwitch),
select Create body

3. In this dialog, select top and bottom horizons

4. Hit the Ok button

5. The above step (4) creates the body with an empty name and
displays it in the scene. In the tree, the <New MCBody 1> sub ele-
ment under the Body menu appears. Save it by launching the
pop-up menu for the body by using the lower DuoSwitch

Interpret Horizons
Seismic horizon interpretation is fast and convenient on the Wacom tablet device. This is
mainly due to the human adaptability with the pen. To help you get started with inter-
preting seismic horizons with OpendTect on the tablet device, simply grab your pen and
follow the workflow set out below.

Please use the pen device instead of mouse in the following workflow.

Tap/Press/Select all refer to the tip of the pen device.

Setup an orthogonal Display:
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1. A flat (orthogonal) display has proven useful when interpreting
horizons on seismic data. This view enables you to view the
inlines/crosslines/z- slices as '2D' planes. Simply switch the
default perspective view to orthographic:

Use the pen device to tap the button to toggle the ortho-
graphic view on/off.

2. If you wish to interpret horizons on inlines, you may want to
select the View Inline display option from the Graphical Toolbar.

3. Optional: You may also adjust the zoom of the display using
the touch strips available on the back side of the table.

Display seismic data:

4. Display seismic data in the scene by tapping either Inline or
Crossline in the tree. By default data is being displayed as a
white colored 'empty' element in the centre of the survey. Select
data by tapping the <right-click> sub-element. Use the lower
DuoSwitch to access the sub-element and select seismic data to
be displayed (as shown below).

Once the seismic data is loaded, you can proceed to
the next step

Add a New Horizon:

5. Use the pen tip to add a new horizon in the tree. Tap the Hori-
zon element in the tree using the pen. A drop-down list appears;
select New...
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6. A new horizon is added in the tree, labeled <New Horizon 1>
by default. A pop-up dialog also appears (i.e. the Tracking Setup).

Pick seeds and Auto-track:

7. The tracking setup window features four tabs, presented briefly
below. Please refer to the general help documentation of
OpendTect for detailed descriptions.

Mode: Select tracking mode i.e. auto-tracking, track-
ing on a line, or tracking manually.

Event: Used if the mode is set to either auto-tracking
or line tracking. Select seismic data in the Input data
field and provide the event type (Peak/Trough/Zero-
crossing). Please, note that Max refers to peak, Min
refers to trough, 0+/- refers to positive to negative zero
crossing, and 0-/+ refers to negative to positive zero
crossing. Use the default search window as a starting
point. These settings can be accessed and changed
later. Also, use the default step-wise-tracking options
i.e. Relative (amplitude) difference of 1, 2, 5, 10, 20
â€¦%. Leave the other settings to default.
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Similarity: Matches the seismic events based on the
picked seeds and searches for the corresponding sig-
nal in the immediate vicinity. Please, leave this blank
for now. [Tip: For fast tracking in a good quality area,
reduce the threshold (e.g. 0.5), and the time gate (e.g.
-16 and +16).

Properties: Change horizon colour and the seed prop-
erties (e.g. size, colour and shape).

8. By default the seed mode is toggled on in the OpendTect track-
ing toolbar (shown below). Note that volume tracking is set on by
default (i.e. tracking in a small sub volume)

9. Next, start interpreting by picking a seismic event using the pen
device. [Tip: Drag the pen over a seismic event if the area is
coherent and of good quality, otherwise use the pen clicks on the
event to drop seeds]

10. Move the inline position and continue interpreting over the
entire survey.

11. In order to remove a seed, simply use the Eraser on the end of
the pen. Optionally, use the ExpressKeys on the tablet device
(subject to availability).
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Pen tap on a plane = pick and local track

Pen tap with Ctrl + Shift express keys pressed =
drop/undrop a seed at a pen location

Pen tap with Ctrl express key = remove the seed and
track locally

Pen tap with Shift express key = remove the seed and
erase auto-tracking from that seed until the next seed
(s)

12. After interpreting a good part of the survey area, test the auto-
track settings by specifying a small auto-tracking area. Select the

show tracking area button in the tracking toolbar.

13. A 3D boundary box appears around the interpreted horizon.
Use the green anchors at the corners of the box to re-size ormove
it: place the pen tip at one of the anchors and drag in the respect-
ive directions (diagonal anchors resize the entire box in 3D with
equal proportion, whilst the others stretch/squeeze the box hori-
zontally/vertically). [Tip: toggle view mode to perspective to see
the whole box.]

14. Once the tracking area is defined, tap anywhere in an empty
area in the scene to read/load seismic data within the specified
tracking volume. [Tip: Preferably, tap outside the survey area with
a zoomed-out view.]

15. Press the auto-track button to start auto-tracking the hori-
zon within the tracking area. [Tip: It is recommended to save the
raw interpretation as a separate file before attempting to auto-
track.]

Manual Tracking:
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16. Manual tracking is accessed by changing the tracking setup to

Line manual in the tracking toolbar drop-down list.

17. With Line manual selected, you will just need to draw hori-
zons using the pen [Tip: Drag the pen over the event and release
once done.]

18. Move about 5 or 10 inlines (or cross-lines) forward/backward
and repeat manual interpretation. [Tip: Instead of interpreting the
data in 3D, you may interpret the data in a 2D viewer]

Save Horizon(s):

Click on the save button that is present in the tracking toolbar to Save the <New Hori-
zon 1>>, alternatively right click the horizon in the tree menu and choose either Save or
Save as...

Save Session:
Save the session to continue interpreting the horizon at a later time if not completed

Manually Edit Horizons
This is an important exercise where you will learn how to edit a Horizon in OpendTect
with your tablet device.

1. In map view , draw a polygonal area using the polygon selec-

tion tool (from the Graphical Toolbar to the left).

2. Click the horizon from the tree (to activate it) and press the

trash icon to remove the outlined portion of the horizon
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3. Now switch to inline/cross-line view in the area of the removed
polygon

4. Enable the tracking mode; use the DuoSwitch to launch the
use the pop-up menu of the horizon and select the Enable track-
ing option under the Tracking sub-menu. This will enable the
tracking controls and now you can either edit the horizon in the
3D scene or in a 2D Viewer

5. From the tracking controls available at the bottom of OpendTect
by default, set setup to Line manual
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6. In this exercise, we will edit the horizon in a 2D viewer:

7. Display the inline in a 2D Viewer (use the lower DuoSwitch as
shown above)

8. In the 2D viewer, you will have to display the same horizon

9. Toggle Edit mode ON (or as shown below)

10. Now, start editing the horizon by drawing over an event using
the pen

11. Move the inline/cross- line to next/previous 10 lines, and
repeat the interpretation

12. Save the horizon after editing. This can be done directly from
the tree available in the 2D Viewer
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Interpret Faults

Faults in OpendTect can be interpreted as a FaultStickSets or directly as fault planes.
The FaultStickSet (in the tree) is a set of sticks that can be converted to 3D fault planes.
The FaultStickSet element can be used for a 2D line or for a 3D volume (inline/cross-
line/timeslice). Contrary to the FaultStickSet, the Fault element in the tree is generally
used to interpret a single 3D fault plane in a 3D survey, however FaultStickSets can be
converted and merged to new or existing single or grouped faults at any time (and vice
versa).

In this manual, you will learn the use of both mentioned methods of interpreting faults in
a 3D survey.

In the following workflow, use the pen device instead of mouse.

Tap/Press/Select in this workflow refers to the tip of the pen device.

Basic Fault Interpretation for 3D Seismic Data:
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1. Display an inline (or a cross-line) in the scene. [Make sure that
the seismic data has already been displayed along the displayed
inline]. Optional: Position the inline to a location at where you
want to start the 3D fault interpretation. To position, you may use
the slice position controls

2. Click on the Fault element to add a New Fault sub-element in
the tree. Next, make sure that it is selected / active

3. Now in the scene, start drawing the fault stick on the inline.
[Drag the pen over the inline at fault plane location]

4. To remove a seed of a fault plane, you may use the Eraser of
the pen

5. To position a seed to a new location, you may move the seed
by clicking and dragging it in any direction

6. Move (step) the inline to the next position to interpret another
stick of the fault in a new location (5 or 10 inlines forward or back-
ward or smaller steps if continuation is unclear). [Tip: Display the
fault plane on sections online. For this use may use the lower but-
ton of the DuoSwitch to launch the pop-up menu. In the pop-up
menu please select the Display option]

7. Repeat the steps to interpret the fault on other inline/cross-lines

8. Use the lower button of DuoSwitch to Save the <New Fault 1>

Interactive Fault Interpretation using Auto-scroll method:
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This is an alternative workflow for quick 3D fault interpretation.

1. Preload the seismic data on which you are intended to interpret
faults. [Tip: Use the Survey menu i.e. Survey > Preload > Seis-
mics]

2. Display an inline (or a crossline) in the scene. [Make sure that
the seismic data has already been displayed along the displayed
inline]

3. Click on the Fault element to add a New Fault sub-element in
the tree. This will add a <New Fault 1> fault under Fault element.
[Make sure that it is clicked / active]

4. Use the lower button of DuoSwitch on the Inline to launch the
drop-down list and select Position... In the Positioning dialog,
please click on the Scroll button

5. In the scrolling dialog, set the scroll step (i.e. number of
inlines/cross- lines to move, use positive number for forward
scrolling and negative number for backward scrolling) and time to
scroll the inline to the next position (use for example 5 seconds)
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6. Click on the to activate it

7. Now in the scene, start drawing the fault stick on the inline.
Drag the pen over the inline at where you observe the fault. Once
you have interpreted a fault stick on the current inline, wait for a
few seconds for the inline to be moved forward/backward auto-
matically

8. Continue the fault interpretation on all lines (step p-q)

9. Use the lower button of DuoSwitch to Save the <New Fault 1>

Fault Sticks Interpretation for 3D Seismic Data:
This workflow allows for interpreting fault sticks only, which can later be converted to 3D
fault planes. The benefit of this workflow is that you can interpret multiple sticks on an
inline/crossline.

1. Display an inline/crossline in the scene. [Tip: Click on the
Inline element to add a new inline]

2. Add a new FaultStickSet in the tree. [Click on the FaultStick-
Set, and select the Add option in the pop-up menu.]

3. Start drawing multiple fault sticks in the scene. To split sticks,
use lower DuoSwitch
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4. If you want to move a node of a fault stick, place the tip of the
pen over the node to be modified. Click and drag the node in 3D
and position it to a correct location

5. Save the FaultStickSet by launching the drop-down list [Tip:
Use the lower DuoSwitch button.]

6. Move the inline/crossline to the next position and continue the
interpretation

7. While moving the inline/crossline, you may still observe the
sticks from previously interpreted sections. To hide them (and
therefore avoid confusion), please display the fault sticks at sec-
tions only. [Tip: Use the pop-up menu for the fault stick set.]

Optional: Optionally combine the FaultStickSet interpretation workflow above with the
auto-scrolling method.

Convert Fault Sticks to Fault Planes:
To convert fault sticks into fault planes, you will need to familiarize yourself with the Fault
Sticks Toolbar (shown below). By default, this toolbar appears at the bottom of the
OpendTect window.

1. Display a time slice of similarity attribute, so that you can
identify the fault trends

2. Display the fault sticks in a 3D scene. [Tip: Use the pop-up
menu for the fault stick set.]
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3. Optional: Position the time slice (step-a) at where you can see
the tops of the fault sticks

4. Activate the select sticks button

5. Make sure that you are in interact mode

6. In the scene, draw a polygon to select the sticks that you want
to convert into a fault plane. [Use the pen device and draw a red
colored polygon.]

7. Once the tip of the pen is lifted away from the tablet, observe
that the sticks within the polygon turn green. This means that the
sticks have been selected (and can be converted to a fault plane)

8. Next, copy or move the selection to a single new fault plane.
This option is illustrated in the above fault stick toolbar

9. Give a name in the text field of the toolbar

10. Hit the Go button to save and display the fault plane in the
scene and tree

Useful Notes on Fault Sticks Toolbar:

l The 'Copy selection to' option is used to copy the selected fault sticks to
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a fault plane without remove the fault sticks from the original fault stick
set. Contrary to this, the 'Move selection to' option removes the selected
fault sticks from the original fault stick set and moves them to a fault
plane.

l The Fault/FaultStickSet option is used to convert the selected fault
sticks to a fault plane or to another fault stick set.

l There are different ways to name faults/FaultStickSets. This is done via
the output operations list box i.e. Create single new (to create a new
single fault plane or a fault stick set), Create new in series (auto-
matically labels the faults with a numeric index), Merge with existing (to
merge the fault plane to an existing fault plane or fault stick set), and
Replace the existing (replace the selected fault plane with the newly
selected sticks).

l The trash button in the toolbar is used to remove the selected fault
sticks

Supported Platforms
Officially the Wacom Cintiq 21UX and Wacom Cintiq 24HD are only supported on Win-
dows and Mac.
However it is possible to get it to work on Linux.
There is an Open Source group that writes and maintains drivers for the Wacom tablets.
For more information please go to this page.

http://sourceforge.net/apps/mediawiki/linuxwacom/index.php?title=Main_Page
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Appendix E - Synthetic Data Generation
Ray Tracing
Computation of the Zero Offset Reflection Coefficient
Computation of the Reflection Coefficient at any non-zero offset
Elastic Model

Synthetic seismic data is generated in SynthRock by clicking on the edit icon ( ) in
the top-left corner of the main Layer Modeling Interface. This will bring up the following
window:
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Here various types of synthetic data can be generated: Zero Offset Stack, Pre Stack gath-
ers, Angle Stack and AVO Gradient:

Ray tracing

While Zoeppritz equations are used to compute angle-dependent reflectivity; ray tracing
is required to compute the angle of incidence, at various interfaces of elastic model, of
seismic rays recorded at various offsets. The 2D ray-tracing can be performed in two
ways:

Simple Ray Tracer:
The ray is going directly from the source to the depth of the target layer, and
up to the receiver in the same way. This does not account for ray bending, or
velocity inversions. Here the user has to specify the offset range and the step
for creating pre stack gathers; they could in theory be same as defined in
acquisition/processing of the seismic data. It can model both Downgoing and
Upgoing P-waves and S-waves. Now, ray tracer and Zoeppritz equations
have produced angle-dependent or offset-dependent reflectivity traces, which
can be convolved with user defined wavelet to produce pre stack gathers. It
may be noted that in SynthRock, the conversion from offset domain to angle
domain and vice-versa is done using the Vp of the Elastic Model [hyperlink
with Elastic Model] (which is essentially the upscaled and time converted Vp
log of pseudo-wells).

Simple RayTracer parameters

Advanced Ray Tracer (not in the GPL version):
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This works in a more sophisticated way than the simple ray tracer. It honours
the ray bending according to Snell's law and thus velocity inversions as well.
To reduce the processing time, the Elastic Model layers may be blocked:
Consecutive layers with similar Vp, Vs and Density values are concatenated
together, as defined by the threshold. For example the default threshold is
1%, which means if there is less than 1% difference in the elastic model val-
ues of two layers, they will be blocked. The ray is propagated in a straight
line inside a concatenated layer.
It is also possible to compute internal multiples in the advanced ray tracer.
Furthermore, incorporation of spherical divergence, is also possible, by defin-
ing the spreading geometry as either "Distance" or "Distance*Vint" .

Advanced RayTracer parameters

Afterward, NMO corrections can also be applied to create NMO corrected syn-
thetic gathers. Here in the Advanced options, one can specify the % stretch
mute typically applicable at far offsets. If the length of a full seismic waveform
increases by more than the mute %, it will get muted. Moreover, the taper-
length of the muting function, can be defined under this advanced options
menu of NMO corrections:

Advanced RayTracer: Advanced corrections options
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Computation of the Zero Offset Reflection Coefficient For the simplest Zero Offset
Stack, calculation of reflection coefficient at any interface is done using the simple for-
mula:

where Z1 and Z0 are the impedance of the top and bottom layers, respectively. These lay-
ers are basically upscaled and time converted version of various logs (Rho, Vp and Vs)
in pseudo-well models, and as such comprise the Elastic Model [hyperlink with Elastic
Model] for synthetic seismic generation. The upscaling is done using the Backus aver-
aging algorithm in depth, but at a (variable) depth sampling rate which is equivalent to
the seismic sample rate in time. Depth-to-time conversion of the pseudo-well logs, is
done using the velocity model of the pseudo-wells itself.

Backus upscaling is done only for Vp, Vs and Density logs (and

other logs based on them e.g. AI, LambdaRho, MuRho etc.). All

other logs e.g. Phi, Sw etc. are upscaled using thickness weighted

averaging (i.e. weights used for the averaging are the thicknesses

of various pseudo-well layers) and are afterwards converted into

time (using the velocity model of the pseudo-wells), at survey

sample rate. A Nyquist filter, as defined by the survey sample rate

is also applied on these time converted rock property traces; e.g. if

seismic survey sampling is at 4 ms, Nyquist filter will allow a max-

imum frequency of 125Hz. These are accessible to user in real-

time on the Variable Density View:
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Now, computation of above described reflection coefficient, at all the possible acoustic
impedance contrasts in upscaled pseudo-well layers, gives rise to a reflectivity trace in
time.

This reflectivity trace is then convolved with a user defined wavelet, to create the Zero
Offset Stack for all the pseudo-well models:

Computation of the Reflection Coefficient at any non-zero offset Pre Stack data (i.e.
offset gathers) can be generated in OpendTect using full Zoeppritz equations and ray tra-
cing (simple or advanced).
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Full Zoeppritz equations are used to compute angle-dependent reflectivity from the
elastic model (i.e. upscaled and time converted version of various logs (Rho, Vp and Vs)
from pseudo-wells) at various interfaces as:

(above images are fromWikipedia)

Elastic Model
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This Elastic Model can be accessed by clicking the icon, just left of 'Wavelet'. This
model isrequired by OpendTect for generating synthetic seismic data (both zero offset
stack and pre stack gathers). The elastic model essentially tells the software which
quantities to use for the reflection coefficient computation and ray tracing, in terms of
Density, Vp and Vs:

If "Compute from: Defined quantity" is chosen, OpendTect can use appropriate
(upscaled and time converted) quantities from pseudo-wells. User can also chose to
compute missing quantities (not modeled in pseudo-wells) using pre-filled rock-physics
relations, e.g. Vs from Vp using Castagna's equation:
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Glossary

A

Absolute Impedance
Full-bandwith impedance inversion response in which the "missing" low-fre-
quency part of the spectrum has been added by the inversion method. For
example - in model-driven inversions the low-frequency model is typically cre-
ated by interpolating impedance well logs guided by mapped seismic horizons.

Accomodation Space
The available space for sediments to fill (measured from seafloor to base-level).

AI
Acoustic Impedance: the product of seismic velocity and density.

Attribute
An attribute is a derived quantity from a seismic input set. Attributes in OpendTect
are defined by a name, a value, and a position in 3D space (inline, cross-line and
Z (2WT or depth)). Attributes can be calculated from single-trace, multi-trace, and
multi-volume inputs. They can be steered and/or chained. Steered attributes are
multi-trace attributes in which the trace segments are found by following a (pre-)
calculated dip-azimuth. Chained attributes are attributes derived from other attrib-
utes. For example, Similarity and Energy are separate attributes that can be
chained to calculate the Similarity of the Energy using the "Position" attribute.

Attribute Set
An attribute set is an entity consisting of a group of attributes. Usually attributes in
a defined attribute set have something in common. For example, all attributes in a
set have the potential to highlight an object type of interest, or a combined attrib-
ute, using all other attributes as intermediate results. This would be a desirable
output.

B

Base level
The surface at which sediment supply, relative sea level changes and wave
energy are in balance. This is the surface at which the accommodation space
equals zero: there is neither deposition, nor erosion.
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Body
A body is an element that defines an arbitrary three dimensional geological
shape (or a geo-body). The body can also be created manually or by using poly-
gons.

C

ChimneyCube
A volume that highlights vertical disturbances in seismic data. The cube is used
in fluid migration path studies, in prospect ranking and for fault seal analysis. A
ChimneyCube is generated by a neural network that was trained on picked
examples (chimneys and non-chimneys). It gives at every sample location the
"chimney probability" i.e. the likelihood of belonging to the class of identified seis-
mic chimneys.

Chrono-stratigraphy
A set of relative geologic time lines as stored in a HorizonCube.

CLAS
A plugin for petrophysical analysis. CLAS stands for Computer Log Analysis Sys-
tem.

Closed Source
Software that is released in binary form only. The commercial plugins to
OpendTect are released as closed source extensions. Such extensions are only
permitted if OpendTect is run under a commercial (or academic) license agree-
ment.

Color Blending
Combined display of three (four) attributes that are displayed in the Red Green
and Blue color channels. Optionally the fourth channel (alpha) displays trans-
parency. Color blending is aka as RGB (RGBA) blending.

Crossline Dip
Dip in the direction of the Crossline axis, or in the direction of increasing cross-
lines.

D

Dip-Steering
The process of auto-tracking seismic data by following the pre-calculated, local
dip and azimuth of the seismic. Dip-steering is used for: a) extracting seismic
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trace segments along seismic reflectors as input to multi-trace attribute cal-
culations, b) computing special attributes such as polar dip, azimuth, and volume
curvature attributes, c) filtering seismic data (known as dip-steered filtering, aka
structurally oriented filtering), and d) auto-tracking chrono-stratigraphic horizons
in the creation of a HorizonCube.

Dip-Steering Cube
A volume computed from seismic data with at every sample position information
about the local dip and azimuth of the seismic data. In a 3D Steering Cube this
information is stored in two attributes per sample: inline dip and cross-line dip.
On 2D seismic only one value is stored: the line-dip. Dips in a Steering Cube are
measured in the line direction and expressed in us/m or mm/m, for time and
depth data, respectively.

E

EEI
Extended Elastic Impedance. Scaled and rotated impedance response at a paar-
ticular angle. Rotation is typically optimized to predict a certain well log property
of interest.

EI
Elastic Impedance. Impedance response at a particular angle of incidence.

Element
An element is a sub-division of various items (of the tree) that are displayed in a
3D scene. Inline, crossline, timeslices, horizon, wells etc are some elements.
Each element is sub-divided into a sub-element. For instance an inline element
can have further sub-elements e.g. inline # 120 that can contain upto eight dif-
ferent attributes.

Eustatic sea-level
Sea-level relative to center of earth.

Explicit Representation
A representation of a 3D object in OpendTect in the form of a triangulated sur-
face.
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F

Fault Stickset
The faults are interpreted on a section as a stick, and all sticks that belong to one
fault are grouped in one sticksets. Therefore, a fault stickset contains an
unordered collection of the interpreted sticks.

Forced regression
Deposition characterized by progradation and incision. Base-level is falling
decreasing accomodation space, forcing the system to prograde. Forced regres-
sion occurs during the Falling stage systems tract.

G

GMT
An open source mapping package developed and maintained by the University
of Hawaii (http://gmt.soest.hawaii.edu/). GMT stands for Generic Mapping Tools.

GPL License
Gnu General Public License (http://www.gnu.org/licenses/gpl.html) is an open
source license under which OpendTect can be run. The license allows redis-
tribution of (modified) source code under the same licensing conditions (copy left
principle). It is not allowed to combine the open source part with closed source
plugins, which is why OpendTect is also licensed under a commercial license
agreement and under an Academic license agreement.

H

Horizon Data
It refers to a stored attribute grid in a horizon. An attribute is calculated on-the-fly
or in a batch process. On-the-fly, a user needs to store by right-clicking on it an
selecting Save attribute... option. The saved attribute can also be managed in the
Manage horizon. It may be noted that a horizon can contain unlimited stored
attribute/horizon data.

HorizonCube
A dense set of auto-tracked (or modeled) seismic horizons that is indexed and
sorted according to relative geologic time (= chrono-stratigraphy).
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I

Implicit Representation
A representation of a 3D object in OpendTect in the form of an iso-surface
through a cube of values.

Incision
Depositional feature caused by erosion.

Inline Dip
Dip in the direction of the Inline axis, or in the direction of increasing inline num-
bers.

M

Madagascar
An open source seismic processing package. See: http://en.wiki-
pedia.org/wiki/Madagascar_(software)

Meta Attribute
A meta-attribute is an attribute created from multiple input attributes. In
OpendTect, a meta attribute is created either through neural networks, or through
mathematical manipulations and/or logical operations. For example, TheChim-
neyCube and TheFaultCube are meta-attributes. See the Ridge enhancement fil-
ter attribute set from the Default attribute sets for an example of a meta-attribute
created through math and logic. The meta-attribute in this set is the last attribute
in the list.

MLP Neural Network
Multi-Layer-Perceptron type of neural network. The network is used for seismic
object detection (creating Chimney Cubes, Fault Cubes, Salt Cubes etc.) and for
predicting rock properties from seismic data (Porosity, Vshale, Sw etc). An MLP
network is trained on a data set with known examples (supervised learning). In
the training phase the network aims to find the optimal, non-linear mapping
between input attributes and target attributes. The network in OpendTect is a
fully-connected, three-layer MLP (input layer, hidden layer, output layer). The
non-linear transformation takes place in the hidden layer.

MPSI
A plugin for stochastic acoustic impedance inversion. MPSI stands for Multi-Point
Stochastic Inversion.
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N

Normal regression
Deposition characterized by aggradation and progradation. The base level is
rising but the consumption of accommodation space by sedimentation exceeds
the creation of accommodation space by the base level rise. Normal regression
occurs during high stand and low stand systems tracts.

O

Open Source
Software that is released with its source code. OpendTect is released as open
source product that can be extended with closed source plugins. Such exten-
sions are only permitted if OpendTect is run under a commercial (or academic)
license agreement.

P

PDF
PDF is Probability Density Functions. In OpendTect these are created in the
cross-plot tool by selecting a desired area in the cross-plot domain. The density
of the points in the selected area is a measure for the probability of the desired tar-
get variable that can then be predicted by applying the derived PDF function to
(scaled) input volumes in a Bayesian classification scheme.

Pickset
A Pickset is a collection of picked locations, i.e. inline-crossline-Z information.
Picksets are part of a Pickset Group. For example a Pickset Group containing
picks at fault locations may consist of different fault Picksets to differentiate
between large faults and small faults, or to reflect picks on different inlines.

Pickset Group
A Pickset group is a collection of different Picksets. Usually Picksets are grouped
because they refer to the same object, e.g. Chimney_yes or Chimney_no.

R

Regression
Seaward shoreline & facies shift. Regression can be Normal (base level rises) or
Forced (base level falls).
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Relative Impedance
Band-limited impedance inversion response computed by methods such as
colored inversion.

Relative sea-level
The net effect of eustatic sea level changes and local tectonic fluctuations.

Retrogradation
Depositional trend characterized by sediments building landwards aka back-step-
ping.

S

SEG-Y
A file format for exchanging seismic or seismic-like data. It is used for both 2D
and 3D pre- or post-stack data. A file being SEG-Y compliant does not mean that
it can be loaded into OpendTect. There are several possible problems. One of
these is missing trace identification and/or positioning. Another issue is lack of
true compliance ->SEG-Y Rev 0, -> SEG-Y Rev 1). The different types of SEGY
are shown below: * SEG-Y Rev 0: The initial SEG-Y specification in 1975. It is
very precise in some areas but totally unspecified in other, crucial areas. This
has led to an almost uncountable number of variants. Some are sort-of SEG-Y
standard, others blatantly non-compliant. * SEG-Y Rev 1: In 2002 the Revision 1
document made an end to the most obvious shortcomings of ->SEG-Y Rev 0,
especially in the area of ->trace positioning and ->trace identification. Still many
SEG-Y files or files claimed to be SEG-Y are Rev 0 or badly (i.e. not) compliant
with Rev 1. This is why OpendTect has numerous options for the SEG-Y reading
process. * SEG-Y Textual header: The first 3200 bytes of a SEG-Y file must be
filled with textual comment on the contents of the SEG-Y file. Older textual head-
ers are encoded in EBCDIC rather than ASCII, which makes them impossible to
read in a standard text editor. * SEG-Y EBCDIC header: -> SEG-Y Textual
header. * SEG-Y Tape Header: The part of a SEG-Y file that gives information
about all traces in the file. This information is in the ->SEG-Y Textual header and
->SEG-Y Binary header. * SEG-Y Binary header: The second part of the SEG-Y
Tape header contains binary information about, amongst others, values for num-
ber of samples per trace, byte encoding, sample interval, and SEG-Y Revision. *
Trace identification: Every trace in OpendTect needs to have an identification in
form of a trace number (2D data) or inline/crossline (3D data). For pre-stack data
the offset forms and extra trace identification. * Trace positioning: In OpendTect,
every seismic trace needs to be located in 3D space. For 3D data, the position
can be derived from the->Trace identification (inline- and crossline numbers).
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Traces in 2D lines have their own, separate X- and Y- coordinate. For pre-stack
data there must also be an offset available.

SSIS
A plugin to perform a sequence stratigaphic analysis (systems tracts, Wheeler
transforms) from seismic data using HorizonCube input. SSIS stands for
Sequence Stratigraphic Interpretation System.

Stratal Slicing
The process of cutting through a seismic volume along surfaces that are com-
puted proportionally between mapped top and bottom horizons, aka proportional
slicing.

Systems Tracts
Subdivisions of sequences that consist of discrete depositional units that differ in
geometry from other systems tracts and have distinct boundaries on seismic data.
Different systems tracts are considered to represent different phases of baselevel
changes.

T

Trace Identification
Every trace in OpendTect needs to have an identification in form of a trace num-
ber (2D data) or inline/crossline (3D data). For pre-stack data the offset forms and
extra trace identification.

Trace Positioning
In OpendTect, every seismic trace needs to be located in 3D space. For 3D data,
the position can be derived from the->Trace identification (inline- and crossline
numbers). Traces in 2D lines have their own, separate X- and Y- coordinate. For
pre-stack data there must also be an offset available.

Transgression
Landward shoreline & facies shift characterized by aggradation and ret-
rogradation. The base-level is rising and more accommodation space is created
than is consumed by sedimentation

Tree
The tree is the docking window, which is detachable and movable. This is used
to display the data into a scene. The tree is attached to a scene and is labeled as
Tree Scene 1. Where '1' is the scene number. Each tree has its own elements
that are displayed in corresponding scene.
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U

UVQ Neural Network
Unsupervised Vector Quantizer type of neural network. This network is used for
clustering (segmenting) data into a user-defined number of clusters. Cluster cen-
ters are found in a training run on a subset of the data. In the application phase
the network generates two outputs: 1) the index number of the winning cluster
and 2) the match, a value between 0 and 1 indicating how close the input vector
is to the vector representing the winning cluster. UVQ segmentation can be per-
formed in 2D mode (waveform segmentation along mapped horizons) and in 3D
mode (generates 3D bodies). A display of the cluster centers is a useful dia-
gnostic in waveform segmentation (Neural Network module: Info button).

V

VMB
A plugin for picking velocities from semblance gathers, and in a surface-con-
sistent-manner. VMB stands for Velocity Model Building.

W

Waveform Segmentation
Process of clustering seismic trace segments with a UVQ network along a
mapped horizon into a user-defined number of clusters.

WCP
A plugin to pick and QC well log markers with the help of seismic data and
(optionally) the HorizonCube. WCP stands for Well Correlation Panel.

Wheeler Transform
Process of flattening seismic data (or attributes) according to the chrono-strati-
graphic horizons in a HorizonCube. In a Wheeler scene the vertical axis rep-
resent relative geologic time.



- 793 -

Index
2

2D Seismics 357, 740
2D Viewer 41, 46, 98, 109, 578, 740, 767

A

Analysis 53, 405, 423, 438-439, 448, 464, 467, 481
Angle Mute 517, 519, 527
Annotations 189
Ascii 60, 208, 210, 213, 215, 218, 221, 227, 230, 262, 266, 269, 271, 279, 285, 287,

301, 304-305, 325, 386, 393, 400
Attribute 19, 21, 53, 88, 98, 108, 124, 142, 155, 159, 167, 176, 250, 347, 409, 439,

442, 458, 532, 543, 578, 608, 611, 614, 617, 620, 629, 632-633, 638, 640, 646,
650, 652-654, 661, 685, 697

Attribute Set 206, 405, 408, 410, 419, 577
Auto-Update 593

B

Batch 514, 516, 533, 537, 559-560
Batch Job 537
Batch Processing 554, 573, 596
Batch Programs 581
Bayesian 232, 340, 457, 520
Body 140, 173, 311, 314-315, 423, 435, 445, 461
Body Operator 311-312
Bulk 218, 226, 280-283

C

Checkshot 385, 390
Cluster 560, 573, 683
Color Table 316
Command Driver 12, 584, 700
Contours 104, 541
Coordinates 59, 62, 242, 249
Copy 57, 194, 199, 258, 349-352, 357, 360, 774
Create Horizon Output 53, 420, 532
Create Seismic Output 53, 419, 423, 504, 524
Cross-plot 347, 407, 438, 443



- 794 -

D

Development Environment 583
Dip 20, 29, 68, 151, 411, 556, 588, 666, 676, 686, 696
Display 43, 46, 53, 62, 72, 75, 79-80, 90, 99, 105, 111-112, 115, 122, 131, 136, 141,

143, 151, 158, 162, 165-166, 178, 184, 377, 455, 473, 476, 491, 577, 597, 695,
740, 745, 757

Download 12
Dump 357, 361, 578

E

Edit 37, 52, 63, 73, 93, 127, 171, 181, 194, 199-200, 336, 340, 354, 371, 386, 393,
430, 464, 467, 473, 483, 524, 531, 547, 702, 755

Export 87, 107, 140, 284-288, 290, 292-296, 298, 300-301, 304-305, 307, 357, 359,
392, 395, 400, 496, 590, 739

F

Fault 79, 165, 213, 319, 406, 646
Filter 76, 148, 377, 386, 411, 415, 432, 442, 608, 620, 632, 693
Flattened Scene 165

G

Gain 527, 654
Gather 94, 527
Geometry 146, 218, 224, 323, 496
GMT 147, 539-541, 580
GPR 234, 259
Graphics 23, 577
Grid 106, 121, 145, 222, 515

H

Help 12, 42, 583, 606
Histogram 39, 101, 105, 128
Horizon 20, 62, 141-142, 146, 157, 159-160, 164-165, 291, 328, 330, 422, 428, 512,

532, 534, 556, 563, 607, 612, 632, 756
Horizon Data 143, 421, 533, 543
HorizonCube 13, 20, 22-23, 42, 90, 104, 334, 556, 564
HostID 603

I

Import 36, 52, 59-60, 205-208, 210, 213, 215, 217, 227, 229, 232, 234, 251-252, 256-
257, 259, 261, 265, 267, 276, 377, 386, 392-393, 395, 408, 416, 467, 739, 745



- 795 -

Installation 14, 585, 600
Installation Manager 585, 594
Interpolate 74, 164, 425, 578
Interpret 63, 77, 79, 155, 755
Isopach 153, 536

K

Keyboard Shortcuts 574

L

Layer Modelling 480, 491
License 601
License Installation 600, 602
Lighting 28
Lithologies 374
Log 277, 437, 439, 469, 607, 637
Log File 590, 604

M

Madagascar 22, 549-550, 553
Manage 22, 36, 42, 123, 143, 221, 258, 308-309, 311, 316-317, 319, 321, 323, 327-

328, 330, 335, 339-340, 343, 348, 356-357, 361-362, 366-367, 369, 374-376,
383, 392, 461, 464, 481, 555, 580

Marker 38, 84
Merge 136, 340, 349, 353, 357-358, 383, 775
Modelling 482
Mouse Controls 33, 101, 574
Multi-Cube 511
Multi-Machine 539, 555, 596
Multi-Threaded 19
Multi-Well 277, 386
Multi Attribute 509
Mute 227, 292, 525

N

Neural Network 22, 132, 157, 411, 432, 675

O

Offline Installation 587, 591
Open Source 775



- 796 -

P

PDF 22, 232, 294, 340, 343, 520
Picks 33, 132-133, 183, 220, 229, 231
Pickset 23, 130, 132-134, 136, 156, 461
Plugins 579, 594, 600, 606-607
Polygon 32, 104, 131, 133-134, 136, 444, 446, 545
Position Conversion 582
Pre-load 401-402
Probability Density Function 294
Processing 423, 504-506, 511-512, 523-524, 530-533, 536, 553-554, 559-560, 572,

597, 693, 738

R

Random Line 101, 112, 516
Ranges 36, 202-203, 453, 460
Ray Tracing 489, 776
Restore 40, 94, 717
Rock Physics 398, 464, 643

S

Scene 26, 83, 162
SEG-Y 46, 51, 55-56, 58-59, 62, 194, 198, 202, 205, 234-235, 242-243, 245, 252,

254, 260, 276, 295-296, 298, 300, 323, 430, 511, 529, 563, 577, 581, 649, 739,
745

SEG-Y Examiner 60, 243
Session 40, 203, 766
Settings 31-32, 45, 58, 87, 95, 108, 168, 203, 289, 460, 533, 535, 550, 569, 575, 594,

597, 744
Setup 51, 53, 55, 77, 155, 162, 192, 203, 540, 582, 596, 761
Simple File 254
Slice Position 32
Smoother 425-426
Snapshot 719
SSIS 90, 140, 565, 743
Steering 20, 511, 652, 662, 666, 679, 687
Stereo Viewing 567
Stratal Amplitude 533
Stratigraphy 23, 333, 369, 374-375, 484
Survey 19, 21, 40, 51, 53, 55-56, 58-60, 62, 84, 140, 192, 198, 201-203, 210, 213,

217, 227, 229, 234, 254, 262, 266, 270, 276, 282, 285-286, 305, 308-309, 319,
321, 323, 327-328, 348, 358, 361-362, 366-367, 369, 376, 383, 402, 542, 557,
575, 580, 582, 597, 702, 771



- 797 -

Synthetic 375, 378, 467, 481, 485-486, 491, 501, 776

T

Table 2, 104, 117, 444, 446
Tagged Seismic Data 260, 563
Taper 377, 381, 479, 526, 623, 626, 693
Time-Depth Conversion 530
Toolbars 21, 568
Tools 15, 22, 76, 144, 163, 539, 581, 601, 603
Trace 46, 299-300, 304, 634, 662, 665
Track 60, 141, 160, 270, 385
Tracking 18, 31, 64, 78, 155, 158, 162, 763
Tree 83, 89, 758

U

Utilities 32, 62, 157, 569, 581, 590, 596, 599, 604, 701
UVQ 132, 157

V

Variogram 149, 450
Velocity 20, 184, 260-261, 352, 396, 399, 429, 530, 556, 579, 608, 693
Velocity Conversion 531
View 15, 24, 34, 175, 356, 386, 419, 427, 476, 542, 566, 623, 702, 760, 779
Volume 20-21, 60, 65, 90, 98, 105, 128, 137, 156, 167, 258, 261, 297, 302, 306, 311,

350, 431, 436, 516, 519, 531, 534, 555, 608, 617, 678, 692, 697
Volume Builder 167, 423-424, 438, 531, 579
Voxel 432

W

Wacom 15, 755
Wavelet 20, 23, 307, 377, 379, 469, 479, 485, 487, 500, 555, 610, 670, 782
Well 21, 23, 60, 62, 88, 107, 174, 269, 276-277, 280, 283, 370, 383, 389, 392, 395,

436, 439, 445, 453, 458, 464, 467-469, 476, 522, 579, 637
Well-Tie 468-469, 472, 476
Wells 62, 104, 115, 174, 267, 384, 390, 464, 523, 541

Z

Z-slice 19, 24, 33, 36, 79, 88, 99, 104, 135, 190


	Preface
	About this Manual
	Release Notes
	About OpendTect
	Copyright
	Acknowledgements

	Getting Started
	System Overview
	Multi-Threaded Programming

	Toolbars
	OpendTect Toolbar
	Manage Toolbar
	Graphics Toolbar
	Take Snapshots
	Directional Lighting

	Tracking Toolbar
	Slice Position Tool

	Mouse Controls - Scenes and Graphical Interaction
	Color Tables
	General Selection Window
	2D Viewer
	Pre-Stack 2D Viewer


	How To
	QuickStart a Project
	OpendTect Survey
	Setup 2D & 3D Survey
	Survey Name and Type
	Survey Ranges
	Coordinate Settings

	Data Loading
	Load Seismic (2D & 3D)
	Load Well Data


	Display Loaded Data
	Interpret Horizons
	3D Horizons
	Edit 3D Horizons
	2D Horizons

	Interpret Faults

	OpendTect Trees and Elements
	Scene
	Inline, Crossline & Z-Slice
	Volume
	Random Line
	Manual Mode (Empty)
	Create from Existing
	Create Along Contour
	Create from Polygons
	Create From Wells
	Create From Table
	Interactive Mode

	2D Seismic
	Pickset & Polygon
	Manual & Empty Picksets
	Generate Random Picks (3D)
	Generate Random Picks (2D)
	Polygon
	Pop-Up Menus

	Horizon
	Add Attribute
	Color-Blended Display
	Tools
	Grid
	Filter
	Snap-To Event
	Variogram

	Display Contours
	Calculate Isopach
	Flattening
	Tracking
	Shift
	Calculate Volume
	Other Options
	Store Z as Attribute
	Set Z Values

	2D Horizon
	Display
	Tracking
	Tools
	Workflows

	Fault
	FaultStickSet
	FaultStickSet to Fault

	Body
	Well
	Pre-Stack Events
	Pre-Stack 3D Viewer
	Annotations

	Survey
	Select & Setup Survey
	Survey Selection Window
	New Survey Window
	Edit Survey Window
	Survey Ranges
	Coordinate Ranges


	Session
	Import
	Import Attributes
	Import Color Table
	Import Cross-Plot Data
	Import Faults
	Import Fault Ascii 3D

	Import FaultStickSets
	Import FaultStickSets Ascii 3D
	Import FaultStickSets Ascii 2D

	Import Horizons
	Geometry 3D
	Attributes 3D
	Geometry 2D
	Bulk 3D

	Import Mute Functions
	Import PickSets & Polygons
	Import Probability Density Functions
	Import Seismics
	SEG-Y
	SEG-Y Import Preparation
	SEG-Y Revision
	SEG-Y Examiner
	SEG-Y Import
	SEG-Y Scan

	SEG-Y Scanned
	Simple File
	Import CBVS Cube
	GPR - DTZ
	Tagged Seismic Data

	Import Velocity Functions
	Import Wavelets
	Import Wells
	From Ascii Files
	Track
	Logs
	Markers

	Import Zero-Offset VSP
	Simple Multi-Well
	Bulk
	Bulk Well Track Import
	Bulk Well Log Import
	Bulk Well Marker Import
	Bulk Well Time-Depth Model Import



	Export
	Export Faults
	Export FaultStickSets
	Export Geometry 2D
	Export Horizons
	Export Ascii 3D Horizons
	Export Ascii 2D Horizons

	Export Mute Functions
	Export PickSets & Polygons
	Export Probability Density Functions
	Export Seismics
	Export SEG-Y
	Export SEG-Y 3D
	Export SEG-Y 2D
	Export SEG-Y Prestack 3D

	Export Simple File
	Export 3D Simple File Format
	Export 2D Simple File Format
	Export PreStack Simple File


	Export Wavelets

	Manage
	Manage Attribute Sets
	Manage Bodies
	Body Operator
	Body Region Constructor
	Estimate Body Volume
	Switch Body Values

	Manage Color Tables
	Manage Cross-Plot Data
	Manage Faults
	Manage FaultStickSets
	Manage Geometry 2D
	Manage Horizons
	Horizon Manager 2D
	Horizon Manager 3D

	Manage Layer Properties
	Manage PickSets & Polygons
	Manage Probability Density Functions
	Generate Probability Density Functions

	Manage Seismics
	Manage 3D Seismics
	Copy Cube
	Copy - Volume Sub-Selection
	Copy - Format & Scaling

	Merge Files
	Browse & Edit Cube Locations

	Manage 2D Seismics
	Manage 2D Seismic Lines
	Merge 2D Lines
	Extract 2D Attributes from 3D Volumes
	Export 2D Geometry to Google Earth

	Copy Data Set
	Dump 2D Geometry


	Manage Seismics Prestack
	Manage 3D Prestack
	Manage 2D Prestack

	Manage Sessions
	Manage Stratigraphy
	Manage Lithologies
	Manage Contents
	Layers & Synthetic Modelling

	Manage Wavelets
	Import Wavelet
	Generate Synthetic Wavelets
	Statistical Wavelet Extraction
	Rotate Phase
	Taper a Wavelet in Time or Frequency Domain
	Merge Synthetic Wavelets

	Manage Wells
	Simple Multi-Well Creation
	Well Track Editor
	Checkshot and Time-Depth Models
	Manage Markers
	Logs Import
	Logs Creation
	Rock Physics Library

	Logs Export
	Export Well Surface Positions to Google Earth


	Pre-load
	Preload Seismics
	Preload Horizons


	Analysis
	Attributes
	Attribute Set Window
	Attribute Set Toolbar
	Auto-Load Attribute Set
	Default Attribute Sets
	Input Selection
	Input Selection for 3D Attribute Sets
	Input Selection for 2D Attribute Sets

	Import an Attribute Set from
	Calculate Attributes

	Volume Builder Setup
	Body Shape Painter
	Lateral Smoother
	Smoother
	Horizon-based Painter - Advanced
	Velocity Gridder
	Input Volume
	Voxel Connectivity Filter
	Well Log Interpolator

	Cross-Plot
	Cross-Plot Data Extraction
	Well-based Data Extraction
	Attribute-based Extraction Window
	Location Filters

	Cross-Plot Table
	Cross-Plot Window
	Cross-Plot Properties
	Probability Density Functions
	Overlay from a Third Attribute
	Well-based Color Coding
	Selection Settings

	Open Crossplot

	Wells
	Well Log Tools
	Tie Well to Seismic
	Well-Tie Selection Window
	Well-Tie Checkshot Editor
	Well-Tie Display Panel
	Well-Tie Crosscheck Parameters


	Layer Modelling
	Basic Modelling - Introduction
	Layer Description
	Synthetic- and Property-Log Generation
	Synthetic Layer Properties
	Wavelet
	Ray Tracing
	Display
	Layer Properties
	Remove Layer
	Export Synthetic Datasets

	Cross-Plots
	Wavelet Scaling
	Seismic Attributes
	Layer Attributes



	Processing
	Create Seismic Output
	Attributes
	2D - Create Output
	3D - Create Output
	Multi Attribute
	Multi-Cube Data Store
	Along Horizon
	Between Horizons

	2D to 3D Conversions
	Create 2D Grid
	Extract 2D from 3D

	Angle Mute Function
	Advanced Angle Mute Paramaters

	Bayesian Classification
	Create from Well Logs
	Pre-Stack Processing
	Mute
	Automatic Gain Control
	Super Gather
	Angle Mute

	SEG-Y Scanned Re-Sort
	Velocity
	Time-Depth Conversion
	Velocity Conversion

	Volume Builder Output

	Create Horizon Output
	Attribute
	Stratal Amplitude
	Isopach

	(Re-)Start Batch Job
	GMT
	Initial Setup
	Create Postscript Maps

	Madagascar
	Madagascar Installation
	Madagascar Processing Window
	Toolbar
	Processing Input
	Madagascar Processing Output

	Batch Processing
	Single Machine Batch Processing Window
	Multi-Machine Batch Processing Window
	Batch Log File
	Cluster Processing


	Scenes
	Time- and Depth-Converted Scenes
	Flattened Horizon Scenes
	Wheeler Scenes

	View
	Work Area
	Z-Scale
	Stereo Viewing
	Toolbars

	Utilities
	Settings
	Look and feel
	Mouse Controls
	Keyboard Shortcuts
	Advanced Settings
	Personal Settings
	Survey Defaults


	Tools
	Batch Programs
	Position Conversion
	Create Plugin Development Environment
	Command Driver

	Installation
	Update (Installation Manager)
	Package Manager
	Utilities Menu
	Export Download List
	Rollback
	Show Log File

	Offline Installation
	Package Verification



	Auto-Update Policy
	Connection Settings
	Plugins
	Setup Batch Processing
	Licenses
	Install demo/node-locked license
	Clear License Installation
	Show HostID


	Show Log File

	Help
	Appendix A - Attributes and Filters
	Convolve (2D & 3D)
	Delta Resample
	Energy
	Event
	Fingerprint
	Frequency Filter
	Frequency
	GapDecon
	Grubbs Filter
	Horizon
	Instantaneous
	Log
	Match Delta
	Mathematics
	Position
	Prestack
	Reference
	Reference Shift
	Sample Value
	Scaling
	Semblance
	Similarity
	Spectral Decomposition
	Texture
	Texture - Directional
	Velocity Fan Filter
	Volume Statistics

	Appendix B - Command Driver Manual
	Appendix C - SEG-Y Checklist
	Appendix D - Wacom Digitizing Tablets
	Appendix E - Synthetic Data Generation
	Glossary
	Index
	Bookmarks
	search_window
	2D_tracking_setup
	add_isosurface
	scan_report
	edit_pdf
	Evaluate_Attribute
	Crossplot_attributes
	Reconstruct_set_from_job_file
	Batch_Execution
	top
	Horizons
	introduction
	The_Command_Driver_control_window
	Executing_scripts_from_the_command_line
	Window_management
	Search_keys
	Identifiers_and_expressions
	Command_specifications
	table_iii
	question_commands
	Expressional
	Repetitive_task_example
	Standard_test_scripts
	User_history_recording
	textual_header
	line_header
	soluton_one
	no_headers
	first_but_no_others
	examine_scan
	loaded_wrong_amp
	loaded_holes
	loaded_shifted
	excel_utilities
	segy_file_size_comp
	segy_trace_number_comp
	Introduction
	pen_device
	basic_interaction
	draw_polygons
	interpret_horizons
	man_edit_horizons
	interpret_faults
	supported_platforms
	Ray_tracing
	Computation_of_the_Zero_Offset_Reflection_Coefficient
	Computation_of_the_Reflection_Coefficient_at_any_non-zero_offset
	Elastic_Model


